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For Your Safety

Read the User's Manual (this manual) for your safety before using the product.

Cautions Topics to Safety

General Cautions
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Cautions Topics to Safety

Indicates additional information which, if ignored or not followed, may result in
 personal injury or death.

Indicates additional information which, if ignored, may result in personal injury.
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General Cautions

Do not touch the
 safety switch inside
 this machine. High
 voltage may occur,
 resulting in electric
 shock. Also, a gear
 may rotate, resulting
 in injury.

Do not use a highly
 combustible spray
 near this machine.
 Some parts inside the
 machine become very
 hot, possibly resulting
 in fire.

If the cover becomes
 extremely hot, the
 machine emits smoke
 or odor, or you hear a
 strange sound, unplug
 the power plug from
 the outlet, and contact
 your dealer. 
Fire may result.

If liquid such as water
 gets inside the
 machine, unplug the
 power plug from the
 outlet, and contact
 your dealer. 
Fire may result.

If you drop a clip or
 other foreign objects
 into the machine,
 unplug the power plug
 from the outlet, and
 take the foreign
 objects out. 
Electric shock, fire, or
 injury may result.

Do not perform any
 operation or
 disassembly other
 than instructed in the
 user manual. 
Electric shock, fire, or
 injury may result.

If the machine is
 dropped or the cover
 is damaged, unplug
 the power plug from
 the outlet, and contact
 your dealer. 
Electric shock, fire, or
 injury may result.

Unplug the power plug
 regularly, and clean
 the bases of and in
 between the plug
 blades. 
If the power plug is left
 plugged into the outlet
 for an extended period
 of time, dust adheres
 on the bases of the
 plug blades, and a
 short may occur,
 possibly resulting in
 fire.

Do not vacuum spilled
 toner with an electric
 vacuum cleaner.
 Vacuuming spilled
 toner with an electric
 vacuum cleaner may
 result in ignition due
 to sparks from electric
 contacts or other
 reasons. 
If toner spills on the
 floor or other places,
 wipe the toner gently
 with a damp rag or
 other cloth while using
 care not to scatter the
 toner.

Do not insert any
 object into a vent
 hole. 
Electric shock, fire, or
 injury may result.

Do not place a cup
 filled with water or
 other objects on the
 machine. Electric
 shock or fire may
 result.

Do not let pet urine or
 other liquid get inside
 this machine, or allow
 this machine to get
 wet. Electric shock or
 fire may result.

When the machine
 cover is opened, do
 not touch the fuser.
 Burns may result.

Do not throw the toner
 cartridge or image
 drum into a fire. The
 toner may ignite,
 resulting in burns.

Do not connect the
 power cord, cables, or
 the ground wire in any
 way other than
 instructed in the user
 manual. 
Fire may result.

Operation using an
 UPS (uninterruptible
 power supply) or
 inverter is not
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 guaranteed. Do not
 use an uninterruptible
 power supply or
 inverter. 
Fire may result.

Do not go near the paper output part
 when you turn the power on or when
 printing is in progress. Injury may
 result.

Do not touch a broken liquid crystal
 display. Injury may result. If you get
 liquid (liquid crystal) spilled from the
 liquid crystal display into your eyes or
 mouth, immediately rinse with a large
 amount of water. Seek medical advice
 if necessary.

Do not disassemble the image drum or
 toner cartridge, or force them open.
 You may inhale the scattered toner, or
 the toner may land on your hands or
 clothes, making them dirty.

Do not put credit cards, USB Memory,
 etc. close to the clip tray on the
 document glass. Doing so may damage
 data.

NOTE!
This product is not intended for use in the immediate visual field on the display work place.
 To avoid disturbing reflections on the display work place, this product shall not be placed in
 the immediate field of vision.
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About This Manual

Various information about this manual is provided here. Read these sections before using
 this manual.

How to Use This Manual

This section describes how to use and conditions of use of this manual.

Disclaimer

Every effort has been made to ensure that the information in this document is complete,
 accurate, and up-to-date. The manufacturer assumes no responsibility for the result of
 errors beyond its control. The manufacturer also cannot guarantee that changes in
 software and equipment made by other manufacturers and referred to in this manual will
 not affect the applicability of the information in it. Mention of software products
 manufactured by other companies does not necessarily constitute endorsement by the
 manufacturer.

While all reasonable efforts have been made to make this document as accurate and
 helpful as possible, we make no warranty of any kind, expressed or implied, as to the
 accuracy or completeness of the information contained herein.

Copyright of the manual

All rights reserved by Oki Data Corporation. No part of this document may be reproduced
 in any form or by any means without prior written permission from Oki Data Corporation.

© 2015 Oki Data Corporation

Manual Composition

The following manual is included in this product.

Setup Guide

User's Manual ------ This manual (HTML manual)
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How to Use This Manual

Note
There are some restrictions to use this manual. Use care.

The manual saved in a shared folder created on a network, etc. may not be correctly
 displayed. In such case, save the manual on a computer you are using.

For your comfortable use this manual, recommended environments are as follows.

With other than following environments, parts of display may be disturbed, and some
 function may not be used.

Windows: Internet Explorer 11.0 or later

Mac OS: Safari 7.0 or later

Display resolution: 1024 x 768 or more

Some functions are restricted if your Web browser cannot use the cookie function or does not
 permit it.

When you start this manual by clicking "index.html", the Active X console is displayed. Click
 [Allow blocked content].

If tables in this manual are not correctly displayed, widen the well browser window.

Screen Composition

This section describes the screen composition of this manual.

How to Use the Table of Contents

This section describes how to utilize the table of contents, such as registration of favorite
 topics.

Using the Search Function

This section describes how to search for topics that include entered keywords.

Printing a Topic

This section describes how to print the topic you want to view.

About Descriptions

This section describes marks, symbols, abbreviations, and other information in this
 manual.
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Screen Composition

This manual is composed of the top page and body pages in each category.

Top Page

Content Page

Top Page

The top page is the first page that is displayed when you open this manual.

Number Item Description

1 Before Starting This section describes how to use this manual, conditions of use of
 this manual, etc.. Read carefully before using this manual.

2 Searches for a word in this manual.
Using the Search Function

3 Functions Put your mouse over to display "See more functions". Click to
 display useful functions. Switch four tabs to search for functions.

4 Links Moves to the corresponding topic.

Maintenance Describes how to replace consumables and how to clean this
 machine.

Troubleshooting Describes how to solve problems.

Settiing Items Describes how to set up this machine and register information
 before using.

5 FAQ Open the FAQ web page.

Site Map Displays the site map of this manual.

Trademarks and
 Other
 Information

Displays the trademarks in this manual.

License Displays the software license agreement and other licenses.

Contacts Displays the contact information.

Content Page

26



Number Item Description

1 Table of Contents
 Area

Displays a topic in a category in the content area by clicking a
 topic title.
Some categories, such as Error Message Search do not have the
 contents area.

How to Use the Table of Contents

2 Content area Displays a topic.

3 Returns to the top page.

COPY Displays [Using the Copy Functions].

SCAN Displays [Using the Scan Functions].

PRINT Displays [Using the Print Functions].

FAX Displays [Using the Fax Functions].

4 SITE MAP Displays the site map of this manual.

5 Prints the selected topic.
Printing a Topic

6 Topic Title Indicates the title of the displayed topic.

7  /  : Collapse all
 : Expand all

8 Displays the previous topic.

9 Displays the next topic.

10 Returns to the top of the displayed topic.
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How to Use the Table of Contents

This section describes the [TOC] tab on the top of the contents area.

Memo
Click  to hide the contents area and widen the content area. Click  to shrink the content area
 and widen the contents area.

[TOC] tab

The table of contents of the category to which the topic displayed on the right screen
 belongs is displayed.

A title with a  mark at the beginning has subtopics. Click the  mark to display the
 subtopics of the title. Also, click the  mark to close the subtopics.

Click [Expand all] to display all the topic titles of the category.

Click [Collapse all] to close all the expanded titles.
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Using the Search Function

You can enter a "word you want to search" or an "error message displayed on the touch
 panel" as a keyword to search for a specific topic from all the topics in this manual.

1. Enter the word you want to find in the search box at the top of the
 screen, and then click [ ].
Top page:

Content page:

Search results are displayed in a separate screen.

When entering multiplex words, input a space between the words. The topics that
 include all of the entered keywords are searched for.

Search Options
Click search options and add options when searching to narrow searching range.

Memo
AND Search is set by default.

2. Click the title of the topic to view.
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The topic is displayed on the right screen.

Memo
To run a case sensitive search, select [Case-sensitive] check box, and then click .

For the page number on the bottom of the search results
 screen
10 search results are displayed on 1 page. To change the page to display other
 10 search results, click the page number.

If 50 or fewer search results are found, only page numbers are displayed.

If 51 or more search results are found, the following icons are displayed before
 and after the page numbers.

: Returns to the first page of the search results

: Proceeds to the last page of the search results

: Returns to the previous page of the search results

: Proceeds to the next page of the search results
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Printing a Topic

Setting for Printing

Printing the Displayed Topic

You can print the topic that is currently displayed.

Setting for Printing

Memo
You must check the setting of your Web browser by following the procedure below before
 printing for the first time.

1. Select [Print] from  of your Web browser.
If the Web browser menu is not displayed, press the <F10> key.

2. Click [Print preview] from the drop-down list.

3. Click  (Page Setting).

4. Select the [Print background colors and images] check box.

Printing the Displayed Topic

Print the topic displayed on the right screen.

1. When a topic is displayed, click [ ] at the top of the screen.

2. Set printing settings, and then print.
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About Descriptions

About Marks

About Symbols

About Illustrations

Marks, symbols, illustrations, and other descriptions are provided.

Unless otherwise specified, this manual uses screenshots of the following screens.

For Windows: Windows 7

For Mac OS X: Mac OS X 10.9

Memo
The descriptions in this manual may vary depending on your OS or model.

About Marks

This manual uses the following marks.

Symbol Meaning

Indicates the cautions and restrictions for operating this machine correctly. Be sure to
 read to ensure that you can operate the machine correctly.

Indicates information that is useful for using this machine. It is recommended to read.

Indicates a reference topic. Read when you need more information.

Indicates a related topic. Read when you need related information.

Indicates a title within the topic. If you click the link, the topic is displayed.

About Symbols

This section describes symbols and their meaning in this manual.

Symbol Meaning

Illustration (button
 name)

Indicates a button (button name) on the operator panel of the machine.

[ ] Indicates a menu name, item name, option, or other items that are
 displayed on the display screen.
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Indicates a menu, window, or dialog box name that is displayed on the
 screen on a computer.
They can be clearly distinguished in descriptions or illustrations in
 procedures.

" " Indicates a message on the display screen or entered text.
Indicates a file name on a computer.
Indicates the topic title of a link destination.

< > Indicate a key on the computer keyboard.

> Indicates how to display the required menu of the machine or computer.

About Illustrations

The illustrations of MC873 are used in this manual as examples.

The illustrations of the touch panel used in this manual are displayed with the factory default
 settings.

Memo
The descriptions in this manual may vary depending on your model.
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Setting Up

Installation Requirements

Checking the Accessories

Unpacking and Installing the Machine

Installing Options

Turning the Machine On

Setting Up This Machine

Connecting This Machine to a Network

Connecting via a USB Interface

Connecting a Telephone Line

Installing a Driver and Software to a Computer
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Installation Requirements

Installation Environment

Installation Space

Installation Environment

Install the machine in the following environment.

Ambient temperature: 10℃ to 32℃
Ambient humidity: 20% to 80% RH (relative humidity)

Maximum wet bulb temperature: 25℃

Note
Use care to prevent condensation. It may cause a malfunction.

If installing your machine where the ambient humidity is 30% RH or below, use a humidifier
 or antistatic mat.

The diffusion of dust, ozone, styrene, benzene, TVOC, and ultrafine particles conforms to the
 Eco Mark 155, "Printer" substance emission certification criteria. (Toner was tested by
 performing black and white and color printing with Oki Data genuine toner cartridges
 according to the appendix S-M of the Blue Angel RAL UZ-171:2012 test method.)

Depending on the installation environment, the operation noise may be louder. If the noise
 bothers you, we suggest you to install the machine in the place away from you or in another
 room.

Do not install this machine in a location where temperature becomes high or near open flames.

Do not install this machine in a location where chemical reactions may occur (such as a
 laboratory).

Do not install this machine near alcohol, thinners, or other flammable solvents.

Do not install this machine in a location within the reach of children.

Do not install this machine in an unstable location (such as on an unsteady stand or slanted
 location).

Do not install this machine in a location with high level of humidity or dust, or in a location
 where the machine is exposed to direct sunlight.

Do not install this machine in an environment where it is exposed to salty air or corrosive gas.

Do not install this machine in a location where it is exposed to a high level of vibration.

Do not install this machine in a location where its vent hole is blocked.
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Do not install this machine directly on a thick rug or carpet.

Do not install this machine in a closed room or other locations with bad circulation and
 ventilation.

If you use this machine in a small room continuously for an extended period of time, make
 sure to ventilate the room.

Install this machine away from a source that emits strong magnetic fields or noise.

Install this machine away from a monitor or television.

Carry this machine by holding both its sides and slightly slanting its rear side down.

Installation Space

Install the machine on a flat surface that is wide enough to accommodate the legs of the
 machine.

Allow for enough room around the machine as shown in the following figures.

Top view

Side view
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Checking the Accessories

Check that you have everything shown below.

Lift this machine by 3 persons, because it weighs approximately 64 kg.

Note
Be sure to use the supplied consumables or maintenance units first. If other consumables or
 maintenance units are used first, the life time may not be shown correctly or supplied
 consumables may not be applied.

Main body

Four image drums (black, yellow, magenta and cyan)

Four starter toner cartridges (black, yellow, magenta and cyan)

For the MC models, the starter toner cartridges are installed in the image drums, which
 are installed in the machine before shipment.

Note
The starter toner cartridge is not installed in the ES models. Install the toner cartridge that is
 included in this machine. Refer to "Replacing the Image Drum".

Software DVD-ROM

Injury may result.
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Power cord

Telephone cable

Core

Memo
LAN cables or USB cables are not included in the package. Prepare the cable that suits your
 computer separately.

Packaging and cushioning materials are used when transporting the machine. Do not dispose
 packaging materials as they may be used in the future.
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Unpacking and Installing the Machine

This section describes how to unpack and install the machine.

Lift this machine by 3 persons, because it weighs approximately 64 kg.

Note
Use extra care when handling the image drum (the green cylinder), because it is fragile.

Do not expose the image drum to direct sunlight or strong light (approximately 1,500 lux or
 more). Even under room lighting, do not leave the image drum for 5 minutes or more.

Packaging and cushioning material is required for transporting the machine. Do not dispose
 of it, and keep it for future use.

1. Remove the machine from the box, and then remove cushioning
 material and the plastic bag from the machine.
A set of accessories is packed within the cushioning material.

2. Lift the machine, and then place it where it is to be installed.

Note

Injury may result.
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Do not open the scanner unit until step 6.

3. Take the accessories out.

4. Remove the cushioning materials and protection tapes.

5. Remove the protection tapes.

6. Hold the handle (A) to open the scanner unit.

7. Remove the desiccant pack and protective sheet attached to the
 transparent part.
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8. Remove the protective sheet.

9. Insert your finger into the lever (B) on the right side of the
 machine andpull the front cover open lever (1) to open the front
 cover (2) forward.

Note
Open the front cover gently. If opening rapidly, an MP tray may open.

10. Press the button (C) and open the Output Tray (3).
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11. Take all four image drums out.

Note
Do not expose the image drum to light for 5 minutes or more.

Do not touch the shiny green surface at the bottom of the image drum.

12. Remove the protective sheets from four image drums.

Place an image drum on a newspaper.

Remove a tape stuck on a protective sheet and open it.

Pull out a protective sheet in the direction of the arrow.

Note
Do not turn the blue lever of the toner cartridge.

13. Put all four image drums back into the machine.
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14. Turn the blue lever of the toner cartridge backward until its top
 aligns on the  mark.
Turn the levers of all 4 toner cartridges.

15. Close the output tray.

16. Close the front cover.
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Note
The front cover cannot be closed securely if the output tray is not closed.

When the error message that the output tray or front cover is open does not disappear
 from the operator panel's display screen, make sure they are closed securely.

17. Hold the handle (A) to close the scanner unit.
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Installing Options

The following optional parts are provided for the machine.

Additional tray unit

Wireless LAN module

Note
Be sure to turn the machine off and unplug the power cord and all the cables before installing
 the option. Installing the option with the machine turned on may cause the machine and option
 to malfunction.

Installing the Additional Tray Unit(s) to the Machine

Installing the Wireless LAN module
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Installing the Additional Tray Unit(s) to the Machine

If you want to load more paper, install additional tray units. You must set the printer driver
 after installing.

Installing the Additional Tray Unit(s)

Setting the Printer Driver

Setting Additional Tray(s) to the Windows PCL Printer Driver

Setting Additional Tray(s) to the Windows XPS Printer Driver

Setting Additional Tray(s) to the Windows PS Printer Driver

Setting Additional Tray(s) to the Mac OS X Printer Driver

Installing the Additional Tray Unit(s)

Additional Tray Unit Cabinet Caster Base

Model Number: N35110A

Note
Be sure to turn the machine off and unplug the power cord and all the cables before installing
 the additional tray. Installing the additional tray with the machine turned on may cause the
 machine and additional tray to malfunction.

Available Combinations

Machine + Cabinet

Machine + Additional Tray + Cabinet

Machine + Additional Tray + Additional Tray + Caster Base

Machine + Additional Tray + Additional Tray + Additional Tray + Caster Base

This section describes how to install three additional trays as an example.

If you use the cabinet, install in the same manner.

Lift this machine by 3 persons, because it weighs approximately 64 kg.

1. Turn the machine off, and then unplug the power cord and all the

Injury may result.
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 cables.

Turning the Machine Off

2. Stack 3 additional trays on the caster base aligning a back side of
 each tray.

3. Screw the additional trays on the caster base.

4. Join the additional trays.
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5. Place the machine on the additional trays gently aligning the back
 sides of the machine and the additional trays.

6. Join the machine and additional trays.

7. Lock the casters.
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8. Set the tip-over protection tools.
You can find two tip-over protection tools on the left and right sides of the caster base,
 and also two tools on its back side. Pull them straight out, then turn them 90 °
 counter-clockwise until they click.

9. Plug the power cord and the unplugged cables.

10. Press the power switch for approximately a second.
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When the machine is turned on, the power switch LED lamp is lit.

Note
Do not push the machine with the ADF or scanner unit open.

Do not apply force from above to the cassettes when they are pulled out.

Do not push the machine from the back with the cassettes pulled out.

Setting the Printer Driver

If the additional tray unit(s) are installed, set the tray(s) to a printer driver.

Note
To follow this procedure, you must log in to a computer as the administrator.

If your Mac OS applies to the following conditions, the information about the installed option
 is automatically obtained, not requiring you to set the printer driver.

If the USB connection or the network connection with Bonjour is used and you install the
 option to the machine before installing the driver

The Windows XPS printer driver is not available with Windows Server 2003.

You must register the printer driver in the computer in advance.

Installing a Driver and Software to a Computer

Setting Additional Tray(s) to the Windows PCL Printer
 Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click [OKI MC873], and then select [OKI MC873(PCL6)] from
 [Printer properties].
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3. Select the [Device Options] tab.

4. Enter the total number of trays and then click [OK].

Memo
If a TCP/IP network connection is used, click [Get Printer Settings] to set the driver
 automatically.

Setting Additional Tray(s) to the Windows XPS Printer
 Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click [OKI MC873], and then select [OKI MC873(XPS)] from
 [Printer properties].

3. Select the [Device Options] tab.

4. Enter the total number of trays and then click [OK].

52



Setting Additional Tray(s) to the Windows PS Printer
 Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click [OKI MC873], and then select [OKI MC873(PS)] from
 [Printer properties].

3. Select the [Device Settings] tab.

4. Select [Get installed options automatically] for [Installable
 Options], and then click [Setup].

Memo
When using a USB connection, select the total number of trays for [Available Trays] in
 [Installable Options].

5. Click [OK].
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Setting Additional Tray(s) to the Mac OS X Printer Driver

1. Select [System Preferences] from the Apple menu.

2. Click [Print & Scan].

3. Select the machine, and then click [Options & Supplies].

4. Select the [Driver] tab.

5. Select the total number of trays for [Available Tray], and then click
 [OK].
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Installing the Wireless LAN module

Installing the optional wireless LAN module to the machine allows you to use the wireless
 LAN function.

Note
The wireless LAN module may not be available in some countries and regions.

1. Turn the machine off, and then unplug the power cord.

Note
Wait for at least 1 minute after unplugging the power cord, and then proceed to the next
 step.

2. Open the connector cover by pressing the knob of the cover.

3. Connect the connector of the connection cable to the wireless LAN
 module, and then install the module to the machine.

4. Close the connector cover.

5. Turn the machine on.

6. Press [Device Settings] > [AdminSetup] > [User Install].

7. Press [Enable] for [Wireless Module].
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Turning the Machine On

For details of power supply, see "About the Power Supply" in "Turning the Machine On or
 Off".

1. Plug the power cord into the power connector.

2. Plug the power cord into the outlet.

3. Check that no documents are set on the document glass or in the
 ADF, and the ADF cover is closed.

4. Press the power switch for approximately a second.

When the machine is turned on, the power switch LED lamp is lit.

When the machine is turned on for the first time after the wireless LAN board is
 attached, the wireless setting screen is displayed.
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If you select [Yes], the wireless LAN setting is performed.

If you select [Do not show next time.], the wireless setting is not performed. The
 wireless setting screen is not displayed any more.

If you select [No], the wireless LAN setting is not performed. The wireless setting
 screen is displayed every time you turn the machine on.
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Setting Up This Machine

Follow the on-screen instructions to set required information.

1. Press [English] and proceed to the next screen.

2. Press [Continue with default settings] and proceed to the next
 screen.

3. Check the content displayed on the screen and press [Next].

4. Press [Next] and set the date and time.

5. Press [Next] and set the administrator password.
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6. Press [Next] and set the fax number and sender's information.

7. Press [Next] and set the essential network information.

8. Press [Next] and set the information related to E-mail.

9. Press [Next] and print the configuration list.
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10. Now the machine is set up.
Here is the procedure to install the software into your computer.
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Connecting This Machine to a Network

Connect the machine to a wireless LAN or a network with a LAN cable, and then enter the IP
 address of the machine and other network information from the operator panel. You can set
 the IP address manually or automatically.

Note
The machine cannot connect to a wired LAN and wireless LAN at the same time. If using a
 wireless LAN, do not connect a LAN cable to the machine.

Connecting to a Wireless LAN (Only When the Wireless LAN Module is Mounted)

Connecting with a LAN Cable

Connecting to a Wireless LAN (Only When the Wireless
 LAN Module is Mounted)

Connect this machine to a network with a wireless LAN.

Note
Wireless LAN module (optional) is required.

Read the following cautions carefully before using this machine in a wireless LAN environment.

The machine cannot connect to a wired LAN and wireless LAN at the same time. If using a
 wireless LAN, do not connect a LAN cable to this machine.

If the machine is used in a wireless network environment, the machine does not enter Deep
 Sleep mode but enters Sleep mode.

Do not place any electric products that emit weak radio waves (such as microwaves or digital
 cordless telephones) close to the machine.

If there is metal, aluminum sash, or a reinforced concrete wall between the machine and
 wireless LAN access points, connections may be harder to be established.

The communication speed of a wireless LAN connection may be slower than that of a wired
 LAN or USB connection depending on the environment. If you want to print big data such as
 a photo, it is recommended to print with a wired LAN or USB connection.

Preparations to use a wireless LAN
The machine can connect to a wireless LAN environment via wireless LAN access points
 (WPS supported).

Check whether your wireless LAN access point supports the following environment before
 using.

Item Value

Standard IEEE 802.11 a/b/g/n

Access method Infrastructure mode
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Checking the wireless LAN setting method
Check whether your wireless LAN access point supports WPS, and then select a setting
 method.

If your access point supports WPS, refer to "Connecting with WPS", and if you are not
 sure whether your access point supports WPS, refer to "Selecting a Wireless LAN Access
 Point from the Operator Panel to Connect".

Connecting with WPS

If a wireless LAN access point supports WPS, you can connect to the wireless LAN with the
 WPS button.

Selecting a Wireless LAN Access Point from the Operator Panel to Connect

If a wireless access point does not support WPS, you can specify a wireless LAN access
 point you want to use from the wireless LAN access points that the printer detects to
 establish a connection.

Setting from the Operator Panel Manually to Connect

Set the wireless LAN access point information (the SSID, encryption method, and
 encryption key) manually to connect to the wireless LAN.

Checking That Connection is Established Correctly

This section describes the procedure for checking by using the printer whether a
 connection to a wireless LAN is properly established.

Connecting with a LAN Cable

If there is no DHCP server on a network, you must set the IP address on a computer or
 machine manually.

Even if you are instructed to set a unique IP address that is specified by your network
 administrator, Internet service provider, or router manufacturer, you must set the IP
 address to the computer and machine manually.

Note
Complete the network setting of the computer before this procedure.

You must log in as the administrator.

If you set an IP address manually, contact your network administrator or Internet service
 provider for the IP address to use. If the IP address is set incorrectly, the network may go
 down or Internet access may be disabled.

Memo
If you construct a small network that consists of only the machine and a computer, set IP
 addresses as shown below (according to RFC1918).

For the computer
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IP address: 192.168.0.1 to 254

Subnet mask: 255.255.255.0

Default gateway: Not used

DNS server: Not used

For the machine

IP address setting: Manual

IP address: 192.168.0.1 to 254 (Select a different value from the computer's IP address.)

Subnet mask: 255.255.255.0

Default gateway: 0.0.0.0

Network scale: Small

To set [Network Scale], select [Device Settings] > [Admin Setup] > [Network Menu] >
 [Network Setup] > [Network Setting] > [Network Scale] > [Small].

1. Prepare a LAN cable and hub.
Prepare a LAN cable (category 5 or higher, twist pair, straight) and hub.

2. Turn the machine and computer off.
Turning the Machine Off

3. Attach the core to the LAN cable.
Wind the LAN cable in a single loop at 2 to 3 cm from the end of the cable, and then
 attach the core to the looped cable.

4. Insert one end of the LAN cable into the network interface
 connector.
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5. Insert the other end of the LAN cable into the hub.

6. Turn the machine on.
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Connecting via a USB Interface

Note
USB connection is disabled by factory default. You need to change the USB mode setting before
 connecting this machine to a computer with a USB cable. Select [AdminSetup] - [Management]
 - [Local Interface] - [USB Menu], and then change [USB Assignment] from [IPP] to [Legacy].

1. Prepare a USB cable.
USB cables are not included in the package. Prepare a USB 2.0 cable separately.

Memo
If you want to connect in USB 2.0 Hi-Speed mode, use a Hi-Speed USB 2.0 USB cable.

2. Turn the machine and computer off.
Turning the Machine Off

3. Insert one end of the USB cable into the USB interface connector
 on the machine.

Note
Do not insert the USB cable into the network interface connector. It may cause a
 malfunction.

4. Insert the other end of the USB cable into the USB interface
 connector on the computer.
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Note
For Windows, do not insert the other end of the USB cable into the computer until an
 instruction is displayed on the screen when the driver installation is in progress.
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Connecting a Telephone Line

This section describes how to connect a telephone line for fax transmissions. Be sure to
 connect the telephone line that suits your environment before sending or receiving faxes.

The telephone line connection method varies depending on your environment. Connect the
 telephone line that suits your environment by referring to the illustrations in this manual.

Set the telephone line in the recess of the machine so that it is not to be loose.

Note
You cannot connect an ISDN line directly. To connect, use a terminal adaptor (TA) and connect
 to the LINE connector of the machine.

Connecting to the Public Line (If Using Only for Faxes)

Connecting to the Public Line (If Connecting a Telephone to the Machine)

Connecting to the ADSL Environment

Connecting the Optical IP telephone

Connecting a CS Tuner or Digital Television

Connecting PBX, Home Telephone or Business Phone

Connecting as an Extension Telephone

Connecting to the Public Line (If Using Only for Faxes)

No. Name

1 Telephone cable

2 LINE connector

3 Public line (analog)
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1. Plug one end of the included telephone cable (1) into the LINE
 connector (2) of the machine and the other end into a public line
 (analog) (3).

Note
Do not plug the cable into the TEL connection by mistake.

Connecting to the Public Line (If Connecting a Telephone
 to the Machine)

No. Name

1 Telephone cable

2 LINE connector

3 Public line (analog)

4 Telephone connector cover

5 TEL connector

1. Plug one end of the included telephone cable (1) into the LINE
 connector (2) of the machine and the other end into a public line
 (analog) (3).

2. Remove the telephone connector cover (4).

3. Plug the external telephone cable into the TEL connector (5) of the
 machine.
A telephone that is connected to the machine is called an external telephone.
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Note
Only one telephone can be connected to the machine.

Do not connect the telephone to the machine in parallel. If you connect the telephone
 to the machine in parallel, the following problems occur, resulting in the machine not
 functioning correctly.

If you pick up the handset of the telephone that is connected in parallel while the
 machine is sending or receiving a fax, the fax image may be corrupted or a
 communication error may occur.

If the incoming call is a voice call, the telephone may ring late or stop halfway, and if
 the incoming call is a fax, the machine may not be able to receive the fax.

If you connect a telephone with the fax function, disable the fax function (disable fax
 reception) before using.

Memo
In the case of direct interconnection, separate construction work is required. Contact your
 telephone company.

Connecting to the ADSL Environment

No. Name

1 Telephone cable
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2 LINE connector

3 Public line (analog)

4 TEL connector

5 Splitter

6 ADSL modem

1. Plug the included telephone cable (1) that is connected to the ADSL
 modem (6) into the LINE connector (2) of the machine.

2. Remove the telephone connector cover.

3. Plug the external telephone cable into the TEL connector (4) of the
 machine.

Memo
If a fax dial fails, set [Dial Tone Detection] to [OFF].

User Install

If a fax transmission or reception fails, set [Super G3] to [OFF].

User Install

Connecting the Optical IP telephone

No. Name

1 Telephone cable

2 LINE connector

3 TEL connector

4 Optical IP telephone corresponding telephone
* Insert into the telephone cable jack.

5 LAN cable

6 Optical Network Unit (ONU)

7 Optical cable

1. Plug the included telephone cable (1) that is connected to the
 Optical IP telephone into the LINE connector (2) of the machine.
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2. 

3. Plug the external telephone cable into the TEL connector (3) of the
 machine.

Memo
If a fax dial fails, set [Dial Tone Detection] to [OFF].

User Install

If a fax transmission or reception fails, set [Super G3] to [OFF].

User Install

Connecting a CS Tuner or Digital Television

No. Name

1 Telephone cable

2 LINE connector

3 Public line (analog)

4 TEL connector

5 CS tuner or digital television

1. Plug the included telephone cable (1) that is connected to the
 public line (analog) (3) into the LINE connector (2) of the machine

2. Remove the telephone connector cover.

3. Plug the telephone cable (1) that is connected to the CS tuner or
 digital television (5) into the TEL connector (4) of the machine.

Connecting PBX, Home Telephone or Business Phone
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No. Name

1 Telephone cable

2 LINE connector

3 Public line (analog)

4 TEL connector

5 Control device including PBX, etc.

1. Plug the included telephone cable (1) that is connected to the
 public line (analog) (3) into the LINE connector (2) of the machine.

2. Plug the telephone cable (1) that is connected to a control device
 such as PBX (5) into the TEL connector (4) of the machine.

Memo
Home Telephone is a simple switcher for home use, which connects multiple telephones with
 one or two telephone lines, enabling you to use extension and door phones.

Business Phone is a simple switcher, which accommodates three or more telephone lines,
 with which many telephones can be shared, allowing for extension phones or other usage.

Connecting as an Extension Telephone

No. Name

1 Telephone cable

2 LINE connector

3 Public line (analog)

4 Control device including PBX, etc.

1. Plug one end of the included telephone cable (1) into the LINE
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 connector (2) of the machine and the other end into a control
 device such as a PBX (4).

Memo
If you connect to a PBX (private branch exchange), set the PBX line to ON.

Fax Setup
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Installing a Driver and Software to a Computer

When using the print, scan, and fax functions of this machine from your computer, you must
 install the printer driver, scanner driver, and fax driver that meet your computer.

Install the driver with the "Software DVD-ROM".

You can install other utility software besides drivers using the "Software DVD-ROM".

For the utility software that can be used on the machine, refer to the following.

List of Utility Software

For Windows

Connect this machine to the Internet or connect to a computer with a USB cable, and then
 start installing.

Note
Check the status of this machine before installing. This machine is turned on. For network
 connection, this machine is connected to the network via a network cable and required
 information such as IP address is already set. USB connection is disabled by factory default. You
 need to change the USB mode setting before connecting this machine to a computer with a USB
 cable. Select [AdminSetup] - [Management] - [Local Interface] - [USB Menu], and then change
 [USB Assignment] from [IPP] to [Legacy], and then connect the computer and the machine via
 a USB cable.

1. Insert the included "Software DVD-ROM" into a computer.

2. When [Auto Play] is displayed, click [Run setup.exe].

Memo
If the [User Account Control] dialog box is displayed, click [Yes].

3. Select a language from the drop-down list.

4. Read the license agreement, and then click [Accept].
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5. Read [Environment advice], and then click [Next].

6. Select [Network(Wired/Wireless)] or [USB] in accordance to the
 connection method of the machine and computer, and then click
 [Next].

7. Select the model name of the machine, and then click [Next].

8. Click [Install Optional Software].

Installation starts.

Memo
The following software is installed.

PCL6 Printer Driver

Scanner Driver

ActKey

Install other software from Custom Install.

Installing Software

9. Make sure that the software is successfully installed, and then click
 [Complete].
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10. Click [Next].

11. Click [Exit].

For Mac OS X

This section describes how to install the PS printer driver and scanner driver.

For installation of utilities, see the following.

Installing Software

Note
USB connection is disabled by factory default. You need to change the USB mode setting before
 connecting this machine to a computer with a USB cable. Select [AdminSetup] - [Management]
 - [Local Interface] - [USB Menu], and then change [USB Assignment] from [IPP] to [Legacy].

Install the Mac OS X scanner driver.
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1. Make sure that the machine and a computer are connected and the
 machine is turned on, and then insert the included "Software DVD-
ROM" into the computer.

2. Double-click the [OKI] icon on the desktop.

3. [Drivers] > [Scanner] > Double-click [Installer for OSX10.8-10.10]
 or [Installer for OSX10.6-10.7] in accordance to your Mac OS X
 version.

4. Click [Continue].

5. Click [Continue].

6. Check that the displayed content, and then click [Continue].

7. Read the license agreement, and then click [Continue].

8. Click [Agree].

9. Click [Install].
To change the driver installation location, click [Change Install Location].

10. Enter the administrator name and password, and then click [OK].

11. Click [Continue Installation].

12. Click [Restart].
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Install the Mac OS X printer driver.
When the installation is complete, print a test page in step 14.

1. Make sure that the machine and a computer are connected and the
 machine is turned on.

2. Insert the "Software DVD-ROM" into a computer.

3. Double-click the [OKI] icon on the desktop.

4. [Drivers] > [PS] > Double-click [Installer for OSX].

5. Enter the administrator password, and then click [OK].
Follow the on-screen instructions to complete the installation.

6. Select [System Preferences] from the Apple menu.

7. Click [Print & Scan].

8. Click [+].

9. Click [Default].

10. Select the machine , and then make sure that [OKI MC873(PS)] is
 displayed for [Use].

Types of Names Displayed in the Connection Methods List
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Network OKI-MC873 (last 6 digits of MAC address) Bonjour

USB OKI DATA CORP MC873 USB

Memo
To change the name, enter a new name into [Name:].

11. Click [Add].

12. When [Installable options] is displayed, click [Continue].

13. Make sure that the machine is added to [Printers] and [OKI
 MC873(PS)] is displayed for [Kind].

Note
If [OKI MC873(PS)] is not displayed for [Kind] correctly, click [-], delete the machine from
 [Printers], and then newly perform steps 8 to 12.

14. Click [Open Print Queue...].

15. Select [Print Test Page] from the [Printers] menu.
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Copy

Basic Operations of Copy Functions

Useful Functions

For a Better Finish

Color Settings

Advanced Copy Settings

Descriptions of Screens for Copy
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Basic Operations of Copy Functions

Setting a Document

Loading Paper

Copying

Cancelling Copying

Switching Color Modes

Specifying the Number of Copies

Specifying the Paper Feed Tray (Paper Feed)

Switching Output Trays

Making Enlarged or Reduced Copies (Zoom)
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Setting a Document

This chapter describes how to set the document on this machine.

Setting a Document

Copying Different Size Documents (Mixed Size)
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Loading Paper

This chapter describes paper that can be loaded in the paper feed sources on the machine.

Loading Paper

Setting Output Tray
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Copying

1. Press [Copy] or the  (COPY) button on the operator panel.
The touch panel display switches to the copy top screen.

2. Set a document in the ADF or on the document glass.

3. Set the copy setting if necessary.
Useful Functions

For a Better Finish

Color Settings

Advanced Copy Settings

4. Press the  (START) button.

Memo
You can ring a tone when copying is complete.

Adjusting Volume
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Cancelling Copying

You can cancel copying before a message is displayed to inform you that copying is
 complete.

1. Press the  (STOP) button when scanning the document.
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Switching Color Modes

Switches the Color Modes. You can use the following three color modes.

Color: All documents are copied in full color.

Mono: All documents are copied in black and white.

Auto: This machine detects the color of each page automatically. (Default) Color
 documents are copied in full color, black and white documents are copied in black and
 white. Copying becomes slow.

Note
When [Auto] is selected, printout's colors may not look as you expected in the following
 cases. In such a case, set [Color] or [Mono].

Here are some examples.

Documents with extremely small colored part

Dark-colored documents

Pale documents

Yellowish documents

Documents with colored background

Memo
You can change the criteria for determining color document and black and white document from
 [Device Settings] > [Admin Setup] > [Scanner Setup] > [Scanner Adjust] > [Auto Color Judge
 Level].

Scanner Setup

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Color Mode] on the [Basic] or [Image Settings] tab.

4. Select a color mode.

5. Press the  (START) button.
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Specifying the Number of Copies

You can specify the number of copies to make multiple copies.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Enter the number of copies by using the 10-key pad or the 10-key
 button.

Memo
You can enter the number of copies from 1 to 999.

If you enter an incorrect value, press the  (CLEAR) button, and then enter the correct
 value.

4. Press the  (START) button.

Topics

Sorting Each Set in Page Order (Sort)
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Specifying the Paper Feed Tray (Paper Feed)

Setting the Paper Feed Tray to Tray 1/Tray 2/Tray 3/Tray 4

Using the MP (Multi-Purpose) Tray

Setting the Paper Feed Tray to Tray 1/Tray 2/Tray 3/Tray
 4

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Paper Feed] on the [Copy] or [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

4. Select a tray, and then press [OK].
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5. Press the  (START) button.

Memo
To use the MP (Multi-Purpose) tray with [Paper Feed] being set to [Auto], press [Device
 Settings], and then select [Paper Setup] > [Select Tray] > [Copy] > [MP Tray] > [ON] or
 [ON(Prior)].

[Tray 2]/[Tray 3]/[Tray 4] are displayed only when the optional tray units are installed.

If [Paper Feed] is set to [Auto], you can select a paper tray that holds A3, A4 , A4 , A5 
, A5 , A6 , B4, B5 , B5 , Tabloid, Letter , Letter , Legal13/13.5/14, Executive ,

 Statement , Statement , Folio, or 8.5 SQ paper. To use a different paper size, select the
 paper tray in the [Paper Feed] setting.

Using the MP (Multi-Purpose) Tray

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Paper Feed] on the [Copy] or [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

4. Select [MP Tray], and then press [OK].
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5. Load paper in the MP tray.
Loading Paper

6. Press the  (START) button.

7. Check the message, and then press [Start].

8. Press [OK].
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Switching Output Trays

Switches output trays for printed paper.

Note
Check that the Rear Output Tray on the rear side of the machine is closed.

While the Rear Output Tray is open, paper is always output to the Rear Output Tray.

Memo
The default setting for output tray can be changed from [Device Settings] > [Paper Setup] >
 [Output Tray] > [Copy].

When paper remains on the upper output tray, the LED blinks.

Not to blink the LED, from [Device Settings] > [Admin Setup] > [Management] > [System
 Setup] > Set [Enable] for [Near Life LED].

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Output Tray] on the [Basic] tab.

4. Select an Output Tray.

5. Press the  (START) button.
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Making Enlarged or Reduced Copies (Zoom)

Note
You can use [Auto] only if copying on A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 ,
 Tabloid, Letter , Letter , Legal13/13.5/14, Executive , Statement , Statement , Folio,
 or 8.5 SQ paper.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Zoom] on the [Copy] or [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

4. Set the zoom rate.
When using [Auto]

Select [Auto], and then press [OK].

When selecting a preset zoom rate

Select a zoom value, and then press [OK].

Available rate settings:

To set other zoom rate

Press [Reduce] or [Enlarge].

Specify a zoom rate.
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Memo
If [Fit to page(98%)] is selected and the size of the document and the paper are the same,
 the document is reduced to fit the paper.

When setting the zoom rate by using the 10-key pad

Enter the zoom rate from 25 to 400% by using the 10-key pad or pressing  
 on the touch panel, and then press [OK].

Memo
You can set the rate in units of 1%.

If you enter an incorrect value, press the  (CLEAR) button, and then enter the correct
 value.

When setting different zoom rates for vertical and horizontal axes

Press [Custom].

Specify the zoom rates for vertical and horizontal axes.

Enter the zoom rate from 25 to 400% by using the 10-key pad or pressing  
 on the touch panel, and then press [OK].

Memo
When setting different zoom rates for vertical and horizontal axes, you need to specify
 the feeding tray.

You can set the rate in units of 1%.

If you enter an incorrect value, press the  (CLEAR) button, and then enter the correct
 value.

5. Press the  (START) button.

Memo
If [Paper Feed] is set to [Auto], [Zoom] is automatically set to [100%]. To select a different
 rate, set [Paper Tray], and then set [Zoom].

If [Paper Feed] is set to [Auto], the paper tray is automatically selected according to the
 selected zoom rate. To use a specific paper tray, reset [Paper Feed] again.

Even if [Paper Feed] is set to [Auto], you cannot select a paper tray that holds paper other
 than A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter , Letter ,
 Legal13/13.5/14, Executive , Statement , Statement , Folio, or 8.5 SQ. In this case,
 specify from [Paper Feed].

If [Paper Feed] is set to [Auto], the [Paper Feed] setting automatically changes by setting
 [Zoom] to [Auto]. A message is displayed on the touch panel to inform you that the setting
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 has been changed.
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Useful Functions

This chapter describes various settings for copying, such as N-in-1 and duplex printing.

Memo
Settings on the copy top screen is temporarily enabled. To change the default settings, select
 [Device Settings] > [Admin Setup] > [Copy Setup] > [Default Settings].

Copy Setup

Copying on Both Sides of Paper (Duplex Copy)

Combining Multiple Pages on One Sheet of Paper (N-in-1)

Changing the Scan Size (Scan Size)

Sorting Each Set in Page Order (Sort)

Enabling Continuous Scan Mode (Continuous Scan)

Copying Different Size Documents (Mixed Size)

Resetting Copy Settings (Reset)

Cancelling a Setting

Changing the Document Orientation (Direction)

Interrupting Current Job to Perform a Copy Job
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Copying on Both Sides of Paper (Duplex Copy)

Available Printing Methods

Note
Use plain paper of a standard size. Use of paper other than paper of standard sizes may
 cause paper jams.

Loading Paper

To copy a document in your preferred orientation, specify the orientation in [Direction] in
 advance.

Changing the Document Orientation (Direction)

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

Memo
When printing duplex documents on the both sides of paper or on the single side of
 paper, set the documents in the ADF.

When making duplex copies from simplex documents using the document glass,
 Continuous Scan mode is automatically enabled. Follow the on-screen instructions.

Enabling Continuous Scan Mode (Continuous Scan)

3. Press [Duplex Copy] on the [Copy] or [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].
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4. Select a duplex copy mode.

Memo
To make simplex copies so that each of the front and back sides of a duplex document can
 be copied on one side of different sheets of paper, select [2 1].

5. Select a binding method.

6. To change the document orientation, press [Change].

Changing the Document Orientation (Direction)

7. Press [OK].

8. Press the  (START) button.

Topics

You can change other copy settings.

Useful Functions

For a Better Finish

Color Settings

Advanced Copy Settings

It is recommended to set a margin when you want to staple or punch holes in duplex copies.
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Setting Margins (Margin)

Available Printing Methods

Simplex document  Duplex copies with the long edge bound

Simplex document  Duplex copies with the short edge bound

Duplex documents  Duplex copies with the long edge bound
 or the short edge bound

Set a document in the ADF.

Duplex documents with the long edge bound  Simplex copies
Set a document in the ADF.

Duplex documents with the short edge bound  Simplex
 copies

Set a document in the ADF.
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Combining Multiple Pages on One Sheet of Paper (N-in-
1)

Printing Methods That Can be Set

You can copy two, four, or eight pages of a document into one side of a single sheet of
 paper.

Setting [Duplex Copy] at the same time can save more sheets of paper.

Note
To copy a document in your preferred orientation, specify the orientation in [Direction] in
 advance.

Changing the Document Orientation (Direction)

If [N-in-1] is enabled, [Zoom] is automatically set to [Auto]. To specify a zoom rate, set [N-
in-1], and then [Zoom].

Making Enlarged or Reduced Copies (Zoom)

A part of the document may not be copied properly depending on the paper size, document
 size or specified rate.

If [N-in-1] is enabled you cannot select [Auto] for paper feeding source. Select the paper
 tray to be used.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

Memo
When using the document glass, Continuous Scan mode is automatically enabled.
 Follow the on-screen instructions.

Continuous Scan mode enables you to copy multiple documents at once. You can use
 both the ADF and document glass for copying multiple documents as a single job.

Enabling Continuous Scan Mode (Continuous Scan)

3. Press [N-in-1] on the [Copy] or [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].
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4. Select an N-in-1 method.

5. Select a layout.

6. To change the document orientation, press [Change].

Changing the Document Orientation (Direction)

7. Change other settings if necessary, and then press [OK].
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8. Press the  (START) button.

Printing Methods That Can be Set

Two sheets  One side of a sheet

Four sheets  One side of a sheet
 Vertical

 Horizontal

Eight sheets  One side of a sheet
 Vertical

 Horizontal
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Changing the Scan Size (Scan Size)

You can select the appropriate size of the document to be scanned.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Scan Size] on the [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

4. Select a size.

Memo
Both ADF and the document glass automatically detect the following document sizes.

Basis Detectable sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

* If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

If the machine cannot detect document size with the scan size setting set to [Auto],
 the scanning size selection screen appears when the start button is pressed.

5. Press the  (START) button.
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Sorting Each Set in Page Order (Sort)

The sort function is enabled by factory default.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

Memo
Continuous Scan mode enables you to copy multiple documents at once.

You can use both the ADF and document glass for copying multiple documents as a
 single job.

Enabling Continuous Scan Mode (Continuous Scan)

3. Check that [Sort] on the [Advanced] tab is set to [ON].

Memo
Pressing [Sort] switches between [ON] and [OFF].

4. Enter the number of copies.

5. Press the  (START) button.
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Enabling Continuous Scan Mode (Continuous Scan)

This function is useful when you want to copy multiple books.

To scan multiple sets of documents and make copies as a single job, enable the Continuous
 Scan mode. This mode is useful when using the [Sort], [N-in-1], or [Duplex Copy] function.

In Continuous Scan mode, you can copy your documents from the ADF, document glass, or
 both of them.

Sorting Each Set in Page Order (Sort)

Combining Multiple Pages on One Sheet of Paper (N-in-1)

Cancelling Copying

1. Press [Copy] or the  (COPY) button.

2. Set the first sheet of a document in the ADF or on the document
 glass.

Memo
When making N-in-1 and/or duplex copies by using the document glass, the [Please set
 next document] screen is displayed after scanning the documents even if [Continuous
 Scan] is set to [OFF].

3. Press [Continuous Scan] on the [Advanced] tab.
[Continuous Scan] is set to [ON].

Memo
Pressing [Continuous Scan] switches between [ON] and [OFF].

4. Enter the number of copies by using the 10-key pad.

5. Press the  (START) button.

6. When the [Please set next document.] screen is displayed, set the
 next document in the ADF or on the document glass.

Note

108



When changing the place to set the next document, be sure to remove the document from
 the place you used first.

7. Press [Start Scan].

8. When scanning all sets of the documents is complete, press [Scan
 Complete].

Memo
If you press [Scan Complete] after scanning all the documents with multiple copies (2 or
 more) being set for [Copies], the remaining number of copies is copied.
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Copying Different Size Documents (Mixed Size)

You can set multiple documents having the same width but different lengths in the ADF so
 that they can be copied on their respective paper sizes.

Note
You can use this mixed-size function only for the following combinations.

Specify the size of the larger document for the document size.

Small Size Large Size Remarks

A4 A3

A4 Folio

A5 A4 *

B5 B4 *

Letter Legal13

Letter Legal13.5

Letter Legal14

Letter Tabloid

Statement Letter *

* Available only one-sided scanning and one-sided printing.

If [Mixed Size] is enabled, [Paper Feed] cannot be selected. The paper tray that matches the
 document is automatically selected to feed the paper.

[Mixed Size] is available only if [Zoom] is set to [98% Fit to page] or [100%].

You cannot set [Edge Erase] and [Mixed Size] at the same time.

To use multiple sheets of paper, press [Device Settings], and then select [Paper Setup] >
 [Select Tray] > [Copy] to enable [MP tray].

When you use the MP tray, load paper in the MP tray, and then display the [Mixed Size]
 menu.

Memo
This section covers an example of A3 loaded in Tray 1 and A4  loaded in the MP tray.

1. Load A3 paper in Tray 1, and then load A4  paper in the MP tray.

2. Set the paper size dial of the Tray 1 to [A3].

Memo
You can use only standard paper for this function.

3. Press [Device Settings].
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4. Press [Paper Setup].

5. Press [MP tray] and [Paper Size] in order, and then select [A4].

6. Press [Back] until the home screen is displayed.

7. Press [Copy] or the  (COPY) button.

8. Set a document that is mixed with A4 and A3 sizes in the ADF.
Loading Paper

9. Press [Mixed Size] on the [Advanced] tab.
[Mixed Size] is set to [ON].

Memo
Pressing [Mixed Size] switches between [ON] and [OFF].

10. Check that the following settings are displayed on the copy start
 screen.

[Mixed Size]: ON

[Paper Feed]: Auto

[Zoom]: 100%
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[Scan size]: Auto

11. Enter the number of copies by using the 10-key pad if necessary.

12. Press the  (START) button.

Note
When using the Mixed Size function, be careful about the binding position of duplex documents.

When copying mixed-size duplex documents, specify the binding position for the bigger
 documents and bind smaller documents in the same direction as the bigger ones. (Their binding
 positions may not be the same.)

Example 1: For A3/A4 

For A3 documents with long-edge binding, set A4  documents with short-edge binding.
 (When loading in the ADF, set the documents so that their binding positions align to the
 top or bottom of the ADF.)

For A3 documents with short-edge binding, set A4  documents with long-edge binding.
 (When loading in the ADF, set the documents so that their binding positions align to the
 left or right of the ADF.)

Example 2: For Legal/Letter 

For Legal documents with long-edge binding, set Letter  documents with long-edge
 binding. (When loading in the ADF, set the documents so that their binding positions align
 to the top or bottom of the ADF.)

For Legal documents with short-edge binding, set Letter  documents with short-edge
 binding. (When loading in the ADF, set the documents so that their binding positions align
 to the left or right of the ADF.)
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Resetting Copy Settings (Reset)

You can reset the copy function you changes to their default settings in the following ways.

Auto Reset
If you do not perform any operation for a certain period of time, all the copy settings for
 your copy job are reset to their default settings. The auto reset time is set to 3 minutes
 by factory default.

Memo
The auto reset time can be changed from [Device Settings] > [Admin Setup] > [Device
 Management] > [Screen Auto Reset] > [Reset Time].

Using [Reset] on the Touch Panel
If you press [Reset] on the copy top screen or each setting screen, the settings for your
 copy job return to their default settings.

Memo
When copying is complete, press [Reset] to reset the default settings for the next user.
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Cancelling a Setting

If you set multiple copy functions at the same time, you may not be able to use these
 functions depending on the combination. In such a case, a message is displayed.

For example, if [Margin] is specified, [N-in-1] and [Repeat] cannot be set.

Cancel the setting of a function with low priority among the ones that are displayed in the
 message, and then set the function you want to use again.

To cancel the setting of any function, reset the setting to the default setting.

Memo
If you have changed the default value from the factory default setting, select the changed
 default value.

Administrator Setup

1. Select a function to cancel on each tab on the copy top screen or
 from [Function Settings].

2. Set the default setting again.
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Changing the Document Orientation (Direction)

You can select [Top Edge On Top] or [Top Edge On Left] for the document orientation.
 Specify the appropriate orientation to get the copy result you want.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Direction] on the [Copy] or [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

4. Select the document orientation, and then press [OK].

Memo
If you press [Cancel], the screen returns to the previous screen without saving the
 changes.

5. Press the  (START) button.
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Interrupting Current Job to Perform a Copy Job

To perform interrupt copying, follow the procedure below.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times, and press [Admin Setup].

3. Enter the administrator name and password, and then press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Copy Setup].

5. Press [Interrupt], and then make sure that [Interrupt] is set to
 [Enable].

6. Press  (Start) while printing, you can interrupt the current job to
 copy a new document.
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For a Better Finish

Adjusting the Density (Density)

Selecting the Document Type (Document Type)

Specifying the Scan Resolution (Resolution)

Copying a Document with a Colored Background Clearly (Background Removal)

Erasing Edge Shadows (Edge Erase)

Erasing Shadow Lines (Center Erase)

Erasing Outside of Documents (Outside Erase)

Removing Show-Through (Show-Through Removal)
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Adjusting the Density (Density)

You can adjust the copy density in seven levels.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Density] on the [Image Settings] screen on the [Image
 Settings] tab.

4. Select density.

Memo
[0] is the standard value. To increase the density, select [+1], [+2], or [+3] (darkest). To
 decrease the density, select [-1], [-2], or [-3] (lightest).

5. Press the  (START) button.
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Selecting the Document Type (Document Type)

You can select a document type from [Text], [Text&Photo], [Photo], or [Photo (Glossy)] to
 make copies at the most suitable quality.

Note
If you select [Text], the gray level may be reduced depending on the document.

If you select [Photo] or [Photo (Glossy)], fine texts or lines may be blurred depending on the
 document.

If you select [Photo (Glossy)], images may be bright.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Document Type] on the [Image Settings] screen on the
 [Image Settings] tab.

4. Select a document type.

Memo
[Text]: Set when copying a text document.

[Text&Photo]: Set when copying a document having texts and photos. The well-
balanced text and photo are reproduced on an image.

[Photo]: Set when copying photos and graphic documents. Images are reproduced
 with the focus on grayscales.

[Photo (Glossy)]: Set when copying a glossy photography or photo documents printed
 on glossy inkjet paper. Images are reproduced with the focus on grayscales in
 consideration of the glossy.
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5. Press the  (START) button.
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Specifying the Scan Resolution (Resolution)

You can change the resolution to scan a document.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Resolution] on the [Image Settings] tab.

4. Select a resolution.

Memo
Resolution setting is available only when the color mode is set to "Auto" or "Color".

If you select [ExtraFine], the reproducibility and gray level of fine lines or small
 characters will be improved.

5. Press the  (START) button.
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Copying a Document with a Colored Background Clearly
 (Background Removal)

To adjust a level of the document background removal, you can select Auto or OFF, or
 adjust in six levels.

If you select [Auto], the background is automatically removed in a level that suits the
 document.

Note
If a greater value of the background removal is set, fine lines, texts or light colors may not
 be reproduced depending on the document.

In the following cases, background color may not be correctly detected and not be eliminated
 successfully.

When a custom-size document is loaded

When a document with the front edge folded is loaded

When a document missing the front edge or an oblique document is loaded

When a document having a hole near the front edge is loaded

When a document is placed without aligning it with the guide on the document glass

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Background Removal] on the [Image Settings] screen on the
 [Image Settings] tab.

4. Select a value.

Memo
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[3] for [Background removal] is the standard level. To increase a level of the document
 background removal, select [4], [5], or [6]. To decrease a level of the document
 background removal, select [2], [1], or [OFF] (no removal).

5. Press the  (START) button.
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Erasing Edge Shadows (Edge Erase)

When you copy a document with the document glass cover opened or when you copy a
 book, a black shadow may appear around the edges on the printed copy. This function
 enables you to erase the black shadow.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Edge Erase] on the [Image Settings] tab.

4. Enter a value from 2 to 50 mm (0.1 to 2.0 inches) in [Width] by
 using the 10-key pad or by pressing  and , and then press
 [OK].

5. Press the  (START) button.
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Erasing Shadow Lines (Center Erase)

When copying documents with the document glass cover open, or copying a book or
 magazine, shadow lines may appear in the printouts.

You can eliminate the shadow lines from the printouts.

1. Press [Copy] or the  (COPY) button.

2. Set a document on the document glass.

3. Press [Center Erase] on the [Image Settings] tab.

4. Enter a value from 1 to 50 mm (0.1 to 2.0 inches) in [Width] by
 using the 10-key pad or by pressing  and , and then press
 [OK].

5. Press the  (START) button.
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Erasing Outside of Documents (Outside Erase)

When copying a thick document such as a book on the document glass, a clearance between
 the document glass and document glass cover causes the outside of the document to be
 dark like a shadow. The Outside Erase function erases the outside of the documents.

Outside Erase is set.

Outside Erase is set to OFF.

Note
When copying documents from the ADF or with the ADF or document glass cover firmly
 closed, the function becomes disabled.

When the function is enabled, manually adjust the background removal. The Auto
 Background Removal function is disabled. When Background Removal is set to Auto, Level 3
 is applied.

When copying documents with slashes or of complicated shapes, documents and outside
 documents may not be correctly detected.

1. Press [Copy] or the  (COPY) button.

2. Set a document on the document glass.

Note
Do not use the function under a light. Shadows may not be erased successfully.

Widely open the ADF or document glass cover.

If the ADF or document glass cover opens insufficiently, documents and outside
 documents may not be correctly detected.

Strong light is emitted while copying. Do not look straight the document glass surface.

3. Press [Outside Erase] on the [Image Settings] tab.

4. Enter a value from 1 to 5 in [Range Adjustment] by using the 10-
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key pad or by pressing  and , and then press [OK].

If there are any problems with the standard level (3), adjust the criteria in the
 following steps.

If the outside of the document is not erased, increase the value on the criteria.

If dark parts inside the document are erased, decrease the value on the criteria.

5. Press the  (START) button.
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Removing Show-Through (Show-Through Removal)

Show-Through Removal removes show-through of text from the reverse side. You can select
 the removal level from OFF, Low, Middle, or High.

Note
This function is enabled only when [Background Removal] is set to [Auto].

This function is enabled only when [Document Type] is set to [Text] or [Text&Photo].

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Show-Thr. Rem.] on the [Image Settings] screen on the
 [Image Settings] tab.

4. Select a value.

Memo
[Middle] is set by default.

If light color becomes too faint with Middle (default value), set to [Low] (show-through
 may not be removed completely).

If show-through is not completely removed with Middle (default value), set to [High]
 (light color may not be represented).

For documents printed only one side or when reproducing light color, set to [OFF]. (For
 documents printed on two side, show-through remains.)

5. Press the  (START) button.
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Color Settings

Adjusting the Contrast (Contrast)

Adjusting Hue for Color Copy

Adjusting Saturation

Adjusting RGB
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Adjusting the Contrast (Contrast)

Differences between bright and dark sections on a document are adjusted to make images
 and texts easier to view and read.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Contrast] on the [Image Settings] screen on the [Image
 Settings] tab.

4. Select a value.

5. Press the  (START) button.
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Adjusting Hue for Color Copy

Red/green balance adjustment. Reddish: Enhance red. Greenish: Enhance green.

1. Press [Copy] or the  (COPY) button.

2. Press [Image settings] on the [Image Settings] tab.

3. Press [Hue].

4. Select a value.

5. Press the  (START) button.
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Adjusting Saturation

Saturation setting. Vivid: Enhance image sharpness. Light: Mute color.

1. Press [Copy] or the  (COPY) button.

2. Press [Image settings] on the [Image Settings] tab.

3. Press [Saturation].

4. Select a value.

5. Press the  (START) button.
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Adjusting RGB

Adjust RGB contrast settings.

1. Press [Copy] or the  (COPY) button.

2. Press [Image settings] on the [Image Settings] tab.

3. Press [RGB].

4. Select a value each for RGB, and then press [OK].

5. Press the  (START) button.
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Advanced Copy Settings

Making Multiple Copies on a Sheet of Paper (Repeat)

Copying Two-Page Spread Separately onto Two Sheets (Book Copy)

Adding a Stamp (Watermark)

Copying Both Sides of a Card to One Side (ID Card Copy)

Setting Margins (Margin)

Skipping White Pages When Copying (White Page Skip)
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Making Multiple Copies on a Sheet of Paper (Repeat)

This function enables you to repeatedly copy the same document on one side of a sheet of
 paper. The document can be repeated two, four, or eight times.

Two repeat

Four repeat

Eight repeat

Note
If [Repeat] is enabled, [Zoom] is automatically set to [Auto]. To specify a zoom rate, enable
 [Repeat], and then set [Zoom].

To copy a document in your preferred orientation, specify the orientation in [Direction] in
 advance.

Changing the Document Orientation (Direction)

A part of the document may not be copied depending on the paper, document, or zoom rate.

If the repeat function is enabled, the paper tray is automatically set.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

Memo
Continuous Scan mode enables you to copy multiple documents at once.

Enabling Continuous Scan Mode (Continuous Scan)

3. Press [Repeat] on the [Advanced] tab.
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4. Select a repeat method, and then press [OK].

Memo
If you press [Paper Feed], you can set a paper feed tray.

Specifying the Paper Feed Tray (Paper Feed)

5. Press [OK].

6. Press the  (START) button.
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Copying Two-Page Spread Separately onto Two Sheets
 (Book Copy)

Copies two-spread pages of bound documents onto separate sheets of paper.

Note
You cannot use the ADF for this function. Always use the document glass.

Place two-spread document with the face down on the document glass.

Only A3, A4 , B4, Tabloid, and Letter  size documents are available.

A part of the document may not be copied depending on the paper, document, or zoom rate.

1. Press [Copy] or the  (COPY) button.

2. Set a document on the document glass.

3. Press [Book Copy] on the [Advanced] tab.

4. Select the binding direction of the document to be copied.
Left side bound Right side bound

5. Select the paper tray in which available paper is loaded.

Press [Tray] and select paper.

Select the paper tray in which available paper is loaded.

6. Press the  (START) button.
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Adding a Stamp (Watermark)

You can stamp a date, sequential page numbers, or any character string when copying.

Note
Character strings are printed in black.

The font Universe Medium is used for character strings.

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Watermark] on the [Image Settings] tab.

4. Press [Page Number] to set the start page number and printing
 position.

5. Press [String] to specify the characters and printing position.

6. Press [Font Size] and specify character size.

7. Press the  (START) button.
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Copying Both Sides of a Card to One Side (ID Card
 Copy)

This function enables you to copy both sides of an ID card, such as a driver's license, on one
 side of a sheet of paper.

Note
You cannot use the ADF for this ID Card Copy function.

Set the ID card with the upper side facing leftward.

2 mm from the edge of the document glass is the scan margin.

The machine scans an area half the size of the specified paper. If the document is more than
 half the size of the paper size, the excess part is discarded.

1. Press [Copy] or the  (COPY) button.

2. Press [ID Card Copy] on the [Advanced] tab.
[ID Card Copy] is set to [ON].

Memo
Pressing [ID Card Copy] switches between [ON] and [OFF].

3. Set your card with the front side down on the document glass.

4. Enter the number of copies.

5. Press the  (START) button.

6. When the [Please set back side of document.] screen is displayed,
 place your card with the back side down on the document glass.

142



Memo
If you press [Scan Complete], only the front side is copied without scanning the back side.

7. Press [Start Scan].
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Setting Margins (Margin)

Copying with Margins on One Side

Copying with Margins on Both Sides

The margin function enables you to set margins. This function is useful when you want to
 staple or punch holes in copies. You can set the top, bottom, right, and left margins by
 specifying the [Top] and [Left] values.

For Portrait Printing

Specifying the left margin is suitable for long edge binding printing.

Specifying the top margin is suitable for short edge binding printing.

For Landscape Printing

Specifying the left margin is suitable for short edge binding printing.

Specifying the top margin is suitable for long edge binding printing.

Note
A part of a document may not be copied.

The specified margin values stay active even after you change the zoom rate.

To copy a document in your preferred orientation, specify the orientation in [Direction] in
 advance.

Changing the Document Orientation (Direction)

Memo
If all the values are set to [0], [Margin] is disabled.

You can set [Margin] as default so that you do not have to set margins every time you make
 copies.

The value of the margin can be changed from [Device Settings] > [Admin Setup] > [Copy
 Setup] > [Default Settings] > [Margin].

Copying with Margins on One Side
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Set margins to a simplex document before copying.

Set [Direction] correctly.

Changing the Document Orientation (Direction)

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Margin] on the [Advanced] tab.

4. To set the left or right margin, specify a margin in [Left] of [Front]
 by using the 10-key pad or by pressing , , and [+/-].

To create a margin on the left side of the output, specify a positive value.

To create a margin on the right side of the output, specify a negative value.

5. To set the top or bottom margin, specify a margin in [Top] of
 [Front] by using the 10-key pad or by pressing , , and [+/-],
 and then press [OK].

To create a margin at the top of the output, specify a positive value.

To create a margin at the bottom of the output, specify a negative value.
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Memo
You do not need to specify the [Back] margin when copying on a single side.

If you press [Cancel], the screen returns to the previous screen without saving the
 changes.

6. Press the  (START) button.

Copying with Margins on Both Sides

When you make duplex copies with [Margin] enabled, you must specify the document
 direction as well as the [Back] margin.

Set [Direction] correctly.

Changing the Document Orientation (Direction)

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [Duplex Copy] on the [Copy] or [Basic] tab.

4. Set [Duplex Copy].
Copying on Both Sides of Paper (Duplex Copy)

5. Press [Margin] on the [Advanced] tab.
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6. Set each margin of [Front] and [Back].
For portrait documents with long edge binding

Enter values in [Left].

Enter a positive value in [Front].

Enter a negative value in [Back].

For portrait documents with short edge binding

Enter values in [Top].

Enter a positive value in [Front].

Enter a negative value in [Back].

For landscape documents with long edge binding

Enter values in [Top].

Enter a positive value in [Front].

Enter a negative value in [Back].

For landscape documents with short edge binding

Enter values in [Left].

Enter a positive value in [Front].

Enter a negative value in [Back].
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7. Press the  (START) button.

Memo
The margins' positions conform to [Direction].

When using the document glass, Continuous Scan mode is automatically enabled. Follow the
 on-screen instructions.
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Skipping White Pages When Copying (White Page Skip)

If blank pages are included in the scanned document, you can skip the blank pages when
 copying.

Note
Blank pages may not be detected correctly in the following cases.

Halftone documents

Documents with extremely small printed area (e.g. blank pages with page numbers)

When N-in-1 is applied, pages are moved up if white pages are omitted.

If you make duplex copies of two-sided documents including blank pages, two sides of copies
 and originals may not correspond.

Memo
You can change the criteria for determining blank pages from [Device Settings] > [Admin Setup]
 > [Scanner Setup] > [Scanner Adjust] > [White Page Skip Level].

Scanner Setup

1. Press [Copy] or the  (COPY) button.

2. Set a document in the ADF or on the document glass.

3. Press [White Page Skip] on the [Advanced] tab.

4. Select White Page Skip.
[White Page Skip] is set to [ON].

5. Press the  (START) button.
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Descriptions of Screens for Copy

Names and Functions of Screen Items for Copy
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Names and Functions of Screen Items for Copy

This section describes the items of the screens.

[Copy] Tab

Item Description

1 Stationary button
 area

Displays buttons that appear on the screen at all times.

2 Title and operation
 guide area

Displays the title of the current screen and provides guide for possible
 operations.

3 Tab labels Displays labels for tabs. Press a label to switch between tabs.

4 Main area Displays a preview of copy output that will be produced with the current
 settings.

5 Shortcut buttons Displays shortcut buttons for using certain copy functions.
The screen image shows the factory default setting. The setting can be
 changed by Administrator Setting.

6 Function Settings Displays the current settings.
The setting can be changed for certain functions.

7 Device Settings Specifies various settings such as Administrator Setting.

8 Reset Returns the settings for the current copy job to their default settings.

9 Displays Help topics.

10 Copies Specifies the number of copies to make.

[Basic] Tab
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Item Description

1 Paper Feed Specifies the tray to set the copy paper.

2 Output Tray Specifies the output tray.

3 Duplex Copy Makes copies on both sides of paper.

4 N-in-1 Combines multiple pages on one sheet of paper.

5 Zoom Specifies the zoom rate for making enlarged or reduced copies.

6 Direction Specifies the orientation according to the document, TopEdgeOnTop or
 TopEdgeOnLeft.

7 Scan Size Specifies the scan size according to the size of the document.

8 Register to Job
 Macro

Registers current settings to Job Macro.

[Advanced] Tab

Item Description

1 Continuous Scan Scans multiple sets of documents as a single copy job.

2 Mixed Size Scans multiple documents having the same width but different lengths in
 the ADF, so that they can be copied on their respective paper sizes.

3 Book Copy Copies two-spread pages of bound documents onto separate sheets of
 paper.

4 Sort Sorts multiple sets of copies in the same page order as the document.

5 Repeat Repeatedly copies the same document on one side of a sheet of paper
 (two or four times).

6 Margin Specifies top, bottom, right, or left margin on printed copy.

7 ID Card Copy Copies both sides of an ID card, such as a driver's license, on one side of a
 sheet of paper.

8 White page skip Skips blank page when copying.

[Image Settings] Tab
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Item Description

1 Image
 Settings

Specifies the following image settings: Document Type, Background Removal,
 Density, Contrast, Hue, Saturation, and RGB.

2 Color
 Mode

Specifies color mode to copy a document.

3 Edge Erase Eliminates a black shadow that may appear around the edges on the scanned
 image when scanning, for example, a book.

4 Center
 Erase

Eliminates shadow lines when scanning a book or magazine.

5 Resolution Specifies the resolution to scan a document.

6 Outside
 Erase

Eliminates shadow lines outside of document when scanning a book or magazine.

7 Watermark Stamps text when copying.

[Function Settings] Screen

Item Description

1 Setting display area
 1

Displays the current settings for displayed items.

2 Setting display area
 2

Displays a list of settings that are not displayed in the setting display
 area 1.
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Scan

Basic Operations of Scan Functions

Sending Scanned Data as an E-mail Attachment

Sending Scanned Data to a Computer

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Scanning from a Computer

Descriptions of Screens for Scan
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Basic Operations of Scan Functions

Setting a Document

Setting to Scan a Document

Displaying a Preview Image

Cancelling Scanning

Other Settings to Scan
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Setting a Document

This section describes how to set a document.

Setting a Document

Scanning Documents of Different Sizes (Mixed Size)
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Setting to Scan a Document

This section describes useful scan functions. You can set the scan functions to produce the
 optimum image quality if necessary. The scan functions can be used for Scan To E-mail,
 Scan To USB Memory, and Scan To Shared Folder.

Specifying a Document Type

Specifying a Scan Resolution

Adjusting the Density

Scanning a Document with a Colored Background Clearly (Background Removal)

Removing Show-Through (Show-Through Removal)

Adjusting the Contrast

Adjusting the Hue

Adjusting the Saturation

Adjusting RGB

Erasing Edge Shadows (Edge Erase)

Erasing Shadow Lines (Center Erase)

158



Specifying a Document Type

If you select a document type, the document can be scanned at the most suitable quality.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.
Setting a Document

Memo
When scanning a document with the machine, a document in the ADF is given priority.
 Check that there is no document in the ADF when using the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Document Type] and press a document type.

Memo
[Text]: Set when copying a text document.

[Text/Photo]: Set when copying a document having texts and photos. The well-
balanced text and photo are reproduced on an image.

[Photo]: Set when copying photos and graphic documents. Images are reproduced
 with the focus on grayscales. In [Photo] mode, it takes longer to scan.

[Photo (Glossy)]: Set when copying a glossy photography or photo documents printed
 on glossy inkjet paper. Images are reproduced with the focus on grayscales in
 consideration of the glossy.

Note
If you select [Text], the gray level may decrease depending on the document.

If you select [Photo] or [Photo (Glossy)], fine texts or lines may be blurred depending
 on the document. It takes longer to scan.
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If you select [Photo (Glossy)], images may be bright.

6. Change other settings if necessary, and then press the  (START)
 button.
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Specifying a Scan Resolution

Specify a resolution to scan a document to obtain the most suitable quality.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Resolution] and press a resolution.

6. Change other settings if necessary, and then press the  (START)
 button.
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Adjusting the Density

You can adjust the density in seven levels.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Density] and press a density level.

Memo
[0] is the standard value. To increase the density, select [+1], [+2], or [+3] (darkest). To
 decrease the density, select [-1], [-2], or [-3] (lightest).

6. Change other settings if necessary, and then press the  (START)
 button.
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Scanning a Document with a Colored Background
 Clearly (Background Removal)

To adjust a level of the document background removal, you can select Auto or OFF, or
 adjust in six levels.

If you select [Auto], the background is automatically removed in a level that suits the
 document.

Note
In the following cases, background color may not be correctly detected and not be eliminated
 successfully.

When a custom-size document is loaded

When a document with the front edge folded is loaded

When a document missing the front edge or an oblique document is loaded

When a document having a hole near the front edge is loaded

When a document is placed without aligning it with the guide on the document glass

If a greater value of the background removal is set, fine lines, texts or light colors may not
 be reproduced depending on the document.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Background Removal] and press a value.
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6. Change other settings if necessary, and then press the  (START)
 button.
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Removing Show-Through (Show-Through Removal)

Show-Through Removal removes show-through of text from the reverse side. You can select
 the removal level from OFF, Low, Middle, or High.

Note
This function is enabled only when [Background Removal] is set to [Auto].

This function is enabled only when [Document Type] is set to [Text] or [Text&Photo].

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Show-Thr. Rem.] and press a value.

Memo
[Middle] is set by default.

If light color becomes too faint with Middle (default value), set to [Low] (show-through
 may not be removed completely).

If show-through is not completely removed with Middle (default value), set to [High]
 (light color may not be represented).

For documents printed only one side or when reproducing light color, set to [OFF]. (For
 documents printed on two side, show-through remains.)

6. Change other settings if necessary, and then press the  (START)
 button.
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Adjusting the Contrast

Differences between bright and dark sections on a document are adjusted to make images
 and texts easier to view and read.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Contrast] and press a value.

6. Change other settings if necessary, and then press the  (START)
 button.
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Adjusting the Hue

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Hue] and press a value.

6. Change other settings if necessary, and then press the  (START)
 button.
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Adjusting the Saturation

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [Saturation] and press a value.

6. Change other settings if necessary, and then press the  (START)
 button.

169



Adjusting RGB

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Image Settings] on the [Image Settings] tab.

5. Press [RGB] and press a value for Red, Green, Blue respectively,
 and then press [OK].

6. Change other settings if necessary, and then press the  (START)
 button.
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Erasing Edge Shadows (Edge Erase)

When you scan a document with the document glass cover opened or when you scan a
 book, a black shadow may appear around the edges on the scanned image. The edge erase
 function allows you to erase the black shadow.

Memo
[Edge Erase] is set to [ON], and [Width] to 5 mm by factory default.

The default value of the edge width to erase can be changed from [Admin Setup] > [Scanner
 Setup] > [Default Settings] > [Edge Erase] > [ON] > [Width].

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Edge Erase] on the [Image Settings] tab.

5. Enter a value from 5 to 50 mm (0.2 to 2.0 inches) in [Width] by
 using the 10-key pad or pressing   on the touch panel, and
 then press [OK].

6. Change other settings if necessary, and then press the  (START)
 button.
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Erasing Shadow Lines (Center Erase)

When scanning documents with the document glass cover open, or scanning a book or
 magazine, shadow lines may appear in the scanned images.

You can eliminate the shadow lines from the scanned images.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Center Erase] on the [Image Settings] tab.

5. Enter a value from 1 to 50 mm (0.1 to 2.0 inches) in [Width] by
 using the 10-key pad or pressing   on the touch panel, and
 then press [OK].

6. Change other settings if necessary, and then press the  (START)
 button.
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Displaying a Preview Image

Using the Preview function, you can check the scanned image on the touch panel before
 saving or sending.

Note
The image previewed on the display does not completely match the printout. Use the
 function to check the content or orientation of scanned documents.

For the Scan To Computer, Remote Scan, or WSD Scan function, Preview is not available.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.

4. Press [Preview] on the [Advanced] tab to set it to [ON].

Memo
Pressing [Preview] switches between [ON] and [OFF].

5. Press the  (START) button.

6. When preview image is displayed, check the scanned image.

Memo
There are three methods to display preview images.

 : Displays full page.

 : Displays across the width of the screen.

 : Displays the scanned page at the same magnification.

Press  to display the preview image in full screen.

Use  ,  ,  , and  to scroll the preview image.

When scanning multiple pages of documents, use the navigation button to switch
 between the pages.

 : Displays the previous page.

 : Displays the next page.

173



: Displays any page. Press this button and enter page number you want to
 display.

If you set the next document on the ADF or document glass and press  button,
 the machine scans the document and displays the scanned document.

Press  button to close the preview screen and cancel sending.

7. Press [Start Transmission].
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Cancelling Scanning

This chapter describes how to cancel scanning.

Cancelling Scanning from the Operator Panel

Cancelling Scanning from a Computer

Cancelling Scanning from the Operator Panel

You can cancel scanning while a message is being displayed to inform you that scanning is in
 progress.

1. Press the  (STOP) button.

Note
You cannot cancel when you are performing Scan To Computer or Remote Scan.

Cancelling Scanning from a Computer

When performing Scan To Computer or Remote Scan, you can cancel scanning while a
 message is being displayed to inform you that scanning is in progress.

1. Click [Cancel] in the scanning dialog box.
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Other Settings to Scan

This section describes useful scan functions. You can set the scan functions to produce the
 optimum image quality if necessary. The scan functions can be used for Scan To E-mail,
 Scan To USB Memory, and Scan To Shared Folder.

Scanning Multiple Documents Continuously (Continuous Scan)

Specifying a Scan Size

Scanning a Duplex Document (Duplex Scan)

Skipping White Pages When Scanning (White Page Skip)

Changing the Document Orientation (Direction)

Scanning Documents of Different Sizes (Mixed Size)

Specifying a File Name

Specifying a Color Mode

Specifying a File Format

Specifying a File Compression Rate

Encrypting a PDF File
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Scanning Multiple Documents Continuously (Continuous
 Scan)

To scan multiple documents as a single job, enable Continuous Scan mode.

In Continuous Scan mode, you can scan your documents from the ADF, document glass, or
 both of them.

1. Press [Scan] or the  (SCAN) button.

2. Set the first sheet of a document in the ADF or on the document
 glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Continuous Scan] on the [Advanced] tab to set it to [ON].

Memo
Pressing [Continuous Scan] switches between [ON] and [OFF].

5. Change other settings if necessary, and then press the  (START)
 button.

6. When the [Please set next document] screen is displayed, set the
 next document in the ADF or on the document glass.

Note
If you set the next document to a different place, remove the document from the place
 you used first.

7. Press [Start Scan].

177



8. When scanning all sets of the documents is complete, press [Scan
 Complete].
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Specifying a Scan Size

You can specify the suitable size to scan a document.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Follow the procedure in the table below to press [Scan Size].

Scan method Display on the touch panel and operation procedures

Scan To E-mail [Basic] tab > [Scan Size]

Scan To USB Memory [Scan To USB Memory] tab > [Scan Size]

Scan To Shared Folder [Basic] tab > [Scan Size]

5. Select a size.

Memo
Both ADF and the document glass automatically detect the following document sizes.

Basis Detectable sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

* If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

If the machine cannot detect document size, the scanning size selection screen
 appears.

6. Change other settings if necessary, and then press the  (START)
 button.
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Scanning a Duplex Document (Duplex Scan)

Note
Use standard size plain paper. Use of paper other than standard size plain paper may cause
 paper jams.

To scan a duplex document, set the document in the ADF.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Follow the procedure in the table below to press [Duplex Scan].

Scan method Display on the touch panel and operation procedures

Scan To E-mail [Advanced] tab > [Duplex Scan]

Scan To USB Memory [Scan To USB Memory] tab > [Duplex Scan]

Scan To Shared Folder [Basic] tab > [Duplex Scan]

5. Select a printing method.

6. Change other settings if necessary, and then press the  (START)
 button.
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Skipping White Pages When Scanning (White Page
 Skip)

If blank pages are included in documents, you can skip the blank pages from the scanned
 results.

Note
Blank pages may not be detected correctly in the following cases.

Halftone documents

Documents with extremely small printed area (e.g. blank pages with page numbers)

Memo
You can change the criteria for determining blank pages from [Device Settings] > [Admin Setup]
 > [Scanner Setup] > [Scanner Adjust] > [Blank Page Skip Level].

Scanner Setup

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [White Page Skip] on the [Advanced] tab to set it to [ON].

Memo
Pressing [White Page Skip] switches between [ON] and [OFF].

5. Change other settings if necessary, and then press the  (START)
 button.
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Changing the Document Orientation (Direction)

You can specify the orientation of images.

Specify the top edge position of the image.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Direction] on the [Image Settings] tab, [Advanced] tab, or
 [Basic] tab.

5. Select a direction.

6. Change other settings if necessary, and then press the  (START)
 button.
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Scanning Documents of Different Sizes (Mixed Size)

You can set multiple documents having the same width but different lengths in the ADF and
 scan them in their respective paper sizes.

Note
You can use this mixed-size function only for the following combinations.

Specify the larger size for the document size.

Small Size Large Size Remarks

A4 A3

A4 Folio

A5 A4 *

B5 B4 *

Letter Legal13

Letter Legal13.5

Letter Legal14

Letter Tabloid

Statement Letter *

* Available only one side scanning.

For the Scan To Computer, Remote Scan, and WSD Scan function, Mixed Size is not
 available.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Follow the procedure in the table below to press [Mixed Size] and
 set it to [ON].

Scan method

Scan To E-mail [Advanced] tab > [Mixed Size]

Scan To USB Memory [Basic] tab > [Mixed Size]

Scan To Shared Folder [Basic] tab > [Mixed Size]

Memo
Pressing [Mixed Size] switches between [ON] and [OFF].
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5. Change other settings if necessary, and then press the  (START)
 button.

Note
When using the Mixed Size function, be careful about the binding position of duplex
 documents.

When scanning mixed-size duplex documents, specify the binding position for the bigger
 documents and bind smaller documents in the same direction as the bigger ones. (Their
 binding positions may not be the same.)

Example 1: For A3/A4

For A3 documents with long-edge binding, set A4 documents with short-edge binding.
 (When loading in the ADF, set the documents so that their binding positions align to
 the top or bottom of the ADF.)

For A3 documents with short-edge binding, set A4 documents with long-edge binding.
 (When loading in the ADF, set the documents so that their binding positions align to
 the left or right of the ADF.)

Example 2: For Legal/Letter

For Legal documents with long-edge binding, set Letter documents with long-edge
 binding. (When loading in the ADF, set the documents so that their binding positions
 align to the top or bottom of the ADF.)

For Legal documents with short-edge binding, set Letter documents with short-edge
 binding. (When loading in the ADF, set the documents so that their binding positions
 align to the left or right of the ADF.)
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Specifying a File Name

You can specify a name of a scanned data file.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [File Name] on the [Advanced] tab.

5. Enter a file name, and then press [OK].
You can enter up to 64 characters.

6. Change other settings if necessary, and then press the  (START)
 button.
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Specifying a Color Mode

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Follow the procedure in the table below to press [Color mode].

Scan method Display on the touch panel and operation procedures

Scan To E-mail [Basic] tab > [Color Mode]

Scan To USB Memory [Scan To USB Memory] tab > [Color Mode]

Scan To Shared Folder [Basic] tab > [Color Mode]

5. Select a color mode.

Memo
When [Auto(Color/Grayscale)] is enabled, this machine detects the color of each page
 automatically. Color documents are scanned in full color; black and white documents
 are scanned in grayscale.

When [Auto(Color/Mono)] is enabled, this machine detects the color of each page
 automatically. Color documents are scanned in full color; black and white documents
 are scanned in black and white.

You can change the criteria for determining color document and black and white
 document from [Device Settings] > [Admin Setup] > [Scanner Setup] > [Scanner
 Adjust] > [Auto Color Judge Level].

Scanner Setup

6. Change other settings if necessary, and then press the  (START)
 button.
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Specifying a File Format

You can specify a file format of a scanned document.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [File Format] on the [Image Settings] tab.

5. Press a file format.
The screen that appears when [Auto (color/Gray)] is selected is shown as an example.

6. Press a file format.

The available file formats vary depending on the selected color type.

Color type File format

Auto
 (Color/Gray)

Single-PDF, Multi-PDF, Single-HC-PDF, Multi-HC-PDF, Multi-PDF/A, Single-
TIFF, Multi-TIFF, JPEG, XPS

Auto
 (Color/Mono)

Single-PDF, Multi-PDF, Multi-PDF/A, Single-TIFF, Multi-TIFF, XPS

Color Single-PDF, Multi-PDF, Single-HC-PDF, Multi-HC-PDF, Multi-PDF/A, Single-
TIFF, Multi-TIFF, JPEG, XPS

Grayscale Single-PDF, Multi-PDF, Single-HC-PDF, Multi-HC-PDF, Multi-PDF/A, Single-
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TIFF, Multi-TIFF, JPEG, XPS

Mono Single-PDF, Multi-PDF, Multi-PDF/A, Single-TIFF, Multi-TIFF, XPS

7. Change other settings if necessary, and then press the  (START)
 button.
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Specifying a File Compression Rate

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Compression Rate] on the [Image Settings] tab.

5. Select a compression rate.

6. Select a compression rate.

7. Select a color type.

8. Change other settings if necessary, and then press the  (START)
 button.
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Encrypting a PDF File

When converting a scanned document to a PDF file, you can encrypt the file. You can set an
 encryption level, a document open password, a permission password, and use permissions
 for the created PDF file. The higher the encryption level is, the higher the security level is.

A document open password is intended to open an encrypted PDF file. A document open
 password cannot be the same as a permission password. You can enter up to 32 characters.

A permission password is intended to control printing, extracting, editing, or other
 operations for encrypted PDF files. A permission password cannot be the same as a
 document open password. You can enter up to 32 characters.

Note
[Encrypted PDF] can be selected only if [File Format] is set to [PDF] or [HC-PDF]. [PDF/A]
 cannot be selected.

To encrypt a PDF file, you must set a document open password or permission password.

Memo
The permission setting items for printing and editing a PDF file vary depending on the
 encryption level.

A permission to print a document, a permission to extract text and graphic, and a permission
 to change a document are displayed only if you select [Enable] or [Apply Default Password]
 for [Permissions Password].

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Select a scan method.
Sending Scanned Data as an E-mail Attachment

Saving Scanned Data in USB Memory

Saving Scanned Data in a Shared Folder

Specify a destination by following the procedure for the selected scan method.

4. Press [Encrypted PDF] on the [Image Settings] tab.

5. Press [Encrypt], select encryption level, and then press [Next].

6. To set a document open password, press [Enable] or [Apply Default
 Password].
To select [Apply Default Password], you must register the default password from
 [Device Settings] > [Admin Setup] > [Scanner Setup] > [Default Settings] >
[Encrypted PDF Setting] in advance.

Administrator Setup

7. Enter a password, and then press [OK].
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You can enter up to 32 characters.

8. Enter the password again, and then press [OK].

9. To set a permission password, press [Enable] or [Apply Default
 Password].

10. Enter a password, and then press [OK].
A permission password cannot be the same as a document open password. You can
 enter up to 32 characters.

11. Enter the password again, and then press [OK].

12. Select a permission to print, and then press [Next].

13. Select a permission to extract, and then press [Next].

14. Select a permission to edit, and then press [Next].

15. Check the security setting, and then press [Yes].

16. Change other settings if necessary, and then press the  (START)
 button.
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Sending Scanned Data as an E-mail Attachment

Before Using Scan To E-mail

Using Scan To E-mail

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book or Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (Searching the LDAP Server)

Setting the Sender's Address

Setting the Reply Address

Specifying a Subject

Registering Body Text

Using a Template

Saving Transmission Data
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Before Using Scan To E-mail

Register the E-mail Address of the Machine and Server
 Information

If using Scan To E-mail, Internet Fax, or Scan To Fax Server, you must register the e-mail
 setting information in this machine in advance. You register the e-mail address of the
 machine that is used as the destination and the mail server, but the settings vary
 depending on the provider with which you make a contract for e-mail usage. Have the
 setting information ready to fill in the following sheet.

Setting Information Sheet

Item Description Example Entry column for
 your information

* Write down
 Memos here

 about the details
 you have

 checked or your
 settings.

Sender The e-mail address that is used for
 sending e-mails from the machine

mc873@test.co.jp (Within
 80 characters)

SMTP server The server address that is used for
 sending e-mails

smtp.test.co.jp

POP3 server The server address that is used for
 receiving e-mails

pop3.test.co.jp

Authentication
 method

Mail transmission server
 authentication

SMTP

SMTP user ID The account name of the mail
 transmission server

OKIMC873

SMTP password The password of the mail
 transmission server

okimc873

POP user ID The account name of the mail
 reception server

user

POP password The password of the mail reception
 server

okimc873

The name of the
 e-mail
 transmission
 destination

The name of the recipient to whom
 you want to send with Scan To E-
mail or Internet Fax

user

E-mail address The e-mail address of the recipient
 to whom you want to send with
 Scan To E-mail or Internet Fax

user@test.co.jp

You can register the e-mail address of this machine and server information in the
 following three ways. This manual recommends to use the operator panel or the Web
 page where you can enter information with the computer keyboard.

Registering from the Web page
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Registering from the Operator Panel

Registering from the Web page

You can register and edit the e-mail address of this machine and server information with the
 Web page of this machine. When registering and editing the server information, the content
 in the setting information sheet is required.

The setting procedure varies depending on the protocol that the machine uses for receiving
 e-mails.

Memo
The setting information is provided from your provider when you make a contract. If you do
 not have the setting information, check with your provider or network administrator.

If you do not have any e-mail address that this machine uses, obtain the e-mail address by
 making a contract with a provider or using other ways.

Setting the Reception Protocol

Easy Setup

Registering from the Operator Panel

You can register and edit the e-mail address of the machine and server information with the
 operator panel on the machine. When registering and editing the server information, the
 content in the setting information sheet is required.

Set the reception method for the machine to receive e-mails. If you want to receive and
 print e-mail attachment files that are sent to the machine, select [POP3] or [SMTP] to suit
 your e-mail setting environment. If you do not want to receive e-mails, select [Disable].

Note
If you use a free mail server or any mail server other than that is provided by your Internet
 service provider, You cannot set with Easy Setup.

If you press [Device Settings], and then select [Admin Setup] > [Network Menu] > [Mail Server
 Setup], the detailed mail server settings are displayed on the screen where you can perform the
 setting.

Memo
The setting information is provided from your provider when you make a contract. If you do
 not have the setting information, check with your provider or network administrator.

If you do not have any e-mail address that this machine uses, obtain the e-mail address by
 making a contract with a provider or using other ways.

Setting the Reception Protocol

Easy Setup
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Using Scan To E-mail

Set a network and e-mail setting before using the Scan To E-mail function.

Connecting This Machine to a Network

Before Using Scan To E-mail

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Press [Scan To E-mail].

If the access control is enabled and E-mail address of the user who currently logs in is
 registered, the E-mail address of the user is automatically entered in [To].

Memo
Here, you can add a destination with a one-touch button. A destination is added to [To].
 To add multiple destinations, press another one-touch button.

4. Check the [Scan To E-mail] tab is selected.
To select [Cc] or [Bcc], press [To] several times.

5. Specify a destination.
Specify a destination in one of the following ways.

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book or Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (Searching the LDAP Server)

6. Set scan settings if necessary.
Displaying a Preview Image

Specifying a Document Type

Specifying a Scan Resolution

Scanning Multiple Documents Continuously (Continuous Scan)

Adjusting the Density

Setting to Scan a Document
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Other Settings to Scan

7. Press the  (START) button.
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Specifying a Destination (Direct Entry)

Enter an e-mail address directly on the operator panel.

Memo
Set an e-mail address in the following steps.

A destination of scanned data: Step 5 in "Using Scan To E-mail"

A reply destination of a received e-mail: Step 9 in "Setting the Sender's Address"

1. Press [Manual Input] on the [Scan To E-mail] or [Basic] tab.

2. Enter an e-mail address.
You can enter up to 80 characters.

3. Press [OK].
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Specifying a Destination (Address Book or Group List)

You can select a destination from the address book or group list. You must register
 destinations in the address book or group list in advance.

For details on how to add an e-mail address to the address book or group list, refer to "E-
mail Address".

Memo
Set an e-mail address in the following steps.

A destination of scanned data: Step 5 in "Using Scan To E-mail"

A reply destination of a received e-mail: Step 9 in "Setting the Sender's Address"

1. Press [Address Book] or [Group List] on the [Scan To E-mail] or
 [Basic] tab.

2. Select the transmission destination or group.
You can select multiple items.

3. When you complete the selection of all the destinations, press
 [OK].
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Specifying a Destination (One-touch Button)

You can select an e-mail address registered in the address book with a one-touch button.

To select the speed dial numbers 09 to 40 that are assigned to one-touch buttons, press 
 or  to switch between the screens.
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Specifying a Destination (Transmission History)

Memo
Set an e-mail address in the following steps.

A destination of scanned data: Step 5 in "Using Scan To E-mail"

A reply destination of a received e-mail: Step 9 in "Setting the Sender's Address"

1. Press [Tx History] on the [Scan To E-mail] or [Basic] tab.

2. Select the destination.
You can select multiple items.

3. When you complete the selection of all the destinations, press
 [OK].
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Specifying a Destination (Searching the LDAP Server)

For Simple Search

For Advanced Search

You can search for a destination from a list on the LDAP server. There are two search
 methods, as shown below.

[Simple Search]: You can run a search with only one keyword as a user name. You can
 only search for character strings included in usernames, and not in e-mail addresses.

[Advanced Search]: You select search conditions to search for items that include all the
 specified keywords or any of the keywords. You can specify user names or e-mail
 addresses as search keywords.

Up to 100 search results are displayed.

For details on setting the LDAP server, refer to "Setting the LDAP Server".

Memo
Set an e-mail address in the following steps.

A destination of scanned data: Step 5 in "Using Scan To E-mail"

A reply destination of a received e-mail: Step 9 in "Setting the Reply Address"

For Simple Search

1. Press [LDAP] on the [Scan To E-mail] or [Basic] tab.

2. Press [Simple Search].

3. Enter a keyword to search for a user name in the LDAP server.

4. Press [OK] to start searching.

5. When the search results are displayed, press the destination.
You can select multiple items.

6. When you complete the selection of all the destinations, press
 [OK].

205



7. Press [Back] to return to the start screen.

For Advanced Search

1. Press [LDAP] on the [Scan To E-mail] or [Basic] tab.

2. Press [Advanced Search].

3. Select [OR] or [AND] for [Search Method].

4. Press [User name].

5. Enter the keyword to search for.

6. Press [OK].

7. Press [E-mail Address].

8. Enter the keyword to search for.

9. Press [OK].

10. Press [OK] to start searching.

11. When the search results are displayed, press the destination.
You can select multiple items.

12. When you complete the selection of all the destinations, press
 [OK].

13. Press [Back] to return to the start screen.
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Setting the Sender's Address

1. Press [Device Settings] on the operator panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [E-mail Setup].

6. Press [From/Reply To].

7. Press [From].

8. Enter an e-mail address.

9. Press [OK].

10. Press [Back] until the top screen is displayed.
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Setting the Reply Address

1. Press [Device Settings] on the operator panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [E-mail Setup].

6. Press [From/Reply To].

7. Press [Reply To].

8. Specify a destination.

9. Press [Back] until the top screen is displayed.
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Specifying a Subject

You can register up to five templates with a variety of subjects and body text.

1. Press [Device Settings] on the operator panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [E-mail Setup].

6. Press [Template].

7. Press [Edit Subject].

8. Select a number from [Subject1] to [Subject5].

9. Enter a subject.
You can enter up to 80 characters.

10. Press [OK].

11. Press [Back] until the top screen is displayed.
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Registering Body Text

1. Press [Device Settings] on the operator panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [E-mail Setup].

6. Press [Template].

7. Press [Edit Body].

8. Select a number from [Body1] to [Body5].

9. Enter body texts.
You can enter up to 256 characters.

10. Press [OK].

11. Press [Back] until the top screen is displayed.
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Using a Template

You can use subjects and body texts that are registered as a template in standard e-mails.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Press [Scan To E-mail].

4. Press the [Advanced] tab.

5. Press [E-mail Setup].

6. Press [Subject] or [E-mail Body].

7. Press [Select Subject] or [Select Text].

8. Press the subject or body to select.

9. Press the [Scan To E-mail] tab to select an entry method.

10. Specify a destination.

11. Press the  (START) button.

Topics

Setting the Sender's Address
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Saving Transmission Data

You can save data sent via Scan To E-mail, etc. For details, refer to "Saving Sent and
 Received Data (Transmission Data Save)".
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Sending Scanned Data to a Computer

You can send a scanned image to a computer that is connected via a network or USB
 interface. Scan a document set on the machine by operating from the operator panel.

Before Using Scan To Computer

Before Using WSD Scan

Registering a Computer That is Connected

Removing Computer

Setting to Start ActKey When Using Scan To Computer

How to Use Scan To Computer
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Before Using Scan To Computer

Before Using Scan To Computer with ActKey

Before Using Scan To Computer with WSD Scan

Before Using Scan To Computer with Image Capture (Mac OS X)

Setting to Use Network TWAIN

To use the Scan To Computer function, you need the following settings depending on your
 OS and connection method.

Note
To connect the machine to a network, set the following.

Set the [TCP/IP] setting of the machine to [Enable].

Match the IP version between the machine and a computer.

Set the DNS server.

Memo
You cannot send an image to multiple computers at the same time with this function.

The required software varies depending on the OS of your computer and the function to use.
 Install the appropriate software.

On the Windows computer, Scan To Computer function can be used with ActKey or WSD
 Scan.

Refer to the following.

Before Using Scan To Computer with ActKey (Windows)

Before Using Scan To Computer with WSD Scan (Windows)

If you use Mac OS X, you can use Image Capture.

Refer to the following.

Before Using Scan To Computer with Image Capture (Mac OS X)

Before Using Scan To Computer with ActKey

1. Set the machine for using Scan To Computer.
Refer to the following.

Setting for Using Network TWAIN (Network Connection)

2. Install the scanner driver and ActKey.
Installing a Driver and Software to a Computer

If you use the network connection, perform the following steps.

3. Register a destination computer that is used for Scan To Computer
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 in the machine.
Registering a Computer That is Connected

Memo
Your computer may automatically be registered when the scanner driver is installed.

If the computer information, such as computer name or IP address is changed, you
 need to newly register the information.

4. Start Network Configuration.
Click [Start], and then select [All Programs] > [Okidata] > [ActKey] > [Tool] >
 [Network Configuration].

Once installed, it automatically starts when you log on.

Before Using Scan To Computer with WSD Scan

1. Set the machine for using WSD Scan on the machine.

2. Install this machine as a WSD device to a connected computer.
For details, see "Before Using WSD Scan".

When the machine is installed in the computer, the computer is also registered to the
 machine as a destination computer for WSD Scan.

Before Using Scan To Computer with Image Capture
 (Mac OS X)

If you use Mac OS X, you can use Image Capture.

1. Set the machine for using Scan To Computer.
Refer to the following.

Setting for Using Network TWAIN (Network Connection)

2. Install the Mac OS X scanner driver.
Installing a Driver and Software to a Computer

For the USB connection, proceed to step 4.

3. Register a destination computer that is used for Scan To Computer
 in the machine. (For the network connection)

Registering a Computer That is Connected

Memo
If the computer information, such as computer name or IP address is changed, you need
 to newly register the information.

4. Start Image Capture, and then select this machine from the list on
 the left side of Image Capture.
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Setting to Use Network TWAIN

Enable the Network TWAIN function so that you can use the Scan to Computer function on a
 computer that is connected via a network.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times, and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [TWAIN Setup].

6. Make sure that [Network TWAIN] is set to [ON].

Memo
Pressing [Network TWAIN] switches between [ON] and [OFF].

7. Press [Back] until the home screen is displayed.
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Before Using WSD Scan

About WSD Scan

Setting to Use WSD Scan

Installing This Machine as a WSD Device to a Computer

Setting a Binding Position for Duplex Scanning

About WSD Scan

This section describes how to set a computer to use the WSD Scan function. To use the WSD
 Scan function, install the machine to the computer.

You can set WSD Scan from Scan To Computer or Remote Scan via a network.

To use WSD Scan, the machine must be connected to a computer with the following installed
 via a network: Windows 8.1/ Windows 8/ Windows Vista/ Windows 7/ Windows Server
 2012/ Windows Server 2012 R2/ Windows Server 2008/ Windows Server 2008 R2

Check the network connection before starting the procedure below.

Connecting This Machine to a Network

Setting to Use WSD Scan

To use the Scan To Computer (WSD Scan) function and the Remote Scan (WSD Scan)
 function via the WSD Scan connection, follow the procedure below.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [WSD Scan Setup].

6. Check that [WSD Scan] is set to [Enable].

Memo
Pressing [WSD Scan] switches between [Enable] and [Disable].

7. Press [Back] until the home screen is displayed.

Installing This Machine as a WSD Device to a Computer
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Install this machine as a WSD Scan device with a Windows computer that supports WSD
 Scan so that you can use the WSD Scan function.

Note
If a computer for WSD Scan recognizes this machine and the IP address of this machine is
 changed, you must register from the beginning. Uninstall this machine, and then install it
 again.

Before starting this installation, check that Network Search is enabled.

From [Control Panel], click [Network and Internet] > [Network and Sharing Center] >
 [Change advanced sharing settings], select [Turn on network discovery] for [Network
 discovery], and then click [Save Changes].

Memo
You can register up to 50 computers in this machine.

Installing This Machine in a Computer

1. Select [Network] from the [Start] menu.
The devices that are connected to the network are displayed.

2. Right-click the MC873 icon under [Multifunction Devices], and then
 select [Install].
If the [User Account Control] dialog box is displayed, click [Yes].

3. When a balloon message is displayed to inform you that the
 installation is complete on the task bar, click the balloon to check
 the details, and then click [x (Close)].
Check the device installation on the machine as follows.

Checking That the Machine is Connected to a Computer

1. Press [Scan] or the  (SCAN) button.

2. Press [Scan To Computer].

3. Press [Select A Connecting PC].

4. Press [From WSD Scan].

5. Check that a computer is displayed on this machine as a connection
 destination of WSD Scan.

Setting a Binding Position for Duplex Scanning

To set a binding position for duplex scanning with Scan To Computer and Remote Scan via
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 WSD Scan, follow the procedure below.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [WSD Scan Setup].

6. Press [Binding].

7. Select a binding position.

8. Press [Back] until the home screen is displayed.
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Registering a Computer That is Connected

Register the name of the destination computer, IP address, and port number before using
 Scan To Computer on the Network TWAIN.

Registering a Computer from the Operation Panel

Using Network Configuration (Windows Only)

Using the Network Scanner Setup Tool (Mac OS X Only)

Registering a Computer from the Operation Panel

You can register a computer on the same network as a scanning destination.

1. Press [Device Settings].

2. Press  or  several times to select [Network Scan Destination].

3. Press [Register] of a registration location.
To edit a registered group number, select [Edit].

4. Enter a destination in [Destination].

5. Enter a destination.
You can enter up to 16 characters.

6. Press [OK].

7. Press [Destination Address].

8. Enter an IP address, host name, or computer name.
You can enter up to 64 characters.

9. Press [OK].

10. Press [Port No.].

11. Enter a port number, and then press [OK].

12. Press [Close] on a confirmation screen.

13. Press [Back] until the home screen is displayed.

Using Network Configuration (Windows Only)

To change the computer name and IP address of your computer after the scanner driver is
 installed, start the Network Configuration, select the driver, and then change the registered
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 information for Scan To Computer.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [ActKey] > [Tools] > [Network Configuration].

2. Right-click [Show Network Configuration] in the task tray.

3. Select the scanner driver to be used, and then select [Properties]
 from the [Scanner] menu.

4. Click the [Register] tab.

As the computer information, the computer name, IP address and port number are
 displayed. You do not need to set the computer name, because the computer's host
 name is automatically acquired.

Although the setting value of the computer's IP address is automatically displayed, if
 multiple network cards are installed in the computer, multiple IP addresses are
 displayed. Select the IP address of the network card that is currently used. Change
 the current setting for the port number that is displayed if necessary.

5. After all settings are complete, click the [Register] button to
 register the setting to the machine.
If the machine is tuned off and cannot be connected, an error occurs when registering.
 If the computer information, such as computer name, IP address, and port number, is
 changed, you need to newly register the information following the procedure above.

Using the Network Scanner Setup Tool (Mac OS X Only)
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1. Select [Application] > [OKIDATA] > [Scanner] > [Network Scanner
 Setup Tool].

2. Select the machine from the [Scan Settings] dialog box, click
 [Register], register [Name] and Host in the [Register host
 address], and then click [OK].
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Removing Computer

Deleting a Registered Computer

You can delete a computer that is registered in this machine as a scanning destination.

1. Press [Device Settings].

2. Press  or  several times to select [Network Scan Destination].

3. Press [Delete] of an item to delete.

4. Press [Yes] on the confirmation.

5. Press [Back] until the home screen is displayed.

Using Network Configuration (Windows Only)

1. Click [Start], and then select [All Programs] > [Okidata] >
 [ActKey] > [Tools] > [Network Configuration].

2. Right-click [Show Network Configuration] in the task tray.

3. Select [Properties] from the [Scanner] menu.

4. Click the [Unregister] tab.
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5. Select the computer name to unregister, and then click
 [Unregister].
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Setting to Start ActKey When Using Scan To Computer

You can set so that ActKey can start when you select [Scan To Computer] on the machine.

1. Click [Start], and then select [Devices and Printers].

2. Right-click [OKI MC873], and then [Scan properties].
If the [User Account Control] dialog box is displayed, click [Yes].

3. Click the [Events] tab.

4. Select an event from [Select an event].

5. Select [Start this program], and then select [ActKey].

6. Repeat steps 4 and 5 so that all events are set to [ActKey].

7. Click [OK].
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How to Use Scan To Computer

Using ActKey (Windows)

Using WCD Scan

Using Image Capture (Mac OS X)

To use Scan to Computer, you must prepare the following:

Before Using Scan To Computer

The procedure depends on the operation system of your computer and connection method.

On the Windows computer, Scan To Computer function can be used with ActKey or WSD
 Scan.

See the follorwing:

Using ActKey (Windows)

Using WCD Scan

If you use Mac OS X, you can use Image Capture.

See the following:

Using Image Capture (Mac OS X)

Using ActKey (Windows)

You can use ActKey to display the scanned image on an application, save the image in a
 folder, or start a fax transmission application.

Memo
If you use ActKey via network, start Network Configuration in advance.

Click [Start], and then select [All Programs] > [Okidata] > [ActKey] > [Tools] > [Network
 Configuration].

1. Press [Scan] or  (Scan).

2. Set a document in the ADF or on the document glass.

3. Press [Scan To Computer].
If [Select A Connecting PC] does not appear, proceed to step 7.

4. Press [Select A Connecting PC].

5. Press [From Network] or [From USB Interface] in accordance with
 the connection method of the machine and computer.

6. For the network connection, select a destination computer to which
 the data is sent.
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If the targeted computer is not displayed, register the computer to the machine.

Registering a Computer That is Connected

7. Press [Select An Application].

Memo
If you select [Application], the application that you specify [Application-1] of ActKey or
 dedicated application for Windows starts, and then the scanned image is displayed on
 the application.

If you select [Folder], the scanned document is saved in the specified folder.

If you select [PC-FAX], a fax transmission application starts. After sending the scanned
 document, send a fax with the fax transmission application on your computer.

8. Select the destination.

9. Press  (START).
ActKey starts automatically, and then the scanner driver starts scanning.

Using WCD Scan

Memo
To start duplex scanning, turn the setting on, and then set a document in the ADF. The
 machine cannot scan the both side of the document set on the document glass even if you
 turn duplex scanning on.

If you use the scanner application on a computer, a document is scanned with the scanner
 type of the scan profile setting on the computer, regardless of the place where the
 document is set or the [Duplex Scan] setting.

1. Press [Scan] or  (Scan).

2. Set a document in the ADF or on the document glass.

3. Press [Scan To Computer].

4. Press [Select A Connecting PC].

5. Press [From WSD Scan].

6. Select a destination computer to which the data is sent.
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7. Press  (START).

Using Image Capture (Mac OS X)

Start Image Capture included to Mac OS X as standard to capture scanned images.

Note
A document on a flatbed scanner can be scanned to the A4 size only.

A file can be saved only in JPEG.

When scanning via network connection, start Image Capture in advance. Select a device
 from a list that is displayed on the left side of the Image Capture screen.

Use Image Capture in the standard view. This function cannot be used in the detail view.

1. Press [Scan] or  (Scan).

2. Set a document in the ADF or on the document glass.

3. Press [Scan To Computer].
If [Select A Connecting PC] does not appear, proceed to step 7.

4. Press [Select A Connecting PC].

5. Press [From Network] or [From USB Interface] in accordance with
 the connection method of the machine and computer.

6. For the network connection, select a destination computer to which
 the data is sent.
If the targeted computer is not displayed, register the computer to the machine.

Registering a Computer That is Connected

7. Press [Select An Application].

Memo
If you select [Application] or [PC-FAX] on Mac OS X, the same action as when [Folder] is
 selected takes place.

8. Select the destination.
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9. Press  (START).
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Saving Scanned Data in USB Memory

To save scanned data to USB Memory, follow the procedure below.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Insert USB Memory into the USB port.

Note
Insert USB Memory straight into the USB port. Inserting USB Memory at a wrong angle
 may damage the USB port.

4. Press [Scan To USB Memory].

5. Set scan settings if necessary.

Memo
Press [Preview] on the [Advanced] tab to preview the scanned image.

6. Press the  (START) button.

7. When a message is displayed to inform you that you can remove
 USB Memory from the port, remove it.
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Saving Scanned Data in a Shared Folder

Before Using Scan To Shared Folder

How to Use Scan To Shared Folder

Changing Registered Destination (Profile)

Deleting a Registered Destination (Profile)
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Before Using Scan To Shared Folder

Creating a Shared Folder in a Computer

Registering a Destination (Profile)

Registering a Destination (Profile) from Configuration Tool

Registering a Destination (Profile) from the Web Page

Registering a Destination (Profile) from the Operator Panel

Creating a Shared Folder in a Computer

Create a shared folder in a computer in which the scanned document is saved.

1. Click [Start] on the Windows task bar, right-click [Computer], and
 then click [Properties].

2. Check the name of [Computer name].
You need the computer name you checked when you register the destination in the
 machine. Write it down.

3. Close the window.

4. Create a folder in which documents are saved on the computer.

5. Right-click the created folder, and then click [Properties].

6. Click the [Sharing] tab, and then click [Advanced Sharing].

7. Select the [Share this folder] check box, and then click
 [Permissions].

8. Select the [Allow] check box of [Change] in [Permissions for
 Everyone], and then click [OK].

9. Click [OK].

Registering a Destination (Profile)

Register the created shared folder in the machine so that the folder can be used for Scan To
 Shared Folder.

When you perform Scan To Shared Folder, you send data to the profile that you specify as a
 destination.

You can register up to 50 profiles.

You can register a destination (profile) in the following three ways. This manual
 recommends to use Configuration Tool or the Web page where you can enter information
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 with the computer keyboard.

Registering a Destination (Profile) from Configuration Tool

This section describes the registration method that uses the Configuration Tool on a
 computer.

If you click  (Save to device), the changed settings are reflected to this machine.

Note
To use the Profile Manager, install the User Setting plug-in. You can install the User Setting
 plug-in at the same time as when installing Configuration Tool or install the plug-in later.

Installing Software

You must register the machine in Configuration Tool in advance.

Starting Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Profile Manager].
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5. Enter the administrator password, and then click [OK].

6. Click  (New).

7. Enter the name of a transmission destination in [Profile Name].

8. Select [CIFS] for [Protocol] to register a shared folder.

9. Enter the path of the shared folder that you set on the computer in
 [Target URL].

10. Enter the port number to use in [Port No.].

11. If access privileges are set to the shared folder, enter the user
 name and password in [User Name] and [Password].

12. Select [Encode Communication] and [CIFS Character Set] if
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 necessary.

13. Enter [File Name] if necessary.

14. Click [Advanced], and then set the advanced settings.

15. Click [OK].

16. Click  (Save to device).

Registering a Destination (Profile) from the Web Page

This section describes the registration method that uses the Web page on a computer.

1. Start a Web browser.

2. Enter the URL, "http://(The IP address of this machine)" in the
 address bar, and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".

3. Click [Administrator Login].

4. Enter "admin" in [User Name] and the administrator password of
 the machine in [Password], and then click [OK].
For Mac OS X, enter "admin" in [Name] and the administrator password of the
 machine in [Password], and then click [Login].

5. Click [SKIP].
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6. Click [List] at the top of the screen.

7. Click [Profile] on the left side of the screen.

8. Click [New].

9. Enter the name of a transmission destination in [Profile Name].

10. Select [CIFS] for [Protocol] to register a shared folder.

11. Enter the path of the shared folder that you set on the computer in
 [Target URL].

12. Enter the port number to use in [Port Number].

13. If access privileges are set to the shared folder, enter the user
 name and password in [User Name] and [Password].

14. Select [CIFS Character Set] and [Encode Communication] if
 necessary.

15. Set [Detail] if necessary.
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16. Click [Submit].

Registering a Destination (Profile) from the Operator
 Panel

This section describes how to register profiles from the operator panel.

1. Press [Device Settings] on the touch panel.

2. Press [Profile].

3. Select a number, and then press [Register].

4. Enter a profile name, and then press [Next].

5. Select a setting, and then press [Next].

6. Enter the values of the transmission destination computer name
 and the shared folder name in the " the transmission destination
 computer name the shared folder name" format.
Example: PC1 share

Memo
If there is no DNS server in the network, you cannot specify the computer with the
 computer name (the transmission destination computer name). In such a case, use
 the IP address of the computer to set.

Example: 192.168.0.3 share

7. Press [Next].

8. If access privileges are set to the shared folder, enter the user
 name and password in [User Name] and [Password].

Note
If domain management is performed, enter "User name@domain name".

If domain management is performed and you cannot establish a connection even after
 entering "User name@domain name", delete "@domain name".

Also, access the Web page of this machine, select [Admin Setup] > [Network Menu],
 and then set the NetBIOS domain name in [Workgroup name] in [NBT].
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For the domain name, check with your network administrator.

9. Press [Next].

10. Set other items if necessary.

11. Press [OK].
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How to Use Scan To Shared Folder

This section describes how to operate Scan To Shared Folder.

Scanned data is converted into a PDF, JPEG, TIFF, or XPS file. PDF is set by factory default.

Set a network and shared folder default setting before using the Scan To Shared Folder
 function.

Connecting This Machine to a Network

Before Using Scan To Shared Folder

Memo
The following procedure uses the factory default setting.

1. Press [Scan] or the  (SCAN) button.
The touch panel display switches to the scan top screen.

2. Set a document in the ADF or on the document glass.

3. Press [Scan To Shared Folder].

4. Press [Select Profile].
If a profile is not displayed, check the Scan To Shared Folder settings.

Before Using Scan To Shared Folder

5. Select a profile.

Memo
Press [Preview] on the [Advanced] tab to preview the scanned image.

6. Set scan settings if necessary.

7. Press the  (START) button.
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Changing Registered Destination (Profile)

You can change a destination (profile) in the following three ways. This manual recommends
 to use Configuration Tool or the Web page where you can enter information with the
 computer keyboard.

Changing a Destination (Profile) from Configuration Tool

Changing a Destination (Profile) from the Web page

Changing a Destination (Profile) from the Operator Panel

Changing a Destination (Profile) from Configuration Tool

This section describes the change and deletion methods that use Configuration Tool on a
 computer.

If you click  (Save to device), the changed settings are reflected to this machine.

Note
To use the Profile Manager, install the User Setting plug-in. You can install the User Setting
 plug-in at the same time as when installing Configuration Tool or install the plug-in later.

Installing Software

You must register the machine in Configuration Tool in advance.

Starting Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.
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4. Click [Profile Manager].

5. Enter the administrator password, and then click [OK].

6. Click a profile name to change.

7. Edit the profile, and then click [OK].
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8. Click  (Save to device).

Changing a Destination (Profile) from the Web page

This section describes how to change destinations using the Web page on a computer.

1. Start a Web browser.

2. Enter the URL, "http://(The IP address of this machine)" in the
 address bar, and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".

3. Click [Administrator Login].

4. Enter "admin" in [User Name] and the administrator password of
 the machine in [Password], and then click [OK].
For Mac OS X, enter "admin" in [Name] and the administrator password of the
 machine in [Password], and then click [Login].

5. Click [SKIP].
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6. Click [List] at the top of the screen.

7. Click [Profile] on the left side of the screen.

8. Click a profile to change.

9. Click [Edit].

10. Edit the profile if necessary.

11. Click [Submit].
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Changing a Destination (Profile) from the Operator Panel

1. Press [Device Settings] on the touch panel.

2. Press [Profile].

3. Select a number, and then press [Edit].

4. Select an item to change.

5. Change the item, and then press [OK].

6. To change multiple items, repeat steps 4 to 5.

7. Press [Back].

8. Press [OK] to register the setting.
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Deleting a Registered Destination (Profile)

You can delete a destination (profile) in the following three ways. This manual recommends
 to use Configuration Tool or the Web page where you can enter information with the
 computer keyboard.

Deleting a Destination (Profile) from Configuration Tool

Deleting a Destination (Profile) from the Web page

Deleting a Destination (Profile) from the Operator Panel

Deleting a Destination (Profile) from Configuration Tool

This section describes the change and deletion methods that use Configuration Tool on a
 computer.

If you click  (Save to device), the changed settings are reflected to this machine.

Note
To use the Profile Manager, install the User Setting plug-in. You can install the User Setting
 plug-in at the same time as when installing Configuration Tool or install the plug-in later.

Installing Software

You must register the machine in Configuration Tool in advance.

Starting Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

246



4. Click [Profile Manager].

5. Enter the administrator password, and then click [OK].

6. Click a profile name to delete.

7. Click  (Delete).

Memo
To delete all the destinations (profiles), click  (Delete all).
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8. Click  (Save to device).

Deleting a Destination (Profile) from the Web page

This section describes the registration and deletion methods that use the Web page on a
 computer.

1. Start a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".

3. Click [Administrator Login].

4. Enter "admin" in [User Name] and the administrator password of
 the machine in [Password], and then click [OK].
For Mac OS X, enter "admin" in [Name] and the administrator password of the
 machine in [Password], and then click [Login].

5. Click [SKIP].
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6. Click [List] at the top of the screen.

7. Click [Profile] on the left side of the screen.

8. Click a profile to delete.

9. Click [Delete].

10. Click [OK] in a dialog box.

Deleting a Destination (Profile) from the Operator Panel

1. Press [Device Settings] on the touch panel.

2. Press [Profile].

3. Select a number, and then press [Delete].

4. When a confirmation screen is displayed, press [Yes].

Topics

Changing Registered Destination (Profile)
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Scanning from a Computer

Remote Scan allows you to start the scan function of the machine and scan documents from
 a computer.

Before Using Remote Scan

How to Use Remote Scan

Using ActKey (Windows)

Using the TWAIN Driver (Windows)

Using the WIA Driver (Windows Only)

Using Image Capture (Mac OS X)
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Before Using Remote Scan

Before Using Remote Scan with the ActKey, TWAIN Driver, WIA Driver

Before Using Remote Scan with WSD Scan

Before Using Remote Scan with Image Capture (Mac OS X)

Setting to Use Remote Scan

Selecting a Remote Scan Mode

Before using the remote scan function, you need the following settings corresponding to the
 connection method and OS of your computer.

Note
When connecting the machine to the network, set the followings.

Set [TCP/IP] to [Enable].

Match the IP version between the machine and a computer.

Set the DNS server.

Memo
The required software varies depending on the OS of your computer and the function to use.
 Install the appropriate software.

On the Windows computer, Remote Scan function can be used with ActKey, TWAIN Driver,
 WIA Driver, or WSD Scan.

Refer to the following.

Before Using Remote Scan with ActKey, TWAIN Driver, or WIA Driver

Before Using Remote Scan with WSD Scan

If you use Mac OS X, you can use Image Capture.

Refer to the following.

Before Using Remote Scan with Image Capture (Mac OS X)

Before Using Remote Scan with the ActKey, TWAIN Driver,
 WIA Driver

1. Set the machine for using Remote Scan.
Refer to the following.

Setting to Use Remote Scan

2. Set the type of stand-by mode for Remote Scan.
Refer to the following.

Selecting a Remote Scan Mode
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3. Install the scanner driver and ActKey.
Installing a Driver and Software to a Computer

For the USB connection, setting is complete.

4. Register a computer that is used for Secure Scan in the machine.
 (Only when you use Secure Scan.)

Registering a Computer That is Connected

Memo
Your computer may automatically be registered when the scanner driver is installed.

If the computer information, such as computer name or IP address is changed, you
 need to newly register the information.

Before Using Remote Scan with WSD Scan

1. Set the machine for using WSD Scan on the machine.

2. Set the type of stand-by mode for Remote Scan.
Before Using WSD Scan

3. Install this machine as a WSD device to a connected computer.
For details, see "Before Using WSD Scan".

When the machine is installed in the computer, the computer is also registered to the
 machine as a destination computer for WSD Scan.

Before Using Remote Scan with Image Capture (Mac OS X)

If you use Mac OS X, you can use Image Capture.

1. Set the machine for using Remote Scan.
Before Using Scan To Computer

2. Set the type of stand-by mode for Remote Scan.
Refer to the following.

Selecting a Remote Scan Mode

3. Install the Mac OS X scanner driver.
Installing a Driver and Software to a Computer

For the USB connection, setting is complete.

4. Register a computer that is used for Secure Scan in the machine.
 (Only when you use Secure Scan.)

Registering a Computer That is Connected

Memo
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If the computer information, such as computer name or IP address is changed, you need
 to newly register the information.

Setting to Use Remote Scan

Enable the Network TWAIN function so that you can use the Remote Scan function on a
 computer.

Note
If you set this function to [OFF], you cannot use the Scan To Computer function and Remote
 Scan.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times to select [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [TWAIN Setup].

6. Check that [Network TWAIN] is set to [ON].

Memo
Pressing [Network TWAIN] switches between [ON] and [OFF].

7. Press [Back] until the home screen is displayed.

Selecting a Remote Scan Mode

There are three Remote Scan modes: Simple Scan, Manual Scan, and Secure Scan.

In Simple Scan mode, you can start scanning anytime if the machine is in standby status.

In Manual Scan mode, you must turn Remote Scan on the touch panel before starting
 scanning.

In Secure Scan mode, you can operate only from a specified computer. Only one computer
 can be connected at a time.

If you perform a remote scan via the WSD Scan connection, you can start scanning only
 from computers that are already registered in this machine, regardless of the Remote Scan
 modes.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times to select [Admin Setup].
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3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press  or  several times to select [PC Scan Mode].

6. Select a scan mode, and then press [OK].

7. Press [Back] until the home screen is displayed.
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How to Use Remote Scan

Simple Scan Mode

Manual Scan Mode

Secure Scan Mode

You can send scanned images to a computer that is connected via a network or USB
 interface. You can scan documents set on the machine by operating on the computer.

To use Remote Scan, you must prepare the following:

Before Using Remote Scan

Set the machine in the stand-by mode for Remote Scan before starting scanning on the
 computer. The procedure depends on the Remote Scan mode.

See the following:

Simple Scan Mode

Manual Scan Mode

Secure Scan Mode

The required operation on the computer depends on the operation system of your computer
 and connection method.

On the Windows computer, ActKey, TWAIN compatible applications (TWAIN Driver), WIA
 compatible applications (WIA Driver, WSD Scan) can be used.

Using ActKey (Windows)

Using the TWAIN Driver (Windows)

Using the WIA Driver (Windows Only)

If you use Mac OS X, you can use Image Capture.

Using Image Capture (Mac OS X)

Simple Scan Mode

In the Simple Scan mode, you can start scanning from a computer while the default screen
 is displayed on the operator panel.

Memo
Scanning can be started only if the machine displays the screen shown as follows.

[Device Settings] > [Admin Setup] > [Management] > [Default Mode]

1. Press  (Home).

2. Set a document in the ADF or on the document glass.

3. Start a scan program on a computer.

4. Start scanning from the program.
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Using ActKey (Windows)

Using the TWAIN Driver (Windows)

Using the WIA Driver (Windows Only)

Using Image Capture (Mac OS X)

Manual Scan Mode

Manual Scan Mode starts the scan function from the computer after setting the Remote Scan
 mode from the operator panel.

1. Press [Scan] or the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Press one of the remote scan button corresponding to the scanning
 software to turn the machine into the standby mode for the
 remote scan.

Memo
To display the remote scan buttons, you must set [PC Scan Mode] to [Manual Scan Mode]
 on the touch panel.

4. Start a scanning software on the computer.

5. Perform the scan operation on the software.
Using ActKey (Windows)

Using the TWAIN Driver (Windows)

Using the WIA Driver (Windows Only)

Using Image Capture (Mac OS X)

Secure Scan Mode

In the Secure Scan mode, set the machine in the stand-by mode for Remote Scan from a
 computer on which you specified the machine as a destination, and then start scanning on
 the computer. Only one computer can be connected at a time.

1. Press [Scan] or the  (SCAN) button.
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2. Set a document in the ADF or on the document glass.

3. Press one of the remote scan button corresponding to the scanning
 software to turn the machine into the standby mode for the
 remote scan.

Memo
To display the remote scan buttons, you must set [PC Scan Mode] to [Secure Scan Mode]
 on the touch panel.

4. Press [From Network] or [From USB Interface] in accordance with
 the connection method of the machine and computer.

5. For the network connection, select a computer to be connected,
 and then press [OK].

Memo
If the targeted computer is not displayed, register the computer to the machine.

Registering a Computer That is Connected

6. Start a scan program on a computer.

7. Start scanning from the program.
Using ActKey (Windows)

Using the TWAIN Driver (Windows)

Using the WIA Driver (Windows Only)

Using Image Capture (Mac OS X)
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Using ActKey (Windows)

ActKey enables you to start scanning according to the specified settings just by clicking a
 button.

About ActKey

Installing ActKey

Scanning from ActKey

Sending Scanned Data by Fax

Changing the Setting of Each ActKey Button

Using Network Configuration (Windows Only)
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About ActKey

ActKey enables you to start scanning according to the specified settings just by clicking a
 button.

Memo
ActKey does not support Mac OS X.

When you install ActKey, Network Configuration is also installed at the same time.
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Installing ActKey

1. Insert the "Software DVD-ROM" into a computer.

2. When [AutoPlay] is displayed, click [Run Setup.exe].
If the [User Account Control] dialog box is displayed, click [Yes].

3. Select a language, read the license agreement, and then click
 [Agree].

4. Read the environment advice, and then click [Next].

5. Select a model, and then click [Next].

6. Select a connection type, and then click [Next].

7. Click [Custom Install].

8. Select only the [ActKey] check box, and then click [Install].

9. Install the software by following the instructions.

10. Click [Finish].
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Scanning from ActKey

Memo
To scan using ActKey, preparation procedure such as installation of the scanner driver is
 required.

Before Using Remote Scan

You also need to set the machine in the stand-by mode for Remote Scan before starting
 scanning on the computer.

How to Use Remote Scan

1. Set a document in the ADF or on the document glass.

2. Click [Start], and then select [All Programs] > [Okidata] >
 [ActKey] > [ActKey].
If the scanner selection screen is displayed, select [OKI Universal Twain USB] for a
 USB connection or [OKI Universal Twain ****** (*; the last six digits of the MAC
 address)] for a network connection, and then click [OK].

3. Click a scan button.

Scanning starts.

A scanned image is opened with a selected application, saved in a folder, or sent with
 PC-FAX according to the scan button you click.

Memo
If you select [Application1] or [Application2], the application specified by ActKey or Default
 program in Windows, which associates with the file type starts, and the scanned document
 is displayed in the application.

If you select [Folder], the scanned document is saved in the specified folder.

If you select [PC-Fax], the fax transmission application starts, and the scanned document is
 sent to the application. Send a fax with the fax transmission software on your computer.
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Sending Scanned Data by Fax

You can send a scanned document with the fax service of the Windows component.

Note
After scanning a document, you cannot change the orientation of the image on an
 application.

This function uses the fax service of the Windows component.

Memo
For the PC-FAX transmission function, the resolution is fixed to 200 dpi and the color mode is
 fixed to black and white.

To scan using ActKey, preparation procedure such as installation of the scanner driver is
 required.

Before Using Remote Scan

You also need to set the machine in the stand-by mode for Remote Scan before starting
 scanning on the computer.

How to Use Remote Scan

1. Set a document in the ADF or on the document glass.

2. Click [Start], and then select [All Programs] > [Okidata] >
 [ActKey] > [ActKey].

3. Click [PC-FAX] on a computer.

[Fax Setup] starts.

4. Send a fax by following the on-screen instructions.

263



264



Changing the Setting of Each ActKey Button

You can change the settings of each of four scan buttons.

1. Start ActKey.

2. Select [Button settings] from the [Options] menu.

3. Click a button to set.

4. Change the setting if necessary.

Memo
The default save destination is automatically created when ActKey is installed.

The scanned data is saved in the save destination folder with "file name (date)
 sequential number".

5. Click [OK].
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Using Network Configuration (Windows Only)

About Network Configuration

Registering the Machine (New Machine) to Network Configuration

Setting Scan To Computer

Changing the Setting Information of the Registered Machine

Deleting Computer Information Registered in the Machine

About Network Configuration

Network Configuration is a tool to set in advance when performing Scan To Computer. Also,
 if information, such as the IP address of the machine or computer, is changed when
 performing a network scan, you can change the setting values with this tool.

When you install ActKey, Network Configuration is also installed at the same time.

When you start a computer, Network Configuration is automatically included in the task bar.

Registering the Machine (New Machine) to Network
 Configuration

1. Click [Start], and then select [All Programs] > [Okidata] >
 [ActKey] > [Tools] > [Network Configuration].

2. Right-click [Show Network Configuration] in the task tray.

3. Select a scanner driver to use, and then select [Add Scanner] from
 the [Scanner] menu.

4. Select the scanner driver name to be added.
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Setting Scan To Computer

To perform Scan To Computer, you must register the computer name, IP address, and port
 number to the machine.

For details, see "Using Network Configuration (Windows Only)" in "Registering a Computer
 That is Connected".

Changing the Setting Information of the Registered
 Machine

Change the IP address and port number of the machine.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [ActKey] > [Tools] > [Network Configuration].

2. Right-click [Show Network Configuration] in the task tray.

3. Select the scanner driver and select [Edit Scanner] from the
 [Scanner] menu.

The setting value that is currently set to the computer is displayed.

4. Change to the IP address and port number of the machine.

Deleting Computer Information Registered in the Machine

For details, see "Using Network Configuration (Windows Only)" in "Removing Computer".
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Using the TWAIN Driver (Windows)

Scanning

Changing Settings in Simple Mode

Changing Settings in Advanced Mode

How to start scanning from an application on a computer after setting the Remote PC from
 the operator panel of the machine.

Note
To use this function, a TWAIN-compatible application (such as Adobe Photoshop CS3) must be
 installed.

Memo
This section uses Adobe Photoshop CS3 as an example.

This section describes the procedure when using Remote Scan with a USB connection.

To scan using TWAIN Driver, preparation procedure such as installation of the scanner driver
 is required.

Before Using Remote Scan

You need to set the machine in the stand-by mode for Remote Scan before starting scanning
 on the computer.

How to Use Remote Scan

Scanning

1. Set a document in the ADF or on the document glass.

2. Start Adobe Photoshop CS3 on the computer.

3. Click [Import] from [File], and then select the scanner driver of the
 machine.

4. Click [Scan].

5. Click a scan button.
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6. Click [Quit].

7. If you do not scan other pages or the back side, click [Quit].

Memo
The five buttons ([Scan Photograph], [Scan Magazine], [Scan for OCR], [Scan for
 Internet], [Customize]) are registered as the default settings.

Changing Settings in Simple Mode

You can adjust how a document is scanned by changing the driver settings.

The following explains each setting item.

You can change the settings of five registered buttons.

1. Set a document in the ADF or on the document glass.

2. Start Adobe Photoshop CS3 on the computer.

3. Click [Import] from [File], and then select the scanner driver of the
 machine.

4. Click [Scan].

5. Select [Simple] from [Mode].

6. Click [Settings].
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7. Click a scan button to change the setting.

8. Click [OK].

9. To start scanning, click the scan button.

Changing Settings in Advanced Mode

You can adjust how a document is scanned in details.

1. Set a document in the ADF or on the document glass.

2. Start Adobe Photoshop CS3 on the computer.

3. Click [Import] from [File], and then select the scanner driver of the
 machine.

4. Click [Scan].

5. Select [Advanced] from [Mode].

6. Change the setting if necessary.

7. Click [Scan] to start scanning.
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Using the WIA Driver (Windows Only)

This section describes how to start scanning from a WIA compatible application via USB or
 WSD Scan connection.

Memo
The WIA driver does not support the network scan function. Connect the machine to a
 computer via a USB interface or WSD Scan.

The WIA driver does not support Mac OS X.

The WIA 2.0 driver supports Windows 8.1/Windows Sever 2012 R2/Windows 8/Windows
 Server 2012/Windows 7/Windows Server 2008 R2.

The WIA 1.0 driver supports Windows Vista/Windows Server 2008/Windows Server 2003.

To scan using WIA Driver, preparation procedure such as installation of the scanner driver is
 required.

Before Using Remote Scan

You also need to set the machine in the stand-by mode for Remote Scan before starting
 scanning on the computer.

How to Use Remote Scan

Scanning

Memo
The following procedure uses PaperPort as an example.

1. Set a document in the ADF or on the document glass.

2. Start Adobe Photoshop CS3 on the computer.

3. Select [Import] from [File], and then select [WIA: OKI Universal
 WIA] for the USB connection or select [WIA-OKI-XXXXX] for the
 WSD scan.

4. Click [Scan].

5. Select a paper feed method.

6. Select an image type.

7. Specify the area to scan.

8. Click [Scan].

9. To complete scanning, click [Cancel].
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10. If you do not scan other pages or the back side, click [Quit].

Using Windows Fax and Scan

"Windows FAX and Scan" is a function available with Windows 8/Windows 7/Windows Vista.

1. Set a document in the ADF or on the document glass.

2. Click [Start] on a computer, and then select [All Programs] >
 [Windows FAX and Scan]. (For Windows 8, right-click on the
 [Start] screen, and then select [All Programs] > [Windows FAX
 and Scan].)

3. Click [New Scan].

4. Select [OKI Universal WIA], and then click [OK].

5. Set the setting if necessary.

6. Click [Scan].

7. Exit [Windows FAX and Scan].
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Using Image Capture (Mac OS X)

Scanning

Changing Settings

To scan using Image Capture, preparation procedure such as installation of the scanner
 driver is required.

Before Using Remote Scan

You also need to set the machine in the stand-by mode for Remote Scan before starting
 scanning on the computer.

How to Use Remote Scan

The ICA driver does not support Windows.

The ICA driver does not support Mac OS X 10.6.7 or earlier.

Scanning

1. Set a document in the ADF or on the document glass.

2. Start Image Capture on the computer.

3. Select the machine from the list on the left side of the Image
 Capture screen.

4. Click [Scan].
Scanning starts.

5. Select [Close Image Capture] from [Image Capture].

Changing Settings

You can adjust how a document is scanned by changing the driver settings.

The following explains each setting item.

If you display detailed information, you can adjust how a document is scanned in details.

1. Set a document in the ADF or on the document glass.

2. Start Image Capture on the computer.

3. Select the machine from the list on the left side of the Image
 Capture screen.

4. Click [Display the detailed information].
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5. Change the setting if necessary.

6. Click [Scan].
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Descriptions of Screens for Scan

This section describes the items of the screen.

Scan To E-mail Screen

[Scan To E-mail] Tab

Item Description

1 Destination
 area

Select a destination e-mail address. The selected e-mail address appears in this
 area. If at least 1 destination is specified, you can press [Display all] to edit,
 add, or delete a destination.

2 Shortcut
 buttons

Displays shortcut buttons for using certain scan functions.
The screen image shows the factory default setting. The setting can be changed
 by Administrator Setting.

3 One touch
 buttons

Displays destinations assigned to one-touch buttons. Press a button to add a
 destination.

4 Function
 Settings

Displays the current settings.
The setting can be changed for certain functions.

[Basic] Tab
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Item Description

1 Address Book Displays e-mail addresses registered in the Address Book.
Select an e-mail address as a destination from the Address Book.

2 Group List Displays a list of groups in which e-mail addresses are registered.
Select a group as a destination from the Group List.

3 Tx History Displays a transmission history.
Select a destination from the transmission history.

4 Manual Input Enter an e-mail address manually to use it as a destination.

5 LDAP Search for an e-mail address from the LDAP server to use it as a
 destination.
There are two search methods: Simple Search and Advanced Search.

6 Color Mode Specifies color mode to scan a document.

7 Scan Size Specifies the scan size to scan a document.

8 Register to Job
 Macro

Registers current settings to Job Macro.

9 Displays Help topics.

[Advanced] Tab

Item Description

1 Duplex Scan Specifies duplex scanning.
Set this function when scanning both sides of a document.

2 Direction Specifies the orientation of images.

3 Mixed Size Scans documents of different sizes.

4 E-mail Setup Specifies an e-mail address as a reply destination.
If the recipient replies to the received e-mail, the reply is sent to the e-mail
 address specified here.
Specifies the subject of the e-mail.
Specifies the body of the e-mail.

5 File Name Specifies a file name for the scanned file.
If not specified, the file will be named according to the factory default setting.

6 Continuous
 Scan

Scans multiple documents as a single job.

7 Preview Specifies whether to preview scanned images.

8 White Page Skips blank pages when scanning.
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[Image Settings] Tab

Item Description

1 Image
 Settings

Specifies the following image settings: density, document type, resolution,
 background removal, contrast, hue, saturation, and RGB.

2 File Format Specifies a file format for the scanned file.

3 Encrypted
 PDF

Creates an encrypted (password-protected) scanned file.
This function is available only when the file format is set to PDF or HC-PDF.

4 Compression
 Rate

Specifies a compression level for the scanned file.

5 Edge Erase Eliminates a black shadow that may appear around the edges on the scanned
 file when scanning, for example, a book.

6 Center Erase Eliminates shadow lines when scanning a book or magazine.

[Function Settings] > [Destination] Tab

Add, edit or delete a destination to which a document is sent.

[Function Settings] > [Scan Setting] Tab

Item Description

1 Setting display
 area 1

Displays the current settings for displayed items.
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2 Setting display
 area 2

Displays a list of settings that are not set by items displayed in setting
 display area 1.

Scan To Computer Screen

Item Description

1 Select A
 Connecting PC

Specifies a list of computers connected to this machine. Select a
 computer as a destination.

2 Displays Help topics.

Scan To USB Memory Screen

[Scan To USB Memory] Tab

Item Description

1 Color Mode Specifies color mode to scan a document.

2 Scan Size Specifies the scan size according to the size of the document.

3 Duplex Scan Specifies duplex scanning.
Set this function when scanning both sides of a document.

4 Register to Job Macro Registers current settings to Job Macro.

5 Function Settings Displays the current settings.
The setting can be changed for certain functions.

6 Displays Help topics.
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[Basic] Tab

Item Description

1 Direction Specifies the orientation of images.

2 Mixed Size Scans documents of different sizes.

[Advanced] Tab

Item Description

1 File Name Specifies a file name for the scanned file.
If not specified, the file will be named according to the factory default
 setting.

2 Continuous
 Scan

Scans multiple documents as a single job.

3 Preview Specifies whether to preview scanned images.

4 White Page Skip Skips blank pages when scanning.

[Image Settings] Tab

Item Description

1 Image
 Settings

Specifies the following image settings: Density, Document Type, Resolution,
 Background Removal, Contrast, Hue, Saturation and RGB.
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2 File Format Specifies a file format for the scanned file.

3 Encrypted
 PDF

Creates an encrypted (password-protected) scanned file.
This function is available only when the file format is set to PDF or HC-PDF.

4 Compression
 Rate

Specifies a compression level for the scanned file.

5 Edge Erase Eliminates a black shadow that may appear around the edges on the scanned
 file when scanning, for example, a book.

6 Center Erase Eliminates shadow lines when scanning a book or magazine.

[Function Settings] > [File Name] Tab

Edit a file name of a scanned document.

[Function Settings] > [Scan Setting] Tab

Item Description

1 Setting display
 area 1

Displays the current settings for displayed items.

2 Setting display
 area 2

Displays a list of settings that are not set by items displayed in setting
 display area 1.

Scan To Shared Folder Screen

[Scan To Shared Folder] Tab
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Item Description

1 Profile area Select a destination profile from [Select Profile]. The selected profile appears in
 this area.

2 Shortcut
 buttons

Displays shortcut buttons for using certain scan functions.
The screen image shows the factory default setting. The setting can be changed
 by Administrator Setting.

3 One touch
 buttons

Displays destinations assigned to one-touch buttons. Press a button to add a
 destination.

4 Function
 Settings

Displays the current settings.
The setting can be changed for certain functions.

5 Displays Help topics.

[Basic] Tab

Item Description

1 Color Mode Specifies color mode to scan a document.

2 Scan Size Specifies the scan size to scan a document.

3 Duplex Scan Specifies duplex scanning.
Set this function when scanning both sides of a document.

4 Direction Specifies the orientation of images.

5 Mixed Size Scans documents of different sizes.

6 Job Macro Registers current settings to Job Macro.

[Advanced] Tab

Item Description

1 File Name Specifies a file name for the scanned file.
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If not specified, the file will be named according to the factory default
 setting.

2 Subfolder Specifies a sub folder in which to save the scanned document.
If not specified, the scanned data will be saved in the root folder.

3 Continuous
 Scan

Scans multiple documents as a single job.

4 Preview Specifies whether to preview scanned images.

5 White Page Skip Skips blank pages when scanning.

[Image Settings] Tab

Item Description

1 Image
 Settings

Specifies the following image settings: Density, Document Type, Resolution,
 Background Removal, Contrast, Hue, Saturation and RGB

2 File Format Specifies a file format for the scanned file.

3 Encrypted
 PDF

Creates an encrypted (password-protected) scanned file.
This function is available only when the file format is set to PDF or HC-PDF.

4 Compression
 Rate

Specifies a compression level for the scanned file.

5 Edge Erase Eliminates a black shadow that may appear around the edges on the scanned
 file when scanning, for example, a book.

6 Center Erase Eliminates shadow lines when scanning a book or magazine.

[Function Settings] > [Profile] Tab

Delete a selected profile on the [Profile] tab.

[Function Settings] > [Scan Setting] Tab
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Item Description

1 Setting display
 area 1

Displays the current settings for displayed items.

2 Setting display
 area 2

Displays a list of settings that are not set by items displayed in setting
 display area 1.
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Print

This chapter describes information about various ways to print using this machine.

Basic Operations of Print Functions

Printing on Various Types of Paper

Printing with Various Settings from a Computer

Saving Paper, Saving Toner

Adjusting Color on the Computer

For a Better Finish

Useful Functions

Printing Confidential Document

Descriptions of Screens for Print
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Basic Operations of Print Functions

Loading Paper

Printing from a Computer (Windows)

Printing from a Computer (Mac OS X)

Cancelling a Print Job
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Loading Paper

This chapter describes paper that can be loaded in the paper trays of this machine.

Loading Paper

Printing on Envelopes

Setting Output Tray
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Printing from a Computer (Windows)

You can set a paper size, paper tray, and paper weight, and paper type with the printer
 driver.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Windows XPS Printer Driver

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the printer driver.

4. Click [Preferences].

5. Select a paper size from [Size] on the [Setup] tab.

6. Select a paper tray from [Source].

7. Select a paper type from [Type].

8. Select a paper weight option from [Weight].
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9. Click [OK].

10. Click [Print] on the [Print] Screen.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the PS printer driver.

4. Click [Preferences].

5. Select the paper tray from [Paper Source] on the [Paper/Quality]
 tab.

6. Click [Advanced].

7. Select a paper weight option from [Media Weight], and then click
 [OK].
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8. Click [OK] on the [Print Preferences] screen.

9. Click [Print] on the [Print] screen.

For Windows XPS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the printer driver.

4. Click [Preferences].

5. Select a paper size from [Size] on the [Setup] tab.
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6. Select a paper tray from [Source].

7. Select a paper type from [Type].

8. Select a paper weight option from [Weight].

9. Click [OK].

10. Click [Print] on the [Print] Screen.
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Printing from a Computer (Mac OS X)

For Mac OS X

You can set a paper size, paper tray, and paper weight, and paper type with the printer
 driver.

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the machine from [Printer].

4. Select the paper size from [Paper Size].

5. Select the paper tray for [All Pages From] on the [Paper Feed]
 panel.

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

6. Select a paper weight option for [Media Weight] on the [Print
 Options] panel.
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7. Click [Print].
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Cancelling a Print Job

You can cancel a print job by deleting the job in the job list from the operator panel.

Note
The pages that are ready to be printed on this machine will be printed without changes.

If the operator panel indicates that printing is in progress for a long time, delete the print job
 from the computer.

1. Press the  (STATUS) button.
The touch panel display switches to the status screen.

2. Press the [Device Information] tab.

3. Press [Job List].

4. Select the job you want to delete, and press [Delete].

5. Press [Yes] on the confirmation screen.
The print data is deleted.
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Printing on Various Types of Paper

Printing on Envelopes

Printing on Labels

Printing on Long Paper

Printing on Custom Size Paper
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Printing on Envelopes

Loading Envelopes

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

Note
Curling or creasing may occur after printing. Be sure to perform a test print to check that no
 problems exist.

Load envelopes with the address side up in the direction as described below.

If you are using envelopes with the flap (for gluing) on the long edge (Monarch, Com-10,
 DL, C5), load them with the flap folded so that the flap is on the left side when fed.

Duplex printing is not available for envelopes.

Loading Envelopes

When printing on envelopes, change the paper size setting, and use the MP tray and rear
 output tray.

1. Load envelopes in the MP tray.
Com-10, DL, C5

C4

2. Open the rear output tray.

3. Press [Device Settings] on the touch panel.

4. Press [Paper Setup].

5. Press [MP Tray].

6. Press [Media Type].

7. Press the size of envelopes you use.

8. Press [Back] until the home screen is displayed.
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Next, set printing settings from a printer driver.

Topics

Available envelope types.

Loading Paper

The manual feed mode is available for envelopes.

Printing Manually One by One

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Envelope*] from [Size] on the [Setup] tab.
* Select an envelope type.

5. Select [Multi Purpose Tray] from [Source].

6. Select [Landscape] from [Orientation].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver to print.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Page Setup] from the [File] menu.

3. Select the envelope size from [Size], [Landscape] from
 [Orientation], and then click [OK].

4. Select [Print] from the [File] menu.

5. Click [Preferences].

6. Select [Multi-Purpose Tray] from [Paper Source] on the
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 [Paper/Quality] tab.

7. Click [OK].

8. Change other settings if necessary, and then click [Print].

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the envelope size from [Paper Size] and select the
 orientation from [Orientation].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

4. Select [Multi-Purpose Tray] for [All Pages From] on the [Paper
 Feed] panel.

5. Change other settings if necessary, and then click [Print].
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Printing on Labels

Loading Labels

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

Set a paper size and paper type for the MP tray from the operator panel. Then, set a paper
 size, paper tray, and other printing settings with a printer driver.

Note
Duplex printing is not available for labels.

Loading Labels

When printing on labels, change the paper type and paper size setting, and use the MP tray
 and rear output tray.

1. Load labels in the MP tray.

2. Open the rear output tray.

3. Press [Device Settings] on the touch panel.

4. Press [Paper Setup].

5. Press [MP Tray].

6. Press [Paper Size].

7. Press [A4] or [Letter].

8. Press [Media Type].

9. Press [Labels].

10. Press [Back] until the home screen is displayed.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.
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3. Click [Preferences].

4. Select [A4 210x297mm] or [Letter 8.5x11in] from [Size] on the
 [Setup] tab.

5. Select [Multi Purpose Tray] from [Source].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select an envelope size from [Size] in the [Setup] tab to print.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Page Setup] from the [File] menu.

3. Select [A4] or [Letter] from [Size], [Portrait] or [Landscape] from
 [Orientation], and then click [OK].

4. Select [Print] from the [File] menu.

5. Click [Preferences].

6. Select [Multi-Purpose Tray] from [Paper Source] on the
 [Paper/Quality] tab.

7. Click [OK].

8. Change other settings if necessary, and then click [Print].

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Letter] or [A4] from [Paper Size] and select the orientation
 from [Orientation].

Memo
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If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10, click
 [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

4. Select [Multi-Purpose Tray] for [All Pages From] on the [Paper
 Feed] panel.

5. Change other settings if necessary, and then click [Print].
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Printing on Long Paper

Loading Long Paper

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

Set a paper size for the MP tray from the operator panel. Then, register a paper size with a
 printer driver.

Note
Register the paper size so that the length is longer than the width. You cannot set the length
 that is shorter than the width.

This function may not be available for some applications.

If the paper length exceeds 356 mm, the print quality may not be guaranteed even if the
 paper is used under the recommended conditions.

Loading Long Paper

When printing on long paper, change the paper type setting, and use the MP tray and rear
 output tray.

1. Load paper in the MP tray.

2. Open the rear output tray.

3. Press [Device Settings] on the touch panel.

4. Press [Paper Setup].

5. Press [MP Tray].

6. Press [Paper Size].

7. Select [Custom].

8. Press [Custom] to set a paper size within the following range, and
 then click [OK].

Width: 64 to 297 mm

Length: 90 to 1321 mm

9. Press [Back] until the home screen is displayed.

Topics
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Available long paper

Loading Paper

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [User Defined Size] from [Size] on the [Setup] tab.

Memo
You can select the paper size from [Banner *** x ***] if the paper size is set to
 210.0 x 900.0 mm, 215.0 x 900.0 mm, 215.0 x 1200.0 mm, 297 x 900 mm, or
 297 x 1200 mm.

5. Change other settings if necessary, and then click [OK].

6. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, click [Start] > [Devices and Printers] and create a new
 paper size in the [Forms] tab for [Print server proterties] on the top bar in the window. And
 then select the paper size created in the [Print server proterties] dialog box from [Paper size] on
 the [Settings] tab.

For Windows PS Printer Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 Preferences] > [OKI MC873(PS)].

3. Click [Advanced] on the [Layout] tab.

4. Click [Paper Size], select [PostScript Custom Page Size] from the
 drop-down list, and then enter values in [Width] and [Height].

5. Press [OK] until the print setting dialog box is closed.

6. Open a file to print from a computer.

7. Change other settings if necessary, and then click [OK].
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8. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Manage Custom Sizes] from [Paper Size].

4. Click [+] to add an item to the list of custom paper sizes.

5. Double-click [Untitled], and then enter a name of the long paper
 size.

6. Enter values in [Width] and [Height].

7. Click [OK].

8. Select the registered paper size from [Paper Size].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

9. Select [Multi-Purpose Tray] for [All Pages From] on the [Paper
 Feed] panel.

10. Change other settings if necessary, and then click [Print].
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Printing on Custom Size Paper

Loading Custom Size Paper

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

Set a custom paper size and paper type on the operator panel. Then, register a paper size
 with a printer driver.

Available paper size

Tray 1 Width 105 to 297 mm (4.1 to 11.7 inches), Length 148 to 431.8 mm (5.8 to
 17 inches)

Tray 2/3/4
 (Optional)

Width 148 to 297 mm (5.8 to 11.7 inches), Length 182 to 431.8 mm (5.8 to
 17 inches)

MP tray Width 64 to 297 mm (2.5 to 52 inches), Length 90 to 1321 mm (3.5 to
 52 inches)

Note
Register paper in portrait, and load paper in a tray in portrait.

If the paper length exceeds 432 mm (17 inches), use the Rear Output Tray.

This function may not be available for some applications.

If the paper length exceeds 432 mm (17 inches), the print quality cannot be guaranteed.

If paper is so long that it exceeds the paper supports of the MP tray, support the paper with
 your hands.

It is not recommended to use a paper width of less than 100 mm (3.9 inches), because
 paper jams may result.

About available paper sizes for each tray and for duplex printing

Loading Paper

The auto tray switch function is set to [ON] by factory default. When a tray runs out of paper
 during printing, another tray automatically starts feeding paper. To feed custom size paper
 from a specified tray, set the auto tray switch function to [OFF].

If images are not correctly printed on large size paper, selecting [Standard (600x600dpi)] for
 [Print Quality], image in the PS printer driver may allow for correct printing.

Loading Custom Size Paper

When printing on custom paper size, change the paper type setting, and specify a paper
 tray.

1. Load paper that can be set to the custom size in Tray 1, Tray 2, 3
 or 4 (optional).

2. Press [Device Settings] on the touch panel.
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3. Press [Paper Setup].

4. Press [Tray1], [Tray2], [Tray3] or [Tray4].

5. Press [Paper Size].

6. Select [Custom].

7. Press [Custom] to set a paper size within the following range, and
 then click [OK].

8. Change other settings if necessary.

9. Press [Back] until the home screen is displayed.

For Windows PCL Printer Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 Preferences] > [OKI MC873(PCL6)].

3. Click [Paper Feed Options] on the [Setup] tab.

4. Click [Custom Size].

5. Enter a name of the new size in [Name].

6. Enter values in [Width] and [Length].

7. Click [Add] to save the custom paper size to the list, and then click
 [OK].
You can save up to 32 custom sizes.

8. Click [OK] until the [Printing Preferences] dialog box is closed.

9. Open a file.

10. Select [Print] from the [File] menu.

11. Click [Preferences].

12. Specify a registered paper size.

13. Change other settings if necessary, and then click [OK].

14. Click [Print] on the [Print] screen.
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Memo
For the Windows XPS printer driver, click [Start] > [Devices and Printers] and create a new
 paper size in the [Forms] tab for [Print server proterties] on the top bar in the window. And
 then select the paper size created in the [Print server proterties] dialog box from [Size] on the
 [Settings] tab.

For Windows PS Printer Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 Preferences] > [OKI MC873(PS)].

3. Click [Advanced] on the [Layout] tab.

4. Click [Paper Size], and then select [PostScript Custom Page Size]
 from the drop-down list.

5. Click [Edit Custom Page Size].

6. Enter values in [Width] and [Length], and then click [OK].

Note
You cannot set [Offsets Relative to Paper Feed Direction].

7. Click [OK] until the print setting dialog box is closed.

8. Open a file.

9. Select the paper size for the registered paper.

10. Change other settings if necessary, and then click [OK].

11. Click [Print] on the [Print] screen.

For Mac OS X

Note
You can set a paper size out of the available range in the printer driver, resulting in improper
 printing. Set a paper size within the available range.

1. Open the file to print.

2. Select [Print] from the [File] menu.
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3. Select [Manage Custom Sizes] from [Paper Size].

4. Click [+] to add an item to the list of custom paper sizes.

5. Double-click [Untitled], and then enter a name of the custom paper
 size.

6. Enter values in [Width] and [Height].

7. Click [OK].

8. Select the paper size created from [Paper Size].

9. Change other settings if necessary, and then click [Print].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.
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Printing with Various Settings from a Computer

Printing Manually One by One

Enlarging or Reducing to Fit the Specified Paper Size

Printing Only the Cover from a Different Tray

Making a Booklet

Dividing a Document to Print on Some Sheets for Making a Poster

Adding Semi-transparent Text (Watermarks)

Overlaying Forms or Logos (Overlay)

Outputting a Document to a File Instead of Printing on Paper

Storing Frequently-printed Documents in the Printer

Printing E-mail Attachment Files
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Printing Manually One by One

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

You can print one sheet at a time by loading paper in the MP tray.

The "Paper request on MP Tray." message is displayed on the operator panel every time you
 print one page. To continue printing, select [Print Resume].

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Multi Purpose Tray] from [Source] on the [Setup] tab.

5. Click [Paper Feed Options].

6. Select the [Use MP tray as manual feed] check box, and then click
 [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

9. When a message is displayed on the touch panel, load paper in the
 MP tray,and then press [Start].
If the message is not displayed, press [Print].

When printing a multiple page document, the same message is displayed every time
 you print one page.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Multi Purpose Tray] from [Source] on the [Setup] tab. And then, click [Paper Feed
 Options] and select the [Use MP tray as manual feed] checkbox.

For Windows PS Printer Driver

1. Open the file to print.

310



2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Multi-Purpose Tray] from [Paper Source] on the
 [Paper/Quality] tab.

5. Click [Advanced].

6. Click [Multipurpose tray is handled as manual feed], and then
 select [Yes].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

9. When the message is displayed on the touch panel, load paper in
 the MP tray and press [Start].
If the message is not displayed, press [Print].

When printing a multiple page document, the same message is displayed every time
 you print one page.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Multi-Purpose Tray] for [All Pages From] on the [Paper
 Feed] panel.

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

4. Select [Print Options] from the panel menu.

5. Select [Multipurpose tray is handled as manual feed] check box in
 the [Feed] tab.

6. Change other settings if necessary, and then click [Print].

7. When the message is displayed on the touch panel, load paper in
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 the MP tray and press [Start].
If the message is not displayed, press [Print].

When printing a multiple page document, the same message is displayed every time
 you print one page.
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Enlarging or Reducing to Fit the Specified Paper Size

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

You can print on different paper sizes without changing the print data.

Note
This function may not be available for some applications.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select a paper size to edit from [Size] on the [Setup] tab.

5. Select the [Resize document to fit printer page] check box, and
 then select a paper size to print.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Paper Feed Options] in [Media] in the [Setup] tab, and then click [Conversion].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Resize document to fit printer page] check box on the
 [Job Options] tab.
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5. Select the paper size, and then click [OK].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the [Scale to fit paper size] check box on the [Paper
 Handling] panel.

4. Select a paper size to use from [Destination Paper Size].

5. Change other settings if necessary, and then click [Print].
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Printing Only the Cover from a Different Tray

For Windows PCL Printer Driver

For Mac OS X

You can feed the first page of a print job from one tray and the remaining pages from
 another tray.

Note
This function is not available with the Windows PS printer driver.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Click [Paper Feed Options] on the [Setup] tab.

5. Select the [Use different source for first page] check box, and then
 click [OK].

6. Select a paper tray from [Source], and then click [OK].
Select a paper type from [Type] and media weight from [Weight] if necessary.

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Paper Feed Options] in [Media] in the [Setup] tab, and then click [Use different source
 for first page].

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.
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3. Select [Paper Feed] from the panel menu.

4. Select [First Page From], and then select a tray to feed the first
 page.

5. Select a tray to feed the remaining pages from [Remaining From].

6. Change other settings if necessary, and then click [Print].
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Making a Booklet

For Windows PCL Printer Driver

For Windows PS Printer Driver

Note
This function may not be available for some applications.

This function is not available on Mac OS X.

Watermarks may not be printed properly with this function.

This function is disabled when performing encrypted authentication printing from a client
 computer that shares this machine via the print server.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Booklet] from [Finishing Mode] on the [Setup] tab.

5. Click [Options], and then set booklet printing settings if necessary.
[Signature]: Specify a unit of pages to be bound.

[2 pages]: Print two pages on one page.

[Right to Left]: Print a booklet that is opened from the right.

[Bind Margin]: Set a margin.

6. Click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

Memo
To make an A5 booklet by using A4 paper, select [A4] from [Size] on the [Setup] tab.

If this function is not available with the Windows PCL printer driver, select [Start] > [Devices
 and Printers], right-click the OKI MC873 icon, and then select [Printer properties] > [OKI
 MC873(PCL6)] > the [Advanced] tab > [Print processor] > [OKX055PP] > [OK].

For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Finishing Mode] in the [Setup] tab.
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For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Booklet] from [Page Format] on the [Layout] tab.

5. Select the [Draw Borders] check box if necessary.

6. Click [Advanced].

7. Click [Booklet Binding Edge], and then set margins.

Memo
To make a right-fold booklet (a booklet with its binding on the right side when the first
 page is facing up), select [On Right Edge].

To make an A5 booklet by using A4 paper, select [A4] from [Paper Size].

8. Press [OK] until the print setting dialog box is closed.

9. Change other settings if necessary, and then click [OK].

10. Click [Print] on the [Print] screen.
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Dividing a Document to Print on Some Sheets for
 Making a Poster

For Windows PCL Printer Driver

You can create a poster by printing a document onto multiple sheets of paper, and then
 combining the sheets afterwards.

Note
This function is not available when you are using the IPP network.

This function is not available with the Windows PS printer driver or on Mac OS X.

This function is disabled when performing encrypted authentication printing from a client
 computer that shares this machine via the print server.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu

3. Click [Preference].

4. Click [Poster Print] from [Finishing Mode] on the [Setup] tab.

5. Click [Options].

6. Set values to [Enlarge], [Add Registration Marks], and [Add
 Overlap] if necessary, and then click [OK].
To make an A3 poster using two sheets of A4 paper, select [A4] for the paper size, and
 the select [2] for [Zoom].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

Memo
If this function is not available with the Windows PCL printer driver, select [Start] > [Devices
 and Printers], right-click the OKI MC873 icon, and then select [Printer properties] > [OKI
 MC873(PCL6)] > the [Advanced] tab > [Print processor] > [OKX055PP] > [OK].

For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Finishing Mode] in the [Setup] tab.
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Adding Semi-transparent Text (Watermarks)

For Windows PCL Printer Driver

For Windows PS Printer Driver

Note
This function is not available on Mac OS X.

Watermarks are not printed properly for booklet printing.

When the [Background] check box is selected on the [Watermark] screen, a watermark may
 not be printed depending on the application. In such a case, clear the [Background] check
 box.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Extend] tab.

5. Click [Watermarks].

6. Click [New].

7. Specify the text, size, and angle, and then click [OK].

8. Click [OK].

9. Change other settings if necessary, and then click [OK].

10. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Watermarks] in the [Job Options] tab.

For Windows PS Printer Driver

1. Open the file to print.
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2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Click [Watermark] on the [Job Options] tab.

5. Click [New].

6. Enter text that is printed as a watermark in [Text] in
 [Watermarks].

7. Set [Font], [Size], or other settings if necessary, and then click
 [OK].

8. Check that the watermark to print is selected, and then click [OK].

9. Change other settings if necessary, and then click [OK].

10. Click [Print] on the [Print] screen.
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Overlaying Forms or Logos (Overlay)

For Windows PCL Printer Driver

For Windows PS Printer Driver

You can print overlays (such as logos or forms) on a document. An overlay is a group of
 forms. You can register three forms to an overlay. The forms are overlaid in order of
 registration and printed. The form that is registered last is printed on the top.

Note
This function is not available with the Windows XPS printer driver or on Mac OS X.

Memo
In advance, you can create a form, and then register it in this machine.

Registering Forms (Form Overlay)

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Extend] tab.

5. Click [Overlays].

6. Select the [Print Using Active Overlays] check box.

7. Click [Define Overlays].

8. Enter a name of the overlay in [Overlay Name].

9. Enter the ID of the form you registered with the Storage Manager
 plug-in for Configuration Tool in [ID].

10. Select the pages of the document on which to print the overlay
 from [Print on Pages].

11. Click [Add].

12. Click [Close].
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13. Select an overlay to use from [Defined Overlays], and then click
 [Add].

14. Click [OK].

15. Change other settings if necessary, and then click [OK].

16. Click [Print] on the [Print] screen.

For Windows PS Printer Driver

Note
To use this function with the Windows PS printer driver, you must log in to a computer as the
 administrator.

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 Preferences] > [OKI MC873(PS)].

3. Click [Overlays] on the [Job Options] tab.

4. Select [User Overlay] from the drop-down list, and then click
 [New].

5. Enter the form name that you registered with the Storage Manager
 plug-in for Configuration Tool in [Form Name], and then click
 [Add].

6. Enter a name of the overlay in [Overlay Name].

7. Select the pages of the document on which to print the overlay
 from [Print on Pages].

Memo
To apply an overlay by specifying the pages, select [Custom], and then enter the pages to
 which to apply the overlay in [Custom Pages].

8. Click [OK].

9. Select an overlay to use from [Defined Overlays], and then click
 [Add].

10. Click [OK].
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11. Change other settings if necessary, and then click [OK].

12. Open the file to print.

13. Select [Print] from the [File] menu.

14. Click [Print] on the [Print] screen.
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Outputting a Document to a File Instead of Printing on
 Paper

For Windows Printer Driver

For Mac OS X

You can output a document to a file.

Note
You must log in to a computer as the administrator.

For Windows Printer Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon and then select [Printer properties]
 > [OKI MC873(*)].
* Select a driver type to use.

3. Select the [Ports] tab.

4. Select [FILE:] from the port list, and then click [OK].

5. Open a file.

6. Select [Print] from the [File] menu.

7. Click [Print].

8. Enter the name of a file, and then click [OK].

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [PDF] in the print dialog box, and then select a file format.

4. Enter the name of a file, select a save destination, and then click
 [Save].
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Storing Frequently-printed Documents in the Printer

Storing from a Computer in This Machine (Windows PCL Only)

Storing from a Computer in This Machine (Windows PS Only)

Printing the Stored Document from This Machine

Store a print job in the internal Memory of the printer. When printing, call a print job by
 entering the password from the operator panel.

Note
If you cannot store the spooled data due to insufficient free space in the Memory, a message
 is displayed to inform you that the file system is full, and the print job is not executed.

This function is not available with the Windows XPS printer driver or on Mac OS X.

Storing from a Computer in This Machine (Windows PCL
 Only)

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select [Store for Re-print].

6. Enter a job name in [Job Name] and a password in [Job Password].

7. If you select the [Request Job Name for each printer job] check
 box, a prompt is displayed to ask the job name when you send the
 job to this machine.

8. Click [OK].

9. Set other settings if necessary.
The print job is only sent to the printer, and it is not printed yet.

Storing from a Computer in This Machine (Windows PS
 Only)

1. Open the file to print.
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2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Click [Store for Re-print] from [Job Type].

6. Enter a job name in [Job Name] and a password in [Personal ID
 Number (PIN)].

7. If the [Request Job Name for each printer job] check box is
 selected, a screen asking a job name appears when a job is sent.

8. Click [OK].

9. Set other settings if necessary, and then click [OK].

10. Click [Print] on the [Print] screen.
The print job is only sent to the printer, and it is not printed yet.

Printing the Stored Document from This Machine

1. Press [Print] or the  (PRINT) button.
The touch panel display switches to the print top screen.

2. Press [Stored Job].

3. Enter the password , and then press [OK].
A job searching starts.

Memo
The password is the one you specified on a computer when printing.

To clear an incorrect entry, press  (CLEAR).

To stop a job search, press  (STOP).

4. Press [Print].
To cancel the print job, select [Delete].
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Printing E-mail Attachment Files

Setting a POP Server

Setting an SMTP Server

To use this function, you must set the e-mail reception settings on a POP server or SMTP
 server.

Note
The following file formats are supported.

PDF (v1.7), JPEG, TIFF (V6 Baseline)

For the number of copies, duplex printing or other printing settings, the current settings on
 the [Admin Setup] menu are applied.

Memo
Up to 10 files, each of which is a maximum of 8 MB, can be printed.

You can switch output destinations for printouts of attachment files from [E-mail/I-Fax] of
 [Output Tray]. (Only for MC873 Series)

Setting Output Tray

You can forward attachment file of received E-mail.

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)

Setting a POP Server

Memo
If the POP server does not support SSL encryption, you may not receive e-mails correctly.

1. Open the Web page of this machine.
How to log in to the Web page

Log In as the Administrator

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [E-mail] > [Receive Settings].

5. Select [POP3], and then click [To STEP2].

6. Follow the on-screen instructions to set detailed settings.
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Memo
Set the mail server you are using correctly. If your mail server does not support the
 APOP protocol, you may not receive e-mails correctly.

If you want to specify the domain name of the mail server, set the DNS server in the
 [TCP/IP] setting.

7. Click [Submit].

Setting an SMTP Server

1. Open the Web page of this machine.
How to log in to the Web page

Log In as the Administrator

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [E-mail] > [Receive Settings].

5. Select [SMTP], and then click [To STEP2].

6. Follow the on-screen instructions to set detailed settings.

7. Click [Submit].
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Saving Paper, Saving Toner

Printing on Both Sides of Paper (Duplex Printing)

Saving Toner

Combining Multiple Pages onto One Sheet of Paper
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Printing on Both Sides of Paper (Duplex Printing)

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

You can print on both sides of a sheet of paper.

Duplex printing is available for the following paper sizes.

A3, A4, A5 , B4, B5, B6 , Letter, Legal (13 inches), Legal (13.5 inches), Legal
 (14 inches), Tabloid, Executive , 8.5SQ (8.5in x 8.5in), Folio, 8K (270mm x 390mm,
 273mm x 394mm, 260mm x 368mm), 16K (197 mm x 273 mm, 195 mm x 270 mm,
 184 mm x 260 mm), Custom size

Duplex printing is available for the following media weight.

64 to 220g/m2 (17 to 58 lb)

Do not use media weight other than the above, because paper jams may occur.

Note
This function may not be available for some applications.

Memo
When printing on custom size paper, duplex printing is available for the following width and
 length ranges.

Width: 128 to 297 mm (5.0 to 11.7 inches)

Length: 182 to 431.8 mm (7.2 to 17 inches)

For Windows PCL Printer Driver

1. Close the rear output tray.

2. Open the file to print.

3. Select [Print] from the [File] menu.

4. Click [Preferences].

5. Select [Long Edge] or [Short Edge] from [2-Sided Printing] on the
 [Setup] tab.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.
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Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [2-Sided Printing (Duplex)] in the [Setup] tab.

For Windows PS Printer Driver

1. Close the rear output tray.

2. Open the file to print.

3. Select [Print] from the [File] menu.

4. Click [Preferences].

5. Select [Flip on Long Edge] or [Flip on Short Edge] from [Print on
 Both Sides] on the [Layout] tab.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Close the rear output tray.

2. Open the file to print.

3. Select [Print] from the [File] menu.

4. Select [Long-Edge binding] or [Short-Edge binding] from [Two-
Sided] on the [Layout] panel.

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

5. Change other settings if necessary, and then click [Print].
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Saving Toner

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

Printing is possible with less toner.

The amount of toner can be saved in three levels.

[Printer setting]: Conforms to the printer setting.

[Off]: Prints at a normal density without saving toner.

[Save Level Low]: Prints at a somewhat lower density level.

[Save Level Middle]: Prints at a low density.

[Save Level High]: Prints at a very low density.

Note
If using this function, only [Normal (600x600)] or [Fast (600x600)] can be specified as the print
 quality.

Memo
The density of the image that is printed with this function may vary depending on the printed
 document.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Setup] tab.

5. Select the amount of toner to save from [Toner saving].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Toner Saving] in the [Job Options] tab.
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For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Color] tab.

5. Select the amount of toner to save from [Toner Saving].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Print Options] from the panel menu.

4. Select the amount of toner to save from [Toner Saving] in the
 [Quality2] tab.

5. Change other settings if necessary, and then click [Print].
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Combining Multiple Pages onto One Sheet of Paper

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

You can print multiple pages of a document onto a single side of a sheet of paper.

Note
This function reduces the page size of your document for printing. The center of the printed
 image may not be in the center of the paper.

This function may not be available for some applications.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the number of pages to print on each sheet at [Finishing
 Mode] on the [Setup] tab.

5. Click [Options].

6. Set each setting at [Page Borders], [Page layout], and [Bind
 Margin], and then click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Finishing Mode] in the [Setup] tab and set the details from [Options].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.
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3. Click [Preferences].

4. Select [Pages per Sheet] on the [Layout] tab.

Note
[Draw Borders] and [Pages per Sheet Layout] are not available with Windows Server 2003.

5. Select a value from the drop-down list.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the number of pages to print on each sheet from [Pages per
 Sheet] on the [Layout] panel.

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

4. Set each setting at [Border] and [Layout Direction].

5. Change other settings if necessary, and then click [Print].
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Adjusting Color on the Computer

Printing Color Data in Grayscale

About Color Matching

Color Matching (Automatic)

Color Matching (Office Color)

Color Matching (Graphic Pro)

Color Matching (No Color Matching)

Simulating Printing Results for Ink

Color Separation

Correcting Color Registration Error Manually

Correcting Density Manually

Make Minor Adjustment for Color Registration

Adjusting Color Balance (Density)

Adjusting Color with Software
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Printing Color Data in Grayscale

You can print color documents in grayscale.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences] or [Properties].

4. On the [Setup] tab, select [Monochrome].

5. Click [OK].

Memo
Selecting [Monochrome] on the printer driver enables you to print a color document in
 grayscale even when the cyan, magenta, and yellow toners are empty.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences] or [Properties].

4. Select the [Color] tab and select [Greyscale].

5. Click [OK].

Memo
Set grayscale printing on the [Job Options] tab.

Selecting [Greyscale] on the printer driver enables you to print a color document in
 grayscale even when the cyan, magenta, and yellow toners are empty.

For the Windows XPS printer driver, follow the steps for the Windows PS printer driver.

For Mac OS X

1. Open the file to print.

2. From the [File] menu, select [Print].
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3. Select [Color] from the panel menu.

4. Select [Grayscale].

5. Click [Print].

Memo
Selecting [Grayscale] on the printer driver enables you to print a color document in
 grayscale even when the cyan, magenta, and yellow toners are empty.
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About Color Matching

Color Matching means managing and adjusting documents color to keep it consistent
 between input and output devices.

There are two color matching functions: [Office Color] and [Graphic Pro] ([Color (User
 Settings)] if you use an XPS driver). If you use Mac OS X, you can also use [ColorSync]
 function to do color matching.
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Color Matching (Automatic)

If you use business documents mainly, Automatic is suitable. Color matching is applied when
 RGB color space print data is converted to CMYK color space for the printer.

Note
This function can support only RGB color data.

If you want to manage CMYK color data, use the Graphic Pro function.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Click [Detail...] in the [Setup] tab and select [Automatic], and then
 click [OK].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select the [Color] tab and select [Automatic], and then click [OK].

Memo
For the Windows XPS printer driver, follow the steps for the Windows PS printer driver and select
 [Auto Color] in the [Color] tab.

For Mac OS X

1. Open the file to print.
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2. From the [File] menu, select [Print].

3. Select the [Color] tab.

4. Select [Automatic] for [Color] and then click [Print].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.
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Color Matching (Office Color)

If you use business documents mainly, Office Color is suitable. Color matching is applied
 when RGB color space print data is converted to CMYK color space for the printer.

Note
This function can support only RGB color data.

If you want to manage CMYK color data, use the Graphic Pro function.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Click [Detail...] in the [Setup] tab and select [Office Color], and
 then click [OK].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select the [Color] tab and select [Office Color], and then click [OK].

Memo
For the Windows XPS printer driver, follow the steps for the Windows PS printer driver and select
 [Color Mode] in the [Color] tab.

For Mac OS X

1. Open the file to print.
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2. From the [File] menu, select [Print].

3. Select [Color] from the panel menu.

4. Select [Office Color] for [Color] and then click [Print].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.
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Color Matching (Graphic Pro)

The Graphic Pro function is suitable for using the DTP software. You can specify the
 simulation of printing with the CMYK output devices.

Note
Link profiles for CMYK cannot be specified with the Windows PCL printer driver.

This function is not available with the Windows XPS printer driver.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Click [Detail...] in the [Setup] tab and select [Graphic Pro], and
 then click [OK].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select the [Color] tab and select [Graphic Pro], and then click [OK].

For Mac OS X

1. Open the file to print.

2. From the [File] menu, select [Print] .

3. Select [Color] from the panel menu.

4. Select [Graphic Pro] for [Color] and then click [Print].
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Color Matching (No Color Matching)

You can print in the specified color without colors being adjusted by a printer or a printer
 driver. This function is suitable for colors matched with an application.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Click [Detail...] in the [Setup] tab and select [No Color Matching],
 and then click [OK].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select [Color] tab and select [No Color Matching], and then click
 [OK].

Memo
For the Windows XPS printer driver, follow the steps for the Windows PS printer driver and select
 [Color Mode] in the [Color] tab, and then select [Disabled] for [Color Matching].

For Mac OS X

1. Open the file to print.

2. From the [File] menu, select [Print].

3. Select [Color] from the panel menu.
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4. Select [No Color Matching] for [Color] and then click [Print].
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Simulating Printing Results for Ink

You can simulate output such as that of an offset printing press by adjusting the CMYK color
 data.

Note
Windows XPS printer driver cannot be used for this function.

Mac OS X PS printer driver may not be available depending applications.

This function can be used when the [Office Color] or [Graphic Pro] is selected for [Color
 Mode].

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Click [Detail...] in the [Setup] tab and select [Graphic Pro].

5. Select [Printer Simulation].

6. Select an ink feature you want to simulate from [Simulation Target
 Profile] on [Input Profile] and click [OK].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select the [Color] tab and select [Graphic Pro], and then click
 [Detail].
You can do a printer simulation with [Office Color], for business or other documents,
 then click [Advanced], and select the properties of the ink you want to simulate from
 [CMYK Ink Simulation].
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5. Select the [Printer Simulation] check box.

6. Select an ink feature you want to simulate from [Simulation Target
 Profile] on [Input] and click [OK].

For Mac OS X

1. Open the file to print.

2. From the [File] menu, select [Print].

3. Select [Color] from the panel menu.

4. Select [Graphic Pro].

5. Click [Options] to select [Printer Simulation].

6. Select an ink feature you want to simulate from [Simulation Target
 Profile].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If no print options but two menu options are displayed in the print dialog box for
 Mac OS X 10.6.8, click the disclosure triangle next to the [Printer] drop-down list.
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Color Separation

You can print by separating each color without using any applications.

Note
Windows PCL/XPS printer driver cannot be used for this function.

If you are using Adobe Illustrator, use the color separation function of the application. Turn
 off the color matching function of the printer driver.

For Windows PS Drivers

For Mac OS X

For Windows PS Drivers

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select the [Color] tab and select [Advanced].

5. Select the color you want to separate from [Print Color
 Separations] and then click [OK].

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the [Print Options] panel.

4. Select [Print Color Separations] in the [Quality 2] tab and click
 [Print].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.
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Correcting Color Registration Error Manually

The machine automatically adjusts color registration when the machine turns on or the
 output trays are opened/closed. You can manually adjust color registration from the
 operation panel if necessary.

1. Press [Device Setting].

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Print Setup].

5. Press [Color Menu].

6. Press [Adjust Registration].

7. Press [Yes].
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Correcting Density Manually

This machine automatically adjusts color registration when an image dram cartridge is
 replaced or when 500 sheets are printed. You can manually adjust color registration from
 the operation panel if necessary.

1. Press [Device Setting].

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Print Setup].

5. Press [Color Menu].

6. Press [Adjust Density].

7. Press [Yes].
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Make Minor Adjustment for Color Registration

Misalignment between black and cyan, magenta, or yellow is called color registration error.

This machine automatically corrects color registration errors on a regular basis. In some
 conditions, color registration error may be conspicuous. For color registration errors in the
 feeding direction, you can perform finer adjustment manually. Adjust the conspicuous parts
 from the actual print result.

This section describes how to finely adjust color registration for cyan. To adjust other colors,
 perform in the same procedure.

1. Press [Device Settings].

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Print Setup].

5. Press [Color Menu].

6. Press [CMY Reg Fine Adj].

7. Press [Cyan Reg Fine Adj].

8. Select value, and then press [Yes].

Memo
If the color misaligns upward to the feeding direction, select +1 to +3, if the color
 misaligns downward, select -1 to -3.

9. Press the  (HOME) button.

10. Start printing.
If the color registration error is still conspicuous, repeat the steps above.
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Adjusting Color Balance (Density)

When you adjust the shade to suit your preferences, operate from the operator panel.

To specify, darken or lighten pale part (Highlight), middle tone part (Mid-tone), and dark
 part (Dark) of each color.

This section describes how to adjust for cyan. When adjusting other colors, perform the
 same procedure to all colors and parts you want to adjust.

1. Press [Device Setting].

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Print Setup].

5. Press [Color Menu].

6. Press [Color Tuning/Print Pattern] and [Yes] to print color
 adjustment pattern.

7. Press [Cyan Tuning].

8. The sliders for Highlight, Mid-Tone, and Dark are displayed. Select
 the values, and then press [OK].

Memo
To darken a little, select +1 to +3, to lighten a little, select -1 to -3.

9. Press the  (HOME) button.

10. Start printing.
Repeat the procedure until the color shade meets your preferences.
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Adjusting Color with Software

Adjusting Color with PS Gamma Adjuster Utility
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For a Better Finish

Enhancing Photos

Printing with a Specified Resolution

Emphasizing Fine Lines

Specifying the Font to Use

Changing Black Finish

Eliminating White Gap Between Text and Background (Overprinting Black)
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Enhancing Photos

You can print photographs more vividly.

Note
This function is not available with the Windows PS/XPS printer drivers or on Mac OS X.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences] or [Properties].

4. Select the [Job Options] tab.

5. Select the [Photo Enhance] check box.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.
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Printing with a Specified Resolution

For Windows Printer Driver

For Mac OS X

You can change the print quality if necessary.

Memo
If printing on large-size paper with the Windows PS printer driver or Mac OS X PS printer driver,
 using [Normal (600x600)] may improve the print quality.

For Windows Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select a print quality level from [Quality].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the [Print Options] panel.

4. Select a desired value from [Quality] in the [Quality 1] tab.

5. Change other settings if necessary, and then click [Print].
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Emphasizing Fine Lines

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

When [Adjust ultra fine lines] on the printer driver is turned on, you can prevent blurry
 small letters or fine lines.

Bar code gaps or other gaps may narrow depending on the application. In such a case, turn
 this function off.

Note
This function is not available with the Windows XPS printer driver.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Click [Advanced].

6. Select [Adjust ultra fine lines] and select [On] for [Settings], and
 then click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.
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5. Click [Advanced].

6. Check the [Adjust ultra fine lines] check box, and then click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Quality1] from tabs.

4. Check the [Adjust ultra fine lines] check box in the [Quality 1] tab.

5. Change other settings if necessary, and then click [Print].
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Specifying the Font to Use

Print Using the Printer Fonts

Print Using the Fonts of Computer

Print Using the Printer Fonts

Note
The printer fonts do not exactly duplicate the appearance of the TrueType fonts displayed on
 the screen.

This function is not available with the Windows XPS printer driver or Mac OS X PS printer
 driver.

This function may not be available for some applications.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Extend] tab.

5. Click [Fonts].

6. Select the [Font Substitution] check box in [TrueType Font Output
 Type].

7. Specify the printer font to use instead of TrueType fonts in [Font
 Substitution Table].

8. Click [OK].

9. Change other settings if necessary, and then click [OK].

10. Click [Print] on the [Print] screen.

For Windows PS Printer Driver

1. Right-click the OKI MC873 icon and then select [Printer properties]
 > [OKI MC873(PS)].
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2. Double-click [Font Substitution Table] on the [Device Settings] tab.

3. Click a TrueType font, and then select a printer font to be used to
 substitute the TrueType font from the list.

4. Click [OK].

5. Open a file to print from a computer.

6. Select [Print] from the [File] menu.

7. Click [Preferences].

8. Click [Advanced] on the [Layout] tab.

9. Click [TrueType Font], and then select [Substitute with Device
 Font].

10. Click [OK].

11. Change other settings if necessary, and then click [OK].

12. Click [Print] on the [Print] screen.

Print Using the Fonts of Computer

You can print your documents by using TrueType fonts in a computer to reproduce the same
 font appearance as on the screen.

Note
This function is not available with the Windows XPS printer driver or on Mac OS X.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Extend] tab.

5. Click [Fonts].

6. Clear the [Font Substitution] check box in [TrueType Font Output
 Type], select one of the following output formats, and then click

371



 [OK].
Download as outline font

Creates font images in the printer.

Download as bitmap font

Creates font images using the printer drivers.

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Click [Advanced] on the [Layout] tab.

5. Click [TrueType Font], and then select [Download as Softfont].

6. Click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.
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Changing Black Finish

You can change the black finish when printing in color. The black finish setting can be used
 when [Office Color] or [Graphic Pro] is selected in the printer driver.

There are two types of black finish: composite black (made from CMYK toner) and true black
 (made from black toner only).

There are two types of black finishes; one is composed of cyan (C), magenta (M), yellow (Y)
 and black (K) toners, and the other is composed of a black (K) toner only. A black finish
 using CMYK toners is suitable for printing photographs. A black finish using a black toner
 only is suitable for printing black text or graphics.

If you use the [Office Color] function, you can also select the auto. If Automatic is selected,
 the suitable method is selected automatically to print out the document.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Click [Detail...] in the [Setup] tab, select [Office Color] or [Graphic
 Pro], and then click [Detail].

5. Select the method to create black from [Black Finish].

6. Click [OK] to close the Details window.

7. Click on [OK].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select [Color] tab and select [Office Color] or [Graphic Pro] and
 then click [Detail].
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5. Select the method to create black from [Black Finish].

6. Click [OK] to close the Details window.

7. Click on [OK].

Memo
For the Windows XPS printer driver, follow the steps for the Windows PS printer driver and select
 [Color Mode] in the [Color] tab, and then select the method to create black from [Black Finish].

For Mac OS X

1. Open the file to print.

2. From the [File] menu, select [Print].

3. Select [Color] from the panel menu.

4. Select [Office Color] or [Graphic Pro] and then click [Options].

5. Select the method to create black from [Black Finish].

6. Click on [OK].

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If no print options but two menu options are displayed in the print dialog box for
 Mac OS X 10.6.8, click the disclosure triangle next to the [Printer] drop-down list.
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Eliminating White Gap Between Text and Background
 (Overprinting Black)

Depending on the conditions of use, you can set black to overprint and reduce the white gap
 between black letters and colored background.

Note
This function cannot be used with some applications.

This function can be used when printing only text over a background color.

If the toner layer is thick, the toner may not be fixed firmly.

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. On the [Job Options] tab, Select [Advanced].

5. Set [Overprint Black] to [On].

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click on [Preferences] or [Properties].

4. Select the [Color] tab and select [Advanced].

5. Select the [Black Overprint] check box.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PS printer driver and select
 [Advanced] in the [Job Options] tab, and then select the [Overprint Black] check box.
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For Mac OS X

1. Open the file to print.

2. From the [File] menu, select [Print].

3. Select the [Print Options] panel.

4. Select the [Black Overprint] check box in the [Quality 1] tab.

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.
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Useful Functions

Collating a Multiple Page Document in Units of Copies

Printing from the Last Page of a Document

Alternating Output Orientation by a Copy

Selecting a Tray Automatically for the Specified Paper

Switching to Another Paper Feed Tray Automatically When a Tray Runs Out Of Paper

Selecting Output Tray

Changing the Default Settings with a Printer Driver

Saving Frequently-Used Settings in the Printer Driver to Use

Storing Print Data in This Machine before Printing

Printing without Opening a PDF File (PDF Print Direct)

Printing Data in USB Memory
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Collating a Multiple Page Document in Units of Copies

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

You can print a multiple page document in units of copies.

Note
This function may not be available for some applications.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select the number of print copies from [Copies], and then select
 the [Collate] check box.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and set
 [Copies] and [Collate] in the [Job Options] tab.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Enter the number of print copies in [Copies], and then select the
 [Collate] check box on the [Job Options] tab.
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5. Change other settings if necessary, and then click [OK].

6. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Enter the number of copies in [Copies]. Deselect the [Collate
 pages] check box in the [Paper Handling] tab.

4. Select [Print Options] on the panel menu, and then click [Collate]
 check box in the [Paper] tab.

Memo
Printing is performed without using the printer's Memory when [Paper Handling] is selected
 on the panel menu and the [Collate pages] check box is selected.

5. Change other settings if necessary, and then click [Print].
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Printing from the Last Page of a Document

For Windows PS Printer Driver

For Mac OS X

You can print in forward or reverse page order to suit your needs.

When using the upper output tray, print in the forward page order to stack printouts in
 forward page order.

When using the rear output tray, print in the reverse page order to stack printouts in
 forward page order.

Note
If the rear output tray is not open, printouts are output to the upper output tray.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Front to Back] or [Back to Front] from [Page Order] on the
 [Layout] tab.

5. Change other settings if necessary, and then click [OK].

6. Click [Print] on the [Print] screen.

Memo
If [Page Order] is not displayed, select [Start] > [Devices and Printers], right-click the OKI
 MC873 icon, select [Printer properties] > [OKI MC873(PS)] > the [Advanced] tab, and the select
 the [Enable advanced printing features] check box.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Reverse] for [Page Order] on the [Paper Handling] panel.
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4. Change other settings if necessary, and then click [Print].
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Alternating Output Orientation by a Copy

You can alternate the output orientation by a set of printouts.

Printouts are output alternately in portrait or landscape orientation so that you can easily
 handle multiple sets of printouts.

Memo
Be sure to load paper in the portrait and landscape orientations in the paper feed trays in
 advance.

Available paper sizes:

A4, A5, B5, Letter, 16K (184 x 260 mm), 16K (195 x 270 mm), 16K (197 x 273 mm)

For Windows Printer Driver

For Mac OS X

For Windows Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preference].

4. For PCL printer driver, select the [Job Options] tab,for PS/XPS
 printer driver, select the [Job Options] tab.

5. Enter the number of print copies in [Copies], and then select the
 [Collate] check box.

6. Select the [Rotate Sort] check box.

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Enter the number of copies in [Copies].

4. Select [Collate pages] on the [Paper Handling] panel.

5. Select the [Print Options] panel, select [Collate] and [Page Rotate]
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 in the [Paper] tab.

6. Change other settings if necessary, and then click [Print].
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Selecting a Tray Automatically for the Specified Paper

Setting the MP Tray

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

You can automatically select a tray (paper cassette (Tray 1/2/3 or Tray 4)) or the MP tray
 that holds paper of the same size that is set with the printer driver. Trays switch in
 accordance with the [Tray Sequence] setting.

Memo
Be sure to set the paper size and weight for paper cassettes and the MP tray on the display
 screen.

Loading Paper

Setting the MP Tray

Set the MP tray as a target of the auto tray selection.

1. Press [Device Settings] on the home screen.

2. Press [Paper Setup].

3. Press [MP Tray].

4. Press [MP Tray Usage].

5. Press [Normal Tray].

Memo
[MP Tray Usage] is set to [Do Not Use] by factory default.

6. Press [Back] until the home screen is displayed.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].
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4. Select [Auto] from [Source] on the [Setup] tab.

5. Change other settings if necessary, and then click [OK].

6. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Auto] from [Source] in the [Setup] tab.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select [Automatically Select] from [Paper Source] on the
 [Paper/Quality] tab.

5. Click [OK].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Auto Select] from [All Pages From] on the [Paper Feed]
 panel.

4. Change other settings if necessary, and then click [Print].
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Switching to Another Paper Feed Tray Automatically
 When a Tray Runs Out Of Paper

Setting Trays for the Auto Tray Switching

For Windows PCL Printer Driver

For Windows PS Printer Driver

For Mac OS X

When the specified tray runs out of paper, the machine can continue to print from another
 tray if paper of the same paper size and weight is loaded in the paper cassettes (Tray 1/2/3
 and Tray 4) and the MP tray.

To use this function, enable the auto tray switching function on the touch panel first. Then,
 set the auto tray switching function with the printer driver.

Note
Be sure to set the same values (paper size, media type, media weight) for each tray used for the
 auto tray switch function. Available paper sizes vary depending on the tray.

Loading Paper

Setting Trays for the Auto Tray Switching

1. Press [Device Settings] on the home screen.

2. Press [Paper Setup].

3. Check that [Auto Tray Switch] is set to [ON].

Memo
Pressing [Auto Tray Switch] switches between [ON] and [OFF].

Trays switch in accordance with the [Tray Sequence] setting.

4. Press [Back] until the home screen is displayed.
Next, set printing settings from a printer driver.

For Windows PCL Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].
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4. Click [Paper Feed Options] on the [Setup] tab.

5. Select the [Auto Tray Change] check box, and then click [OK].

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Tray Change] from [Paper Feed Options] in the [Setup] tab.

For Windows PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Click [Advanced] on the [Layout] tab.

5. Click [Tray Switch] and then select [ON].

6. Click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Print Options] from the panel menu.

4. Check the [Tray Switch] check box in the [Feed] tab.

5. Change other settings if necessary, and then click [Print].
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Selecting Output Tray

You can select the tray to output printouts.

For Windows Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. If you use the MC873 Series, select the desired tray from [Output
 Tray].

6. Click [Print] on the [Print] screen.

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the [Print Options] panel.

Memo
If setting details are not displayed in the print dialog box for Mac OS X 10.7 to 10.10,
 click [Show Details] at the bottom of the dialog box.

If the print option is not displayed in the print dialog box for Mac OS X 10.6.8, click the
 disclosure triangle next to the [Printer] drop-down list.

4. If you use the MC 873 Series, select the desired tray from [Output
 Bin] in the [Paper] tab.

5. Click [Print].
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Changing the Default Settings with a Printer Driver

For Windows Printer Driver

For Mac OS X

You can use frequently-used printing settings as the printer driver's default settings.

For Windows Printer Driver

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 Preferences] > [OKI MC873(*)].
* Select a driver type to use.

3. Set the printing settings to use as the driver's default settings.

4. Click [OK].

For Mac OS X

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select [Show Presets] from [Presets].

4. Clear the [Reset Presets Menu to "Default Settings" After Printing]
 check box.

5. Click [OK].

6. Select a preset that is used as the driver's default settings from
 [Presets].

7. Click [Print].
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Saving Frequently-Used Settings in the Printer Driver to
 Use

Registering Frequently-used Settings

Printing with Registered Settings

Registering Frequently-used Settings

You can save the printer driver settings.

Note
This function is not available with the Windows PS printer driver.

Memo
You can save up to 14 settings.

Registering the Windows PCL Driver Settings

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 preferences] > [OKI MC873(*)].
* Select a driver type to use.

3. Set the printing settings to save.

4. Click [Save] in [Driver Setting] on the [Setup] tab.

5. Enter a name to save the settings, and then click [OK].
If you select the [Include media settings] check box, the paper setting on the [Setup]
 tab is also saved.

6. Click [OK] to close the print setup dialog box.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select [Save] from [Driver Settings] in the [Setup] tab.

Registering the Mac OS X PS Printer Driver Settings

Note

391



The default settings on the [Page Setup] dialog box cannot be changed.

The operation of the settings that are saved with a different printer driver cannot be
 guaranteed. Save the settings with a name that you can distinguish.

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Set the printing settings to save.

4. Select [Save Current Settings as Preset] from [Presets].

5. Enter a name to save the settings, and then click [OK].

Printing with Registered Settings

Note
This function is not available with the Windows PS printer driver.

For Windows PCL Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select a setting to use from [Driver Setting] on the [Setup] tab.

5. Click [OK].

6. Click [Print] on the [Print] screen.

Memo
For the Windows XPS printer driver, follow the steps for the Windows PCL printer driver and
 select the setting you use from [Driver Settings] in the [Setup] tab.

For Mac OS X PS Printer Driver

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select a setting to use from [Presets].
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4. Click [Print].
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Storing Print Data in This Machine before Printing

For Windows PCL Printer Driver

For Windows PS Printer Driver

You can spool print jobs to the Memory that is integrated in this machine. This allows you to
 finish your work on your computer early, which makes it possible for your computer to
 process other tasks while this machine is operating in the background.

Note
If you cannot store the spooled data due to insufficient free space in the internal Memory of
 this machine, a message is displayed to inform you that the file system is full, and the print
 job is not executed.

This function is not available with the Windows XPS printer driver or on Mac OS X.

For Windows PCL Printer Driver

1. Open the file to open.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Click [Advanced].

6. Select [Job Spool], and select [On] for [Settings], and then click
 [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.

For Windows PS Printer Driver

1. Open the file to open.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.
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5. Click [Advanced].

6. Check the [Job Spool] check box, and then click [OK].

7. Change other settings if necessary, and then click [OK].

8. Click [Print] on the [Print] screen.
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Printing without Opening a PDF File (PDF Print Direct)

For Windows

For Mac OS X

You can send a PDF file to this machine to directly print it. With PDF Print Direct, you can
 omit opening the PDF file with an application, such as Adobe Reader.

Note
The paper size depends on the [PDF Paper Size] setting from [Device Settings] > [Admin Setup]
 > [Print Setup] > [PS Setup].

Memo
For Windows, install PDF Print Direct beforehand.

List of Utility Software

For Windows

1. Check that the OKI MC873(*) icon is in the [Devices and Printers]
 folder.
* Select a driver type to use.

2. Right-click a PDF file to print, and then select [PDF Print Direct].

3. Select a printer to use.
To set the user authentication function with the selected printer driver, select [User
 Auth] from the [Printer Setting] menu.

4. To print an encrypted file, select the [Setting Password] check box,
 and then enter the password.
If the same password is to be used again, click [Save Password].

5. Change other settings if necessary, and then click [Print].

For Mac OS X

1. Select [Print & Scan] in [System Preferences].

2. Check that the OKI MC873(*) icon is listed.
* Select a driver type to use.

3. Drag the icon of the driver to the desktop or Dock.
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4. Drag the file you want to print to the driver icon.
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Printing Data in USB Memory

Printing Data in USB Memory

Cancelling a Print Job

Specifying the Paper Feed Tray (Paper Feed Tray)

Printing on Both Sides of Paper (Duplex Printing)

Printing to Fit the Paper Size (Fitting)

Switching Output Trays (Only For MC873 Series)

Specifying the Number of Copies (Number of Copies)

Printing with Specified Color Mode

Note
Not all USB Memory is guaranteed to use. (USB Memory with security functions are not
 supported.)

USB hubs and external USB HDDs are not supported.

Encrypted PDF files are not supported.

Memo
The following file systems are supported: FAT12, FAT16, FAT32.

Supported file formats: PDF(v1.7), JPEG, PDF, TIFF(v6 baseline), XPS, PRN (PS, PCL, XPS)

Up to 32 GB USB Memory is supported.

Up to 100 files in supported file formats that are saved in USB Memory are displayed in the
 file list.

If 100 or more files are saved in USB Memory, the file list is not displayed properly.

USB Memory with a directory structure of 20 or more levels may not be read properly.

A file path exceeding 240 characters may not be read correctly.

You can print one file in USB Memory at a time.

Printing Data in USB Memory

1. Insert USB Memory into the USB port.
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2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].

4. Press [Select Print File].

5. Select the folder that has the file you want to print.

6. Set printing settings if necessary.

7. Press the  (START) button.

8. When a message is displayed to inform you that you can remove
 USB Memory from the port, remove it.

Cancelling a Print Job

You can cancel a print job from USB Memory by pressing the  (STOP) button.

You can cancel a print job until a message is displayed to inform you that printing is
 complete.

Note
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The pages that are ready to be printed on this machine will be printed without changes.

1. Press the  (STOP) button.
Printing is cancelled and the screen returns to the print start screen.

Specifying the Paper Feed Tray (Paper Feed Tray)

Note
When printing a PRN file, the paper tray specification follows the driver settings at the time of file
 creation.

1. Insert USB Memory into the USB port.

2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].

4. Press [Select Print File].
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5. Select the folder that has the file you want to print.

6. Select a paper tray.

Memo
[Tray 2]/[Tray 3]/[Tray 4] is displayed if the optional second tray unit is installed.

7. Press the  (START) button.

Printing on Both Sides of Paper (Duplex Printing)

You can select 1-sided (simplex) or 2-sided (duplex) printing. When performing duplex
 printing, you can select a binding position.

Note
When printing a PRN file, the duplex printing settings follow the driver settings at the time of file
 creation.

About long edge binding and short edge binding

Copying on Both Sides of Paper (Duplex Copy)

1. Insert USB Memory into the USB port.
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2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].

4. Press [Select Print File].

5. Select the folder that has the file you want to print.

6. Press [Long Edge Bind] or [Short Edge Bind].
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Memo
Setting [Duplex] to [OFF] is for simplex printing.

Copying on Both Sides of Paper (Duplex Copy)

7. Press the  (START) button.

Printing to Fit the Paper Size (Fitting)

If the page size of a file to print is larger or smaller than the valid printing area, the page
 size is automatically adjusted to fit the paper size.

Note
When printing a PRN file, this setting does not work.

Memo
This function is set to [ON] by the factory default setting.

1. Insert USB Memory into the USB port.

2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].
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4. Press [Select Print File].

5. Select the folder that has the file you want to print.

6. Press [Fit] to select [ON] for fitting.

Memo
Set [Fit] to [OFF] when you do not need to fit page.

7. Press the  (START) button.

Switching Output Trays (Only For MC873 Series)

Switches output trays.
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Note
Check that the rear output tray on the rear side of the machine is closed.

If the rear output tray is open, paper is always output to the rear output tray.

For a PRN file, the output tray setting depends on the driver setting when the file is created.

1. Insert USB Memory into the USB port.

2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].

4. Press [Select Print File].

5. Select the folder that has the file you want to print.
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6. Select the output tray.

7. Press the  (START) button.

Specifying the Number of Copies (Number of Copies)

1. Insert USB Memory into the USB port.

2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].

4. Press [Select Print File].
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5. Select the folder that has the file you want to print.

6. Enter the number of copies.

Memo
You can enter the number of copies from 1 to 999.

If you enter an incorrect value, press the  (CLEAR) button, and then enter the correct
 value. If you press the  (CLEAR) button, the value returns to the original setting
 value.

7. Press the  (START) button.

Printing with Specified Color Mode

You can select color or monochrome when printing.

Note
This setting in not available when printing a PRN file.

1. Insert USB Memory into the USB port.
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2. Press [Print] or the  (PRINT) button.

3. Press [Print From USB Memory].

4. Press [Select Print File].

5. Select the folder that has the file you want to print.

6. Press [Color Mode].

7. Select [Color] or [Mono].

8. Press  (START).
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Printing Confidential Document

Setting a Password to the Print Data (Authentication Print)

Setting a Password and Encrypting the Print Data (Encrypted Authentication Print)

Encrypting Printing Data and Requiring User Authentication before Printing (ID Secure Job)

410



Setting a Password to the Print Data (Authentication
 Print)

For Windows PCL Printer Driver

For Windows PS Printer Driver

Note
If you cannot store the spooled data due to insufficient free space in the Memory, a message
 is displayed to inform you that the file system is full, and the print job is not executed.

This function is not available with the Windows XPS printer driver or on Mac OS X.

For Windows PCL Printer Driver

1. Open the file to open.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select [Secure Print] from [Job Type].

6. Enter a job name in [Job Name] and a password in [Job Password].
If you select the [Request Job Name for each printer job] check box, a prompt is
 displayed to ask the job name when you send the print job to this machine.

7. Click [OK].

8. Change other settings if necessary, and then click [OK].

9. Click [Print] on the [Print] screen.

10. Press [Print] or the  (PRINT) button from the operator panel.

11. Press [Stored Job].

12. When printing, enter the password that you set on the computer,
 and then press [OK].

13. Press [Print].

Note
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If you forget your password that is set to a job and do not print the job sent to this
 machine, the job remains in the internal Memory.

For Windows PS Printer Driver

1. Open the file to open.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select [Secure Print] from [Job Type].

6. Enter a job name in [Job Name] and a password in [Personal ID
 Number (PIN)].
If you select the [Request Job Name for each printer job] check box, a prompt is
 displayed to ask the job name when you send the print job to this machine.

7. Click [OK].

8. Change other settings if necessary, and then click [OK].

9. Click [Print] on the [Print] screen.
The print job is only sent to the machine, and it is not printed yet.

Note
If you forget your password that is set to a job and do not print the job sent to this
 machine, the job remains in the internal Memory.
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Setting a Password and Encrypting the Print Data
 (Encrypted Authentication Print)

Setting the Password/Encrypting a File on a Computer (Windows PCL/PS Only)

Printing an Encrypted/Password-protected Document from This Machine

You can encrypt your documents before sending them from a computer to this machine. The
 document is unprinted and saved in an encrypted format in the internal Memory of this
 machine until you enter the registered password on the operator panel. You can prevent
 unauthorized access to confidential information.

Note
If you cannot store the spooled data due to insufficient free space in the internal Memory of
 this machine, a message is displayed to inform you that the file system is full, and the print
 job is not executed.

This function is not available with the Windows XPS printer driver or on Mac OS X.

You cannot use this function with the poster printing function and the booklet printing
 function with the Windows PCL printer driver if you share this machine via the print server.

When you use this function, clear the [Give Priority to the host release] check box.

Storing Print Data in This Machine before Printing

Setting the Password/Encrypting a File on a Computer
 (Windows PCL/PS Only)

You can encrypt a file to print. The encrypted data is saved in the Memory of this machine.
 You cannot print the data until you enter the password on the operator panel.

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select [Encrypted Secure Print].

6. Enter a password in [Password].

7. Click [OK].

8. Set other settings if necessary.
The encrypted and password-protected print job is only sent to this machine, and it is
 not printed yet.
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Memo
The print job saved in the Memory is automatically deleted if the printing is complete or
 not printed for a certain period of time. If an error occurs while sending the data or the
 job is altered after being sent, the job is automatically deleted.

Printing an Encrypted/Password-protected Document
 from This Machine

Print an encrypted and password-protected print job saved in the internal Memory of this
 machine.

1. Press [Print] or the  (PRINT) button.

2. Press [Encrypted Job].

3. When printing, enter the password that you set on the computer,
 and then press [OK].

4. Press [Print].
To cancel the print job, select [Delete].

All the encrypted jobs with the same password are deleted.
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Encrypting Printing Data and Requiring User
 Authentication before Printing (ID Secure Job)

You can encrypt classified information and send it to this machine with the information of
 the user who is currently logging in the computer. The document is saved in the internal
 Memory storage of this machine and printed when you enter the same user name as the
 one entered in the computer and operate to print.

This function prevents unauthorized accesses to classified information and makes it efficient
 because you do not need to enter password for each job.

Note
To use this function, enable the access control function and log in the machine and computer
 with the same user information.

If you cannot store the spooled data due to insufficient free space in the internal Memory of
 this machine, a message is displayed to inform you that the file system is full, and the print
 job is not executed.

This function is only available with the Windows PCL printer driver.

If you share this machine via network using a print server, you cannot use this function with
 the poster printing function or the booklet printing function.

When you use this function, clear the [Give Priority to the host release] check box.

Storing Print Data in This Machine before Printing

Setting the ID Secure Job Setting on a Computer
 (Windows PCL Only)

Specify "ID Secure Job" for the job type.

Encrypted ID secure jobs are sent to the machine with the information of the user who is
 currently logging in.

The encrypted secure jobs cannot be printed unless you log in the machine using the same
 user information as that you used on the computer.

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Preferences].

4. Select the [Job Options] tab.

5. Select [ID Secure Print].
If the ID secure job is unavailable, select [Start] > [Devices and Printers], right-click
 the [OKI MC873] icon, select [OKI MC873(PCL)] from [Printer properties], and then
 select [ID Secure Job] in the [Device Options] tab to enable it.

6. Click [OK].

7. Set other settings if necessary.
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The ID secured print job is sent to the machine, and printing does not start yet.

Memo
The print job saved in the Memory is automatically deleted if the printing is complete or if
 the job is not printed after a certain period of time elapses. If an error occurs while
 sending the data or the job is altered after being sent, the job is automatically deleted.

Printing Saved ID Secured Documents from This Machine

Print an ID secured job saved in the internal Memory storage of this machine.

1. Log in the machine with the user information you used on the
 computer.
You can use any types of authentications (User name/Password, PIN, IC card).

2. Press [Print] or  (Print).

3. Press [ID Secure Print].
If you log in with the administrator rights, select whether to display ID secured jobs for
 all users at first.

If you select [Yes], all ID secured jobs saved in the machine are displayed.

If you select [No], only your own ID secured jobs are displayed.

4. When ID secured jobs are listed, press [Print] for a desired job. To
 print all the displayed ID secured jobs, press [All Print].
Press [Delete] to delete selected ID secured job and press [All Delete] to delete all the
 ID secured jobs currently displayed.

When you display all the ID secured jobs with the administrator rights, you can delete
 jobs but cannot print jobs on that screen.
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Descriptions of Screens for Print

About Screens and Functions of Each Printer Driver

Names and Functions of Screen Items for Print
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About Screens and Functions of Each Printer Driver

This section describes about screens and functions of each printer driver.

Windows PCL Printer Driver

Windows XPS Printer Driver

Windows PS Printer Driver

Mac OS X PS Printer Driver
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Windows PCL Printer Driver

You can switch between the [Setup], [Job Options], and [Extend] tabs for settings.

[Setup] Tab

Item Description

1 Driver Settings Saves your settings.

2 Preview Displays a preview image of the printed result.

3 Media Specifies the paper size, type, weight, paper feed method, or other
 settings.

4 Finishing Mode Specifies the multi-page printing, booklet printing, poster printing,
 or other settings.

5 2-Sided Printing
 (Duplex)

Specifies this setting when you want to perform duplex printing.

6 Orientation Specifies the printing direction.

7 Color Setting Switches between color printing and monochrome printing.

8 Toner saving Decreases the print density to save toner.

9 About Displays the version of the printer driver.

10 Default Resets the settings on the tab to their default settings.

[Job Options] Tab

Item Description

1 Quality Specifies the resolution for printing.

2 Scale Specifies the enlargement/reduction rate for printing.

3 Copies Specifies the number of copies to print.
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4 Job Type Specifies the print type.

5 Output Tray Specifies output destination of printouts.

6 Advanced Sets other printing settings.

7 Default Resets the settings on the tab to their default settings.

[Extend] Tab

Item Description

1 Watermarks Specifies when you want to use stamp print.

2 Overlays Specifies when you want to use overlay print.

3 Fonts Specifies TrueType fonts and printer fonts.

4 User Authentication Specifies the user authentication.
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Windows PS Printer Driver

You can switch between the [Layout], [Paper/Quality], [Job Options] and [Color] tabs for
 settings.

[Layout] Tab

Item Description

1 Orientation Specifies the printing direction.

2 Print on Both
 Sides

Specifies this setting when you want to perform duplex printing.

3 Page Order Specifies a page order to print.

4 Page Format Specifies the number of pages that is printed on a sheet of paper and
 booklet printing.

5 Preview Displays a preview image of the printed result.

6 Advanced Allows you to set detailed settings for print quality and a paper size.

[Paper/Quality] Tab

Item Description

1 Tray Selection Changes the paper feed tray.
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2 Color Selects Color or Black & White.

3 Advanced Allows you to set detailed settings for print quality and a paper size.

[Job Options] Tab

Item Description

1 Quality Specifies the resolution for printing. If you set [Toner Saving], the print
 density decreases to save toner.

2 Job Type Specifies the job type and the number of copies to print. [JOB PIN] can be
 used if [Secure Print] or [Store for Re-print] is selected. If you select the
 [Collate] check box, multiple documents are printed in units of copies.

3 Output
 Tray

Specifies output destination of printouts.

4 Fit to Page If you select the [Resize document to fit printer page] check box, a document
 is printed on paper of a different size from that of the document.

5 Watermark Specifies when you want to use stamp print.

6 Overlays Specifies when you want to use overlay print.

7 Advanced Sets other print options.

8 User Auth Specifies the user authentication.

9 About Displays the version of the printer driver.

10 Default Resets the settings on the tab to their default settings.

[Color] Tab
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Item Description

1 Color Mode Specifies the color adjustment for color printing.

2 Toner Saving Saves toner when printing.

3 Advanced Sets some other printing settings.

4 Color Swatch Starts Color Swatch Utility.

5 Default Resets the settings on the tab to their default settings.
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Windows XPS Printer Driver

You can switch between the [Setup] and [Job Options] tabs for settings.

[Setup] Tab

Item Description

1 Media Specifies the paper size, type, weight, paper feed method, or other
 settings.

2 Finishing Mode Specifies the multi-page printing, booklet printing, and poster
 printing.

3 Orientation Specifies the printing direction.

4 2-Sided Printing
 (Duplex)

Specifies when you want to use 2-Sided Printing.

5 Driver Settings Saves your settings.

6 Preview Displays a preview image of the printed result.

7 About Displays the version of the printer driver.

8 Default Resets the settings on the tab to their default settings.

[Job Options] Tab
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Item Description

1 Print Quality Specifies the resolution for printing.

2 Toner Saving Decreases the print density to save toner.

3 Skip blank pages Does not print blank pages by selecting this check box.

4 Job Settings Specifies the number of copies and other settings to print.

5 Scale Specifies the enlargement/reduction rate for printing.

6 Output Tray Specifies output destination of printouts.

7 Advanced Displays the Advanced screen.

8 Watermarks Specifies when you want to use stamp print.

9 Default Resets the settings on the tab to their default settings.

[Color] Tab

Item Description

1 Color Mode Specifies the color printing method.

2 Default Resets the settings on the tab to their default settings.
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Mac OS X PS Printer Driver

You can switch between the [Layout], [Color Matching], [Paper Handling], [Paper Feed],
 [Cover Page], [Color], [Print Options], [User Authentication], [Supply Levels] panels for
 settings.

[Layout] Panel

Item Description

1 Pages per Sheet Selects the number of pages that is printed on a sheet of paper.

2 Layout Direction Specifies the layout that is applied when printing multiple pages on a
 sheet of paper.

3 Border Specifies a type of a boundary.

4 Two-Sided Specifies when performing duplex printing.

5 Reverse page
 orientation

Reverses the direction of a page to print by selecting this check box.

6 Flip horizontally Flips left and right to print by selecting this check box.

[Color Matching] Panel

Item Description

1 ColorSync Specifies the ColorSync function.

2 In printer Performs color matching with this machine.

3 Profile Specifies a profile.

[Paper Handling] Panel
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Item Description

1 Collate pages Prints in units of copies by selecting this check box.

2 Pages to Print Specifies pages to print.

3 Page Order Specifies a page order to print.

4 Scale to fit paper
 size

Prints to fit a paper size. A document may not be printed correctly
 depending on the setting.
Enlarges or reduces a document to fit the output paper size by selecting
 this check box.

5 Destination
 Paper Size

Selects the output paper size when the [Scale to fit paper size] check
 box is selected.

6 Scale down only Only reduces a document to fit the output paper size by selecting this
 check box.

[Paper Feed] Panel

Item Description

1 All Pages
 From

Specifies the paper feed tray. If you specify [Auto Select], a tray is
 automatically selected.

2 First Page
 From

Select this setting to print only the first page from the specified tray.

3 Remaining
 From

Select this setting to print the remaining pages from the specified tray.

[Cover Page] Panel
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Item Description

1 Print Cover Page Specifies the cover printing.

2 Cover Page Type Specifies a string when printing the cover.

3 Billing Info This function is not available.

[Color] Panel

Item Description

1 Grayscale Specifies to use monochrome printing.

2 Color Specifies alignment to color mode when printing in color.

[Print Options] Panel

Item Description

1 Print
 Options

Specifies alignment to the items that have been set such as print quality,
 paper type, etc.

2 Items
 Setup

Specifies the setup items conforming to the print setup tab.

[User Authentication] Panel
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Item Description

1 User Authentication Select this check box if you set user authentication when printing.

2 User Name The user name for user authentication.

3 Password The password for user authentication.

[Supply Levels] Panel

Item Description

1 Consumables Displays the remaining amount of consumables.
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Names and Functions of Screen Items for Print

This section describes the items of the screen.

Item Description

1 Stationary
 button area

Displays buttons that appear on the screen at all times.

2 Title and
 operation
 guide area

Displays the title of the current screen and provides guide for possible
 operations.

3 Main area Displays a preview of copy output that will be produced with the current
 settings.

4 [Stored Job] Prints a password-protected document stored in the machine.

5 [Encrypted
 Job]

Prints a password-protected and encrypted document stored in the machine.

ID Secure
 Print

Print encrypted documents secured based on the information saved in the
 machine. This button is not available if the access control is set to [Disable].

6 [Print From
 USB Memory]

Prints a print data stored in USB Memory directly.

7 [Google Cloud
 Print]

Prints a print data received from Google Cloud Print manually.

8 [Offline] Switches this machine offline.

9 [RESET] Returns the settings for the current print job to their default settings.

10 [Device
 Settings]

Specifies various settings such as Administrator Setting.

11 [Online] Switches this machine online.

Item Description

1 Stationary button area Displays buttons that appear on the screen at all times.
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2 Title and operation
 guide area

Displays the title of the current screen and provides guide for
 possible operations.

3 Paper Feed Specifies the tray to set the copy paper.

4 Duplex Prints on the both sides of paper.

5 Fit Prints adjusting the page size to fit the selected paper.

6 Color Mode Specifies color mode to copy a document.

7 Register to Job Macro Registers current settings to Job Macro.

8 Output Tray Specifies the output tray.

9 Select Print file Select files to print.

10 Copies Specifies the number of copies to make.

11 Reset Returns the settings for the current copy job to their default
 settings.

12 Device Settings Specifies various settings such as Administrator Setting.
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Fax

Basic Operations of Fax Functions

Sending a Fax via the Internet

Setting Scanning for Transmission

Settings for Transmission

Setting for Receptions

Performing Confidential Communication and Bulletin Board
 Communication (Fcode Communication)

Useful Functions

Sending Fax from a Computer

Sending Data to the Fax Server

Descriptions of Screens for Fax
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Basic Operations of Fax Functions

This chapter describes faxes that are sent and received by using the standard telephone
 line.

Before Sending and Receiving Faxes

Sending a Fax (Procedure)

Setting a Document

Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

Deleting a Specified Destination

Displaying a Preview Image

Cancelling a Fax Transmission

Receiving a Fax

Checking the Communication Status/Transmission and Reception History
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Before Sending and Receiving Faxes

Prepare for sending and receiving faxes.

Connecting a Telephone Line
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Sending a Fax (Procedure)

1. Press [Fax/Internet Fax] or the  (FAX) button.
The touch panel display switches to the fax/Internet fax top screen.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Specify a destination.
Specify a destination in one of the following ways.

Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

5. Change settings if necessary.

Memo
If you press the  (START) button without changing anything, the following (factory
 default) settings are applied for scanning and sending a document.

[Scan Size]: Auto

[Resolution]: Normal

[Density]: 0

You can change the default settings with [Admin Setup].

Fax Setup

When [Rotate Tx] is ON, A4  is sent as A4  and Letter  is sent as Letter 
 respectively.
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Scanning Multiple Documents Continuously on the Document Glass (Continuous
 Scan (Glass))

Scanning Multiple Documents Continuously with the ADF (Continuous Scan (ADF))

Scanning a Duplex Document (Duplex Scan)

Specifying a Scan Resolution (Resolution)

Setting Scanning for Transmission

Erasing Edge Shadows When Sending (Edge Erase)

Memo
Enable [Preview] on the [Advanced] tab to preview the image to send.

6. Press the  (START) button.
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Setting a Document

About Documents That Can be Set

Setting in the ADF

Setting on the Document Glass

This section describes how to set documents.

About Documents That Can be Set

About Where to Set a Document
Set a document in the ADF or on the document glass to copy, scan, or fax the document.

ADF

Scannable
 size

A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter , Letter ,
 Legal 13/13.5/14, Executive , Statement , Statement , Folio

Paper
 capacity

100 sheets (80 g/m2)

Paper
 weight

60 to 120 g/m2(16 to 32 lb)

Document glass

Scannable
 size

A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter , Letter ,
 Legal 13/13.5/14, Executive , Statement , Statement , Folio

Document
 thickness

Up to 20 mm

Memo
Duplex scan is not available for A5 , A6, B5 , Statement .

Note
For documents on which adhesives, ink, or correction fluid is used, make sure that they have
 completely dried before setting.

About Documents That Cannot be Set
You cannot set the following documents in the ADF. Use the document glass, instead.

Documents with holes or tears

Badly curled or rolled documents

Damp documents

Documents that are stuck together due to static electricity

Carbon-backed documents
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Cloth, metal sheets, OHP films

Stapled, clipped, or taped documents

Documents that are pasted each other, or documents with glue

Glossy documents

Coated documents

Observe the following to avoid damaging the document glass.

When copying a thick document, do not press on it on the document glass.

Place a hard document gently.

Do not set a document that has sharp protrusions.

Symbols Indicating Document Orientation
 This symbol indicates that the document is placed in the vertical orientation from

 the front of this machine.

For the ADF, place the document in such a way as to feed the long edge first.

 This symbol indicates that the document is placed in the horizontal orientation
 from the front of this machine.

For the ADF, place the document in such a way as to feed the short edge first.

When setting an A4  document in the ADF

When setting an A4  document in the ADF

Setting in the ADF
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1. Set a document face up in the ADF.

2. Align the document guide to the document width.

Note
If ADF paper feed problems often occur, reduce the number of document pages to set.

Documents of up to 100 sheets (80 gsm) and 10 mm high can be loaded regardless of
 the size.

For curled documents, make sure that the document guides fit to the document width.

Memo
The machine automatically detects the following document sizes.

Basis Detectable sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

*If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

Setting on the Document Glass

1. Open the document glass cover.

2. Set a document face down on the document glass.

Note
Do not press the document glass forcefully.
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3. Close the document glass cover gently.

Memo
The machine automatically detects the following document sizes.

Basis Detectable sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

*If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

Note
When the document is set on the document glass, the document size is detected after the
 document glass cover is closed.

Be sure to close the document glass cover.
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Specifying a Destination (Direct Entry)

You can directly enter a destination fax number by using the 10-key pad.

Memo
Specify a destination in step 4 in "Sending a Fax (Procedure)".

1. Press [Manual Dial] in the [Fax] tab.

2. Enter a destination fax number by using the 10-key pad or the 10-
key button.
You can enter up to 40 digits.

3. Press [OK].

About the Dial Function

When entering a destination fax number, you can use the following functions.

"-", "Prefix", and "Flash"
Enter each sign by pressing its sign displayed on the fax number entry screen.

- (Hyphen)

Inserts a hyphen to the entered fax number.

Prefix

Inserts a prefix number that is registered in advance. "N" is inserted when entering.

Adding a Prefix (Prefix)

Flash

Orders your PBX (Private Branch Exchange) to connect you with PSTN (Public
 Switched Telephone Network). "F" is entered when entering.

"Pause", "#"
Enter with the < # > key on the 10-key pad. Pressing the < # > key switches between
 "P" and "#".

Pause

Pauses 2 seconds when dialing. You can enter as many pauses as you want. "P" is
 inserted when entering.
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# (Pound)

Sends "#" to the telephone line if [MF(Tone)/DP(Pulse)] is set to [Tone]. "#" is
 inserted when entering.

"Tone", "*"
Enter with the < * > key on the 10-key pad. Pressing the < * > key switches between
 "T" and "*".

Tone

Switches to tone dialing if [MF(Tone)/DP(Pulse)] is set to [Pulse]. "T" is inserted when
 entering.

* (Asterisk)

Sends "*" to the telephone line if [MF(Tone)/DP(Pulse)] is set to [Tone]. "*" is
 inserted when entering.

Topics

Sending a Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)
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Specifying a Destination (Phone Book)

You can select a destination from numbers that are registered in the speed dial list or the
 group list. You must register numbers in advance.

Fax Numbers

Memo
Specify a destination in step 4 in "Sending a Fax (Procedure)".

You can enter up to 1000 destinations in the speed dial list.

You can enter up to 32 groups.

1. Press [Speed Dial] or [Group List] on the [Fax] or [Basic] tab.

2. Press a destination or group.
The check mark on the left side of the destination or group turns on. You can select
 multiple destinations.

3. When you complete the selection of all the destinations, press
 [OK].

Topics

Sending a Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)
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Specifying a Destination (One-touch Button)

You can select a fax number that is registered in the speed dial list with a one-touch button.

Memo
Specify a destination in step 4 in "Sending a Fax (Procedure)".

To select the one-touch button 09 to 40 that are assigned to one-touch buttons, press  or 
 to switch between the screens.

Topics

Sending a Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (Transmission History and Reception History)
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Specifying a Destination (Transmission History and
 Reception History)

You can select a destination from the most recent 50 records in the transmission history or
 reception history.

Note
The reception history that is displayed on the panel shows receptions with Fcode polling only.

Performing Confidential Communication and Bulletin Board Communication (Fcode
 Communication)

Memo
Specify a destination in step 4 in "Sending a Fax (Procedure)".

1. Press [Redial] on the [Fax] tab.

2. Press a destination.
The check mark on the left side of the destination turns on. You can select multiple
 destinations.

3. When you complete the selection of all the destinations, press
 [OK].

Topics

Sending a Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)
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Deleting a Specified Destination

Memo
Delete addresses specified in step 4 of "Sending a Fax (Procedure)".

1. Press [Display All] on the [Fax] tab.

2. Press [Delete] of a destination to delete.

3. When you complete the selection of all the destinations to delete,
 press [Back].

If you have deleted all the destinations, the screen automatically returns to the start
 screen.
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Displaying a Preview Image

Using the preview function, you can check the scanned image on the touch panel before
 sending fax.

Note
The image previewed on the display does not completely match the printout. Use the
 function to check the content or orientation of scanned documents.

For the real time transmission and manual transmission, preview images cannot be
 displayed.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Specify a destination.

5. Press [Preview] in the [Advanced] tab to set to [ON].

Memo
Pressing [Preview] switches [ON] and [OFF].

When sending a fax

Sending a Fax (Procedure)

When sending an Internet fax

Sending an Internet Fax (Procedure)

When sending data to the file server

Basic Procedure for Scan to Fax Server

6. Change settings if necessary.

7. Press the  (START) button.

8. Check the image to be faxed on the preview screen. Press [Start
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 Transmission] after checking.

Memo
There are three methods to display preview images.

 : Displays full page.

 : Displays across the width of the screen.

 : Displays the scanned page at the same magnification.

Press the  button to display the preview image in full screen.

Use  ,  ,  , and  to scroll the preview image.

When scanning multiple pages of documents, use the navigation button to switch
 between the pages.

 : Displays the previous page.

 : Displays the next page.

: Displays any page. Press this button and enter page number you want to
 display.

If you set the next document on the ADF or document glass and press the 
 button, the machine scans the document and displays the scanned document.

Press the  button to close the preview screen and cancel sending.
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Cancelling a Fax Transmission

Cancelling During a Transmission

Cancelling a Reserved Transmission

Cancelling During a Transmission

You can cancel a fax transmission when a message is displayed and scanning is in progress.

1. Press the  (STOP) button.

Cancelling a Reserved Transmission

You can cancel a reserved transmission job.

Note
If you select broadcast, the broadcast job is cancelled.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Press [Fax].

3. Press the [Fax Job View/Cancel] tab.

4. Press [Delete] of a job to cancel.

Memo
A fax that is being sent is displayed on the top of the list.

5. Press [Yes] on a confirmation screen.
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Receiving a Fax

This section describes how to check the received fax.

Printing Received Fax Images

Printing a Received Fax

Paper Size Priority
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Printing Received Fax Images

Available Recording Size

Rotate Printing

Paper Size Priority

Threshold

Available Recording Size

Approximately 4.2 mm from the edges cannot be printed. Therefore, received images may
 be reduced or partially cut off to print. The part that can be printed out is called the
 available recording size.

Rotate Printing

This machine automatically measures width and length of received images and select the
 appropriate paper loaded.

If the orientation of the received image differs from that of loaded paper, the image is
 automatically rotated before printing.

Paper Size Priority

Received images usually printed on the same size of paper as that of the sender's.

If the same-size paper is not loaded on this machine, alternative paper is selected in the
 following priority order.

Memo
Check the priority of the paper size.

Paper Size Priority

Threshold

Threshold means the value that determines the position to reduce or cut off to fit on page
 when the received image exceeds the effective recording size.

Memo
Change threshold.

Setting a Print Method for When a Received Image Exceeds Paper Size

Recording Size List

Document Size Rx Reduc. Rate

Auto 100%
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Standard size document

Original size
* May slightly be
 reduced.

Original size

Banner (longer
 than standard
 size)

When the excessive length
 is within the range of the
 threshold

Reduced to fit on the
 page.

Original size. The
 excess is cut off.

When the excessive length
 is larger than the threshold

Original size. The
 excess is printed on
 the next page.

Original size. The
 excess is printed on the
 next page.
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Printing a Received Fax

Selecting a Tray to Use

If You Cannot Print a Received Fax

A received fax is automatically printed. You can specify a paper tray to use.

Note
Do not pull the paper tray out during printing.

Memo
Use only plain or recycled paper.

Available paper size is as follows.

Basis Available Paper Size

AB A3, A4 , A4 , A5 , A5 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal13, Legal13.5, Legal14, Statement , Statement 

If [Device Settings] > [Admin Setup] > [Management] > [System Setup] > [Default Paper Size]
 is set to A4, see AB series. If set to Letter, see Letter series.

If a received fax is larger than a specified paper size, the fax is reduced, discarded, or
 printed onto multiple sheets of paper depending on the reception print settings.

Setting a Print Method for When a Received Image Exceeds Paper Size

Selecting a Tray to Use

1. Press [Device Settings] on the touch panel.

2. Press [Paper Setup].

3. Press [Select Tray].

4. Press [Fax].

5. Specifies a tray to use.

6. Select a setting.
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The paper tray with [ON(Prior)] set is used ahead of another tray that holds paper of
 the same size.

The MP tray is set to [OFF] by factory default.

7. Press [Back] until the home screen is displayed.

Memo
You can specify the output destination for received faxes.

Switching Output Trays

If You Cannot Print a Received Fax

Even if the machine cannot print received faxes due to a lack of paper or paper jams, the
 machine can receive data of up to 400 sheets. (However, this amount varies depending on
 the remaining Memory space or document content.) If the machine cannot print received
 faxes due to a lack of paper or paper jams, refer to the following items to solve a problem.
 If the problem is solved, printing automatically starts.

Loading Paper

If Paper Jams Occur
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Paper Size Priority

The received faxes are printed according to the paper size priority in the table below.

Document size
 on the sender's

 machine

Paper Size Priority
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Checking the Communication Status/Transmission and
 Reception History

This section describes how to check fax transmission and reception.

Checking the Communication Status

Checking the Transmission History and Reception History

Checking the Communication Status

You can check whether a fax is being sent properly when the fax transmission job is in
 progress.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Press [Fax].

3. Select the [Fax Job View/Cancel] tab.

4. Check the job content.

Checking the Transmission History and Reception History

You can check the transmission history and reception history.

Note
The reception history that is displayed on the panel shows receptions with Fcode polling only.

Performing Confidential Communication and Bulletin Board Communication (Fcode
 Communication)

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Press [Fax].

3. Press [Redial] on the [Fax] tab.

4. Select the [Tx History] tab or [Rx History] tab.

5. Check the history content.

Memo
When a fax transmission is in progress, you can check the transmission status on the [Fax Job
 View/Cancel] screen.

Checking the Transmission History
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Sending a Fax via the Internet

About the Internet Fax Function

Sending an Internet Fax (Procedure)

Receiving an Internet Fax

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

Checking, Deleting or Changing a Specified Destination

Setting Scanning for Transmission

Checking the Transmission History
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About the Internet Fax Function

The Internet Fax function allows you to send and receive faxes through an Internet line.
 When using standard faxes through a standard telephone line, charges are incurred
 depending on the distance. However, if using the Internet line, charges do not fluctuate
 regardless of the distance, allowing you to reduce more costs than standard faxes.

If you use the Internet Fax function, the fax data is converted to a TIFF file, and sent as an
 e-mail attachment file. The data is sent immediately after scanning is complete, and the
 data is not saved in the Memory of this machine. You can specify only e-mail addresses for
 the destination.

Memo
You can set the following document sizes. Any document that contains different paper sizes
 cannot be used.

Document sizes that can be set in the ADF: A3, A4 , A4 , A5 , A6 , B4, B5 ,
 Tabloid, Letter , Letter , Legal13/13.5/14, Executive , Statement , or Folio

Document sizes that can be set on the document glass: A3, A4 , A4 , A5 , A6 , B4,
 B5 , Tabloid, Letter , Letter , Legal13/13.5/14, Executive , Statement , or Folio

The document data may not be printed correctly depending on the recipient's machine.

Before using the Internet Fax function, you must set a server.

Before Using Scan To E-mail

A4  is sent as A4  and Letter  is sent as Letter  respectively.

Documents larger than A4 are automatically reduced to A4 and sent.
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Sending an Internet Fax (Procedure)

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Check that [To] is selected.
To select [Cc] or [Bcc], press [To] several times.

5. Enter a destination e-mail address.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

6. Set scan settings if necessary.

Memo
If you press  (START) without changing anything, the following (factory default) settings
 are applied for scanning and sending a document.

[Scan Size]: Auto

[Resolution]: Normal

[Density]: 0

Scanning Multiple Documents Continuously (Continuous Scan)

Adjusting the Density (Density)

Specifying a Scan Resolution (Resolution)

Setting Scanning for Transmission

Memo
To view a preview image, press [Preview] in the [Advanced] tab to set to [ON].
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7. Press  (START).
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Receiving an Internet Fax

A received Internet Fax is automatically printed.

To receive Internet Faxes, you must set the e-mail reception settings in advance.

Before Using Scan To E-mail

If you want to forward an Internet Fax, you can use the auto delivery function.

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)

Memo
You can switch output destinations for printouts of attachment files from [E-mail/I-Fax] of
 [Output Tray].

Setting Output Tray
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Specifying a Destination (Direct Entry)

Enter an e-mail address directly on the touch panel.

Memo
Specify a destination in step 5 in "Sending an Internet Fax (Procedure)".

1. Press [Manual Input].
An e-mail address can be entered by pressing [Destination (To)].

2. Enter an e-mail address.
You can enter up to 80 characters.

Entering Characters

3. Press [OK].

Topics

Sending an Internet Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)
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Specifying a Destination (Address Book/Group List)

You can select a destination from the address book or group list. You must register
 destinations in the address book or group list in advance.

Before Using Scan To E-mail

Note
If you specify a reply destination of an Internet Fax, you cannot specify a group.

Memo
Specify a destination in step 5 in "Sending an Internet Fax (Procedure)".

You can register up to 1000 destinations in the address book.

You can register up to 32 groups.

1. Press [Address Book] or [Group List] on the [Internet Fax] or
 [Basic] tab.

2. Select the transmission destination or group.
You can select multiple items.

3. When you complete the selection of all the destinations, press
 [OK].

Topics

Sending an Internet Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)
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Specifying a Destination (One-touch Button)

You can select an e-mail address that is registered to the speed dial list with a one-touch
 button.

Memo
Specify a destination in step 5 in "Sending an Internet Fax (Procedure)".

To select the speed dial numbers 09 to 40 that are assigned to one-touch buttons, press 
 or  to switch between the screens.

Topics

Sending an Internet Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)
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Specifying a Destination (Transmission History)

You can select a destination from the transmission history.

Note
The transmission history displays only sent faxes whose destinations were directly entered.

Memo
Specify a destination in step 5 in "Sending an Internet Fax (Procedure)".

1. Press [Tx History] on the [Internet Fax] or [Basic] tab.

2. Select the destination, and then press [OK].
You can select multiple items.

Topics

Sending an Internet Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (LDAP Server)
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Specifying a Destination (LDAP Server)

For Simple Search

For Advanced Search

You can search for a destination from a list on the LDAP server. There are two search
 methods, as shown below.

[Simple Search]: You can run a search with only one keyword as a user name. You can
 only search for character strings included in usernames, and not in e-mail addresses.

[Advanced Search]: You select search conditions to search for items that include all the
 specified keywords or any of the keywords. You can specify user names or e-mail
 addresses as search keywords.

Up to 100 search results are displayed.

For details on setting the LDAP server, refer to "Setting the LDAP Server".

Memo
Specify a destination in step 5 in "Sending an Internet Fax (Procedure)".

For Simple Search

1. Press [LDAP] on the [Internet Fax] or [Basic] tab.

2. Press [Simple Search].

3. Enter a keyword to search for a user name in the LDAP server.
Entering Characters

4. Press [OK].

5. When the search results are displayed, press the destination.

6. When you complete the selection of all the destinations, press
 [OK].

7. Press [Back] to return to the start screen.
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Topics

Sending an Internet Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

For Advanced Search

1. Press [LDAP] on the [Internet Fax] or [Basic] tab.

2. Press [Advanced Search].

3. Press [Search Method].

4. Select [OR] or [AND].

5. Press [User Name].

6. Enter the keyword to search for.
Entering Characters

7. Press [OK].

8. Press [E-mail Address].

9. Enter the keyword to search for.

10. Press [OK].

11. Press [OK] to start searching.

12. When the search results are displayed, press the destination.

13. When you complete the selection of all the destinations, press
 [OK].

14. Press [Back] to return to the start screen.

Topics

Sending an Internet Fax (Procedure)

Specifying a destination in other methods

Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)
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Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)
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Checking, Deleting or Changing a Specified Destination

Checking a Destination

Deleting a Destination

Changing the Destination Type

Checking a Destination

1. Press [Display all] on the [Internet Fax] tab.

2. Press and hold on the destination to check.
Press [Edit] to change the destination, if necessary.

Deleting a Destination

1. Press [Display all] on the [Internet Fax] tab.

2. Press [Delete] on the destination to delete.
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Changing the Destination Type

1. Press [Display all] on the [Internet Fax] tab.

2. Press [To] to change a destination type.
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Setting Scanning for Transmission

This section describes the scan settings for Internet Fax transmissions.

Memo
If using Scan to Fax Server, the following scan settings are not available.

Setting a reply destination

Editing an e-mail

Specifying a file name (file name)

Scanning a duplex document (duplex scan)

Scanning Multiple Documents Continuously (Continuous Scan)

Adjusting the Density (Density)

Specifying a Scan Resolution (Resolution)

Specifying a Scan Size (Scan Size)

Scanning a Document with a Colored Background Clearly (Background Removal)

Setting a Reply Destination

Editing an E-mail

Specifying a File Name (File Name)

Scanning a Duplex Document (Duplex Scan)

Specifying a File Compression Rate (Compression Rate)
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Scanning Multiple Documents Continuously (Continuous
 Scan)

You can scan a fax transmission document from the ADF and document glass. For example,
 you can send a document and a part of a book as a single fax job.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Select the [Advanced] tab.

5. Press [Continuous Scan].
[Continuous Scan] is set to [ON].

Memo
Pressing [Continuous Scan] switches between [ON] and [OFF].

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Press the  (START) button to start scanning the first document.

8. When [Please set next document] is displayed, set the next
 document.

9. Press [Start Scan].

10. Repeat steps 8 and 9 for each fax transmission document if
 necessary.

11. When scanning all sets of the documents is complete, press [Scan
 Complete].
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Adjusting the Density (Density)

You can adjust the density in seven levels.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Density] on the [Image Settings] tab.

5. Select density.

Memo
Alternatively, you can set this setting from [Function Settings].

[0] is the standard value. To increase the density, select [+1], [+2], or [+3] (darkest).
 To decrease the density, select [-1], [-2], or [-3] (lightest).

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Specifying a Scan Resolution (Resolution)

You can change a resolution to scan a document to the value to obtain the most suitable
 quality.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Resolution] on the [Image Settings] tab.

5. Select a resolution.

Memo
If you select [Photo], it takes long to scan a document.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Specifying a Scan Size (Scan Size)

You can specify the suitable size to scan a document.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Scan Size] on the [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

5. Select a size.

Memo
Both ADF and the document glass automatically detect the following document sizes.

Basis Detectable Sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

*If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

If the machine cannot detect document size with the [Scan Size] setting is set to
 [Auto], the scanning size selection screen appears when the start button is pressed.

A4  is sent as A4  and Letter  is sent as Letter  respectively.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)
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7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Scanning a Document with a Colored Background
 Clearly (Background Removal)

To adjust a level of the document background removal, you can select Auto, OFF, or
 adjustments in six levels.

If you select [Auto], the background is automatically removed in a level that suits the
 document.

Note
If a greater (brighter) value of the background removal is set, fine lines, texts or light colors
 may not be reproduced depending on the document.

In the following cases, background color may not be correctly detected and the background
 may not be eliminated successfully.

When a custom-size document is loaded

When a document with the front edge folded is loaded

When a document missing the front edge or an oblique document is loaded

When a document having a hole near the front edge is loaded

When a document is placed without aligning it with the guide on the document glass

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Background Removal] on the [Image Settings] tab.

5. Select a value.

Memo
To increase a level of the document background removal, select [4], [5], or [6]. To
 decrease a level of the document background removal, select [2], [1], or [OFF] (no
 removal).

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)
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Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Setting a Reply Destination

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Reply To] on the [Advanced] tab.

5. Enter a reply destination, and then press [OK].
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (LDAP Server)

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Editing an E-mail

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Subject] on the [Advanced] tab.

5. Press [Select Subject].

6. Select a subject.
If you select [Manual Input] in step 5, enter a subject, and then press [OK].

Memo
When directly entering, you can enter up to 80 characters.

Entering Characters

7. Press [E-mail Body] on the [Advanced] tab.

8. Press [Select Text].

9. Select a text.
If you select [Manual Input] in step 8, enter a text, and then press [OK].

Memo
When directly entering, you can enter up to 256 characters.

10. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

11. Change other settings if necessary, and then press the  (START)
 button.

Topics

Specifying a Subject

You can change other settings for fax transmissions.
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Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Specifying a File Name (File Name)

You can specify a name of a scanned data file.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [File Name] on the [Advanced] tab.

5. Enter a file name, and then press [OK].
You can enter up to 64 characters.

Entering Characters

Memo
If you do not specify a file name, the factory default setting name is used.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Scanning a Duplex Document (Duplex Scan)

You can send a duplex document with the ADF.

Note
You cannot use the document glass for this operation.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF.

3. Press [Internet Fax].

4. Press [Duplex Scan] on the [Advanced] tab.

5. Select a setting.
You can specify [Long Edge Bind] or [Short Edge Bind].

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Specifying a File Compression Rate (Compression Rate)

You can specify the appropriate compression level.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Internet Fax].

4. Press [Compression Rate] on the [Advanced] tab.

5. Select a compression rate.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Address Book/Group List)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History)

Specifying a Destination (LDAP Server)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending an Internet Fax (Procedure)
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Checking the Transmission History

You can check the transmission history.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Press [Internet Fax].

3. Press [Tx History] on the [Internet Fax] or [Basic] tab.

4. Check the transmission history.
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Setting Scanning for Transmission

Scanning a Duplex Document (Duplex Scan)

Specifying a Scan Resolution (Resolution)

Sending a Fax to Multiple Destinations at the Same Time

Specifying a Scan Size (Scan Size)

Adjusting the Density (Density)

Scanning a Document with a Colored Background Clearly (Background Removal)

Erasing Edge Shadows When Sending (Edge Erase)

Disclosing a Sender Name (Originator) to the Recipient

Changing the Sender Name That is Printed on Faxes

Printing Transmission Results Automatically (Transmit Conf. Report)

Registering the Sender Name (Originator)

Changing the Standard Originator Name

Adding a Prefix (Prefix)

Setting the Number of Redial Attempts and Redial Intervals
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Scanning a Duplex Document (Duplex Scan)

You can send a duplex document by fax with the ADF.

Note
You cannot use the document glass for this operation.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF.

3. Press [Fax].

4. Press [Duplex Scan] on the [Advanced] tab.

5. Select a setting.
You can specify [Long Edge Bind] or [Short Edge Bind].

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Specifying a Scan Resolution (Resolution)

You can select a resolution to obtain the most suitable quality.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Resolution] on the [Fax] or [Basic] tab.

Memo
Alternatively, you can set this setting on the [Basic] tab or from [Function Settings].

5. Select a resolution.

Memo
[Extra-Fine] may not be available depending on the receiver's machine.

If you select [Fine], [Extra-Fine], or [Photo], it takes long to scan a document.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Sending a Fax to Multiple Destinations at the Same
 Time

You can send a fax to multiple destinations. You can specify up to 100 destinations by using
 the 10-key pad, speed dial, or group list.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

5. Repeat step 4 to enter all the destinations.

6. Change other settings if necessary, and then press the  (START)
 button.

7. Check the destinations set from the list screen and press the 
 (START) button.

Memo
You can delete specified addresses.

Memo
To cancel operation, press [RESET] on the touch panel.

A group list is useful when you want to broadcast. Register a group list before sending a fax
 in advance.

Specifying a Destination (Phone Book)

If [Broadcast Destination] is enabled, destination numbers are displayed before sending.

Fax Setup

You can cancel a fax transmission.

Cancelling a Fax Transmission
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Specifying a Scan Size (Scan Size)

You can select the suitable size to scan a document.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Scan Size] on the [Basic] tab.

Memo
Alternatively, you can set this setting from [Function Settings].

5. Select a size.

Memo
Both ADF and the document glass automatically detect the following document sizes.

Basis Detectable Sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

*If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

If the machine cannot detect document size with the [Scan Size] setting is set to
 [Auto], the scanning size selection screen appears when the start button is pressed.

Documents in B5 or A5 are sent as documents in A4.

When [Rotate Tx] is ON, A4  is sent as A4  and Letter  is sent as Letter 
 respectively.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)
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Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Adjusting the Density (Density)

You can adjust the scan density in seven levels.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Density] on the [Advanced] tab.

5. Select density.

Memo
Alternatively, you can set this setting from [Function Settings].

[0] is the standard value. To increase the density, select [+1], [+2], or [+3] (darkest).
 To decrease the density, select [-1], [-2], or [-3] (lightest).

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Scanning a Document with a Colored Background
 Clearly (Background Removal)

To adjust a level of the document background removal, you can select Auto, OFF, or
 adjustments in six levels.

If you select [Auto], the background is automatically removed in a level that suits the
 document.

Note
If a greater (brighter) value of the background removal is set, fine lines, texts or light colors
 may not be reproduced depending on the document.

In the following cases, background color may not be correctly detected and the background
 may not be eliminated successfully.

When a custom-size document is loaded

When a document with the front edge folded is loaded

When a document missing the front edge or an oblique document is loaded

When a document having a hole near the front edge is loaded

When a document is placed without aligning it with the guide on the document glass

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Background Removal] on the [Advanced] tab.

5. Select a value.

Memo
To increase a level of the document background removal, select [4], [5], or [6]. To
 decrease a level of the document background removal, select [2], [1], or [OFF] (no
 removal).

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)
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Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Erasing Edge Shadows When Sending (Edge Erase)

A black shadow may be scanned around the edges of the scanned document. The edge
 erase function allows you to erase the black shadow.

Memo
[Edge Erase] is set to [OFF] by factory default.

The default value of the edge width to erase can be changed from [Admin Setup] > [Fax
 Setup] > [Default Settings] > [Edge Erase] > [ON] > [Width].

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Edge Erase] on the [Advanced] tab.

5. Enter a value from 2 to 50 mm (0.1 to 2.0 inches) in [Width] by
 using the 10-key pad or pressing   on the touch panel, and
 then press [OK].

Memo
If you press [Cancel], the screen returns to the previous screen without saving the
 changes.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics
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You can change other copy settings.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Disclosing a Sender Name (Originator) to the Recipient

You can set the machine so that a sender name (originator) can be printed on sent faxes.
 [TTI] is enabled by factory default, resulting in the name that you specify with [Sender ID]
 printed.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Communicating Function] on the [Advanced] tab.

5. Check that [TTI] is set to [ON].

Memo
Pressing [TTI] switches between [ON] and [OFF].

You can change the sender name (originator) to use.

Easy Setup

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

Changing the Sender Name That is Printed on Faxes

Registering the Sender Name (Originator)

You can change other settings for fax transmissions.

Setting Scanning for Transmission
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Sending a Fax (Procedure)

503



Changing the Sender Name That is Printed on Faxes

[TTI] is enabled by factory default, resulting in the name that you specify with [Sender ID]
 printed on faxes as [Standard TTI]. To use any sender name (originator) other than
 [Standard TTI], follow the procedure below.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Communicating Function] on the [Advanced] tab.

5. Press [TTI Select].
To select an originator, you must register the sender name (originator) in advance.

Registering the Sender Name (Originator)

6. Select an originator name.

7. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

8. Change other settings if necessary, and then press the  (START)
 button.

Topics

Disclosing a Sender Name (Originator) to the Recipient

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Printing Transmission Results Automatically (Transmit
 Conf. Report)

Set whether to automatically print transmission results.

Memo
To change the default value, change it from [Admin Setup] > [Fax Setup] > [Default Settings] >
 [Transmit Conf. Report].

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Communicating Function] on the [Advanced] tab.

5. Press [Transmit Confirmation].
[Transmit Conf. Report] is set to [ON].

Memo
Pressing [Transmit Conf. Report] switches between [ON] and [OFF].

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission
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Sending a Fax (Procedure)

506



Registering the Sender Name (Originator)

You can change the sender name (originator) that is printed on a sent fax. To change the
 name, you must register the originator name in advance.

Before using the following function, check that the [TTI] setting is enabled.

Disclosing a Sender Name (Originator) to the Recipient

Note
Only use alphanumeric characters for [Sender ID].

Memo
If you set [Sender ID], the name is automatically registered to [TTI 1].

Easy Setup

You can register up to three sender names (originators).

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [User Install].

5. Press  or  several times and press [TTI Register/Edit].

6. Press an originator number to register.

7. Enter a name.
You can enter up to 22 characters.

8. Press [OK].

9. Press [Back] until the home screen is displayed.

Topics

Disclosing a Sender Name (Originator) to the Recipient

Changing the Sender Name That is Printed on Faxes
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Changing the Standard Originator Name

If you have the sender (originator) name that is frequently used, it is recommended to
 specify the name as the standard originator name.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [User Install].

5. Press  or  several times and press [Standard TTI].

6. Select a sender name (originator) to use.

7. Press [Back] until the home screen is displayed.

Topics

Disclosing a Sender Name (Originator) to the Recipient

Changing the Sender Name That is Printed on Faxes
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Adding a Prefix (Prefix)

Registering a Prefix

Using a Prefix When Sending a Fax

Using a Prefix When Registering a Speed Dial Number

You can add a prefix to a destination number. You can also attach a prefix when registering
 a number to speed dial.

Registering a Prefix

You must register the prefix to [Prefix] in advance. You can enter up to 40 digits.

You can use symbols, such as "#" or "*".

Specifying a Destination (Direct Entry)

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press  or  several times and press [Prefix].

7. Enter a prefix.

8. Press [OK].

9. Press [Back] until the home screen is displayed.

Using a Prefix When Sending a Fax

You can attach a prefix only when you enter a destination number by using the 10-key pad.
 To specify a destination by using the 10-key pad, follow the procedure below.

Note
You cannot use the speed dial after entering a prefix.

Specifying a Destination (Direct Entry)
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1. Press [PreFix:N] on the destination entry screen.
The prefix is displayed as "N".

2. Enter a destination number.

3. Press [OK].

Using a Prefix When Registering a Speed Dial Number

You can add a prefix to a speed dial number.

Fax Numbers

1. Press [PreFix:N] on the fax number entry screen for speed dial
 registration.

2. Enter a fax number.
Specifying a Destination (Direct Entry)

3. Press [OK].
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Setting the Number of Redial Attempts and Redial
 Intervals

If the fax transmission fails, the machine automatically redials. If the recipient's line is busy,
 the recipient's machine does not answer, or a communication error occurs, the sender's
 machine also automatically redials. You can set the number of redial attempts and the
 intervals of redial attempts.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press [Redial Tries].

7. Enter the number of redial tries.

8. Press [OK].

9. Press [Redial Interval].

10. Enter the redial interval.

11. Press [OK].

12. Press [Back] until the home screen is displayed.

Memo
If the transmission failed a specified number of times for redial attempts, the document that is
 stored in Memory is erased and an error message is printed out.

Specifying a Destination (Transmission History and Reception History)
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Settings for Transmission

Scanning Multiple Documents Continuously on the Document Glass (Continuous Scan
 (Glass))

Scanning Multiple Documents Continuously with the ADF (Continuous Scan (ADF))

Sending at a Specified Date and Time (Delayed Tx)

Sending While a Document is being Scanned (Memory Transmission/Real time
 Transmission)

Sending a Fax after Calling (Manual Transmission)

Manual Sending (On-hook dial)

Preventing Wrong Fax Transmissions
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Scanning Multiple Documents Continuously on the
 Document Glass (Continuous Scan (Glass))

Note
For continuous scanning, the settings related to the image settings, such as resolution,
 density, and scan size, cannot be changed.

If documents of different sizes are used, part of documents may be missed when being sent.
 (Example: If an A4  document is set first and an A3 document is set for continuous
 scanning, for part of the A3 document is missed because the machine scans the center part
 of the A3 document (in the same range as A4 ).)

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document on the document glass.

3. Press [Fax].

4. Press [Continuous Scan(Glass)] on the [Advanced] tab and set it to
 [ON].

Memo
Pressing [Continuous Scan(Glass)] switches between [ON] and [OFF].

5. Select the [Fax] tab.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Press the  (START) button to start scanning the first document.

8. When [Please set next document] is displayed, set the next
 document.
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9. Press [Start Scan].

10. Repeat steps 8 and 9 for each fax transmission document if
 necessary.

11. When scanning all sets of the documents is complete, press [Scan
 Complete].

Topics

You can cancel a fax during a transmission.

Cancelling a Fax Transmission
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Scanning Multiple Documents Continuously with the
 ADF (Continuous Scan (ADF))

Note
For continuous scanning, the settings related to the image settings, such as resolution,
 density, and scan size, cannot be changed.

If documents of different sizes are used, part of documents may be missed when being sent.
 (Example: If an A4  document is set first and an A3 document is set for continuous
 scanning, for part of the A3 document is missed because the machine scans the center part
 of the A3 document (in the same range as A4 ).)

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF.

3. Press [Fax].

4. Press [Continuous Scan(ADF)] on the [Advanced] tab and set it to
 [ON].

Memo
Pressing [Continuous Scan(ADF)] switches between [ON] and [OFF].

5. Select the [Fax] tab.

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Press the  (START) button to start scanning the first document.

8. When [Please set next document] is displayed, set the next
 document.
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9. Press [Start Scan].

10. Repeat steps 8 and 9 for each fax transmission document if
 necessary.

11. When scanning all sets of the documents is complete, press [Scan
 Complete].

Topics

You can cancel a fax during a transmission.

Cancelling a Fax Transmission
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Sending at a Specified Date and Time (Delayed Tx)

You can send a fax at specified date and time. If you specify time to send a fax, the fax data
 is saved in the Memory of this machine and the fax is automatically sent at the specified
 date and time.

You can set up to 20 fax transmissions with the acceptable range of reservation up to 1
 month later.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Communicating Function] on the [Advanced] tab.

5. Press [Delayed Tx].

Memo
To change the specified reservation time, cancel it and make a new reservation.

Cancelling a Fax Transmission

You can reserve a different fax transmission even if the machine is sending a fax.

6. Specify the date and time at which to send the fax by using the 10-
key pad or by pressing  or .

Date and time are displayed in order of date, time, and minute.

7. Press [OK].

8. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

9. Change other settings if necessary, and then press the  (START)
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 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Sending While a Document is being Scanned (Memory
 Transmission/Real time Transmission)

There are two types of automatic transmissions: Memory transmission which allows you to
 start sending a fax after the document is scanned, and Real time transmission which allows
 you to send a fax while the document is being scanned.

Memory transmission

Memory transmission is a method to send a fax after the document is scanned in the
 Memory of this machine. You can take the document out without having to wait until the
 transmission is complete, saving your time.

Real time transmission

Real time transmission is a method to send a fax directly to the recipient without scanning
 the document in the Memory of this machine. The transmission starts immediately after
 you complete transmission operation, allowing you to check that the data is sent to the
 recipient.

[Memory Tx] is set by factory default.

To enable real time transmission, follow the procedure below.

Note
For the real time transmission and manual transmission, preview images cannot be
 displayed.

If using the document glass with real time transmission, only one page can be scanned.

You cannot perform an operation that uses the ADF or document glass while a fax is being
 sent with real time transmission.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Communicating Function] on the [Advanced] tab.

5. Press  or  several times and press [Memory Tx] to set it to
 [OFF].

Memo
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Pressing [Memory Tx] switches between [ON] and [OFF].

6. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

7. Change other settings if necessary, and then press the  (START)
 button.

Topics

You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Sending a Fax after Calling (Manual Transmission)

If the recipient's machine is in manual reception mode, or you want to make a call before
 sending a fax, send the fax manually.

Note
To send a fax manually, you must connect an external telephone to the machine in advance.
 Before connecting an external telephone, check how to connect the telephone to the
 machine.

Connecting a Telephone Line

When sending manually, you cannot use the following functions.

Broadcast

Delayed transmission

Fcode transmission

ID check transmission

Check broadcast destinations

Confirm dial

Memo
You do not need to disable Memory transmission.

Even if the machine displays the start screen of any function other than the fax function, you
 can perform manual transmission by picking the handset up.

1. Set a document in the ADF.

2. Pick up the handset of the external telephone connected to the
 machine.

3. Dial the destination number with the external telephone.

4. Set fax functions if necessary.

5. When you hear a beep, press the  (START) button.
Transmission starts.

6. Put the handset down.

Memo
If you put the handset back and the transmission is complete, the screen of the machine
 returns to the screen that is displayed before the manual transmission.
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Manual Sending (On-hook dial)

You can check the receiving tone from the destination machine, and then send a fax.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Off Hook] on the [Fax] tab or [Basic] tab.

5. Enter a destination fax number by using the 10-key pad on the
 operator panel.

6. After you hear the receiving tone (beep) of the destination
 machine, press the  (START) button.
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Preventing Wrong Fax Transmissions

Secure fax functions allow you to prevent wrong fax transmissions.

This machine has the following three security functions for fax transmissions.

ID Check Transmission
This function checks whether the last four digits of the dialed number match with those
 registered in the recipient's machine. If this function is enabled, the sender's machine
 sends faxes only when they match.

Memo
If the recipient's machine has no registered fax number, faxes are not sent.

ID check transmission is not available with manual transmissions.

Checking Broadcast Destinations
When the check broadcast destinations function is enabled, a fax number confirmation
 screen is displayed before transmission starts. By factory defaults, this function is
 enabled.

Memo
The check broadcast destinations function is available only if multiple destinations are
 specified.

If [Confirm Dial] is also enabled, the confirm dial function is executed first.

The check broadcast destinations function is not available with manual transmission.

Confirm Dial
If the confirm dial function is enabled, when you enter the destination number by using
 the 10-key pad, you are asked to re-enter the destination number. The fax is sent only if
 these two numbers match.

Memo
The confirm dial function is not available when you specify the destination by using a
 speed dial.

If the destination number includes symbols, re-enter the symbols as well.

If [Checking Broadcast Destination] is also enabled, the confirm dial is executed first.

The confirm dial is not available with manual transmission.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
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The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [OK].

5. Press [Fax Setup].

6. Press [Security Function].

7. Press a desired security function and set it to [ON].

526



Setting for Receptions

Setting the Reception Mode

Setting a Tray to Print Received Documents

Switching Output Trays

Setting a Print Method for When a Received Image Exceeds Paper Size

Duplex Printing

Setting So That You Can Hear Line Monitor Sound

Forwarding a Fax to Another Fax Number

Setting the Waiting Time from When an Incoming Call Arrives to When Reception Starts
 (Response Waiting Time)

Setting When to Ring the External Telephone (Tel Priority Mode)

Setting Fax Detection Mode

Setting the T/F Timer

Setting TAD Mode

Block Junk Fax

Previewing a Received Fax
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Setting the Reception Mode

Fax Ready Mode

When Receiving Calls and Faxes (Tel/Fax Ready Mode)

When Connecting an Answering Machine (Ans/Fax Ready Mode)

When Using as a Telephone Normally (Tel Ready Mode)

When Using the DRD Function (DRD)

There are five fax reception modes: [Fax Ready Mode], [Tel/Fax Ready Mode], [Ans/Fax
 Ready Mode], [Tel Ready Mode], and [DRD]. The reception operation varies depending on
 the reception mode. When you change the fax reception mode, check the reception
 behavior. In reception mode other than [Fax Ready Mode], you must connect a telephone
 to the machine. A telephone that is connected to the machine is called an external
 telephone.

When a fax reception is in progress, the sender's information is displayed on the display
 screen. Even if the reception is complete, the [DATA IN MEMORY] indicator lights as long as
 the data is saved in the Memory of this machine.

Memo
Change the reception mode in [Admin Setup] > [User Install].

User Install

If Memory overflow occurs during data reception, the reception is canceled. In such a case,
 ask the sender to send the fax again.

Fax Ready Mode

This mode is the factory default setting. If [Fax Ready Mode] is set, the machine
 automatically receives faxes.

If you use the machine only for faxes, this mode is recommended.

When Receiving Calls and Faxes (Tel/Fax Ready Mode)

If [Tel/Fax Ready Mode] is set, the machine automatically determines whether an incoming
 call is a voice call or fax, allowing you to use a telephone and fax. To receive calls, you
 must connect an external telephone to the machine in advance.

Receiving a Fax

Fax reception automatically starts.

Receiving a Call
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When receiving a call, the telephone starts ringing. Pick up the handset of the external
 telephone to answer the call. To receive a fax, press the  (START) button.

Memo
Before connecting an external telephone, check how to connect the telephone to the
 machine.

Connecting a Telephone Line

If you often receive calls, it is recommended to enable [Tel Priority Mode].

Setting When to Ring the External Telephone (Tel Priority Mode)

If the connected telephone is remotely located, you can receive faxes by dialing the remote
 switchover number. When dialing the remote switchover number, enter the next digit of the
 number within 3 seconds of dialing the previous digit.

Instructing a Fax Reception from a Telephone Remotely (Remote Switchover Number)

The external telephone may not ring properly depending on the type of your telephone.

When Connecting an Answering Machine (Ans/Fax Ready
 Mode)

If [Ans/Fax Ready Mode] is set, you can use the answering machine function of the external
 telephone and fax. Connect an external telephone with the answering machine function
 equipped in advance.

Receiving a Fax

The answering machine rings, a response message is played, and fax reception
 automatically starts.

Receiving a Call

The answering machine rings, a response message is played, and a message recording
 starts.

Memo
[Ans/Fax Ready Mode] may not work properly depending on the answering machine function
 of your external telephone or the sender's machine.

Before connecting an external telephone, check how to connect the telephone to the
 machine.

Connecting a Telephone Line

When Using as a Telephone Normally (Tel Ready Mode)

If you often use the external telephone that is connected to the machine, [Tel Ready Mode]
 is recommended.

Receiving a Call

When receiving a call, the external telephone starts ringing.

Receiving a Fax

When receiving a signal, the external telephone starts ringing. Pick up the handset of the
 external telephone, and then press the  (START) button. To resume a talk after the fax
 reception, do not hang up the handset. After the reception is complete, you can talk.
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Memo
Before connecting an external telephone, check how to connect the telephone to the machine.

Connecting a Telephone Line

When Using the DRD Function (DRD)

If you use the distinctive ring detection (DRD) function that is provided by a telephone
 company, this mode is recommended.
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Setting a Tray to Print Received Documents

A received fax is automatically printed. You can specify a paper tray to use.

Note
Do not pull the paper tray out during printing.

If the machine cannot print received faxes due to a lack of paper or paper jams, the machine can
 receive data of up to 400 sheets. (However, this amount varies depending on the remaining
 Memory space or document content.) If the machine cannot print received faxes due to a lack of
 paper or paper jams, refer to the following items to solve a problem. If the problem is solved,
 printing automatically starts.

Loading Paper

If Paper Jams Occur

Checking the Communication Status/Transmission and Reception History

1. Press [Device Settings] on the touch panel.

2. Press [Paper Setup].

3. Press [Select Tray].

4. Press [Fax].

5. Select a paper tray to set.

6. Select a setting.

The paper tray with [ON(Prior)] set is used ahead of another tray that holds paper of
 the same size.

The MP tray is set to [OFF] by factory default.

7. Press [Back] until the home screen is displayed.

Memo
Use only plain or recycled paper.

Available paper sizes are A3, A4, A5, B4, B5, Tabloid, Letter, Legal 13, Legal 13.5, Legal 14,
 Statement, Folio.

Basis Available Paper Size for Printing Received Fax
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AB A3, A4 , A4 , A5 , A5 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal 13/13.5/14, Statement , Statement 

Paper Size Priority

If a received fax is larger than a specified paper size, the fax is reduced, discarded, or
 printed onto multiple sheets of paper depending on the reception print settings.

Setting a Print Method for When a Received Image Exceeds Paper Size
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Switching Output Trays

Switches output destinations for received fax.

Note
Check that the rear output tray on the rear side of the machine is closed.

If the rear output tray is opened, paper is always output to the rear output tray.

Memo
If paper remains on the upper output tray, LED flashes.

Not to flash LED, from [Device Settings] > [Admin Setup] > [Management] > [System
 Setup], set [Output Tray Paper Exist Lamp] to [Disable].

1. Press [Device Settings] on the touch panel.

2. Press [Paper Setup].

3. Press  or  several times and press [Output Tray].

4. Press [Fax].

5. Select an output tray.

6. Press [Back] until the home screen is displayed.
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Setting a Print Method for When a Received Image
 Exceeds Paper Size

Specifying a Reduction Ratio

Specifying a Threshold Value

The excess from the specified paper is reduced or discarded, or printed on the next sheet of
 paper. For example, if the machine receives a fax that is larger than A4 with A4 paper
 specified, the excess of the image is printed on the next sheet of paper.

You can avoid such situation by specifying a reduction ratio.

Specifying a Reduction Ratio

The reduction rate determines whether or not the machine automatically reduces the
 received image to the specified paper size. [Auto] automatically reduces the image and
 [100%] prints the image without reduction. [Rx Reduc. Rate] is set to [Auto] by factory
 default.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press [Rx Reduc. Rate].

7. Select a reduction ratio.

8. Press [Back] until the home screen is displayed.

Specifying a Threshold Value
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The threshold value determines whether or not to print part of the received image on the
 next page.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press  or  several times and press [Reduc. Margin].

7. Enter a value between 0 and 100 (mm) (0.0 to 3.9 inches), and
 then press [OK].

8. Press [Back] until the home screen is displayed.

Memo
If the excess is larger than the specified reduction threshold value, the excess is printed on
 the next page.

If the excess is smaller than the specified reduction threshold value, the received image is
 reduced and printed on the next page.

If [Rx Reduc. Rate] is set to [100%] and the excess from the paper size is smaller than the
 specified threshold value, the excess is discarded.

535



Duplex Printing

Available Printing Methods

Prints received fax images on both sides of paper.

Note
Use plain paper of a standard size. Use of paper other than paper of standard sizes may cause
 paper jams.

Loading Paper

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press  or  several times and press [Duplex].

Setting [Duplex] to [OFF] is for simplex printing.

7. Select a setting.

8. Press [Back] until the home screen is displayed.

Available Printing Methods

Duplex prints with the long edge bound
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Duplex prints with the short edge bound
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Setting So That You Can Hear Line Monitor Sound

To hear the monitor sound during fax transmission and reception, set as described below.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [User Install].

5. Press  or  several times and press [Monitor Control].

6. Select a monitor control.

7. Press [Back] until the home screen is displayed.
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Forwarding a Fax to Another Fax Number

If [Forwarding Setting] is enabled, you can automatically forward received faxes to a
 specified destination as fax documents.

Note
If [Forwarding Setting] is enabled, the machine does not print received faxes.

If [Reception Mode] is set to [Tel Ready Mode], the forwarding function is disabled.

Register a forward destination by following the procedure below.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fax Setting].

6. Press [Forwarding Setting].

7. Press [ON].

8. Enter a forward destination number.

9. Press [OK].

10. Press [Back] until the home screen is displayed.
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Setting the Waiting Time from When an Incoming Call
 Arrives to When Reception Starts (Response Waiting
 Time)

Set the waiting time from when the machine receives an incoming call to when the machine
 starts the fax reception.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Select [Fax Setup].

5. Select [Other Settings].

6. Press  or  several times and press [Ring Response].

7. Select a waiting time.

8. Press [Back] until the home screen is displayed.
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Setting When to Ring the External Telephone (Tel
 Priority Mode)

Set when the external telephone and the machine ring in Tel/Fax Ready mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fax Setting].

6. Press  or  several times and press [Tel Priority Mode] and set it
 to [ON].

Memo
Pressing [Tel Priority Mode] switches between [ON] and [OFF].

[ON]: The sender is assumed to make a voice call. The telephone rings early.

[OFF]: The sender is assumed to send a fax. When the machine determines that the
 sender wants to make a voice call, the telephone rings.

7. Press [Back] until the home screen is displayed.
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Setting Fax Detection Mode

Set the machine so that it can determine whether the sender is sending a fax while the
 recipient is holding the handset of the external telephone after picking it up to answer the
 call when the telephone rings in Tel/Fax Ready mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fax Setting].

6. Press  or  several times and press [CNG Detection] and set it
 to [ON].

Memo
Pressing [CNG Detection] switches between [ON] and [OFF].

[ON]: The machine detects fax beep signals, and then automatically starts receiving
 a fax.

[OFF]: If the sender is sending a fax, the machine receives a fax with manual
 reception.

7. Press [Back] until the home screen is displayed.
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Setting the T/F Timer

Set the time before the machine starts receiving a fax automatically if an incoming call is not
 answered in Tel/Fax Ready mode or Ans/Fax Ready mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fax Setting].

6. Press  or  several times and press [T/F Timer Programming].

7. Select a T/F time.

[20 seconds]: If an incoming call is not answered within 20 seconds, the machine
 starts receiving a fax automatically.

[35 seconds]: If an incoming call is not answered within 35 seconds, the machine
 starts receiving a fax automatically.

8. Press [Back] until the home screen is displayed.
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Setting TAD Mode

Set an operation type in Ans/Fax Ready mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fax Setting].

6. Press [TAD Mode].

7. Select a type.

[Type 1]: Fax signal detection starts immediately after the answering
 machine/telephone responds. If the sender is sending a fax, the fax reception starts
 automatically.

When the answering machine finishes responding, the fax reception starts.

If there is a problem with a fax reception, using this type may improve the problem.

[Type 2]: Fax signal detection starts immediately after the answering
 machine/telephone responds. If the sender is sending a fax, the reception starts
 automatically.

Even after the answering machine finishes responding, the fax reception does not
 start.

If you usually receive calls, use this type.

[Type 3]: Fax signal detection starts in 15 seconds after the answering
 machine/telephone responds. If the sender is sending a fax, the reception starts
 automatically.

When the answering machine finishes responding, the fax reception starts.

Use this type for normal use.

8. Press [Back] until the home screen is displayed.
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Block Junk Fax

Registering (If Selecting [OFF] or [Mode1])

Registering (If Selecting [Mode2] or [Mode3])

Deleting a Registered Number

You can block unwanted faxes by setting to receive faxes only from registered speed dial
 numbers, or rejecting reception from specific registered numbers.

There are three ways to block unwanted junk faxes.

Mode Description

Mode
 1

This mode rejects the senders who are not registered in the speed dial numbers.
If the last four digits of a registered fax number match the sender ID, reception is
 allowed.

Mode
 2

This mode rejects the senders with the numbers that are registered to block junk faxes.
Register four to eight digits of a fax number.
You can enter up to 10 numbers.

Mode
 3

This mode is a combination of Mode 1 and Mode 2.
This mode rejects the senders who are not registered in the speed dial numbers.
This mode also rejects the senders who are registered to block junk faxes.

OFF Junk faxes are not blocked.

Registering (If Selecting [OFF] or [Mode1])

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press [Block Junk Fax List].

7. Press [Settings].

8. Select [OFF] or [Mode1].

Registering (If Selecting [Mode2] or [Mode3])
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Register the numbers of the senders from whom you want to block junk faxes.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Other Settings].

6. Press [Block Junk Fax List].

7. Press [Settings].

8. Select [Mode2] or [Mode3].

9. Press [Registered List].

10. Select a registered box, and then press [Register].

Memo
To change a number that has already been registered, press [Edit] for the box in which the
 number you want to change is registered.

11. Enter the last four to eight digits of the telephone number to block
 junk faxes by using the 10-key pad.

12. Press [OK].

13. Press [Close] on a confirmation screen.

14. To continue registering another number, repeat the procedure from
 step 10.

Deleting a Registered Number

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.
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4. Press [Fax Setup].

5. Press [Other Settings].

6. Press [Block Junk Fax List].

7. Press [Registered List].

8. Select a registered box, and then press [Delete].

9. Press [Yes] on a confirmation screen.
The number is deleted.

Memo
If you select [No], the number is not deleted, and you return to step 9.

10. To continue deleting another number, repeat the procedure from
 step 8.
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Previewing a Received Fax

Before printing received faxes, you can check the preview image on the touch panel.

Only faxes received after "Secure Receive" is set can be previewed.

Make sure that the [DATA IN MEMORY] indicator lights up.

Setting Secure Reception

You can print received faxes after previewing.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times, and press [Store Document Settings].

3. Press [Received Documents].

4. If the password entry screen appears, enter a 4-digit password you
 entered when setting secure receive.
The list of received faxes appears.

5. Press [Preview] for a document to print.

6. Press [Print].

7. Press [Yes] on the confirmation screen.
Printing received document starts.

8. Press [Back] until the home screen is displayed.
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Performing Confidential Communication and Bulletin
 Board Communication (Fcode Communication)

This section describes the confidential communication and bulletin board communication
 using Fcode communication.

About Fcode Communication

Registering an Fcode Box

Deleting a Registered Fcode Box

Sending a Fax to a Destination Confidential Box (Fcode Transmission)

Printing a Document That is Received in the Confidential Box of This Machine

Receiving a Document That is Saved in a Destination Bulletin Board Box by Fax (Fcode
 Polling)

Saving a Document in a Bulletin Board Box of This Machine

Deleting a Document in a Bulletin Board Box of This Machine
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About Fcode Communication

Fcode communication uses sub addresses for communication in accordance with the ITU-T
 standard. You can create and register Fcode boxes, allowing you to perform confidential
 communication and bulletin board communication.

You can register up to 20 Fcode boxes.

When registering an Fcode box, be sure to register a sub address. A sub address is used to
 identify the Fcode box.

Fcode Confidential Communication

If an Fcode confidential box is set in the recipient's machine, you can specify the sub
 address of the box, allowing you to perform confidential transmission.

To print a received document, you must enter the specified PIN number. This function is
 useful when sending or receiving a document that needs security protection.

Sending a Fax to a Destination Confidential Box (Fcode Transmission)

Printing a Document That is Received in the Confidential Box of This Machine

Fcode Bulletin Board Communication

If an Fcode bulletin board box is set in the sender's machine, you can retrieve a document
 from a bulletin box by specifying its sub address.

Receiving a Document That is Saved in a Destination Bulletin Board Box by Fax (Fcode
 Polling)

You can store documents in the bulletin board box of the machine.

Saving a Document in a Bulletin Board Box of This Machine
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Registering an Fcode Box

Registering a Confidential Box

Registering a Bulletin Board Box

To perform Fcode communication, register an Fcode box. There are two types of Fcode
 boxes: Fcode confidential boxes and Fcode bulletin board boxes. Be sure to register a sub
 address and a PIN number (Fcode confidential communication only) for each Fcode box.

Registering a Confidential Box

You can register a confidential box to the machine, allowing you to receive a fax data that
 you do not want to expose to third persons with Fcode communication.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fcode Box].

6. Press [Register] of a box number.

Memo
To edit a registered Fcode confidential box, enter the PIN number, and then select [Edit].

7. Press [Confidential Box].

8. Press the registration button of [Box Name].

9. Enter a box name.
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Memo
You can enter up to 16 characters.

10. Press [OK].

11. Press the registration button of [Sub-Address].

12. Enter a sub address.

Memo
You can enter up to 20 characters including # or *.

13. Press [OK].

14. Press the registration button of [Hold Time].

15. Enter a value between 0 and 31 (days), and then press [OK].

Memo
Set [Hold Time] if necessary.

If you set [0] (days), the document is indefinitely retained.

16. Press the registration button of [I.D. Code].

17. Enter a 4-digit PIN number, and then press [OK].

Note
The entered PIN number is not displayed. Be sure to write the PIN number down and keep
 it safe.
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18. Press [OK].

Registering a Bulletin Board Box

If you register a bulletin board box to the machine, you can have the other party retrieve a
 document that is registered in the bulletin board box any time upon transmission request
 from the other party.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fcode Box].

6. Press [Register] of a box number.

Memo
To edit a registered Fcode bulletin board box, select [Edit].

7. Press [Bulletin Box].

8. Press the registration button of [Box Name].

9. Enter a box name.
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Memo
You can enter up to 16 characters.

10. Press [OK].

11. Press the registration button of [Sub-Address].

12. Enter a sub address, and then press [OK].

Memo
You can enter up to 20 characters including # or *.

13. Press [OK].
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Deleting a Registered Fcode Box

You can delete unnecessary Fcode confidential boxes and Fcode bulletin board boxes.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Fcode Box].

6. Press [Delete] of a box number to delete.

7. Enter a PIN number if necessary, and then press [OK].

Memo
To delete a confidential box, enter the PIN number.

8. Press [Yes] on a confirmation screen.
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Sending a Fax to a Destination Confidential Box (Fcode
 Transmission)

You can perform Fcode confidential transmission by entering the sub address that is
 registered to an Fcode confidential box of the recipient's machine. Check the destination
 sub address before sending.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Press [Communicating Function] on the [Advanced] tab.

5. Press [Fcode Tx].

6. Enter the sub address of the box that is registered to the recipient's
 machine.
The sub address is up to 20 characters in length.

7. Press [OK].

8. Press [Back].

9. Add a destination on the [Fax] tab.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

10. Change other settings if necessary, and then press the  (START)
 button.
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Printing a Document That is Received in the
 Confidential Box of This Machine

When an Fcode confidential box that is set to the machine receives a document, an Fcode
 reception notice is printed. Check the Fcode box number, and then print the stored
 document.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Store Document Settings].

3. Press [Fcode Box].

4. Press [Select] of a box number.

5. Enter a PIN number, and then press [OK].

6. Press [Print] of a file number to print.

7. Press [Yes] on a confirmation screen.

Memo
Received documents in an Fcode confidential box are automatically deleted after printing.

559



Receiving a Document That is Saved in a Destination
 Bulletin Board Box by Fax (Fcode Polling)

You can perform Fcode polling communication (Fcode polling) by entering the sub address of
 an Fcode bulletin board box that is registered to the sender's machine. With this function,
 the sender's machine sends a fax in response to instructions from your machine.

Note
If a password is set to a bulletin board box of the sender's machine, your machine cannot
 receive a fax.

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Press [Fax].

3. Press [Communicating Function] on the [Advanced] tab.

4. Press [Fcode Polling].

5. Enter the sub address of the bulletin board box that is registered to
 the sender's machine.
The sub address is up to 20 characters in length.

6. Press [OK].

7. Press [Back].

8. Add a destination on the [Fax] tab.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (One-touch Button)

Specifying a Destination (Transmission History and Reception History)

9. Press  (START) button.

Memo
Documents that are received with Fcode polling are automatically printed.
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Saving a Document in a Bulletin Board Box of This
 Machine

You can store only one document in an Fcode bulletin board box of the machine. The saved
 document is overwritten by a new document. To store a document, you must register a
 bulletin board box in advance.

Registering an Fcode Box

1. Set a document in the ADF or on the document glass.

2. Press [Device Settings] on the touch panel.

3. Press  or  several times and press [Store Document Settings].

4. Press [Fcode Bulletin Board].

5. Press [Over Write] of a box number.

6. Press [Yes] on a confirmation screen.

Memo
A document that is stored in an Fcode bulletin board box is not deleted even if the recipient
 retrieves the document.
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Deleting a Document in a Bulletin Board Box of This
 Machine

You can delete a document that is saved in a bulletin board box.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Store Document Settings].

3. Press [Fcode Bulletin Board].

4. Press [Delete] of a box number.

5. Press [Yes] on a confirmation screen.

Memo
A document that is stored in an Fcode bulletin board box is not deleted even if the recipient
 retrieves the document.
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Useful Functions

Instructing a Fax Reception from a Telephone Remotely (Remote Switchover Number)

Setting Secure Reception

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)

Saving Sent and Received Data (Transmission Data Save)
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Instructing a Fax Reception from a Telephone Remotely
 (Remote Switchover Number)

If the connected telephone is remotely located, you can switch the machine to the fax
 reception operation by dialing the remote switchover number on the telephone.

If the connected telephone is not a push line, press the tone button on the telephone to
 switch to tone (push) signals before dialing the remote switchover number.

When dialing the remote switchover number, enter the next digit of the number within
 3 seconds of dialing the previous digit.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Fax Setup].

5. Select [Fax Setting].

6. Press [Remote Receive Number].

7. Select a number.

8. Press [Back] until the home screen is displayed.
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Setting Secure Reception

Setting Secure Reception

Printing an Image Stored with Secure Reception

Setting Secure Reception

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Fax Setup].

5. Press [Security Function].

6. Press [Secure Receive].

7. Press [Setting].

8. Enter a 4-digit number by using the 10-key pad, and then press
 [OK].

Note
When previewing or printing received faxes, you need to enter the password you set in this
 step. If you press [OK] without entering a password, previewing and printing can be
 performed without entering a password.

Memo
To disable the secure reception, press [Setting], and then press [OFF] in step 7.

Printing an Image Stored with Secure Reception

Print an image that is received by fax and stored in Memory.

Check that the [DATA IN MEMORY] lamp lights up.

If the lamp is off, there are no images that are received by fax and stored in Memory.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Store Document Settings].
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3. Press [Received Documents].

4. If a password has been set, enter a 4-digit password.
A list of received documents is displayed.

5. Press [Print All] to print all received documents or [Print] to print
 an individual document.

To delete all received documents, press [Delete All].

To preview received documents individually, press [Preview] for the document you
 want to preview.

To delete received documents one by one, press [delete] for each document to be
 deleted.

6. Press [Back] until the home screen is displayed.

Memo
If [Yes] is set for [Delete After Print], the received document will be deleted after it is
 printed.

If [No] is set for [Delete After Print], the received document will remain even after it is
 printed.
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Forwarding Received Document Data to an E-mail
 Destination or Shared Folder (Auto Delivery)

This section describes the auto delivery function and how to set it.

The auto delivery function automatically forwards received data to specified destinations.
 You can specify up to five e-mail addresses and one network folder as destinations.

You can use this function for received faxes, Internet Faxes, and e-mail attachment files.
 The data is forwarded as a PDF or TIFF file depending on the file format of the received
 data.

You can register up to 100 sets of forwarding destinations for the auto delivery function.

1. Open the Web page of this machine.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine" on "Basic Operations".

2. Log in as the administrator.

3. Select [Transmission Settings].

You must set a server in advance.

Setting the Reception Protocol

4. Click [New] on the [Automated Delivery Setup] page.

5. Enter a name in [Automated Delivery].
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6. Select [ON] for [Automated Delivery].

7. Select the check box of a required item for [Search field].

8. Select [OFF] for [Print].
To print the received data, select [ON].
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9. Click [Edit] in [Deliver To].

10. Enter a destination e-mail address, and then click [Add].

11. Check that the entered address is displayed in [Address List], and
 then click [OK].

12. Click [Edit] in [Deliver to].
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To specify a network folder, register a destination (profile) in advance.

Before Using Scan To Shared Folder

13. Select a destination from [Profile List], and then click [OK].

14. Click [Submit].

Memo
If [Forwarding Setting] is enabled, received faxes are not automatically delivered with this
 function.

A received fax is delivered as a PDF file.

If a received e-mail attachment file is not a PDF, JPEG, or TIFF file, the file is not forwarded.

The body text of received e-mails cannot be forwarded.
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The size of data that this function can handle is limited.

If the Memory card space of the machine is insufficient to save received faxes, Internet
 Faxes or e-mail attachment files, the transmission data is not automatically delivered.
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Saving Sent and Received Data (Transmission Data
 Save)

This section describes the transmission data save function and how to set it.

The transmission data save function automatically saves sent e-mails (Internet fax,
 FaxServer), received e-mails (Internet fax), sent faxes, and received faxes in a specified
 network folder. For sent e-mails, only attachment files are saved. You can only specify one
 network folder for each setting, but you can specify a different save destinations for sent
 data and received data respectively.

The data is saved as a PDF or TIFF file depending on the file format of the source data.

Note
The transmission data save function is not available when using the following functions.

Real time transmission

Polling transmission by using Fcode bulletin board communication

Reception by using Fcode confidential communication

Secure Receive

1. Open the Web page of this machine.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine" on "Basic Operations".

2. Log in as the administrator.

3. Select [Transmission Settings].

You must set a server in advance.

Before Using Scan To E-mail

4. Select [Transmission Settings].
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5. Select a data category to save, and then click [Edit].

6. Select [ON].

Memo
The items in the screen is depending on your selected category.

7. Click [Select Profile List].

Register a profile in advance.

Before Using Scan To Shared Folder

8. Select a data save destination from [Profile List], and then click
 [OK].

9. Click [Submit].
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Memo
Repeat steps 5 to 9 until you complete setting all the categories of data to save.

A sent or received fax is saved as a PDF file.

If a sent or received e-mail attachment file is not a PDF, JPEG, or TIFF file, the file is not
 saved.

The body text of an e-mail cannot be saved.

The size of data that this function can handle is limited.

If the Memory space of the machine is insufficient to save received and sent faxes, Internet
 Faxes or e-mail attachment files, the transmission data is not saved.
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Sending a Fax from a Computer

Sending a PC Fax

Sending a Fax from a Computer with a Cover Sheet

Sending a PC Fax to Multiple Destinations at the Same Time

Cancelling a PC Fax Transmission

Managing the PC Fax Phone Book
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Sending a PC Fax

Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

You can send a fax from a computer by using the fax driver. You can send a fax to a
 destination via this machine directly from a computer without printing a document.

Install the fax driver in advance.

Installing a Driver and Software to a Computer

Note
Do not turn the machine off when a fax is being sent from a computer to the machine.

This function is available for Windows OS only.

Memo
This section uses Notepad as an example.

1. Open a file.

2. Select [Print] from the [File] menu.

3. Select [OKI MC873(FAX)] from [Select Printer], and then click
 [Print].

4. Specify a destination.
For details, see the following:

Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

5. Click [OK].

Specifying a Destination (Direct Entry)

Memo
Specify a destination in step 4 in "Sending a PC Fax".

1. Enter a destination name in [Name] on the [Specifying numbers]
 tab in [Recipients].
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2. Enter the fax number of the destination in [FAX number].

3. Enter comments in [Comments] if necessary.

4. Click [Add<-].

5. Repeat steps 1 to 4 to enter all the destinations.

6. Click [OK].

Specifying a Destination (Phone Book)

Memo
Specify a destination in step 4 in "Sending a PC Fax".

1. Select the [Phone book] tab in [Recipients].

2. Select a destination, and then click [Add<-].

3. Repeat steps 1 and 2 to enter all the destinations.

4. Click [OK].
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Sending a Fax from a Computer with a Cover Sheet

Note
If you select [Print all recipients' information on each cover sheet] and send to multiple
 destinations at the same time (broadcasting), the cover sheet is sent to the destinations with
 the following information printed: all transmission destinations' names and fax numbers (only
 when set), and comments in the phone book (only when set). Use care when broadcasting to
 multiple outside destinations.

1. Open a file.

2. Select [Print] from the [File] menu.

3. Select [OKI MC873(FAX)] from [Select Printer].

4. Click [Preferences].

5. Select the [Cover Sheet] tab.

6. Select [Print all recipients' information on each cover sheet] or
 [Print only one recipient's information on each cover sheet].

7. Select a format to use from [Select cover sheet format].
To display an enlarged image of each format, click [Zoom].

To print the recipient's fax number on the cover sheet, select the [Add the recipient's
 FAX number] check box.

To print comments that are registered to the phone book on the cover sheet, select
 the [Add the recipient's comments] check box.

To add a custom cover sheet design, click [Custom cover sheet].

8. Enter the sender's name, fax number, and comment to print on the
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 cover sheet on the [Sender Details] dialog by clicking [Detail].

9. Click [OK].

10. Select [OKI MC873(FAX)] from [Select Printer], and then click
 [Print].

11. Specify a destination.
Sending a PC Fax

12. Click [OK].
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Sending a PC Fax to Multiple Destinations at the Same
 Time

If you use a group, you can specify multiple destinations just by performing one operation.

Managing the PC Fax Phone Book

1. Open a file.

2. Select [Print] from the [File] menu.

3. Select [OKI MC873(FAX)] from [Select Printer], and then click
 [Print].

4. Select the [Phone book] tab in [Recipients].

5. Select a group from the right field, and then click [Add<-].

6. Click [OK] to start the transmission.
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Cancelling a PC Fax Transmission

You can cancel a fax transmission from a computer while the data is being sent to the
 machine.

Note
You cannot cancel a fax transmission from a computer after the data is saved in the
 machine.

For details on how to cancel a fax transmission that is saved in the Memory of this machine,
 refer to "Cancelling a Reserved Transmission" in "Cancelling a Fax Transmission".

1. Double-click the printer icon on the tool bar.

2. Select the job to cancel in the print queue.

3. Select [Cancel] from the [Document] menu.
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Managing the PC Fax Phone Book

This section describes how to edit the phone book for PC Fax from your computer.

Registering a Destination Fax Number

Note
You cannot register the same name. You can register the same fax number with a different
 name.

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 preferences] > [OKI MC873(FAX)].

3. Click [Phone book] on the [Setup] tab.

4. Select [New (FAX number)] from the [FAX number] menu.

5. Enter a destination name in [Name] in the [New (FAX number)]
 dialog box.
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6. Enter the fax number of the destination in [FAX number].

7. Enter comments in [Comments] if necessary.

8. Click [OK].

9. Select [Save] from the [FAX number] menu.

10. Click [OK] in the confirmation window.

11. Select [Exit] from the [FAX number] menu.

Memo
You can register up to 1000 destinations.

The name and fax number that are entered by following the procedure can be printed on the
 cover sheet.

Registering Multiple Destinations as a Group

If you group registered destinations, you can send a fax to multiple destinations at the same
 time.

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
 preferences] > [OKI MC873(FAX)].

3. Click [Phone book] on the [Setup] tab.

4. Select [New (Group)] from the [FAX number] menu.
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5. Enter a group name in [Group name] in the [New (Group)] dialog
 box.

6. Enter comments in [Comments] if necessary.

7. Select the destination to register in the group, and then click [Add-
>].

Memo
Click [New (FAX number)] if necessary.

Managing the PC Fax Phone Book

8. When you complete the addition of the required fax numbers, click
 [OK].
The new group is added in the left field in the [Phone book] dialog box. If you select a
 group, the fax numbers that are registered in the group are displayed in the right field
 of the dialog box.

9. Select [Save] from the [FAX number] menu.

10. Click [OK] in the confirmation window.

11. Select [Exit] from the [FAX number] menu.

Exporting the Phone Book Data to a CSV File (Export)

The import/export function enables you to manage fax numbers in the phone book that is
 created with a different computer. If you follow the procedure below, you can export a
 phone book that is created with your computer so that the phone book can be used on a
 different computer.

Note
You cannot export any group, but you can export each entry in the phone book.

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Printing
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 preferences] > [OKI MC873(FAX)].

3. Click [Phone book] on the [Setup] tab.

4. Select [Export] from the [Tools] menu.

5. Select a save destination in the [Export to file] dialog box.

6. Enter the name of a file, and then click [Save].
The phone book data is exported as a CSV file. The entries are separated with
 commas, and displayed in order of display in the CSV file. They are saved in order of
 the names, fax numbers, and comments.

7. Close the phone book.

Importing the Phone Book Data That is Exported to a CSV
 File (Import)

The import function enables you to import fax numbers in the phone book that is created
 with a different computer into your computer.

Note
Registered entries are not imported.

Importing the Phone Book Data

1. Copy the exported phone book to a different computer.

2. Click [Start], and then select [Devices and Printers].

3. Right-click the OKI MC873 icon, and then select [Printing
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 preferences] > [OKI MC873(FAX)].

4. Click [Phone book] on the [Setup] tab.

5. Select [Import] from the [Tools] menu.

6. Specify the copied file for [Choose a CSV file] in the [Import Phone
 Book] dialog box.

7. Click [Browse] to select a file.

8. Click [Next].

Associating a New Definition with the Phone Book Format
If you want to import a CSV file with the format that is different from that of the phone
 book, select a CSV definition file and associate the definition with the phone book format.

1. Copy the exported phone book to a different computer.

2. Click [Start], and then select [Devices and Printers].

3. Right-click the OKI MC873 icon, and then select [Printing
 preferences] > [OKI MC873(FAX)].
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4. Click [Phone book] on the [Setup] tab.

5. Select [Import] from the [Tools] menu.

6. Specify the CSV file to import in [Choose a CSV file] in the [Import
 Phone Book] dialog box.

7. Select the [Setup relationship between the fields imported and
 phone book] check box.

8. Specify a CSV definition file in [Choose a CSV Definition file] if
 necessary.
Select [Comma(,)] for [Field Delimiter].

Memo
You can continue operating even if you do not specify a definition file. If you do not specify
 a definition file, select whether to save a new definition file in the dialog box that is
 displayed after step 7.

9. Click [Next].

10. Associate the definition that you are importing with the phone book
 definition, and then click [OK].

11. Select [Save] from the [FAX number] menu.

12. Click [OK] in the confirmation window.

13. Select [Exit] from the [FAX number] menu.

Topics

Managing the PC Fax Phone Book
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Sending Data to the Fax Server

Basic Procedure for Scan to Fax Server

Enabling the Scan to Fax Server Function

Editing a Destination E-mail Address

Editing E-mail Body Text
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Basic Procedure for Scan to Fax Server

This section explains the basic procedure for sending data to the fax server.

The fax server function allows you to send fax data as an e-mail attachment file. The
 scanned document is converted to a TIFF file. The data is not saved in Memory, and is sent
 immediately after scanning. You just specify an e-mail address as a destination.

You must enable the Scan to Fax Server function in Admin Setup.

Enabling the Scan to Fax Server Function

If Scan to Fax Server function is enabled, fax receptions and transmissions that use a
 telephone line are disabled.

Set a network and e-mail default setting before using the Scan to Fax Server function.

Connecting This Machine to a Network

Before Using Scan To E-mail

Memo
You can not use mixed size documents.

The document data that is sent with the Scan to Fax Server function may not be printed
 properly depending on the recipient's unit.

The details on the Scan to Fax Server function are the same as those on the Scan To E-mail
 function.

Sending Scanned Data as an E-mail Attachment

1. Press [Fax/Internet Fax] or the  (FAX) button.

2. Set a document in the ADF or on the document glass.

3. Press [Fax].

4. Specify a destination.
Specifying a Destination (Direct Entry)

Specifying a Destination (Phone Book)

Specifying a Destination (Transmission History and Reception History)

5. Change other settings if necessary.

Memo
Turn [Preview] on the [Advanced] tab to ON and press [Preview] to preview the image
 to send.

When [Rotate Tx] is set to ON, A4  documents are rotated and sent as A4 
 documents and Letter  documents are rotated and sent as Letter  documents.

6. Press the  (START) button.

Topics
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You can change other settings for fax transmissions.

Setting Scanning for Transmission

Sending a Fax (Procedure)
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Enabling the Scan to Fax Server Function

To enable the Scan to Fax Server function, follow the procedure below in Admin Setup.

Note
If the Scan to Fax Server function is enabled, the fax function is disabled.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [FaxServer Function].

5. Press [Environmental Settings].

6. Press [FaxServer Function].

7. Press [ON].

8. Press [Yes] on a confirmation screen.
The machine automatically restarts.
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Editing a Destination E-mail Address

A prefix and suffix are used in the following format. The "Fax number" in this format is a
 number that is selected in the "Add Destination" item.

"Prefix + Fax number + Suffix"

For example, if you set "FAX=" as the prefix and set "@faxserver" as the suffix and perform
 the Scan to Fax Server function, the e-mail destination (To:) is set as "FAX=012-345-
6789@faxserver".

Note
Set the prefix and suffix according to the e-mail reception specifications of the fax server. The
 virtual domain and others may be required to be set on the mail server due to the certain fax
 server operating environment.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [FaxServer Function].

5. Press [Environmental Settings].

6. Press [PreFix].

7. Enter a prefix, and then press [OK].

8. Press [Suffix].

9. Enter a suffix, and then press [OK].

10. Press [Back] until the home screen is displayed.
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Editing E-mail Body Text

If [Text] is set to [ON], the text is added to the e-mail. If your fax server supports the
 transmission of e-mail text, the text is included in the fax transmission data.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [FaxServer Function].

5. Press [Environmental Settings].

6. Press [Text].
[Text] is set to [ON].

7. Press [Back] until the home screen is displayed.

8. Press [Fax/Internet Fax] or the  (FAX) button.

9. Press [Internet Fax].

10. Press [E-mail Body] on the [Advanced] tab.

11. Press [Select Text].

12. Select a text.
If you select [Manual Input] in step 11, enter a text, and then press [OK].

Memo
When directly entering, you can enter up to 256 characters.
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Descriptions of Screens for Fax

Names and Functions of Screen Items for Fax

Names and Functions of Screen Items for Internet Fax
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Names and Functions of Screen Items for Fax

[Fax] Tab

Item Description

1 Destination
 area

Select a fax destination. The selected fax destination appears in this area.
If at least 1 destination is specified, you can press [Display all] to edit, add,
 or delete a destination.

2 Shortcut
 buttons

Displays shortcut buttons for using fax functions.
The screen image shows the factory default setting. The setting can be
 changed by Administrator Setting.

3 One touch
 buttons

Displays destinations assigned to one-touch buttons. Press a button to add a
 destination.

4 Function
 Settings

Displays the current settings.
The setting can be changed for certain functions.

5 Displays Help topics.

[Basic] Tab

Item Description

1 Manual Dial Enter a fax number manually to use it as a destination.

2 Speed Dial Displays destinations registered in the speed dial list.
Select a destination from the speed dial list.

3 Group List Displays a list of groups in which fax destinations are registered.
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Select a group as a destination from the Group List.

4 Redial Displays a list of recently used destinations.
Select a destination from the recent records.

5 Off Hook Sends a fax by Off Hook dialing.
Call the destination, and start sending a fax manually when you hear a
 receiving tone (beep) of the destination machine.

6 Resolution Specifies the resolution to scan a document.

7 Scan Size Specifies the scan size to scan a document.

8 Register to
 Job Macro

Registers current settings to Job Macro.

[Advanced] Tab

Item Description

1 Density Adjusts a level of scan density.

2 Duplex Scan Specifies duplex scanning.
Set this function when scanning both sides of a document.

3 Continuous
 Scan (Glass)

Scans multiple documents as a single job using the document glass.

4 Continuous
 Scan (ADF)

Scans multiple documents as a single job using the ADF.

5 Preview Displays fax images to send on the touch panel.

6 Edge Erase Eliminates a black shadow that may appear around the edges on the
 scanned file when scanning, for example, a book.

7 Background
 Removal

Removes background.

8 Communicating
 Function

Specifies the following settings: TTI, TTI Select, Transmit Confirmation,
 Delayed Tx, Fcode Polling, Fcode Tx.

[Fax Job View/ Cancel] Tab
Cancels a transmission or see the detail of the job that is proceeding.
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[Function Settings] > [Destination] Tab
Add, edit or delete a destination to which a fax is sent.

[Function Settings] > [Scan Setting] Tab

Item Description

1 Setting display
 area 1

Displays the current settings for displayed items.

2 Setting display
 area 2

Displays a list of settings that are not set by items displayed in setting
 display area 1.
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Names and Functions of Screen Items for Internet Fax

[Internet Fax] Tab

Item Description

1 Destination
 area

Select a fax destination. The selected fax destination appears in this area.
If at least 1 destination is specified, you can press [Display all] to edit, add,
 or delete a destination.

2 Shortcut
 buttons

Displays shortcut buttons for using fax functions.
The screen image shows the factory default setting. The setting can be
 changed by Administrator Setting.

3 One touch
 buttons

Displays destinations assigned to one-touch buttons. Press a button to add a
 destination.

4 Function
 Settings

Displays the current settings.
The setting can be changed for certain functions.

[Basic] Tab

Item Description

1 Address Book Displays e-mail addresses registered in the Address Book.
Select an e-mail address as a destination from the Address Book.

2 Group List Displays a list of groups in which e-mail addresses are registered.
Select a group as a destination from the Group List.

3 Tx History Displays a transmission history.
Select a destination from the transmission history.

4 Manual Input Enter an e-mail address manually to use it as a destination.
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5 LDAP Search for an e-mail address from the LDAP server to use it as a
 destination.
There are two search methods: Simple Search and Advanced Search.

6 Scan Size Specifies the scan size to scan a document.

7 Register to Job
 Macro

Registers current settings to Job Macro.

8 Displays Help topics.

[Advanced] Tab

Item Description

1 Duplex Scan Specifies duplex scanning.
Set this function when scanning both sides of a document.

2 Reply To Specifies an e-mail address as a reply destination.
If the recipient replies to the received e-mail, the reply is sent to the e-mail
 address specified here.

3 Subject Specifies the subject of the e-mail.

4 E-mail Body Specifies the body of the e-mail.

5 File Name Specifies a file name for the scanned file.
If not specified, the file will be named according to the factory default
 setting.

6 Continuous
 Scan

Scans multiple documents as a single job.

7 Preview Displays fax images to send on the touch panel.

8 Compression
 Rate

Specifies a compression level for the scanned file.

[Image Settings] Tab
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Item Description

1 Density Adjusts a level of scan density.

2 Resolution Specifies the resolution to scan a document.

3 Background Removal Adjusts a level of the document background removal.

[Function Settings] > [Destination] Tab
Add, edit or delete a destination to which a document is sent.

[Function Settings] > [Scan Setting] Tab

Item Description

1 Setting display
 area 1

Displays the current settings for displayed items.

2 Setting display
 area 2

Displays a list of settings that are not set by items displayed in setting
 display area 1.
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Maintenance

This category describes consumable replacements and cleaning to ensure a comfortable use
 of the machine for a longer life. This category also describes the updates and removals of
 driver(s) on a computer connected to the machine.

Memo
The procedures for replacing consumables and cleaning the parts can be seen from the operator
 panel. Press [Troubleshooting] on the touch panel.

Replacing Consumables

This section describes how to replace the consumables.

Cleaning Each Part of the Machine

This section describes how to clean each part of the machine.

Updating Installed Drivers

This section describes how to update computer drivers. You must log in the administrator
 to complete this procedure.

Removing Installed Drivers

This section describes how to remove computer drivers. You must log in the administrator
 to complete this procedure.

Initializing Memory and Settings

This section describes how to initialize Memory and settings saved in the machine.
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Replacing Consumables

This section describes how to replace consumables.

Cautions When Replacing

Replacing the Toner Cartridge

For K (black) Toner Cartridge Only

For C (cyan), M (magenta), Y (yellow) Toner Cartridge

Replacing the Image Drum

Replacing the Image Drum and Toner Cartridge at the Same Time

Replacing the Belt Unit

Replacing the Fuser Unit

Replacing the Feed Roller (Tray 1/Tray 2/Tray 3/Tray 4)

Replacing the Feed Roller (MP Tray)

Replacing the Stapler Cartridge
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Cautions When Replacing

Observe the following cautions when replacing.

Do not throw the toner
 or toner cartridge into
 a fire. The toner
 scatters, resulting in
 burns.

Do not store a toner
 cartridge in a location
 where it is exposed to
 open flames. The
 toner may ignite,
 resulting in fire or
 burns.

Do not vacuum spilled
 toner with an electric
 vacuum cleaner.
 Vacuuming spilled
 toner with an electric
 vacuum cleaner may
 result in ignition due
 to sparks from electric
 contacts or other
 reasons. If toner spills
 on the floor or other
 places, wipe the toner
 with a damp rag or
 other cloth.

Some parts inside the
 machine become very
 hot. Do not touch the
 locations around a
 "CAUTION HOT" label.
 Burns may result.

Keep toner cartridges
 out of the reach of
 children. If a child
 accidentally swallows
 toner, immediately
 seek medical advice.

If you inhale toner,
 gargle with a large
 amount of water, and
 move to a place with
 fresh air. Seek
 medical advice if
 necessary.

If toner lands on your
 hands or other areas
 of skin, wash
 thoroughly with soap
 and water.

If toner gets into your
 eyes, immediately
 rinse with a large
 amount of water. Seek
 medical advice if
 necessary.

If you swallow toner,
 spit it out. Seek
 medical advice if
 necessary.

When handling a paper
 jam or replacing toner
 cartridges, use care
 not to let your clothes
 or hands get dirty with
 toner. If toner lands
 on your clothes, wash
 with cold water. If
 toner gets hot by
 washing with hot
 water or other
 methods, the toner
 will stain the fabric
 and become
 impossible to remove.

Do not disassemble the
 image drum or toner
 cartridge. You may
 inhale the scattered
 toner, or the toner
 may land on your
 hands or clothes,
 making them dirty.

Store used toner
 cartridges by putting
 them into a bag while
 using care not to
 scatter the toner.

Note
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Use Oki Data genuine consumables to ensure optimum performance of the products.

Charges for services for problems caused by the use of consumables other than Oki data
 genuine consumables are incurred, regardless of the warranty or in the maintenance
 contract. (Although the use of non-genuine consumables does not always result in problems,
 use extra care when using them.)
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Replacing the Toner Cartridge

This section describes how to recognize the replacement period of Toner Cartridges.

When the "[COLOR] Toner Low" message ("[COLOR]" indicates C (cyan), M (magenta), Y
 (yellow) or K (black)) which appears on the display screen, prepare a replacement toner
 cartridge.

When the "[COLOR] Toner Empty" appears and printing is stopped, replace the toner
 cartridge.

Memo
Even if the cyan (blue), magenta (red) or yellow toner cartridges run out, you can print in black
 and white by selecting [Monochrome] or [Grayscale]. However, please replace the toner
 cartridge quickly after it runs out, as not doing so may cause the image drum to be damaged.

Note
Have a new toner cartridge ready, as the print quality declines after more than one year
 following breaking the seal.

If you replace the toner cartridge/image drum while it is being used, the amount of toner
 used will not be counted normally.

By opening and closing the output tray after the message "Color toner has run out" is
 displayed, you are able to print. However further printing operations will not be possible
 after that. Please replace the toner cartridge as failure to do so may damage the image
 drum.

Toner powder may spill if you remove a toner cartridge before the toner runs out.

For K (black) Toner Cartridge Only

For C (cyan), M (magenta), Y (yellow) Toner Cartridge
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For K (black) Toner Cartridge Only

Memo
When replacing the C, M, Y toner cartridges, refer to "For C (cyan), M (magenta), Y (yellow)
 Toner Cartridge".

1. Prepare a new [K] toner cartridge.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

4. Turn the blue lever (3) of the toner cartridge toward you until its
 top aligns on the  mark.
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5. Lift the toner cartridge (4) from the right side, and remove it from
 the machine.

Do not throw used toner cartridge in the fire. They may explode, and the toner inside may
 fly off and cause getting burned.

Note
When toner powder drops to the paper feeding area inside the machine, wipe it off with a
 wet cloth that has been well wrung.

Possible to get burned.
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6. Unpack a new toner cartridge.

7. Shake the cartridge several times vertically and horizontally.

8. Remove the tape (5) from the toner cartridge.

9. Insert a new toner cartridge (6) by aligning its left side indentation
 (7) with the protrusion (8) on the image drum so the toner
 cartridge and image drum [K] color label align. Then insert the
 right side gently into place.

Note
Do not insert a toner cartridge without removing the tape.

10. Turn the blue lever (3) of the toner cartridge backward until its top
 aligns on the  mark while pressing the toner cartridge.
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11. Close the front cover (2).

Note
The front cover cannot be closed if the output tray is not closed securely.

12. Hold the handle (A) to close the scanner unit.

13. Please recycle toner cartridges.
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Memo
If you have to dispose of used toner cartridges, put them into polyethylene bags or other
 container, and be sure to follow the regulations or instructions of your local government.
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For C (cyan), M (magenta), Y (yellow) Toner Cartridge

Memo
When replacing only the K toner cartridge, refer to "For K (black) Toner Cartridge Only".

1. Prepare new toner cartridges.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

4. Press the button (C) and open the Output Tray (3).

Possible to get burned.
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The fuser unit is extremely hot. Do not touch it.

5. Identify an empty toner cartridge by its label color.

6. Turn the blue lever (4) of the toner cartridge toward you until its
 top align on the  mark.

7. Lift the toner cartridge (5) from right side, and remove it from the
 machine.

Do not throw used toner cartridge in the fire. They may explode, and the toner inside may
 fly off and cause getting burned.

8. Unpack a new toner cartridge.

Possible to get burned.
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9. Shake the cartridge several times vertically and horizontally.

10. Remove the tape (6) from the toner cartridge.

11. Insert a new toner cartridge (5) by aligning its left side indentation
 (7) with the protrusion (8) on the image drum so the toner
 cartridge and image drum color labels align. Then insert the right
 side gently into place.

Note
Do not insert a toner cartridge without removing the tape.

12. Turn the blue lever (4) of the toner cartridge backward until its top
 align on the  mark while pressing the toner cartridge.
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Note
If the toner cartridge is not securely attached, printing quality may deteriorate.

13. Wipe the lens of the LED head with a soft tissue paper lightly.

Note
Do not use solvents, such as methyl alcohol or thinners. They damage the LED head.

14. Close the Output Tray (3) by pushing the both sides of the Output
 Tray (3) firmly.
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15. Close the front cover (2).

Note
The front cover cannot be closed if the output tray is not closed securely.

16. Hold the handle (A) to close the scanner unit.

17. Please recycle toner cartridges.

Memo
If you have to dispose of used toner cartridges, put them into polyethylene bags or other
 container, and be sure to follow the regulations or instructions of your local government.
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Replacing the Image Drum

This section describes how to recognize the replacement period of an image drum, and how
 to replace the image drum.

Before Replacing

Replacing the Image Drum Only

Before Replacing

When the "[COLOR] Image Drum Near Life" message appears on the display screen, prepare
 a replacement image drum. If you continue printing, the message "[COLOR] Image Drum
 Life" will be displayed and printing will stop.

When the "Please install new Image Drum Unit." message is displayed and printing stops,
 replace the image drum.

When using A4 paper (simplex printing), the estimated replacement cycle of an image drum
 is approximately 30,000 pages. This estimation assumes the standard use condition (three
 pages are printed at a time). Printing one page at a time reduces the drum lifetime
 approximately by half.

The actual number of printed pages may be less than half the above estimation depending
 on the printing conditions.

Note
The actual number of pages you can print with the image drum depends on how you use the
 machine. It may be less than half the above estimation depending on the printing
 conditions.

Printing quality may deteriorate after 1 year following the unpacking of the toner cartridge.
 Replace the toner cartridge with a new one.

Though opening and closing the output tray may extend the life of an image drum for a
 while, it is recommended to replace it soon after the "Install New image drum" is displayed.

When the [Device Setting] > [Admin Setup] > [Management] > [System Setup] > [Near Life
 Status] is set to [Disable], the "[COLOR] Image Drum Near Life" message does not appear.

Replacing the Image Drum Only

This section describes how to replace the image drum when you want to continue using the
 toner cartridge.

Note
If you use a new image drum with the toner cartridges currently in use, the remaining
 amount indication of the toner cartridges will not display correctly. The messages "[COLOR]
 Image Drum Near Life" or "[COLOR] Image Drum Life" may also be displayed soon after
 replacement.

Use extra care when handling the image drum (the green cylinder), because it is fragile.

Do not expose the image drum to direct sunlight or strong light (approximately 1,500 lux or
 more). Even under room lighting, do not leave the image drum for 5 minutes or more.

Use Oki Data genuine consumables to ensure optimum performance of the products.

Charges for services for problems caused by the use of consumables other than Oki data
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 genuine consumables are incurred, regardless of the warranty or in the maintenance
 contract. (Although use of non-genuine consumables does not always result in problems,
 use extra care when using them.)

Memo
You can change the setting for displaying the "[COLOR] Image Drum Near Life" message. Set
 from [Device Setting] > [Admin Setup] > [User Install] > [Drum Near Life Timing]. Available
 values are from 500 to 5,000 (in 500 increaments).

1. Prepare new image drum.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the recess on the lever (B) side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

4. Press the button (C) and open the Output Tray (3).
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5. Identify the image drum that reached its lifetime by its label color.

6. Remove the image drum (4) from the machine and place the image
 drum on a flat surface.

7. Turn the blue lever (6) of the toner cartridge toward you until its
 top align on the  mark while pressing the toner cartridge.

8. Lift the toner cartridge (5) from the right side, and remove it from
 the image drum.

9. Unpack a new image drum and place it on a flat surface.

10. Remove the protective sheets.

11. Remove the toner cover.
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12. Insert the toner cartridge (5) removed in step 8 by aligning its left
 side indentation (7) with the protrusion (8) on the image drum so
 that the toner cartridge and image drum color label align. Then
 insert the right side gently into place.

13. Turn the blue lever (6) of the toner cartridge backward until its top
 align on the  mark while pressing the toner cartridge.

14. Check the label color of the new image drum and place the drum
 into the machine.

15. Close the Output Tray (3) by pushing the both sides of the Output
 Tray (3) firmly.
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16. Close the front cover (2).

Note
The front cover cannot be closed if the Output Tray is not closed securely.

17. Hold the handle (A) to close the scanner unit.

18. Please recycle image drums.

Memo
If you must dispose of an image drum, put it in a plastic bag or similar container and
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 dispose of it in accordance with your municipality's ordinances or guidelines.
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Replacing the Image Drum and Toner Cartridge at the
 Same Time

This section describes how to replace the image drum and toner cartridge with new ones at
 the same time.

Note
Use extra care when handling the image drum (the green cylinder), because it is fragile.

Do not expose the image drum to direct sunlight or strong light (approximately 1,500 lux or
 more). Do not leave the image drum for 5 minutes or more even under room light.

Use Oki Data genuine consumables to ensure optimum performance of the products.

Charges for services for problems caused by the use of consumables other than Oki data
 genuine consumables are incurred, regardless of the warranty or in the maintenance
 contract. (Although use of non-genuine consumables does not always result in problems,
 use extra care when using them.)

1. Prepare new image drum and toner cartridge.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.
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4. Press the button (C) and open the Output Tray (3).

The fuser unit is extremely hot. Do not touch it.

5. Identify an empty toner cartridge by its label color.

6. Remove the image drum (4) from the machine and place it on a flat
 surface.

Do not throw used image drum and toner cartridge in the fire. They may explode, and the
 toner inside may fly off and cause getting burned.

Possible to get burned.

Possible to get burned.
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7. Unpack a new image drum and place it on the flat surface.

8. Remove the protective sheets.

9. Remove the toner cover.

10. Unpack a new toner cartridge.

11. Shake the cartridge several times vertically and horizontally.

12. Remove the tape (5) from the toner cartridge.

13. Insert a new toner cartridge (6) by aligning its left side indentation
 (7) with the protrusion (8) on the image drum so that the toner
 cartridge and image drum color label align. Then insert the right
 side gently into place.
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Memo
For the installation method, refer to "Replacing the Toner Cartridge".

14. Turn the blue lever (9) of the toner cartridge backward until its top
 align on the  mark while pressing the toner cartridge.

15. Check a label color of a new image drum and place the drum into
 the machine.

16. Close the Output Tray (3) by pushing the both sides of the Output
 Tray (3) firmly.

17. Close the front cover (2).

Note
The front cover cannot be closed if the Output Tray is not closed securely.
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18. Hold the handle (A) to close the scanner unit.

19. Please recycle image drums and toner cartridges.

Memo
If you must dispose of an image drum, put it in a plastic bag or similar container and
 dispose of it in accordance with your municipality's ordinances or guidelines.
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Replacing the Belt Unit

When the "Belt Unit Near Life" message appears on the display screen, prepare a
 replacement belt unit. You can keep printing approximately 2,000 pages until the next
 message appears.

When the "Change Belt Unit" message appears, replace the belt unit.

The life expectancy of the belt unit is approximately 80,000 pages for A4 simplex printing
 (three pages per job).

Note
The actual number of pages you can print with the belt unit depends on how you use it.

Though opening and closing the output tray may extend the life of the belt unit somewhat,
 you should replace it soon after the "Change Belt Unit" is displayed to prevent malfunction.

If you replace the belt unit, use it until the end of its useable life. If you remove the belt unit
 and install and use another one before its usable life has expired, the use life will not be
 correctly displayed.

When the [Device Setting] > [Admin Setup] > [Management] > [System Setup] > [Near Life
 Status] is set to [Disable], the [Belt Unit Near Life] message does not appear.

The image drum (the green tube) is very delicate. Handle it carefully.

Do not expose the image drum to direct sunlight or very bright interior light (approximately
 more than 1,500 lux). Even under the normal interior light, do not leave it for more than
 5 minutes.

Memo
You can change the setting for displaying the "Belt Unit Near Life" message. Set from [Device
 Setting] > [Admin Setup] > [User Install] > [Belt Near Life Timing]. Available values are from
 500 to 5,000 (in 500 increaments).

1. Prepare a replacement belt unit.

2. Hold the handle (A) to open the scanner unit.
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3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

4. Press the button (C) and open the Output Tray (3).

The fuser unit is extremely hot. Do not touch it.

5. Take all the four image drums out of the machine, and then place

Possible to get burned.
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 them on a flat surface.

6. Cover the image drums you took out with paper so that the image
 drums do not expose to the light.

7. Turn the blue locks (4) on each side of the belt unit in direction of
 the arrow to unlock.

8. Remove the belt unit by holding the blue lever.
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9. Hold the handle of a new belt unit with your hand and support
 lower part with other hand. Set the belt unit into the machine.

10. Turn the blue locks (4) on each side of the belt unit in direction of
 the arrow.

11. Return all the four image drums to the machine.
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12. Close the Output Tray (3) by pushing the both sides of the Output
 Tray firmly.

13. Close the front cover (2).

Note
The front cover cannot be closed if the Output Tray is not closed securely.

14. Hold the handle (A) to close the scanner unit.
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15. Please recycle belt unit.

Memo
If you must dispose of a belt unit, put it in a plastic bag or similar container and dispose of
 it in accordance with your municipality's ordinances or guidelines.
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Replacing the Fuser Unit

When the "Fuser Unit Near Life" message appears on the display screen, prepare a
 replacement fuser unit. You can keep printing approximately 2,500 pages until the next
 message appears.

When the "Change Fuser Unit" message appears, replace the fuser unit.

The life expectancy of the fuser unit is up to 100,000 pages for A4 simplex printing.

Note
The actual number of pages you can print with the fuser unit depends on how you use it.

Though opening and closing the Output Tray may extend the life of the fuser unit somewhat,
 you should replace it soon after "Change Fuser Unit" is displayed to prevent malfunction.

If you replace the fuser unit, use it until the end of its useable life. If you remove the fuser
 unit and install and use another one before its usable life has expired, the use life will not be
 correctly displayed.

When the [Device Setting] > [Admin Setup] > [Management] > [System Setup] > [Near Life
 Status] is set to [Disable], the [Fuser Unit Near Life] message does not appear.

Do not expose the image drum to direct sunlight or very bright interior light (approximately
 more than 1,500 lux). Even under the normal interior light, do not leave it for more than
 5 minutes.

Memo
You can change the setting for displaying the "Fuser Unit Near Life" message. Set from [Device
 Setting] > [Admin Setup] > [User Install] > [Fuser Near Life Timing]. Available values are from
 500 to 5,000 (in 500 increaments).

1. Prepare a new fuser unit.

2. Hold the handle (A) to open the scanner unit.
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3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

4. Press the button (C) and open the Output Tray (3).

Since the fuser unit gets hot, carry out the operation carefully, and when lifting it up you
 must hold it by the handle. Do not try to hold it whilst it is hot. Wait until it has cooled
 down and then carry out the operation.

5. Pull forward the left locking lever (4) of the fuser unit to unlock.

6. Hold the fuser unit handle (5) and lift the fuser unit out of the
 machine.

Possible to get burned.
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7. Hold the handle and place the new fuser unit into the machine.

8. Push back the left locking lever (4) of the fuser unit to lock.

9. Close the Output Tray (3) by pushing the both sides of the Output
 Tray firmly.
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10. Close the front cover (2).

Note
The front cover cannot be closed if the output tray is not closed securely.

11. Hold the handle (A) to close the scanner unit.

12. Please recycle fuser unit.

Memo
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If you must dispose of a fuser unit, put it in a plastic bag or similar container and dispose
 of it in accordance with your municipality's ordinances or guidelines.
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Replacing the Feed Roller (Tray 1/Tray 2/Tray 3/Tray
 4)

For Tray 1 and Tray 2/Tray 3/Tray 4 (Optional)

Memo
The number of pages you can print with a paper feed roller depends on environment and
 paper.

If paper jams persists even after cleaning the paper feed roller, replacing the paper feed
 roller is recommended.

For Tray 1 and Tray 2/Tray 3/Tray 4 (Optional)

The paper feed roller for Tray 1 differs from those for Tray 2/3/4 in form. Identify the tray
 on which paper feed roller is to be replaced before preparing a new paper feed roller.

The procedure for replacing the paper feed roller for Tray 1 is described here as an example.
 The same procedure is applicable to those of Tray 2/3/4.

1. Make sure that you have everything mentioned below in the paper
 feed roller set for Tray 1.

Paper feed roller (with gear)

Paper feed roller (without gear)

Separating roller

Spring

2. Pull out the paper cassette (1).
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3. While opening the tabs (2) on the paper feed roller in the front of
 the paper cassette outward and slide the paper feed roller (3) to
 the left to remove.

4. While opening the tabs (4) on the paper feed roller in the back of
 the paper cassette outward and slide the feed roller (5) to the left
 to remove.

5. Attach a new paper feed roller (with gear) to the axis in the back.

6. Attach a new paper feed roller (without gear) to the axis in the
 front.

643



7. Remove paper from a paper cassette.

8. While pressing the two tabs (6) in the front of the paper cassette,
 open the cover (7) of the separating roller.

9. Press the parts embedded in the projections on the both sides of
 paper cassettes inward and remove the separating roller and
 spring.

Note
For Tray 2/3/4, removed springs are used later. Do not dispose them.

10. Attach a new spring to a new separating roller. (For Tray 2/3/4, use
 the springs removed in Step 9.)

11. Set the spring to the paper cassette and push the separating roller
 into the paper cassette.
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12. Fit the projections of the paper cassette into the dimples on the
 both sides of the separating roller.

13. Close the separating roller cover.

14. Load paper in the paper cassette and insert the paper cassette into
 this machine.
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Replacing the Feed Roller (MP Tray)

1. Prepare the paper feed rollers for the MP tray.

2. Open the MP tray (1) forward by inserting your fingers into the
 front recesses.

3. Slightly lifting the MP tray (1), press the right arm (2) inward, then
 unlock the tab (3).

4. In the same manner, slightly lifting the MP tray, press the left arm
 inward, then unlock the tab.

5. Open the paper set cover until it touches to the machine body.

Open the tabs on the upper paper feed roller outward and slide the
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6. 
 paper feed roller to the left to remove.

7. Keep pressing the separating roller cover, open the tabs on the
 lower paper feed roller outward and slide the paper feed roller to
 the left to remove.

8. Keep pressing the center of the MP tray and open the separating
 roller cover forward.

9. Remove the separating roller.
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10. Keep pressing the center of the MP tray and set a new separating
 roller.

Memo
Do not touch the rubber part of the roller.

11. Close the separating roller cover.

12. Set the paper feed roller (without gear) to the lower axis.

13. Set the paper feed roller (with gear) to the upper axis.
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14. Lower the paper set cover.

15. While pressing the right arm on the MP tray, slightly lift the MP tray
 and hook the tab.

Note
Closing the MP tray without putting the tab back in place may crack the paper set cover.
 Be sure to put it back in place.

16. In the same manner, while pressing the left arm on the MP tray,
 slightly lift the MP tray and hook the tab.

Note
Closing the MP tray without putting the tab back in place may crack the paper set cover.
 Be sure to put it back in place.

17. Close the MP tray.
If the MP tray cannot be closed, press the paper setting part of the MP tray downward
 to put the paper set cover back in place.
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Replacing the Stapler Cartridge

1. Open the stapler cover.

2. Remove the empty cartridge.

3. Attach the new cartridge.

4. Close the stapler cover.
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Cleaning Each Part of the Machine

This section describes how to clean the machine and parts.

Cleaning the Surface of the Machine

Cleaning the Document Glass

Cleaning the Document Feed Rollers and Document Holding Rollers

Cleaning the Paper Feed Rollers (Tray 1/Tray 2/Tray 3/Tray 4)

Cleaning the Paper Feed Rollers (MP Tray)

Cleaning the LED Head
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Cleaning the Surface of the Machine

Note
Do not use benzine, thinners, or alcohol, because they may damage the plastic parts of the
 machine.

Do not lubricate the machine with oil. Do not apply oil.

1. Turn the machine off.
Turning the Machine Off

2. Wipe the surface of the machine with a soft cloth that has been
 slightly moistened with water or neutral detergent and then
 squeezed well.

Note
Do not use other than water or neutral detergent.

3. Dry the surface of the machine with a dry soft cloth.
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Cleaning the Document Glass

Clean the document glass once a month to maintain image quality of the printouts.

Note
Do not use benzine, thinners, or alcohol. They may damage the plastic parts of the machine.

1. Open the document glass cover.

2. Wipe the ADF document holding pad, document glass, and ADF
 document glass gently with a soft cloth that has been slightly
 moistened with water and squeezed well.

Memo
If the document glass surface and document holding pad are very dirty, wipe gently with a
 soft cloth that has been moistened with neutral detergent and squeezed well, and then
 wipe again with a soft cloth that has been slightly moistened with water and squeezed
 well.

3. Close the document glass cover.
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Cleaning the Document Feed Rollers and Document
 Holding Rollers

If the document feed rollers in the ADF are contaminated with ink, toner particles or paper
 dust, documents and outputs get dirty and a paper jam may occur. Clean the ADF once a
 month to prevent these problems.

Note
Do not use benzine, thinners, or alcohol. They may damage the plastic parts of the machine.

1. Check the ADF cover.

2. Pull the ADF cover open lever (D) and open the ADF cover.

3. Open the Roller cover.

4. Wipe the document feeding rollers with a soft cloth lightly
 moistened with water. Wipe the whole surface of the roller while
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 turning it with your hand.

5. Push and close the Roller cover.

Memo
If the document feed roller is very dirty, wipe gently with a soft cloth that has been
 moistened with neutral detergent and squeezed well, and then wipe again with a soft cloth
 that has been slightly moistened with water and squeezed well.

6. Close the ADF cover.

7. Open the scanner unit.
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8. Pull the lever and open the document holding pad.

9. Wipe the paper feed roller with a soft cloth that has been
 moistened with water and then squeezed well.

10. Put the document holding pad back in place.

658



11. Close the scanner unit.
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Cleaning the Paper Feed Rollers (Tray 1/Tray 2/Tray
 3/Tray 4)

Clean the paper feed roller in the paper tray and the rollers inside the machine.

An example of Tray 1 is covered in the following procedure, and the same procedure applies
 to Tray 2/3/4.

1. Pull out the tray (1).

2. Wipe the two paper feed rollers (2) inside the machine with a wet
 cloth that has been wrung out well.

3. Remove paper loaded in the tray.

4. Wipe the paper feed roller (3) on the tray with a wet cloth that has
 been wrung out well.
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5. Load paper in the tray.

6. Push the tray back into the machine.

7. Close the tray.
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Cleaning the Paper Feed Rollers (MP Tray)

Clean the paper feed rollers in the MP tray.

1. Open the MP tray (2) forward by inserting your fingers into the
 front recesses (1).

2. Slightly lifting the MP tray (2), press the right arm (3) inward, then
 unlock the tab (4).

3. In the same manner, slightly lifting the MP tray (2), press the left
 arm (3) inward, then unlock the tab (4).
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4. Open the paper set cover (5) until it touches to the machine body.

5. Wipe the rollers.

Note
Do not damage the paper end sensor lever when cleaning the rollers.

6. Open the separation roller cover (7) forward while pressing the
 center part of the MP tray.
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7. Wipe the separation rollers (8) with a wet cloth that has been
 wrung out well.

8. Close the separation roller cover (7).

9. Lower the paper set cover (5).
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10. While pressing the right arm (3) on the MP tray (2) inward, slightly
 lift the MP tray (2) and hook the tab (4).

Note
Closing the MP tray without putting the tab back in place may crack the paper set cover.
 Be sure to put it back in place.

11. In the same manner, while pressing the left arm (3) on the MP tray
 (2) inward, slightly lift the MP tray (2) and hook the tab.
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Note
Closing the MP tray without putting the tab back in place may crack the paper set cover.
 Be sure to put it back in place.

12. Close the MP tray.
If the MP tray cannot be closed, press the paper setting part of the MP tray downward
 to put the paper set cover back in place.
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Cleaning the LED Head

Clean the LED head if vertical white lines appear, images are faded, or the periphery of
 letters are smudged in the printouts.

Note
Do not use solvents, such as methyl alcohol or thinners, because they may damage the LED
 head.

Do not expose the image drum to direct sunlight or strong light (approximately 1,500 lux or
 more). Even under room lighting, do not leave the image drum for 5 minutes or more.

1. Hold the handle (A) to open the scanner unit.

2. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

3. Press the button (C) and open the Output Tray (3).
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The fuser unit is extremely hot. Do not touch it.

4. Wipe the four lenses of the LED heads with a soft tissue paper
 lightly.

5. Close the Output Tray by pushing the both sides of the Output Tray
 firmly.

6. Close the front cover.

Note
The front cover cannot be closed if the Output Tray is not closed securely.

Possible to get burned.
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7. Hold the handle (A) to close the scanner unit.
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Updating Installed Drivers

This section describes how to update printer drivers that are installed in a computer. You
 must have the administrator rights for the computer to complete this procedure.

Updating the Printer Driver (Windows)

Updating the Fax Driver (Windows)

Updating the Scanner Driver (Windows)

Updating the Printer Driver (Mac OS X)

Updating the Scanner Driver (Mac OS X)
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Updating the Printer Driver (Windows)

Check details on the latest driver on the Oki Data Web site.

Note
You must log in as the administrator to perform this procedure.

1. Double-click the downloaded file.

Memo
If the [User Account Control] dialog box is displayed, click [Yes].

2. Select a language, and then click [OK].

3. Read the license agreement, and then click [Agree].

4. Install the driver by following the instructions.
If the driver of the previous version is already installed, the screen to select updating
 will be displayed. Follow the instructions.

Also, rebooting the computer may be required before updating the driver.

5. If the [Program Capability Assistant] dialog box is displayed after
 installation, be sure to click [This program installed correctly].
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Updating the Fax Driver (Windows)

Check details on the latest driver on the Oki Data Web site.

Note
You must log in as the administrator to perform this procedure.

1. Double-click the downloaded file.

Memo
If the [User Account Control] dialog box is displayed, click [Yes].

2. Select a language, and then click [OK].

3. Read the license agreement, and then click [Agree].

4. Install the driver by following the instructions.
If the driver of the previous version is already installed, the screen to select updating
 will be displayed. Follow the instructions.

Also, rebooting the computer may be required before updating the driver.

5. If the [Program Capability Assistant] dialog box is displayed after
 installation, be sure to click [This program installed correctly].
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Updating the Scanner Driver (Windows)

Check details on the latest driver on the Oki Data Web site.

Note
You must log in as the administrator to perform this procedure.

1. Double-click the downloaded file.
The file is extracted, and then the installer starts.

2. Install the driver by following the instructions.
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Updating the Printer Driver (Mac OS X)

Check details on the latest driver on the Oki Data Web site.

Note
You must log in as the administrator to perform this procedure.

1. Remove the driver.
Removing the Printer Driver (Mac OS X)

2. Install a new driver.
Installing a Driver and Software to a Computer
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Updating the Scanner Driver (Mac OS X)

Check details on the latest driver on the Oki Data Web site.

Note
You must log in as the administrator to perform this procedure.

1. Remove the scanner driver.
Removing the Scanner Driver (Mac OS X)

2. Install a new scanner driver.
Installing a Driver and Software to a Computer
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Removing Installed Drivers

This section describes how to remove the printer driver that is installed in a computer. You
 must have the administrator rights for the computer to complete this procedure.

Removing the Printer Driver (Windows)

Removing the Fax Driver (Windows)

Removing the Scanner Driver (Windows)

Removing the Printer Driver (Mac OS X)

Removing the Scanner Driver (Mac OS X)
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Removing the Printer Driver (Windows)

Note
You must log in as the administrator to perform this procedure.

Restart the computer before removing the driver.

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Remove device].
To remove a printer driver among multiple printer drivers, select [Remove Print
 Queue] > [OKIMC873(*)].

* Select a driver type to remove.

3. When a confirmation message is displayed, click [Yes].

Note
When a message is displayed to inform you of the device in use, restart a computer, and
 then repeat steps 1 to 2.

4. Select an icon in [Printers and Faxes], and then click [Print server
 properties] on the top bar.

5. Select the [Drivers] tab.

6. If [Change Driver Settings] is displayed, click it.

7. Select a driver to remove, and then click [Remove].

8. When a message is displayed to ask you to select whether you
 want to remove the driver only or the driver and package from the
 system, select to remove the driver and package, and then click
 [OK].

9. When a confirmation message is displayed, click [Yes].

10. When the [Remove Driver Package] dialog box is displayed, click
 [Delete] > [OK].

Note
If removal is rejected, restart the computer, and then repeat steps 4 to 10.

11. Click [Close] in the [Print Server Properties] dialog box.
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12. Restart the computer.
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Removing the Fax Driver (Windows)

Note
You must log in as the administrator to perform this procedure.

Restart the computer before removing the driver.

1. Click [Start], and then select [Devices and Printers].

2. Right-click the OKI MC873 icon, and then select [Remove device].
To remove a printer driver among multiple printer drivers, select [Remove device] >
 [OKIMC873(*)].

* Select a driver type to remove.

3. When a confirmation message is displayed, click [Yes].

Note
When a message is displayed to inform you of the device in use, restart a computer, and
 then repeat steps 1 to 2.

4. Select an icon in [Printers and Faxes], and then click [Print server
 properties] on the top bar.

5. Select the [Drivers] tab.

6. If [Change Driver Settings] is displayed, click it.

7. Select a driver to remove, and then click [Remove].

8. When a message is displayed to ask you to select whether you
 want to remove the driver only or the driver and package from the
 system, select to remove the driver and package, and then click
 [OK].

9. When a confirmation message is displayed, click [Yes].

10. When the [Remove Driver Package] dialog box is displayed, click
 [Delete] > [OK].

Note
If removal is rejected, restart the computer, and then repeat steps 4 to 10.

11. Click [Close] in the [Print Server Properties] dialog box.
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12. Restart the computer.
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Removing the Scanner Driver (Windows)

Note
You must log in as the administrator to perform this procedure.

1. Click [Start], and then select [Control Panel] > [Uninstall a
 program].

2. Select [OKI Universal Scanner], and then click [Uninstall].

3. If the [User Account Control] dialog box is displayed, click [Yes].

4. When a confirmation message is displayed, click [Yes].

5. Click [Finish] on the "Uninstallation Complete" screen.
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Removing the Printer Driver (Mac OS X)

For Mac OS X 10.9 to 10.10

For Mac OS X 10.7 to 10.8

For Mac OS X 10.6.8

Note
You must log in as the administrator to perform this procedure.

For Mac OS X 10.9 to 10.10

1. Select [System Preferences] from the Apple menu.

2. Select [Printers & Scanners].

3. Select a device to remove, and then click [-].
If a confirmation message is displayed, click [Delete Printer].

4. Close the [Printers & Scanners] dialog box.

5. Insert the "Software DVD-ROM" into a computer.

6. Double-click [OKI] > [Drivers] > [PS] > [Uninstaller].

7. Follow the on-screen instructions, enter the administrator
 password, and then click [OK] until the uninstallation procedure is
 complete.

8. Remove the "Software DVD-ROM" from the computer.

For Mac OS X 10.7 to 10.8

1. Select [System Preferences] from the Apple menu.

2. Select [Print & Scan].

3. Select a device to remove, and then click [-].
If a confirmation message is displayed, click [Delete Printer].

4. Close the [Print & Scan] dialog box.

5. Insert the "Software DVD-ROM" into a computer.
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6. Double-click [OKI] > [Drivers] > [PS] > [Uninstaller].

7. Follow the on-screen instructions, enter the administrator
 password, and then click [OK] until the uninstallation procedure is
 complete.

8. Remove the "Software DVD-ROM" from the computer.

For Mac OS X 10.6.8

1. Select [System Preferences] from the Apple menu.

2. Select [Print & Fax].

3. Select a device to remove, and then click [-].
If a confirmation message is displayed, click [Delete Printer].

4. Close the [Print & Fax] dialog box.

5. Insert the "Software DVD-ROM" into a computer.

6. Double-click [OKI] > [Drivers] > [PS] > [Uninstaller].

7. Follow the on-screen instructions, enter the administrator
 password, and then click [OK] until the uninstallation procedure is
 complete.

8. Remove the "Software DVD-ROM" from the computer.
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Removing the Scanner Driver (Mac OS X)

Note
You must log in as the administrator to perform this procedure.

1. From the hard disk, select [Library] > [Image Capture] >
 [Devices].

2. Delete "OKI Scanner".

3. From the hard disk, select [Applications] > [OKIDATA] >
 [Scanner].

4. Delete the "Network Scanner Setup Tool".

5. Restart the computer.

684



Initializing Memory and Settings

Initialize Memory and settings saved in the machine.

Initializing Flash Memory

Initializing the Device Settings

Initializing the Network Settings

Initializing the Job Macro and Fax Transmission and Reception Data
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Initializing Flash Memory

Saved e-mail templates and other data are stored in Memory.

Initialize Memory by following the procedure below.

Note
When you initialize Memory, the following data is deleted.

The job data saved with [Secure Print], [Encrypted Secure Print], [Store to Printer] or [ID
 Secure Job].

Custom demo data

Form data

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Storage Maintenance Setup].

6. Press [Initial Lock] to change the display to [Disable].

7. Press [Back].

8. Press [Flash Memory Setup] or select a storage to format from
 "HDD Setup".

9. Press [Initialize].

10. If HDD is selected in Step 9, press [Format Partition], and then
 select from the following types. The menu in Step 11 appears only
 when "HDD Setup" is selected.
Available selection types:

PCL,  Common,  PS

Memo
Select from 2 ways of initializing Memory.

[Initialize]: Initializes the range of open area of Flash (displayed on File List).

[Format Partition]: Initializes user information.
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11. Press [Yes] on the confirmation screen.
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Initializing the Device Settings

You can return the configured settings to their default.

Note
When you initialize the device settings, the following data is deleted.

Stored documents in the Fcode bulletin board box

Fax jobs that have not been sent

Fax jobs received in the Fcode confidential box

Registered job macros

Dialing logs

E-mail logs

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Reset Settings].
A message is displayed confirming you that continuing automatically restarts the
 system. Select [Yes] to continue.
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Initializing the Network Settings

Initializing from Setting Menus of this Machine

Initializing from the Operator Panel of this Machine (Boot Menu)

Note
This procedure initializes all the network settings.

Initializing from Setting Menus of this Machine

You can restore the network settings to the factory default settings.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Network Menu].

5. Press [Network Setup].

6. Press [Factory Defaults].

7. Press [Yes].
The network card is rebooted to initialize the settings.

Initializing from the Operator Panel of this Machine (Boot
 Menu)

If you cannot initialize from the configuration menu of this machine, you can initialize from
 the operator panel.

1. Turn the machine on while pressing and holding "6" on the 10-key
 pad.
The OKI's logo is displayed.

2. Enter the administrator password.
The factory default administrator password is "aaaaaa".

3. Press "#" on the 10-key pad.
The [Boot Menu] screen is displayed.
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4. Press "1" on the 10-key pad.

5. Press "1" on the 10-key pad.
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Initializing the Job Macro and Fax Transmission and
 Reception Data

You can restore the equipment settings to the factory default settings.

Note
When you initialize the equipment settings, the following data is deleted.

Stored documents in the Fcode bulletin board box

Fax jobs that have not been sent

Fax jobs received in the Fcode confidential box

Registered job macros

Dialing logs

E-mail logs

Received fax data (including images received with Secure Receive)

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [OK].

5. Press  or  several times and press [Management].

6. Press [Reset Settings].
The "If executed, this machine will automatically reboot" message is displayed. Select
 [Yes] to continue.
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Troubleshooting

If Paper Jams Occur

If a Document Jam Occurs

If the STATUS Button on the Operator Panel Lights Up or Flashes

Copy Problems

Print Problems

Scan Problems

Fax Problems

About Problems with Printing Results

Problems about Software

Problems on the Machine or Paper

Network Problems

AirPrint Problems

Google Cloud Print Problems

Fax Error Codes

If an Error Message is Displayed on the Operator Panel

Memo
What if you cannot find expected search results?

If you cannot find expected search results, please read "Using the Search Function".
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If Paper Jams Occur

If the Error Code is "370", "371", "373"

If the Error Code is "372"

If the Error Code is "380"

If the Error Code is "381"

If the Error Code is "382", "383", "385", "389"

If the Error Code is "384"

If the Error Code is "390"

If the Error Code is "391", "392", "393" or "394"
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If the Error Code is "370", "371", "373"

A paper jam has occurred around the duplex unit.

1. Take out the duplex unit (E) by pulling it obliquely upward while
 holding the center recess on the back of the machine.

2. Check for jammed paper inside the machine. If jammed paper
 remains, remove it.

3. Check for jammed paper in the duplex unit. If jammed paper
 remains, pull it out gently. Check the back side of the duplex unit
 and remove jammed paper gently if it remains.

4. Open the upper duplex unit cover (1) and check for jammed paper.
 If jammed paper remains, pull it out gently and close the cover.

5. Replace the duplex unit (E) into the machine.
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Task is complete.
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If the Error Code is "372"

A paper jam has occurred around the front cover.

1. Remove a document from the ADF or document glass.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.
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4. Remove the jammed paper gently in the direction of the arrow if an
 edge of jammed paper can be seen, and then go to step 11. If you
 cannot find jammed paper, go to step 5.

5. Hold the handle (A) to close the scanner unit.

6. Take out the duplex unit (E) by pulling it obliquely upward while
 holding the center recess on the back of the machine.
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7. Check for jammed paper inside the machine. If jammed paper
 remains, remove it.

8. Check if paper remains in the duplex unit. If jammed paper
 remains, pull it out gently. Check the back side of the duplex unit
 and remove jammed paper gently if it remains.

9. Open the upper duplex unit cover (3) and check for jammed paper.
 If jammed paper remains, remove it, and close the cover.

10. Replace the duplex unit (E) to the machine.

11. Close the front cover (2).
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If the Error Code is "380"

A paper jam has occurred around the front cover.

1. Remove a document from the ADF or document glass.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.
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4. Remove the jammed paper gently in the direction of the arrow if an
 edge of jammed paper can be seen.

5. Hold the handle (A) to close the scanner unit.

6. Close the front cover (2).
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Task is complete.
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If the Error Code is "381"

If the "Paper jam has occurred. Please open the scanner unit and the output tray to check."
 message is displayed, a paper jam has occurred near the fuser unit or the image drum.

Remove the jammed paper by following the procedure below.

1. Remove a document from the ADF or document glass.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.
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4. Press the output tray open button (C) and open the output tray (3).

The fuser unit is extremely hot. Do not touch it.

5. Remove all four image drums and place them on a flat surface.

6. Cover the removed image drums with paper so that the image
 drums are not exposed to light.

Possible to get burned.
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7. Pull out the jammed paper gently to the rear of the machine (the
 direction of the arrow) if an edge of jammed paper can be seen.

Pull out the jammed paper gently while lifting the release levers (4) on the fuser unit if
 an edge of jammed paper cannot be seen.

If an edge of jammed paper still remains inside the unit, pull out the jammed paper
 gently to the rear of the machine.

8. Return all four image drums into the machine carefully.
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9. Close the output tray (3) by pushing the both sides of the cover
 firmly.

Memo
When closing the output tray, beware of the front cover. The front cover may open and the
 output tray may pop up.

10. Close the front cover (2).

Note
The front cover cannot be closed if the output tray is not closed securely.

11. Hold the handle (A) to close the scanner unit.
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If the Error Code is "382", "383", "385", "389"

If the "Paper jam has occurred. Please open the scanner unit and the output tray to check."
 message is displayed, a paper jam has occurred near the image drum.

Remove the jammed paper by following the procedure below.

1. Remove a document from the ADF or document glass.

2. Hold the handle (A) to open the scanner unit.

3. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.
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4. Press the output tray open button (C) and open the output tray (3).

The fuser unit is extremely hot. Do not touch it.

5. Remove all four image drums and place them on a flat surface.

6. Cover the removed image drums with paper so that the image
 drums are not exposed to light.

Possible to get burned.
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7. Remove the jammed paper remaining inside of the unit.

8. Lift the left lock lever (4) of the fuser unit forward.

9. Hold the fuser unit handle (5) and lift the fuser unit out of the
 machine.
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10. Lift the release levers (6) on the fuser unit, and pull out the
 jammed paper forward gently.

11. If jammed paper remains in the machine, hold the both sides of the
 paper to remove it gently.

12. Hold the fuser unit handle (5) and place the fuser unit into the
 machine.

13. Push the left lock lever (4) of the fuser unit backward.

14. Return all four image drums into the machine carefully.
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15. Close the output tray (3) by pushing the both sides of the cover
 firmly.

Memo
When closing the output tray, beware of the front cover. The front cover may open and the
 output tray may pop up.

16. Close the front cover (2).
Cannot close the front cover securely if the output tray is not closed.
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17. Hold the handle (A) to close the scanner unit.
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If the Error Code is "384"

Paper jams near the upper output tray. Follow the instructions to remove the jammed
 paper.

1. Remove a document from the ADF and document glass.

2. Hold the handle (A) to open the scanner unit.

3. Remove the jammed paper.

4. Hold the handle (A) to close the scanner unit.
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If the Error Code is "390"

If the "Paper jam has occurred. Please open the scanner unit and the output tray to check."
 message is displayed, a paper jam has occurred near the paper feed entrance.

Remove the jammed paper by following the procedure below.

1. Remove a document from the ADF and document glass.

2. If there is any paper on the MP tray, lift the paper set cover (1) and
 take it out.

3. Hold the handle (A) to open the scanner unit.

4. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (2) to open the front
 cover (3) forward.

716



5. Remove the jammed paper gently by pulling the edge of paper.

Remove the paper from the back gently if the edge of paper cannot be seen.

6. Close the front cover (3).
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7. If loading paper on MP tray, lift the paper set cover (1) and set the
 paper with the print side face up.

8. Lower the paper set cover (1).

Task is complete.
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If the Error Code is "391", "392", "393" or "394"

A paper jam has occurred while feeding paper from a paper tray.

Note
If paper jams occur frequently, clean the paper feed rollers. For details, refer to "Cleaning the
 Paper Feed Rollers (Tray 1/Tray 2/Tray 3/Tray 4)".

This procedure uses Tray 1 as an example.

1. Gently pull out from the machine the tray for which an error is
 indicated.

2. Remove the jammed paper.

Note
If jammed paper cannot be found, check the positions of paper guides and paper stopper
 in the tray and ensure that paper is correctly loaded.

3. Push the tray back into the machine.
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4. Insert your finger into the lever (B) on the right side of the
 machine and pull the front cover open lever (1) to open the front
 cover (2) forward.

5. Close the front cover.
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If a Document Jam Occurs

If a Document is Visible in the Paper Path

If a Document Jams in the ADF (Automatic Document Feeder)

721



If a Document is Visible in the Paper Path

1. Open the ADF cover.

2. Pull out the document upward.

3. Close the ADF cover.
Remove the document on the document tray, and then close the ADF cover.

Otherwise, documents may be torn or folded.
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If a Document Jams in the ADF (Automatic Document
 Feeder)

1. Pull the ADF cover open lever to open the ADF cover.

2. Remove the jammed document. Proceed to step 4 if you cannot
 remove the jammed document.

Note
Do not try to remove the document by force.

3. If you were able to remove the document, proceed to step 7.

4. Open the inner cover.

5. If you can see the edge of the jammed document, pull it out gently.
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6. If you were able to remove the document, close the inner cover
 and proceed to step 7.

7. Close the ADF cover.
If you cannot see the jammed document, proceed to step 8.

This completes the procedure.

Remove the document on the document tray, and then close the ADF cover.

Otherwise, documents may be torn or folded.

8. Open the document holder cover.
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9. Pull down the lever to open the document holding pad.

10. Pull the jammed paper slowly to remove it.

11. Return the document holding pad to its original position.

12. Close the document holder cover.
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This completes the procedure.

Memo
If an error occurs while copying, the copying gets canceled.
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If the STATUS Button on the Operator Panel Lights Up
 or Flashes

Checking the Problem Status

Checking the Device Situation and Job Status

You can check the status of this machine by using the  (STATUS) button.

Checking the Problem Status

If any problem occurs in this machine, the  (STATUS) button lights up or flashes. Press
 the  (STATUS) button, and check the problem status.

1. Press the  (STATUS) button.

2. Press [System Status].

3. Select an item.

Checking the Device Situation and Job Status

You can check the residual life of consumables, the counter information, and the job list
 from the  (STATUS) button.

1. Press the  (STATUS) button.

2. Press [Device Information].

3. Select an item.

4. Press [Close] or [Back].
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Copy Problems

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

Unable to Copy

The Copied Output is Different from the Original

Other Problems (Copy)
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Unable to Copy

Symptom Point to check Solution Reference

Unable to
 copy.

Is the machine
 turned on?

Turn the machine on. Turning the
 Machine On

Is the machine
 being initialized?

Wait until initialization is complete. -

Is your document
 set properly?

Set the document properly. Setting a
 Document

Is there paper in
 the tray?

Load paper in the tray.
Check that the paper cassette is installed in the
 machine.

Loading
 Paper

Is the proper size
 paper for the
 document loaded
 in the tray?

Load the proper size paper for the document. Loading
 Paper

Is the paper tray
 selectable if
 [Paper Feed] is
 set to [Auto]?

Press [Device Settings], select [Paper Setup] >
 [Select Tray] > [Copy] > the paper tray on
 which the paper you use is loaded, and then
 select [ON] or [ON(Prior)].

Specifying
 the Paper
 Feed Tray
 (Paper
 Feed)

Is the loaded
 paper compatible
 with duplex
 printing?

Duplex copying cannot be performed depending
 on the paper size,paper type, or paper weight.
Load the appropriate paper for duplex printing,
 and then set the paper size, document type,
 and document weight correctly.

Loading
 Paper

Is the media type
 of the paper tray
 set to [Plain] or
 [Recycled]?

If [Paper feed] is set to [Auto], set the media
 type for the paper tray to [Plain] or
 [Recycled].

Loading
 Paper

Is there a paper
 jam?

Check an error message, and then remove any
 jammed paper.

If Paper
 Jams Occur

Is there an empty
 toner cartridge?

Replace the empty toner cartridge with a new
 toner cartridge.

Replacing
 the Toner
 Cartridge

Does the image
 drum reach its
 lifetime?

Replace the image drum with a new image
 drum.

Replacing
 the Image
 Drum

Does the fuser
 unit reach its
 lifetime?

Replace the fuser unit with a new one. Replacing
 the Fuser
 Unit

Does the belt unit
 reach its lifetime?

Replace the belt unit with a new one. Replacing
 the Belt
 Unit

Are any covers on
 the machine
 opened?

Close all the covers. -

Has any error
 occurred?

Clear the error. Error
 Message
 List
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Is another job in
 progress?

Start copying after the other job is complete. -

Is a print job from
 a computer or
 other device in
 progress?

Wait until printing is complete. -

Is a fax being
 sent in real time?

Wait until the transmission is complete. -

Is Continuous
 Scan mode on?

Select [Scan completed] on the display screen. Enabling
 Continuous
 Scan Mode
 (Continuous
 Scan)

Is the machine
 offline?

Press the  (PRINT) button, and then select
 [Online/Offline].

-

Are you
 authorized to
 make copies?

Enter the authorized PIN or user name and
 password.

Enabling the
 Access
 Control

Unable to
 copy
 mixed size
 documents.

Is [Mixed Size]
 set to [OFF]?

Set [Mixed Size] to [ON]. Copying
 Different
 Size
 Documents
 (Mixed
 Size)

Is the size of your
 document
 supported for
 making mixed
 size copies?

Use documents sizes supported for mixed size
 copying.

Copying
 Different
 Size
 Documents
 (Mixed
 Size)

Is paper of the
 required sizes
 loaded?

Load paper of the required sizes on each paper
 tray. The paper trays need to be set to [ON] or
 [ON(Prior)] from [Device Settings] > [Paper
 Setup] > [Select Tray] > [Copy].

-

Unable to
 sort
 copies.

Is [Sort] set to
 [OFF]?

Set [Sort] to [ON]. Sorting Each
 Set in Page
 Order
 (Sort)

Is Memory full? Reduce the number of document pages.
Check the free space in Memory.
Delete unnecessary jobs in Memory.

Checking
 the Free
 Space in
 Memory
Deleting
 Unnecessary
 Jobs from
 Memory
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The Copied Output is Different from the Original

Symptom Point to check Solution Reference

The copied output is
 different from the
 original document.

Is [Duplex Copy]
 set?

Set [Duplex Copy] to
 [OFF(Simplex)].

Copying on Both
 Sides of Paper
 (Duplex Copy)

Is [Mixed Size]
 set to [ON]?

Set [Mixed Size] to [OFF]. Copying
 Different Size
 Documents
 (Mixed Size)

The size of the copied
 output is different
 from the size of the
 original document.

Is the proper size
 paper for the
 document loaded
 in the paper
 tray?

Load the proper size paper for
 the document.

Loading Paper

Is the zoom rate
 properly set?

Set the proper zoom rate. Making Enlarged
 or Reduced
 Copies (Zoom)

Is [Repeat]
 enabled?

Set [Repeat] to [OFF]. Making Multiple
 Copies on a
 Sheet of Paper
 (Repeat)

Is [Book Copy]
 enabled?

Turn [Book Copy] to OFF. Copying Two-
Page Spread
 Separately onto
 Two Sheets
 (Book Copy)

A part of the
 document image is
 missing on the
 copied output.

Is [Edge Erase]
 set to [ON]?

Set [Edge Erase] to [OFF]. Erasing Edge
 Shadows (Edge
 Erase)

Is [Center Erase]
 enabled?

Turn [Center Erase] to OFF. Erasing Shadow
 Lines (Center
 Erase)

Is [Outside Erase]
 enabled?

Turn [Outside Erase] to OFF. Erasing Outside
 of Documents
 (Outside Erase)

Is [Margin] set to
 [ON]?

Set [Margin] to [OFF]. Setting Margins
 (Margin)

Is [N-in-1]
 enabled?

Set [N-in-1] to [OFF]. Combining
 Multiple Pages
 on One Sheet
 of Paper (N-in-
1)

Color documents are
 copied in black and
 white.

Is color selection
 set to [Auto]?
The following
 documents may
 be copied in
 black and white.

Documents
 with extremely
 small colored

Set the color selection to [Color]. Switching Color
 Modes

You can change the criteria for
 determining color document and
 black and white document from
 [Auto Color Judge Level].

Scanner Setup
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 part

Dark-colored
 documents

Pale documents

Black and white
 documents are
 copied in color.

Is the color
 selection set to
 [Auto]?
The following
 documents may
 be copied in
 color.

Yellowed
 documents

Documents
 with colored
 background

Set the color selection to [Mono]. Switching Color
 Modes

You can change the criteria for
 determining color document and
 black and white document from
 [Auto Color Judge Level].

Scanner Setup
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Other Problems (Copy)

Symptom Point to check Solution Reference

It takes a
 long time
 to start
 copying.

Is [Warming Up] or
 [Preparing] displayed on
 the display screen on the
 operator panel?

The machine is preparing.
Wait until the copy is started.

-

A copy job
 is
 cancelled.

Has any error occurred? A copy job is cancelled when a specific
 error occurs while copying.
Clear the error, and then start copying
 again.

Error
 Message
 List

Is there paper in the MP
 tray?

When copying using paper from the MP
 tray, check whether enough paper is
 loaded in the MP tray before starting
 copying.
Press [Device Settings], select [Paper
 Setup] > [Select Tray] > [Copy] > [MP
 Tray], and then check that [ON] or
 [ON(Prior)] is selected.

-
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Print Problems

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

For problems caused by an application, contact the manufacturer of the application.

Unable to Print

Network Connection Problems

Wireless LAN Connection Problems

USB Connection Problems
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Unable to Print

Common to Windows and Mac OS X

Cause Solution Reference

The machine is in Sleep
 mode or Deep Sleep
 mode.

Press the  (POWER SAVE) button to enter standby
 status.

Setting
 Power
 Save Mode

The machine is turned
 off.

Turn the machine on. Turning the
 Machine
 On

A LAN cable or USB
 cable is unplugged.

Check that the cable is plugged into the machine and
 computer properly.

Connecting
 This
 Machine to
 a Network

There may be a problem
 with a cable.

Replace the cable with a new cable. -

The machine is offline. Press the  (PRINT) button, and then select
 [Online/Offline].

-

An error message is
 displayed on the display
 screen of the operator
 panel.

Check the error messages displayed on the screen
 display or press [?] on the touch panel.

Error
 Message
 List

The interface setting is
 disabled.

Whether there is a consistency with the machine's
 settings and the network connection environment,
 check the settings of the interface that you are using
 on the operator panel.

Connecting
 This
 Machine to
 a Network

There is a problem with
 the print function.

Check if the menu map can be printed. Checking
 the
 Information
 of the
 Machine

The power switch LED
 lamp quickly flashes at
 approximately 0.3-
second intervals.

A malfunction may occur in the machine. Unplug the
 power cord immediately, and then contact your
 dealer.

-

For Windows

Cause Solution Reference

The machine is not set as
 the default printer.

Set the machine as the default printer.
Right-click the OKI MC873 icon on the [Devices and
 Printers] folder, and then select [Set as Default Printer]
 (if multiple drivers are installed, select [OKI
 MC873(*)]).
* Select the required driver type.

-

The output port of the
 printer driver is incorrect.

Select the output port for connecting the LAN cable or
 USB cable.

-
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The machine is processing
 data from another
 interface.

Wait until printing is complete. -

[Received invalid data] is
 displayed on the display
 screen and the machine
 does not print.

Press [Device Settings], select [Admin Setup] > [Print
 Setup] > [Print menu] > [Printer Adjust] > [Timeout
 Injob], and then select a longer time. The factory
 default setting is 40 seconds.

-
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Network Connection Problems

Common to Windows and Mac OS X

Cause Solution Reference

Using a cross cable. Use a straight cable. -

The machine was
 turned on before a
 cable was
 connected.

Connect cables before turning the machine on. Connecting
 This
 Machine to
 a Network

There is a problem
 with the
 compatibility with
 the hub.

Press [Device Settings], select [Admin Setup] > [Network
 Menu] > [Network Setup] > [Network Setting] > [HUB
 Link Setting], and then change the setting.

-

The network
 connection setting is
 incorrect.

This machine cannot connect to a wired LAN and wireless
 LAN at the same time. To connect to a wired network, set
 the network connection to wired.

Connecting
 This
 Machine to
 a Network

For Windows

Cause Solution Reference

The IP address
 is incorrect.

Check that the same IP address is set for the machine
 and the machine's port setting on the computer.

Check that the IP address is not duplicated by another
 device.

Check that the correct IP address, subnet mask, and
 gateway address are set.

If using OKI LPR Utility, check the IP address setting with
 OKI LPR Utility.

Easy Setup
Printing by Using
 OKI LPR Utility

All pages are
 not printed.

If you are using the WSD port, change it to the standard
 TCP/IP port.

-
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Wireless LAN Connection Problems

Common to Windows and Mac OS X

Cause Solution Reference

The network
 connection setting is
 incorrect.

This machine cannot connect to a wired LAN and wireless
 LAN at the same time. To connect to a wireless network,
 set the network connection to wireless.

Connecting
 This
 Machine
 to a
 Network

Not connected to a
 wireless access point.
 (If wireless LAN
 module is fitted)

Check that the wireless access point power is switched
 on.

Check the wireless access point settings, and then try
 the manual settings or automatic settings.

Restart the wireless LAN function.

Press [Device Settings], select [Admin Setup] >
 [Network Menu] > [Network Setup] > [Wireless
 Setting], and then select [Wireless reconnection].

Install this machine in a place with a good view and
 near a wireless access point. (We suggest that the
 distance between the machine and the access point
 be 30 m or less.)

If there is metal, aluminum sash, or a reinforced
 concrete wall between the machine and wireless
 access points, connections may be harder to be
 established.

Do not place any electric appliances that emit weak
 radio waves (such as microwaves or digital cordless
 telephones) close to the machine.

Connecting
 This
 Machine
 to a
 Network

For Windows

Cause Solution Reference

The IP address
 is incorrect.

Check that the same IP address is set for the machine
 and the machine's port setting on the computer.

Check that the IP address is not duplicated by another
 device.

Check that the correct IP address, subnet mask, and
 gateway address are set.

If using OKI LPR Utility, check the IP address setting with
 OKI LPR Utility.

Easy Setup
Printing by Using
 OKI LPR Utility

All pages are
 not printed.

If you are using the WSD port, change it to the standard
 TCP/IP port.

-
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USB Connection Problems

Common to Windows and Mac OS X

Cause Solution Reference

An unsupported USB cable
 is used.

Use a USB 2.0 cable. -

A USB hub is used. Directly connect the machine to
 the computer.

Connecting via a USB Interface

A printer driver is not
 installed correctly.

Reinstall the printer driver. Installing a Driver and Software
 to a Computer

For Windows

Cause Solution Reference

[USB Assignment]
 is set to [IPP].

Press [Device Settings], and then select [AdminSetup] >
 [Management] > [Local Interface] > [USB Menu] > [USB
 Assignment] > [Legacy].

Management

The machine is
 offline.

Right-click the OKI MC873 icon on the [Devices and
 Printers] folder, and then select [See print jobs] (if
 multiple drivers are installed, select [OKI MC873(*)]). In
 the dialog box, select the [Printer] menu and then clear
 the check of [Use Printer Offline].
* Select the required driver type.

-

A switch, buffer,
 extension cable, or
 USB hub is used.

Directly connect the machine to the computer. Connecting
 via a USB
 Interface

Another printer
 driver that works
 when connected
 via a USB
 interface is
 installed.

Remove the other printer driver from the computer. -
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Scan Problems

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

Unable to Scan

Unable to Send and Receive E-Mail

Unable to Save Files in a Network Folder

Network Connection Problems

Wireless LAN Connection Problems
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Unable to Scan

Point to check Solution Reference

Is the machine turned
 off?

Turn the machine on. Turning the Machine
 On

Is the cable connected
 to the machine?

Check the cable connections, and then
 connect the cables properly.

Connecting This
 Machine to a Network

Is there any damage to
 the cable?

Change the cable. -

Is the network setting
 correct?

Set the network setting correctly. Connecting This
 Machine to a Network

Has any error occurred? Follow the on-screen instructions on the
 display screen of the machine.

Error Message List
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Unable to Send and Receive E-Mail

Point to check Solution Reference

Did you connect
 the LAN cable
 after turning
 the machine
 on?

Turn the machine off. Connect the LAN cable before turning the
 machine on.

Turning
 the
 Machine
 Off

Is the E-mail
 address of the
 machine set?

Set the e-mail address of the machine. Before
 Using
 Scan To
 E-mail

Is the entered e-
mail address is
 correct?

Enter the correct e-mail address. Before
 Using
 Scan To
 E-mail

Is the SMTP
 server address
 correct?

Check the SMTP server setting. Before
 Using
 Scan To
 E-mail

Is the POP3
 server address
 correct?

Check the POP3 server setting. Before
 Using
 Scan To
 E-mail

Is the DNS
 server address
 correct?

Check the DNS server setting. Easy
 Setup

Is another job in
 progress?

Wait until the other job is complete. -

Has any error
 occurred?

Follow the on-screen instructions on the display screen of the
 machine.

Error
 Message
 List

The network
 connection
 setting is
 incorrect.

This machine cannot connect to a wired LAN and wireless LAN
 at the same time. To connect to a wired network, set the
 network connection to wired. To connect to a wireless network,
 set the network connection to wireless.

Connecting
 This
 Machine
 to a
 Network

Not connected
 to a wireless
 access point.

Check that the wireless access point power switch is turned
 on.

Check the wireless access point settings, and then perform
 the manual settings or automatic settings.

Restart the wireless LAN function.

Press [Device Settings], select [Admin Setup] > [Network
 Menu] > [Network Setup] > [Wireless Setting], and then
 select [Wireless reconnection].

Connecting
 This
 Machine
 to a
 Network
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Unable to Save Files in a Network Folder

Point to check Solution Reference

Is the FTP/CIFS
 setting correct?

Check the profile settings. Before Using Scan To
 Shared Folder

Has any error
 occurred?

Follow the on-screen instructions on the display
 screen of the machine.

Error Message List

746



Network Connection Problems

Common to Windows and Mac OS X

Cause Solution Reference

Using a cross cable. Use a straight cable. -

The machine was
 turned on before a
 cable was
 connected.

Connect cables before turning the machine on. Connecting
 This
 Machine to
 a Network

There is a problem
 with the
 compatibility with
 the hub.

Press [Device Settings], select [Admin Setup] > [Network
 Menu] > [Network Setup] > [Network Setting] > [HUB
 Link Setting], and then change the setting.

-

The network
 connection setting is
 incorrect.

This machine cannot connect to a wired LAN and wireless
 LAN at the same time. To connect to a wired network, set
 the network connection to wired.

Connecting
 This
 Machine to
 a Network

For Windows

Cause Solution Reference

The IP address
 is incorrect.

Check that the same IP address is set for the machine
 and the machine's port setting on the computer.

Check that the IP address is not duplicated by another
 device.

Check that the correct IP address, subnet mask, and
 gateway address are set.

If using OKI LPR Utility, check the IP address setting with
 OKI LPR Utility.

Easy Setup
Printing by Using
 OKI LPR Utility
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Wireless LAN Connection Problems

Common to Windows and Mac OS X

Cause Solution Reference

The network
 connection setting is
 incorrect.

This machine cannot connect to a wired LAN and wireless
 LAN at the same time. To connect to a wireless network,
 set the network connection to wireless.

Connecting
 This
 Machine
 to a
 Network

Not connected to a
 wireless access point.
 (If wireless LAN
 module is fitted)

Check that the wireless access point power is switched
 on.

Check the wireless access point settings, and then try
 the manual settings or automatic settings.

Restart the wireless LAN function.

Press [Device Settings], select [Admin Setup] >
 [Network Menu] > [Network Setup] > [Wireless
 Setting], and then select [Wireless reconnection].

Install this machine in a place with a good view and
 near a wireless access point. (We suggest that the
 distance between the machine and the access point
 be 30 m or less.)

If there is metal, aluminum sash, or a reinforced
 concrete wall between the machine and wireless
 access points, connections may be harder to be
 established.

Do not place any electric appliances that emit weak
 radio waves (such as microwaves or digital cordless
 telephones) close to the machine.

Connecting
 This
 Machine
 to a
 Network

For Windows

Cause Solution Reference

The IP address
 is incorrect.

Check that the same IP address is set for the machine
 and the machine's port setting on the computer.

Check that the IP address is not duplicated by another
 device.

Check that the correct IP address, subnet mask, and
 gateway address are set.

If using OKI LPR Utility, check the IP address setting with
 OKI LPR Utility.

Easy Setup
Printing by Using
 OKI LPR Utility
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Fax Problems

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

Unable to Send a Fax

Unable to Receive a Fax

Unable to Send or Received a Fax

Other Problems (Fax)

Fax Error Codes
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Unable to Send a Fax

Symptom Point to check Solution Reference

Unable to send a fax. Did you send in the
 correct procedure?

Check the procedure,
 and then try again.

Sending a Fax
 (Procedure)

Did you specify the
 correct fax
 number?

If you are using
 speed dial, print the
 speed dial list to
 check the
 registration.

Specifying a Destination
 (Direct Entry)
Specifying a Destination
 (Phone Book)
Specifying a Destination
 (One-touch Button)
Specifying a Destination
 (Transmission History
 and Reception History)

Did you specify the
 appropriate dial
 type?

Specify the
 appropriate dial type
 for your region.

User Install

Has any problem
 occurred at the
 recipient machine?

Ask the recipient to
 have the recipient's
 machine ready for
 reception.

-

A document cannot be
 sent continuously.

Did you set the
 document
 correctly in the
 ADF?

Set the document
 after aligning the
 leading edge.

Setting a Document

After dialing, even if the
  (START) button is
 pressed, the machine
 cannot send a fax.

Did you specify the
 appropriate dial
 type?

Specify the
 appropriate dial type
 for your region.

User Install

Is the document
 set properly?

Set the document
 properly.

Setting a Document

Did you dial the
 correct number?

Dial the correct
 number.

-

Is the recipient's
 line busy?

Wait until the line is
 opened, and then
 try again.

-

Unable to send a fax
 manually.

Did you put the
 handset down
 before pressing
 the  (START)
 button?

Press the 
 (START) button
 first.

Sending a Fax after
 Calling (Manual
 Transmission)

A document cannot be
 scanned during
 Memory transmission.

Is the document
 set properly?

Set the document
 properly.

Setting a Document

Is Memory full? Check the reserved
 transmission.
Print the documents
 received with the
 confidential
 transmission.
Delete the
 documents stored in
 the bulletin board
 box.

Sending at a Specified
 Date and Time (Delayed
 Tx)
Printing a Document
 That is Received in the
 Confidential Box of This
 Machine
Receiving a Document
 That is Saved in a
 Destination Bulletin
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Delete the
 documents stored in
 the Secure Receive.

 Board Box by Fax
 (Fcode Polling)
Setting Secure
 Reception
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Unable to Receive a Fax

Symptom Point to check Solution Reference

Unable to
 receive a
 fax.

Did you specify the
 appropriate reception
 mode?

Check the reception
 mode.

Setting the Reception
 Mode

Is there paper in the tray? Load the paper. Loading Paper

Is there a paper jam? Check an error
 message, and then
 remove any jammed
 paper.

If Paper Jams Occur

Is a telephone cable
 connected to the machine
 and telephone line
 correctly?

Connect the telephone
 cable correctly.

Connecting a Telephone
 Line

Is Memory full? Check the reserved
 transmission.
Check whether paper
 jams or paper runs
 out.

Cancelling a Fax
 Transmission
If Paper Jams Occur

Print the documents
 received with the
 confidential
 transmission.
Delete the documents
 stored in the bulletin
 board box.
Delete the documents
 stored in the Secure
 Receive.

Printing a Document That
 is Received in the
 Confidential Box of This
 Machine
Deleting Unnecessary
 Jobs from Memory
Setting Secure Reception

Unable to
 receive a fax
 manually.

Did you put the handset
 down before pressing the 

 (START) button?

Press the  (START)
 button first.

Setting the Reception
 Mode

Fcode polling
 reception is
 not
 available.

Did the sender store a
 polling document in a
 bulletin box?

Ask the sender to
 store the polling
 document.

-
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Unable to Send or Received a Fax

Symptom Point to check Solution Reference

Unable to
 send or
 receive a
 fax.

Did you install an IP phone on
 the machine in a broadband
 environment?

Press [Device Settings], and then
 select [Admin Setup] > [User Install]
 > [Super G3] > [OFF].

User
 Install
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Other Problems (Fax)

Symptom Point to check Solution Reference

The received
 fax is not
 printed on the
 appropriate
 paper.

Did you specify any
 paper type in a tray
 other than [Plain] or
 [Recycled] in [Media
 Type]?

Specify [Plain] or [Recycled] in
 [Media Type] for the paper type
 in the tray.

Setting a Print
 Method for
 When a
 Received Image
 Exceeds Paper
 Size

Junk faxes are
 received.

Is [Block Junk Fax] set
 to [OFF]?

Press [Device Settings] >
 [AdminSetup] > [Fax Sestup] >
 [Other Settings] > [Block Junk
 Fax] > Set [Setting] to [Mode1].

Block Junk Fax
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Fax Error Codes

Error Code Description

01 Your control stopped the communication.

02 The capacity didn't match with the destination. Check the dest. machine.

03 Your control stopped the communication.

11 A document read error occurred. Try again.

14 Memory Overflow.

19 Your control stopped the communication.

21 No dial tone was detected.
Check phone line connection.

22 The destination machine did not respond. Check the machine.

23 The destination didn't receive the communication. Check the destination.

24 No dial tone was detected. Check phone line connection.

25 No dial tone was detected. Check phone line connection.

26 No dial tone was detected. Check phone line connection.

27 The line was busy. Try again.

32 The start of communication in Super G3 mode was not completed.

35 Rx failed as there was no applicable Fcode box.

36 Rx was cancelled as the Fcode box was full.

37 Polling Tx failed as there was no applicable Fcode box.

38 Polling Tx was cancelled as the Fcode box was not accessible.

39 Rx was cancelled as the Fcode box was not accessible.

40 The destination machine did not respond. Check the machine.

41 Tx failed with the minimum speed. Try again.

43 There was no response from the destination machine. Check the machine.

45 There was no response from the destination machine. Check the machine.

46 There was no response from the destination machine. Check the machine.

47 The wrong signal was received.
Check the destination machine.

48 The capacity didn't match with the destination. Check the dest. machine.

49 The destination machine did not respond. Check the machine.

4A Through ID check Tx, the destination was not in agreement with ID.

4B Rx was rejected by Block Junk Fax function.

4C The capacity didn't match with the destination. Check the dest. machine.

4D The capacity didn't match with the destination. Check the dest. machine.

51 Error in myself.

52 Rx was cancelled as the image was not received correctly.
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60 The destination machine did not respond. Try again.

65 The destination machine did not respond. Try again.

66 The destination machine could not receive the document properly.

67 The wrong signal was received. Check the destination machine.

69 The wrong signal was received. Check the destination machine.

6A There were pages which could not be received correctly.

80 Error in myself.

82 The start of communication in SuperG3 mode was not completed.

83 The start of communication in SuperG3 mode was not completed.

84 Error in myself.

90 Too many characters.
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About Problems with Printing Results

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

List of Examples of Problems

Vertical White Lines Appear

Paper feeding direction

Printed Images are Fading Vertically

Paper feeding direction

Printed Images are Light White Spots and Lines Appear

Dew Condensation Appears on
 Printed Paper

Vertical Lines Appear

Paper feeding direction

Horizontal Lines and Spots Appear
 Periodically

Paper feeding direction

White Area on Paper is Lightly Stained

The Periphery of Characters is
 Smudged

The Entire Paper Area is Lightly Stained When Printing on
 Envelopes or Coated Paper
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Toner Comes Off When Printed
 Paper is Rubbed

Uneven Gloss

Black or White Dots Appear Dirt is Printed

The Entire Page is Printed Black Nothing is Printed

White Patches Appear The Entire Page is Dirty

The Peripheral Area of the Page is
 Dirty

The Printed Image is Skewed

Color of the printed image is not
 what you expect

Solid printing of CMY 100% is too light

758



Vertical White Lines Appear

Cause Solution Reference

The LED head is
 dirty.

Wipe the LED head with a soft tissue paper. Cleaning the LED Head

The toner is low. If "Toner Low" or "Toner Empty. Replace
 with new Toner Cartridge." appears, replace
 the toner cartridge.

Replacing the Toner
 Cartridge

The lightproof film
 of the image drum
 is dirty.

Wipe the lightproof film with a soft tissue
 paper.

-

The image drum is
 not installed
 properly.

Install the image drum properly. Replacing the Image Drum

The ADF document
 glass is dirty.

Clean the ADF document glass. Cleaning the Document
 Glass
Cleaning the Document
 Feed Rollers and
 Document Holding Rollers

There may be
 foreign objects in
 the image drum.

Replace the image drum. Replacing the Image Drum
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Printed Images are Fading Vertically

Cause Solution Reference

The LED
 head is
 dirty.

Wipe the LED head with a soft tissue paper. Cleaning the
 LED Head

The toner is
 low.

If "Toner Low" or "Toner Empty. Replace with new Toner
 Cartridge." appears, replace the toner cartridge.

Replacing the
 Toner
 Cartridge

The paper is
 unsuitable.

Use recommended paper. Loading Paper
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Printed Images are Light

Cause Solution Reference

The toner is low. If "Toner Low" or "Toner Empty. Replace with new Toner
 Cartridge." appears, replace the toner cartridge.

Replacing
 the
 Toner
 Cartridge

The paper is
 damp.

Use paper stored under proper temperature and humidity
 conditions.

Loading
 Paper

The paper is
 unsuitable.

Use recommended paper. Loading
 Paper

The paper is
 unsuitable.
The settings of
 the media type
 and weight are
 incorrect.

Press [Device Settings], select [Paper Setup] > the paper tray
 you are using, and then select the proper values for [Media
 Type] and [Media Weight]. Or, select a thicker values for
 [Media Weight].

Loading
 Paper

Recycled paper is
 used.

Press [Device Settings], and then select [Paper Setup] > the
 paper tray you are using, and then select the proper values for
 [Media Type] and [Media Weight].

Loading
 Paper
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White Spots and Lines Appear

Cause Solution Reference

The paper is damp or
 dry.

Use paper stored under proper temperature and humidity
 conditions.

Loading
 Paper
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Dew Condensation Appears on Printed Paper

Cause Solution Reference

The paper is damp. Use paper stored under proper
 temperature and humidity
 conditions.

Loading
 Paper

The machine is printing when the
 temperature and humidity conditions are
 high.

Use the machine under proper
 temperature and humidity
 conditions.

Installation
 Requirements
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Vertical Lines Appear

Cause Solution Reference

The toner is low. If "Toner Low" or "Toner Empty. Replace
 with new Toner Cartridge." appears,
 replace the toner cartridge.

Replacing the Toner
 Cartridge

The document glass and
 document feed roller of
 the ADF are dirty.

Clean the document glass and document
 feed roller.

Cleaning the Document
 Glass
Cleaning the Document
 Feed Rollers and
 Document Holding
 Rollers

The image drum is
 damaged.

Replace the image drum. Replacing the Image
 Drum
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Horizontal Lines and Spots Appear Periodically

Cause Solution Reference

If the intervals of lines or spots are
 approximately 94 mm (3.7 inches), the
 green tube of the image drum is
 damaged or dirty.

Lightly wipe the image drum with a soft
 tissue paper.
Replace the image drum if it is damaged.

Replacing
 the
 Image
 Drum

If the intervals of lines or spots are
 approximately 40 mm (1.6 inches),
 there may be foreign objects in the
 image drum.

Open and close the output tray, and then
 print again.

-

The image drum has been exposed to
 light.

Place the image drum back into the
 machine, and then do not use for a few
 hours. If the problem persists, replace
 the image drum.

Replacing
 the
 Image
 Drum

The paper feed path is dirty. Print a few test copies. Copying
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White Area on Paper is Lightly Stained

Cause Solution Reference

The paper has a
 static charge.

Use paper stored under proper temperature and humidity
 conditions.

Loading Paper

The paper is too
 thick.

Use thinner paper. Loading Paper

The toner is low. If "Toner Low" or "Toner Empty. Replace with new Toner
 Cartridge." appears, replace the toner cartridge.

Replacing the
 Toner
 Cartridge
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The Periphery of Characters is Smudged

Cause Solution Reference

The LED head is dirty. Wipe the LED head with a soft tissue paper. Cleaning the LED Head

The paper is unsuitable. Use recommended paper. Loading Paper

The paper is damp. Replace the damp paper with new paper. Loading Paper
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The Entire Paper Area is Lightly Stained When Printing
 on Envelopes or Coated Paper

Cause Solution Reference

The toner may stick to the whole area of the envelope
 or coated paper.

This is not a malfunction.
Coated paper is not
 recommended.

-
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Toner Comes Off When Printed Paper is Rubbed

Cause Solution Reference

The settings of the
 media type and
 weight are
 incorrect.

Press [Device Settings], select [Paper Setup] > the paper tray
 you are using, and then select the proper values for [Media
 Weight]. Or, select a thicker value for [Media Weight].

Loading
 Paper

Recycled paper is
 used.

Press [Device Settings], select [Paper Setup] > the paper tray
 you are using, and then select a thicker value for [Media
 Weight].

Loading
 Paper
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Uneven Gloss

Cause Solution Reference

The settings of the
 media type and
 weight are
 incorrect.

Press [Device Settings], select [Paper Setup] > the paper tray
 you are using, and then select the proper value for [Media
 Weight]. Or, select a thicker value for [Media Weight].

Loading
 Paper
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Black or White Dots Appear

Cause Solution Reference

The paper is unsuitable. Use recommended
 paper.

Loading
 Paper

If the intervals of lines or spots are approximately
 94 mm (3.7 inches), the green tube of the image drum
 is damaged or dirty.

Lightly wipe the image
 drum with a soft tissue
 paper.
Replace the image
 drum if it is damaged.

Replacing
 the Image
 Drum

The document glass or document holding pad is dirty. Clean the document
 glass and document
 holding pad.

Cleaning
 the
 Document
 Glass
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Dirt is Printed

Cause Solution Reference

The paper is damp. Replace the damp paper with new
 paper.

Loading Paper

The paper is unsuitable. Use recommended paper. Loading Paper

The document glass or document
 holding pad is dirty.

Clean the document glass and
 document holding pad.

Cleaning the
 Document Glass

772



The Entire Page is Printed Black

Cause Solution Reference

A malfunction may occur in the machine. Contact your dealer. -
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Nothing is Printed

Cause Solution Reference

Two or more sheets of paper are fed at
 the same time.

Fan the paper well and load the
 paper again.

Loading Paper

The document is set upside down. Set the document properly. Setting a
 Document

A malfunction may occur in the machine. Contact your dealer. -
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White Patches Appear

Cause Solution Reference

The paper is damp. Replace the damp paper with new
 paper.

Loading Paper

The paper is unsuitable. Use recommended paper. Loading Paper

The document glass is
 dirty.

Clean the document glass. Cleaning the Document
 Glass
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The Entire Page is Dirty

Cause Solution Reference

The document glass is
 dirty.

Clean the document glass. Cleaning the
 Document Glass

The image on the back
 side of a duplex document
 is printed.

If the duplex document is thin, the image
 on the back side may be printed. Lighten
 the density.
Change Show-Through Removal setting or
 lighten the density.

Adjusting the Density
 (Density)
Removing Show-
Through (Show-
Through Removal)
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The Peripheral Area of the Page is Dirty

Cause Solution Reference

The document feed roller or document
 holding pad is dirty.

Clean the document
 feed roller and
 document holding pad.

Cleaning the Document
 Feed Rollers and Document
 Holding Rollers

The paper size is bigger than the size
 of the document (when the zoom rate
 is set to 100%).

Use paper of the same
 size as the document.

Making Enlarged or
 Reduced Copies (Zoom)
Enlarging or Reducing to Fit
 the Specified Paper Size
Setting a Print Method for
 When a Received Image
 Exceeds Paper Size

The document orientation is different
 from the paper orientation.

Set the document
 orientation to suit
 paper.

Changing the Document
 Orientation (Direction)

The document is not reduced at the
 rate that suits the paper size.

Reduce the document at
 the rate that suits the
 paper size.

Making Enlarged or
 Reduced Copies (Zoom)
Enlarging or Reducing to Fit
 the Specified Paper Size
Setting a Print Method for
 When a Received Image
 Exceeds Paper Size
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The Printed Image is Skewed

Cause Solution Reference

The document is set improperly. Set the document
 properly.

Setting a Document

An unsuitable document is set in
 the ADF.

Set a suitable
 document in the
 ADF.

Setting a Document

There may be foreign objects on
 the ADF document glass.

Clean the ADF
 document glass.

Cleaning the Document Glass
Cleaning the Document Feed Rollers
 and Document Holding Rollers
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Color of the printed image is not what you expect

Cause Solution Reference

The toner is low. If "Toner Low" or "Toner Empty. Replace with
 new Toner Cartridge." appears, replace the toner
 cartridge.

Replacing the
 Toner Cartridge

The setting of [Black
 Finish] is not suitable
 for the application.

On the printer driver, select [Composite Black
 (CMYK)] of [True Black (K)] for [Black Finish].

About Screens
 and Functions of
 Each Printer
 Driver

The color adjustment
 has been modified.

Do color matching from the printer driver. Color Matching
 (Office Color)
Color Matching
 (Graphic Pro)

The color balance is out
 of adjustment.

Press [Device Settings] > [Admin Setup] > [Color
 Setup], and adjust density or color balance.

Correcting
 Density Manually
Adjusting Color
 Balance
 (Density)

Color registration is out
 of alignment.

Open and close the output tray. Or, press [Device
 Settings] > [Admin Setup] > [Color Setup], and
 then [Adjust Registration].

Print Setup
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Solid printing of CMY 100% is too light

Cause Solution Reference

[CMY100% Density] is
 set to [Disable].

Press [Device Settings] > [Admin Setup] > [Color Setup] >
 [CMY100% Density], and then select [Enable].

-
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Problems about Software

Problems on Configuration Tool

Problems on a Web Browser

Problems on Other Software

About Restrictions on Each OS
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Problems on Configuration Tool

[Device Setting] tab
Cloning

Symptom Cause Solution Reference

A copy destination device
 is not displayed on the
 screen.

The model name of the copy
 destination device is different.
Cloning functions only between
 the devices with the same
 model name.

Check the model
 name of the copy
 destination device.

-

If multiple devices are
 specified as copy
 destinations, copying
 cannot be made to some
 of the devices.

The entered administrator
 password is different from the
 administrator password of the
 device to which copying cannot
 be made.

Check the
 administrator
 password of the
 device to which
 copying cannot be
 made.

-

[User Setting] tab
E-mail Address Manager

Symptom Cause Solution Reference

Some
 items
 cannot be
 edited.

The items are locked
 because other
 functions use them.

Unlock the used item before editing. -

Cannot
 edit at all

The items are locked
 because this
 machine is being set
 from another
 computer.

Wait until setting from another computer
 is complete.
Alternatively, interrupt setting from
 another computer before editing.

-

Cannot
 set the
 edits to
 this
 machine

Editing is timed out. Set a longer time-out period for this
 machine before editing.
Press [Device Settings], select [Admin
 Setup] > [Management] > [System
 Setup] > [Address Information Lock Time
 Out], and then enter any period of time.

Management

Speed Dial Manager

Symptom Cause Solution Reference

Some
 items
 cannot be
 edited.

The items are locked
 because other
 functions use them.

Unlock the used item before editing. -

Cannot
 edit at all

The items are locked
 because this
 machine is being set
 from another
 computer.

Wait until setting from another computer
 is complete.
Alternatively, interrupt setting from
 another computer before editing.

-

Cannot Editing is timed out. Set a longer time-out period for this Management
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 set the
 edits to
 this
 machine

 machine before editing.
Press [Device Settings], select [Admin
 Setup] > [Management] > [System
 Setup] > [Address Information Lock Time
 Out], and then enter any period of time.

Profile Manager

Symptom Cause Solution Reference

Some
 items
 cannot be
 edited.

The items are locked
 because other
 functions use them.

Unlock the used item before editing. -

Cannot
 edit at all

The items are locked
 because this
 machine is being set
 from another
 computer.

Wait until setting from another computer
 is complete.
Alternatively, interrupt setting from
 another computer before editing.

-

Cannot
 set the
 edits to
 this
 machine

Editing is timed out. Set a longer time-out period for this
 machine before editing.
Press [Device Settings], select [Admin
 Setup] > [Management] > [System
 Setup] > [Address Information Lock Time
 Out], and then enter any period of time.

Management

Network Scan Manager

Symptom Cause Solution Reference

Some
 items
 cannot be
 edited.

The items are locked
 because other
 functions use them.

Unlock the used item before editing. -

Cannot
 edit at all

The items are locked
 because this
 machine is being set
 from another
 computer.

Wait until setting from another computer
 is complete.
Alternatively, interrupt setting from
 another computer before editing.

-

Cannot
 set the
 edits to
 this
 machine

Editing is timed out. Set a longer time-out period for this
 machine before editing.
Press [Device Settings], select [Admin
 Setup] > [Management] > [System
 Setup] > [Address Information Lock Time
 Out], and then enter any period of time.

Management

Cloning

Symptom Cause Solution Reference

A copy destination
 device is not
 displayed on the
 screen.

The model name of the copy
 destination device is
 different.
Cloning functions only
 between the devices with
 the same model name.

Check the model name of
 the copy destination device.

-

If multiple devices
 are specified as
 copy destinations,
 copying cannot be
 made to some of
 the devices.

The entered administrator
 password is different from
 the administrator password
 of the device to which
 copying cannot be made.

Check the administrator
 password of the device to
 which copying cannot be
 made.

-
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Copying cannot be
 made to a device
 by performing
 cloning with the
 following functions.

E-mail Address
 Manager

Speed Dial
 Manager

Profile Manager

Network Scan
 Manager

Auto Delivery
 Manager

Information that is to be
 replaced in the copy
 destination device is locked
 because it is being edited or
 used.

Unlock the used information
 before performing cloning.

-

If I perform cloning
 with Auto Delivery
 Manager, the
 following settings
 are also copied.

E-mail Address
 Manager

Speed Dial
 Manager

Profile Manager

If e-mails or speed dials are
 used for the auto delivery
 settings of the copy source
 device, these settings also
 need to be copied at the
 same time.

To copy only the auto
 delivery settings, delete the
 e-mail, speed dial, or other
 settings from the copy
 source device before
 performing cloning.

-

[Alert Info] tab

Symptom Cause Solution Reference

Cannot enable an alert
 on the [Alert
 Info(Detect and notify
 of device events)]
 screen

[Save the Log
 setup] in this
 machine is
 disabled.

Follow the procedure below:
1. Press [Device Settings], select
 [Admin Setup] > [Management] >
 [Job Log Setup] > [Save Job Log],
 and then select [Enable].
2. Press [Yes] on the confirmation
 screen to reboot the machine.
3. Click [Update device] on the
 [Alert Info(Detect and notify of
 device events)] screen.

Management
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Problems on a Web Browser

Symptom Point to check Solution

Unable to connect with
 the machine

A LAN cable is
 unplugged.

Check that the cable is plugged into the machine
 and computer properly.

The IP address is
 incorrect.

Check the IP address of the machine and enter it
 correctly.
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Problems on Other Software

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

For problems caused by an application, contact the manufacturer of the application.

USB Connection Problems (For Windows)

Symptom Cause/solution Reference

An icon for the machine is not
 created on the [Devices and
 Printers] folder.

The printer driver is not installed
 correctly.
Reinstall the printer driver correctly.

Installing a
 Driver and
 Software to a
 Computer

When a printer driver is
 already installed, another
 printer driver cannot be
 installed.

Perform [Custom Install] by following the
 procedure described in the reference.

Installing a
 Driver and
 Software to a
 Computer

The [Unable to install printer
 driver] error message is
 displayed.

Use Plug-and-Play. Follow the procedure
 below:
1. Check that the machine and computer
 are turned off.
2. Connect a USB cable.
3. Turn the machine on.
4. Turn the computer on.
5. When the [Found New Hardware
 Wizard] is displayed, follow the on-screen
 instructions to complete the setup.

-
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About Restrictions on Each OS

Windows 8/ Windows Server 2012/ Windows 7/ Windows Vista/ Windows Server 2008
 R2/ Windows Server 2008

Windows Server 2003 Service Pack 1

This chapter describes about the restrictions for the printer drivers or utilities.

Windows 8/ Windows Server 2012/ Windows 7/
 Windows Vista/ Windows Server 2008 R2/ Windows
 Server 2008

Item Symptom Cause/solution

Printer driver [Help] is not
 displayed.

The Help function is not supported.

The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog box may be displayed. Click [Yes] or
 [Continue] to run the installer or utility as the administrator.
 If you click [No] or [Cancel], the installer or utility does not
 start.

Network
 Extension

[Help] is not
 displayed.

The Help function is not supported.

The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog may be displayed. Click [Yes] or [Continue]
 to run the installer or utility as the administrator. If you click
 [No], the installer or utility does not start.

The [Program
 Capability
 Assistant]
 dialog box is
 displayed.

If the [Program Capability Assistant] dialog box is displayed
 after installation (including if you stop installation before it is
 complete), be sure to click [This program installed].

Color Correct
 Utility

The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog may be displayed. Click [Yes] or [Continue]
 to run the installer or utility as the administrator. If you click
 [No], the installer or utility does not start.

The [Program
 Capability
 Assistant]
 dialog box is
 displayed.

If the [Program Capability Assistant] dialog box is displayed
 after installation (including if you stop installation before it is
 complete), be sure to click [This program installed correctly].

ColorSwatchUtility The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog may be displayed. Click [Yes] or [Continue]
 to run the installer or utility as the administrator. If you click
 [No], the installer or utility does not start.

The [Program
 Capability
 Assistant]
 dialog box is

If the [Program Capability Assistant] dialog box is displayed
 after installation (including if you stop installation before it is
 complete), be sure to click [This program installed correctly].
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 displayed.

PS Gamma
 Adjuster

The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog may be displayed. Click [Yes] or [Continue]
 to run the installer or utility as the administrator. If you click
 [No], the installer or utility does not start.

The [Program
 Capability
 Assistant]
 dialog box is
 displayed.

If the [Program Capability Assistant] dialog box is displayed
 after installation (including if you stop installation before it is
 complete), be sure to click [This program installed correctly].

ActKey The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog may be displayed. Click [Yes] or [Continue]
 to run the installer or utility as the administrator. If you click
 [No], the installer or utility does not start.

Configuration Tool The [User
 Account
 Control]
 dialog box is
 displayed.

When you start an installer or utility, the [User Account
 Control] dialog may be displayed. Click [Yes] or [Continue]
 to run the installer or utility as the administrator. If you click
 [No], the installer or utility does not start.

Windows Server 2003 Service Pack 1

Notes for Windows Firewall
On Windows Server 2003 Service Pack 1, the Windows firewall function is enhanced. The
 following restrictions may apply to printer drivers and utilities.

Item Symptom Cause/solution

Printer
 driver

Unable to print a
 file when using
 this machine as a
 shared printer on
 a network.

On the server, click [start], and then select [Control Panel] >
 [Windows Firewall].
Select the [Exceptions] tab, select the [File and Printer Sharing]
 check box, and then click [OK].

OKI
 LPR
 Utility

Unable to find a
 printer.

If the [Don't allow exceptions] check box is selected on the
 [General] tab of the Windows firewall, you cannot search for a
 printer in a segment that is connected to another router. Only
 printers within the same segment as the printer are the search
 target.
If you cannot find a printer, specify the IP address of the printer
 on the [Add Printer] or [Confirm Connections] screen.
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Problems on the Machine or Paper

Problems on the Machine

Problems on Document and Paper

If a Power Failure Occurs
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Problems on the Machine

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

Symptom Cause Solution Reference

Nothing is displayed
 on the display
 screen after turning
 the machine on.

The power cord is
 unplugged.

Turn the machine off, and
 then plug in the power cord
 firmly.

-

The power is out. Check whether the power is
 supplied to the outlet.

-

The machine does
 not operate.

The power cord is not
 firmly plugged in.

Plug in the power cord
 firmly.

-

The machine is turned off. Turn the machine on. Turning the
 Machine On

The power switch
 LED lamp quickly
 flashes at
 approximately 0.3-
second intervals.

A malfunction may occur
 in the machine.

Unplug the power cord
 immediately, and then
 contact your dealer.

-

The power switch
 LED lamp lights,
 the  (POWER
 SAVE) button is
 turned on and
 nothing is displayed
 on the operation
 panel.

The screen saver screen is
 displayed on the operator
 panel.

Touch the operation panel. -

The output tray and
 front cover cannot
 be closed.

The belt unit and image
 drams are not properly
 installed.

Remove the four image
 drams and reinstall the belt
 unit. If the blue locks on the
 both sides of the belt unit
 are not locked, the output
 tray and front cover cannot
 be closed.

Replacing the
 Belt Unit

The machine does
 not start printing.

An error is displayed. Check the error code, and
 then follow the on-screen
 instructions.

Error
 Message List

A LAN cable or USB cable
 is unplugged.

Plug in a LAN cable or USB
 cable firmly.

Connecting
 This Machine
 to a Network

There may be a problem
 with a LAN cable or USB
 cable.

Use another LAN cable or
 USB cable.

-

A LAN cable or USB cable
 does not meet the

Use a USB 2.0 cable. -
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 standard. Use an Ethernet 10BASE-
T/ 100BASE-TX cable.

There may be a problem
 with the print function.

Press [Device Settings],
 select [Reports] >
 [Configuration], and print
 out the configuration list to
 check the printing
 performance.

Checking the
 Information
 of the
 Machine

A communication protocol
 is disabled.

Press [Device Settings],
 select [Admin Setup] >
 [Network Menu] > [Network
 Setup] > [Network Setting],
 and then enable the
 communication protocol
 that you are using.

-

A printer driver is not
 selected.

Set the printer driver of the
 machine as the default
 printer.

-

The output port of the
 printer driver is incorrect.

Specify the output port for
 connecting a LAN cable or
 USB cable.

-

The document glass
 is covered with
 condensation.

The machine may be used
 in a humid place or in a
 place where the
 temperature and humidity
 widely vary.

Use machine under proper
 temperature and humidity
 conditions.
Wipe the document glass
 with a soft, dry, and clean
 cloth.
If the inside the document
 glass is covered with
 condensation, wait a while
 until the condensation
 disappears.

Installation
 Requirements

Nothing is displayed
 on the display
 screen.

The machine is in Sleep
 mode or Deep Sleep
 mode.

Check the  (POWER SAVE)
 button flashes, and then
 start the machine by
 pressing the  (POWER
 SAVE) button.

Saving Power
 Consumption
 with the
 Power Save
 Function

Print data is not
 sent.

A LAN cable or USB cable
 is damaged.

Connect a new cable. -

The time-out period set on
 the computer has
 elapsed.

Set a longer time-out period. -

There is an
 abnormal sound.

The machine is inclined. Place the machine on a flat
 surface.

-

There are waste paper or
 foreign objects inside the
 machine.

Check inside the machine,
 and then remove any
 objects.

-

The output tray is opened. Close the output tray. -

There is a buzzing
 sound.

The machine is printing on
 heavy or light paper when
 the temperature inside is
 high.

This is not a malfunction.
 You can proceed with the
 operation.

-

The machine does
 not start printing
 immediately.

The machine is warming
 up to exit Power Save,
 Sleep mode, or Deep
 Sleep mode.

You can set to extend the
 time of period for entering
 Power Save mode, Sleep
 mode or Deep Sleep mode

Saving Power
 Consumption
 with the
 Power Save
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 by following the procedure
 below.
Press [Device Settings], and
 then select [Management]
 > [Power Save] > [Power
 Save Time] > [Sleep Time].

 Function

The machine may be
 cleaning the image drum.

Wait for a while. -

The machine is adjusting
 the temperature of the
 fuser unit.

Wait for a while. -

The machine is processing
 data from another
 interface.

Wait until printing is
 completed.

-

Even if the [Density]
 setting is changed,
 printing results do
 not change.

The settings for [RGB] are
 changed.

The [Density] setting goes
 together with the [RGB]
 setting. They move within
 an appropriate range.

Adjusting the
 Density
 (Density)

Printing stops
 halfway.

The temperature inside
 the machine rises due to
 continuous printing for a
 long time, resulting in the
 temperature being
 adjusted.

Wait for a while.
When the machine reaches
 the suitable temperature,
 printing restarts
 automatically.

-

The specified
 settings such as the
 time setting have
 been erased.

The machine is left turned
 off for a long time, or turn
 the machine on and off
 every time you use the
 machine.

The battery may reach its
 lifetime. Contact your
 dealer.

-

Free space in
 Memory is
 insufficient.

The print data is
 complicated.

Simplify the print data. -

All pages are not
 printed.

The WSD port is used. Change the print port to
 Standard TCP/IP Port.

-

Printing is slow. Printing process is also
 processed in the
 computer.

Use a computer with faster
 processing speed.

-

You have selected [High
 Quality (Multiple tones)]
 on the [Print Job Options]
 tab of the printer driver.

Select [Fine / Detail
 (600x1200)] or [Normal
 (600x600)] on the [Job
 Options] tab of the printer
 driver.

-

The print data is
 complicated.

Simplify the print data. -

The printer driver is
 not correctly
 displayed.

The printer driver may not
 be operating correctly.

Uninstall the printer driver,
 and then install it again.

Removing the
 Printer
 Driver
 (Windows)
Removing the
 Printer
 Driver
 (Mac OS X)
Installing
 Software

The machine turns
 off automatically.

If the machine is not used
 for a certain period of

Press [Device Settings],
 select [Admin Setup] >

Saving Power
 Consumption
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 time (the factory default
 is 4 hours), the machine
 turns off automatically.
 This function is called
 Auto Power Off.

 [User Install] > [Power
 Setup] > [Auto Power Off],
 and then disable the
 function.

 with the
 Power Save
 Function

The web page does
 not open.

The IP address is
 incorrect.

Check the IP address to the
 machine, and then enter
 proper value.

Open the
 Web Page of
 This Machine

The LAN cable is
 disconnected.

Make sure that the LAN
 cable is securely connected.

Connecting
 This Machine
 to a Network
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Problems on Document and Paper

Memo
If you cannot solve a problem with the following solutions, contact your dealer.

Symptom Cause Solution Reference

The document is
 not ejected
 from the
 machine.

The document jammed. Remove the jammed document,
 and then set it again.

Setting a
 Document

The document
 often jams.

The document is not
 appropriate.

Use an appropriate document. Setting a
 Document

The document guides are
 not aligned.

Adjust the document guides to
 the document.

Setting a
 Document

There is a piece of paper
 inside the ADF.

Open the ADF cover to check. If a
 Document
 Jam Occurs

The document feed roller
 of the ADF is dirty.

Clean the document feed roller of
 the ADF.

Cleaning the
 Document
 Feed Rollers
 and
 Document
 Holding
 Rollers

Paper often
 jams.

Multiple
 sheets of
 paper are
 pulled in at
 the same
 time.

Paper is pulled
 in at an
 angle.

The machine is inclined. Place the machine on a flat
 surface.

-

The paper is too light or
 too heavy.

The paper is too light or too
 heavy. Use the appropriate
 paper for the machine.

Loading
 Paper

The paper is damp or has
 a static charge.

Use paper stored under proper
 temperature and humidity
 conditions.

Loading
 Paper

The paper is wrinkled,
 folded, or curled.

Use the appropriate paper for the
 machine. Fix the curled paper.

Loading
 Paper

The back side of the
 paper is printed.

The paper that has been printed
 once cannot be used in Tray 1
 and Tray 2/3/4.
Load the paper in the MP tray for
 printing.

-

The edges of the paper
 are not aligned.

Fan a stack of the paper well, and
 then align the edges of the
 paper.

Loading
 Paper

There is only one sheet of
 paper in the tray.

Load multiple sheets of paper. -

You added new paper
 onto the paper that is
 already loaded in the
 tray.

Remove the already loaded
 paper, stack up it onto the new
 paper, and then align the edges
 of all the paper.

Loading
 Paper

Paper is loaded at an For Tray 1 and Tray 2/3/4, adjust Loading
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 angle.  the paper guide and paper
 stopper to the paper.
For the MP tray, adjust the
 manual feeding paper guide to
 the paper.

 Paper

Envelopes are loaded in
 the wrong direction.

Load the envelopes correctly. Loading
 Paper

Paper, envelopes, or
 labels whose weight is
 221 to 256 g/m2(56 to
 95 lb) is loaded in Tray 1
 and Tray 2/3/4.

Load the paper, envelopes, or
 labels whose weight is 221 to
 256 g/m2(56 to 95 lb) is in the
 MP tray.

Loading
 Paper

The rear output tray is
 not closed firmly.

Close the rear output tray firmly. Setting
 Output Tray

Paper is not fed. The [Paper Feeding
 Source] setting on the
 printer driver is specified
 incorrectly.

Check the paper tray, and then
 select the correct tray in [Paper
 Feeding Source] on the printer
 driver.

-

The manual feeding is
 specified on the printer
 driver.

Load paper in the MP tray, and
 then select [Start] on the
 operator panel.
Alternatively, disable the [Use MP
 tray as manual feed] setting on
 the printer driver.

Printing
 Manually
 One by One

Paper is not fed
 from Tray 2/3/4
 (optional).

Tray 2/3/4 is not set with
 the printer driver.

Set Tray 2/3/4 with the printer
 driver.

Installing the
 Additional
 Tray Unit(s)
 to the
 Machine

Even after the
 jammed paper
 was removed,
 the machine
 does not work.

- Open and close the output tray. -

Paper is curled.
 Paper is
 creased.

The paper is damp or has
 a static charge.

Use paper stored under proper
 temperature and humidity
 conditions.

Loading
 Paper

The paper is light. Press [Device Settings], select
 [Paper Setup] > [(tray name)] >
 [Media Weight], and then specify
 a lighter weight.

Loading
 Paper

The paper twists
 around the
 rollers in the
 fuser unit.

The settings of media
 weight and type are
 incorrect.

Press [Device Settings], select
 [Paper Setup] > [(tray name)] >
 [Media Type]/[Media Weight],
 and then specify the appropriate
 values.
Alternatively, specify heavier
 weight in [Media Weight].

Loading
 Paper

The paper is light. Use heavier paper. -

There are nearly solid fill
 on the leading edge of
 the paper.

Insert a margin into the leading
 edge of the paper.
For duplex printing, insert a
 margin into the bottom edge of
 the paper as well.

-

The paper twists
 around the

Paper is too light or thin. Use heavier paper. -
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 rollers in the
 belt unit.

Or load the paper in the different
 direction. (If the paper is set in
 landscape orientation, set the
 paper in the horizontal
 orientation.)

A corner of
 paper is folded
 (edge folded).

Paper is curled. Use paper stored under proper
 temperature and humidity
 conditions.

-

The paper is
 twinkled when
 printing on
 envelopes.

The paper is damp. Use paper stored under proper
 temperature and humidity
 conditions.

Loading
 Paper

The machine is printing
 when the temperature
 and humidity conditions
 are high.

Set [High Humid Mode] of [User
 Install] to [ON] on [Admin
 Setup].

User Install

If you cannot solve a
 problem with the above
 solutions

Load the envelope with the flap
 (for gluing) on the printer side,
 and then set the reverse page
 orientation (180°) on the
 printing preferences.

About
 Screens and
 Functions of
 Each Printer
 Driver
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If a Power Failure Occurs

The operation of the machine

If a power failure occurs, the machine operates as follows.

Note
Since the machine is not turn on automatically, turn it on by pressing the power switch after
 the power is restored.

The operation that uses an uninterruptible power supply (UPS) or inverter is not guaranteed.
 Do not use an uninterruptible power supply (UPS) or inverter.

Machine's
 Status

Operation

During a call You can continue talking.

During a
 transmission

The transmission stops halfway.
When the power is restored,

If a Memory transmission is used, the machine automatically retransmits from
 the page on which the transmission stopped.

If a real time transmission is used, the machine does not send the data again.
 Set the document, and then specify the destination again to start the
 transmission.

During a
 reception

The reception stops halfway.
If the machine received one or more pages, the erased report is printed after the
 power is restored. A received image is not printed.

Copying or
 printing a
 list

Printing stops halfway.
When the power is restored, start the print job again.

Idle You cannot start another copy, fax, scan, or print job.
You also cannot receive another fax.

Stored fax data
Backing up data in Memory

The image data stored in the Memory is retained even if a power failure occurs or you
 turn the machine off.

Erased report

If the fax data in Memory is lost, an erased report is printed automatically.

The following documents are eligible for an erased report.

Fcode Box Document

Documents received in Memory

An erased report informs you of the following items of deleted data.

Document type

Fcode box number
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Fcode box name

Destination name

Fcode confidential communication/Fcode bulletin board communication

Time when communication started

Number of received pages

Memo
If a fax is received with the manual reception, Fcode polling reception, or Fcode confidential
 reception, its reception type is also printed.
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AirPrint Problems

Note
The machine may take a few minutes to connect to a network after turning the machine on.
 Check that the machine is connected to the network before printing.

If using Mac OS X or iOS, upgrade to the latest version before use.

Symptom Point to check Solution Reference

The "No AirPrint
 Printers Found"
 message is
 displayed on an
 iOS device.

Is the machine
 turned on?

Turn the machine on.
If the machine is turned on, turn it
 off and then back on, and then
 check whether the problem is
 solved.

Turning the
 Machine On or
 Off

Is the machine
 connected to the
 same network as
 the iOS device?

Check that the machine is displayed
 on the print screen of the iOS
 device.
If the machine is not displayed,
 check the IP address.

Easy Setup

The printer
 connected via USB
 is not found.

Is the USB
 setting set to
 "IPP" ?

Press [Device Settings] >
 [AdminSetup] > [Management] >
 [Local Interface] > [USB Menu] >
 [USB Assignment] > Select [IPP].

-

Unable to print. Is the machine
 turned on?

Turn the machine on.
If the machine is turned on, turn it
 off and then back on, and then
 check whether the problem is
 solved.

Turning the
 Machine On or
 Off

Is the machine
 connected to the
 same network as
 the iOS device?

Check that the machine is displayed
 on the print screen of the iOS
 device.
If the machine is not displayed,
 check the IP address.

Easy Setup

Is the latest
 firmware version
 installed?

Check the firmware version of this
 machine and iOS device.
If the version of the firmware is not
 the latest, update to the
 appropriate version from the OKI
 web site or Apple web site.

-

Is there paper in
 the tray?

Check the message informing you
 that paper runs out.

Error Message
 List
If the STATUS
 Button on the
 Operator Panel
 Lights Up or
 Flashes

Is there toner in
 the toner
 cartridge?

Check the message informing you
 that toner runs out.

Error Message
 List
If the STATUS
 Button on the
 Operator Panel
 Lights Up or
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 Flashes

Is AirPrint set to
 [Enable]?

Press [Device Settings], and check
 the status of [AirPrint]. When
 [Disable] is displayed, AirPrint is
 not available.

-

Is an error
 displayed?

Check the error message or the 
 (STATUS) button.

Error Message
 List
If the STATUS
 Button on the
 Operator Panel
 Lights Up or
 Flashes
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Google Cloud Print Problems

Symptom Point to check Solution Reference

The machine cannot
 be registered in
 Google Cloud Print.

- Register again from the beginning. Setting
 Google
 Cloud Print

Unable to print. Is the machine
 registered in
 Google Cloud
 Print correctly?

Register the machine in Google Cloud
 Print correctly.

Checking
 Google
 Cloud Print
 Registrations
Setting
 Google
 Cloud Print

Is there any
 error in the
 connection
 status of the
 machine?

Open the Web page of this machine,
 and check the connection by
 following the procedure below.
Select [Admin Setup] > [View
 Information] > [Network] > [Google
 Cloud Print], and then check [XMPP
 Status] and [HTTP Status]. If
 [Error(error code)] is displayed, refer
 to "Error code is displayed" in this
 topic.

-

Do you use a
 corporate
 internal
 network?

Check that the XMPP(5222) port is
 opened.
For detail on the network, contact
 your network administrator.

-

Even after the
 machine was deleted
 from Google Cloud
 Print, the registration
 information remains
 on the management
 screen.

Did you delete
 the registration
 information
 with the
 machine
 connected to a
 network?

Delete the machine on the
 management screen of Google Cloud
 Print.

Checking
 That
 Deletion is
 Complete

Even after the
 machine was deleted
 from Google Cloud
 Print, the registration
 information remains
 in the machine.

Did you delete
 the machine on
 the
 management
 screen of
 Google Cloud
 Print?

Delete the registration information
 from the operator panel of the
 machine.

Checking
 That
 Deletion is
 Complete

An error code is displayed on the panel
If an error occurs, the error code (8-digit alphanumeric value) is displayed on the
 operator panel of the machine. Check the first three characters, or last two digits of the
 error code, and then follow the procedure of the error code list.

Error code list

An "x" in the error code list means any alphanumeric characters.

Error
 code

Solution Reference

00000000 The machine is operating normally. -
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10axxx13 A connection error with the HTTP server (server
 authentication error).
Access the Web page (http://(IP address of this machine)
 of the machine, and then check the imported CA license.
 Alternatively, update the firmware.

About Importing
 the CA Licenses of
 the Proxy Server10bxxx13

10cxxx13

10axxx16 A connection error with the proxy server (server
 authentication error).
Access the Web page (http://(IP address of this machine)
 of the machine, and then check the imported CA license.
 Alternatively, update the firmware.

About Importing
 the CA Licenses of
 the Proxy Server10bxxx16

10cxxx16

103xxx83 A connection error with the XMPP server (server
 authentication error).
Access the Web page (http://(IP address of this machine)
 of the machine, and then check the imported CA license.
 Alternatively, update the firmware.

About Importing
 the CA Licenses of
 the Proxy Server10bxxx83

103xxx86 A connection error with the proxy server (server
 authentication error).
Access the Web page (http://(IP address of this machine)
 of the machine, and then check the imported CA license.
 Alternatively, update the firmware.

About Importing
 the CA Licenses of
 the Proxy Server10bxxx86

xxxxxx11 An error with the DNS server has occurred.
Check the DNS server setting of the machine.

Checking Google
 Cloud Print
 Registrations

xxxxxx12 Failed to connect to the HTTP server.
The connection cannot be established due to your network
 environment.
Check with your network administrator.

-

xxxxxx13 An HTTP server connection error.
The connection cannot be established due to your network
 environment.
Check with your network administrator.

-

xxxxxx14 An error with the DNS server has occurred.
Check the DNS server setting of the machine or the setting
 of the proxy server name.

Checking Google
 Cloud Print
 Registrations

xxxxxx15 Failed to connect to the proxy server.
Check the proxy server setting of the machine.
If the problem cannot be solved, check with your network
 administrator.

Checking Google
 Cloud Print
 Registrations

xxxxxx16 A proxy server connection error.
The connection cannot be established due to your network
 environment.
Check with your network administrator.

-

xxxxxx17 An authentication error of the proxy server.
Check the proxy server setting of the machine.
If the problem cannot be solved, check with your network
 administrator.

Checking Google
 Cloud Print
 Registrations

xxxxxx81 An error with the DNS server has occurred.
Check the DNS server setting of the machine.

Checking Google
 Cloud Print
 Registrations

xxxxxx82 Failed to connect to the XMPP server.
Check that the XMPP(5222) port is opened.
If the problem cannot be solved, check with your network

-
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 administrator.

xxxxxx83 Failed to connect to the XMPP server.
Check that the XMPP(5222) port is opened.
If the problem cannot be solved, check with your network
 administrator.

-

xxxxxx84 An error with the DNS server has occurred.
Check the DNS server setting of the machine or the setting
 of the proxy server name.

Checking Google
 Cloud Print
 Registrations

xxxxxx85 Failed to connect to the proxy server.
Check the proxy server setting of the machine.
If the problem cannot be solved, check with your network
 administrator.

Checking Google
 Cloud Print
 Registrations

xxxxxx86 A connection error with the proxy server.
Check that the XMPP(5222) port is opened.
If the problem cannot be solved, check with your network
 administrator.

-

xxxxxx87 An authentication error of the proxy server.
Check the proxy server setting of the machine.
If the problem cannot be solved, check with your network
 administrator.

Checking Google
 Cloud Print
 Registrations
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If an Error Message is Displayed on the Operator Panel

If an error occurs in this machine, an error message and/or an error code (a 3-digit number)
 is displayed on the operator panel.

In such a case, the  (STATUS) button lights up or flashes.

If you are not sure how to solve a problem, enter the error message or error code into
 "Error Message List", and then check the error cause and its solution.

Error Message List
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Error Message List

Wait a moment. Network initializing ...

The network is being initialized.

Wait for a while until the machine connects to the network.

Checking File System

File system in the hard disk is being checked. Wait for a while.

Inspection is required. PU Flash Error

Turn the machine off, and then back on. If the same error occurs, contact your dealer.

Inspection is required. PU Communication Error

Turn the machine off, and then back on. If the same error occurs, contact your dealer.

Offline Mode

The machine is offline. Press the Online button to set it to [Online].

Data present.

Data remains unprinted.

Deleting data.

The job was cancelled or user is unauthorized.

Warming up.

The machine is adjusting the temperature of the fuser unit. Wait for a while.

Preparing ...

Color registration and density are being adjusted. Wait for a while.

Updating firmware. Do not turn OFF the power.

The programs on the machine are being updated.

Do not turn the machine off until the update completes.

The machine automatically restarts after the update completes.
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Toner Low.

The toner indicated on the screen is low. Have a new toner cartridge ready.

Waste Toner Full Replace with new Toner Cartridge.

Waste toner is full. Replace the toner cartridge with a new one.

C: Cyan (blue), M: Magenta (red)

C Non Recommended Toner.

An optimum C (Cyan, blue) toner cartridge is not installed.

Use a toner cartridge that matches your machine.

M Non Recommended Toner.

An optimum M (Magenta, red) toner cartridge is not installed.

Use a toner cartridge that matches your machine.

Y Non Recommended Toner.

An optimum Y (Yellow) toner cartridge is not installed.

Use a toner cartridge that matches your machine.

K Non Recommended Toner.

An optimum K (Black) toner cartridge is not installed.

Use a toner cartridge that matches your machine.

Error Postscript

A postscript error has occurred.

Image Drum Near Life.

The image dram indicated on the screen is near life. Have a new image drum ready.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Fuser Near Life.

The fuser unit is near life. Have a new fuser unit ready.

Belt Unit Near Life.

The belt unit is near life. Have a new belt unit ready.
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Fuser Unit Life. Install New Fuser Unit.

The fuser unit reaches its lifetime.

Replace the fuser unit with a new one.

Belt Unit Life. Install New Belt Unit.

The belt unit reaches its lifetime.

Replace the belt unit with a new one.

Toner empty. Replace with new Toner Cartridge.

The toner indicated on the screen is empty. Replace the empty toner cartridge with a new one.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Toner cartridge not installed.

A color toner cartridge indicated on the screen is not installed.

Install the toner cartridge.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Image Drum Life. Please install new Image Drum Unit.

The image dram indicated on the screen reaches its lifetime.

Replace the image drum with a new one.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

TRAY is empty.

No paper is loaded in the tray. Load paper.

File System is full.

Memory in the file system is full.

Delete unnecessary files.

The File System is write-protected.

The file you are trying to write is write-protected.

Check the file name.

Insufficient page Memory to collate.

Insufficient Memory error has occurred during collate printing.

Reduce the number of pages to print.
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Insufficient Memory. Error: 014

Memory full error has occurred during PC Fax reception. Press [Close].

Unauthorized user, job cancelled.

Unauthorized job was sent or unauthorized user attempted to print or send a fax. Data was deleted. 
Contact your administrator to use this machine.

File erasing ...

Files stored for authentication print are being deleted.

Wait for a while.

Deleting encrypted authentication print data.

Files stored for encrypted authentication print are being deleted. Wait for a while.

Erased Data Full

Files supposed to be deleted are full. Erase the files.

Secure job storage period exceeded.

Files whose authentication print data storage period expired were automatically deleted.

Disk Read/Write Error

An error has occurred in the file system. Press [Close].

Flash Error

An error has occurred when firmware was being updated.

Contact the administrator.

Invalid print data received.

Invalid print data or PC fax data was received. To erase the message, press [Close].

If you performed authentication printing, the data was deleted because it was incomplete. Print again.

Received data has been discarded because Job Type is restricted.

Data whose job type is not defined in the acceptable job type settings was received. The data was 
discarded without being processed.

Select a job type defined in the acceptable job type settings for [Job Type] of the printer driver and 
print again.
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About Screens and Functions of Each Printer Driver 

Manual Request.

Print on paper fed manually. Load paper in the MP tray.

Please change [MEDIA_SIZE] [MEDIA_TYPE] in [TRAY]. Error:461, 462, 463, 464

The size and type of fed paper do not match those indicated on the screen. Use the same size and type 
of paper selected on the application.

Please change [MEDIA_SIZE] [MEDIA_TYPE] in MP Tray Error:460

The size and type of paper loaded in the MP tray do not match those indicated on the screen. Make 
sure that the size and type of paper loaded in the MP tray match those selected on the application.

Wait a moment. Message Data processing ...

Messages to be displayed on the machine are being updated. Wait for a while.

Wait a moment. Message Data writing ...

Messages to be displayed on the machine are being updated. Wait for a while.

Restart the machine. Writing message data has been complete.

Messages to be displayed on the machine are now updated.

Turn the machine off, and then back on.

Wait for a while.

Please check data. Message Data Write Error

Updating messages to be displayed on the machine failed.

Make sure that you use right data for this machine.

Wait a moment. Network Configuration writing ...

Network settings for this machine is changed. The new settings are being stored. Wait for a while.

Wait a moment. Network initializing ...

Network settings for this machine are initializing.

Paper [TRAY] is empty Set [MEDIA_SIZE] Error: 490, 491, 492, 493, 494

No paper is loaded in the indicated tray. Load paper of the displayed size.
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[TRAY] cassette is missing. Open and Close the indicated cassette. Error: 440, 441, 
442, 430, 431, 432, 433

The tray is not installed. Install the cassette. If the cassette is already inserted, pull it out, and then 
insert it again.

Insufficient Memory. Error: 420

Data is too complicated. Memory full error has occurred during processing. Reduce the volume of the 
print data.

Waste Toner Full Replace with new Toner Cartridge. Error: 414, 415, 416, 417

Waste toner of the toner cartridge is full. Opening and closing the front cover can resume printing for a 
while, but it may damage the image dram. Replace the toner cartridge with a new one as soon as 
possible.

C: Cyan (blue), M: Magenta (red)

Toner empty. Replace with new Toner Cartridge. Error: 410, 411, 412, 413

The indicated cartridge ran out of toner.

Opening and closing the front cover can resume printing for a while, but it may damage the image 
dram. Replace the toner cartridge with a new one as soon as possible.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Incompatible C Toner. Error: 552, 556, 616, 622

The installed C (Cyan, blue) toner cartridge is not optimum.

We recommend using an optimum toner cartridge.

Incompatible M Toner. Error: 551, 555, 615, 621

The installed M (Magenta, red) toner cartridge is not optimum.

We recommend using an optimum toner cartridge.

Incompatible Y Toner. Error: 550, 554, 614, 620

The installed Y (Yellow) toner cartridge is not optimum.

We recommend using an optimum toner cartridge.

Incompatible K Toner. Error: 553, 557, 617, 623

The installed K (Black) toner cartridge is not optimum.

We recommend using an optimum toner cartridge.

Toner Not Installed. Error: 610, 611, 612, 613

A color toner cartridge indicated on the screen is not installed.
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Install the toner cartridge.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Image Drum Sensor Error Check Image Drum. Error: 540, 541, 542, 543

The sensor error has occurred in the image dram indicated on the screen.

Uninstall the image dram, and then install it again.

If the message persists, uninstall the toner cartridge and install it again.

If the toner cartridge is not installed, install it.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Multiple sheets of paper have been fed. Reset Paper in [TRAY]. Error: 401

The indicated tray fed multiple sheets of paper at a time.

Remove the cassette from the tray, and then load paper again.

Paper Size Error. Reset Paper in [TRAY]. Error: 400

Paper size error has occurred in the indicated tray. Make sure that the size made by paper loaded in 
the tray matches the setting made by the paper size dial in the paper cassette. Load paper according 
to the paper size and direction set for the paper size dial.

If the setting made by the paper size dial is wrong, cancel printing first, set the paper size dial, and 
then print again.

Make sure that the cassette does not feed multiple sheets of paper at a time after starting printing. If 
it happens, remove paper, and then load paper correctly.

Paper jam has occurred. Open the front cover and remove the paper. Error: 390

Paper jammed via the paper feed path from the MP tray.

If the edge of the jammed paper is not visible, open the front cover and remove the paper.

Paper jam has occurred. Pull out the [TRAY] cassette and then remove the paper. 
Error: 391, 392, 393, 394

A paper jammed via the paper feed path from the indicated tray.

Pull out the cassette, and then remove paper. If multiple sheets of paper are fed at a time, remove 
paper and reload paper.

Make sure that the paper stoppers are set in the right position.

Paper jam has occurred. Open the front cover and remove the paper. Error: 372, 
380

Paper jammed in the paper feed path of the machine. Open the front cover and remove the jammed 
paper.
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A paper jam has occurred under the image drum or around the fuser unit. Please 
remove paper. Error: 381, 382, 383, 348, 389

A paper jam has occurred inside the machine.

Open the cover and remove jammed paper.

A paper jam has occurred under the image drum or around the fuser unit. Please 
remove paper. Error: 381, 382, 383, 348, 389

Paper jammed near the duplex printing unit.

Pull out the duplex unit on the back of the machine, and then remove jammed paper.

The 2-Sided Printing unit is not set correctly. Error: 360

The duplex unit is not properly installed. Install the duplex unit.

Image Drum Life. Please install new Image Drum Unit. Error: 350, 351, 352, 353

The image dram indicated on the screen reaches its lifetime.

Replace the image drum with a new one.

Opening and closing the cover can resume printing for a while. Replace with a new one as soon as 
possible, however.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Image Drum Life. Please install new Image Drum Unit. Error: 560, 561, 562, 563, 
564, 565, 566, 567

The image dram indicated on the screen reaches its lifetime.

Replace the image drum with a new one.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Image Drum Life. Please install new Image Drum Unit. Error: 680, 681, 682, 683

Printing has stopped because the image dram indicated on the screen reached its lifetime. Replace 
with a new image dram to print.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Fuser Unit Life. Install New Fuser Unit. Error: 354

The fuser unit reaches its lifetime.

Replace the fuser unit with a new one.

Opening and closing the cover can resume printing for a while. Replace with a new one as soon as 
possible for maintaining the print quality.

Belt Unit Life. Install New Belt Unit. Error: 355

The belt unit reaches its lifetime.
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Replace the belt unit with a new one.

Opening and closing the cover can resume printing for a while. Replace with a new one as soon as 
possible for maintaining the print quality.

The Fuser Unit is not installed correctly. Reset Fuser Unit. Error: 348

The fuser unit is not properly installed. Remove and re-install the fuser unit. If the error persists after 
re-installing, replace the fuser unit with a new one.

Waste Toner Full. Install New Belt Unit. Error: 356

Waste toner of the belt unit is full. Replace the belt unit with a new one. Opening and closing the cover 
can resume printing. Printing stops after 500 sheets are printed.

Toner cartridge not properly installed. Error: 544, 545, 546, 547

A color toner cartridge indicated on the screen is not installed.

Make sure that the lever on the toner cartridge is fully turned and the protective tape is removed.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Image Drum not properly installed. Check Image Drum. Error: 340, 341,342, 343

The indicated image dram is not installed correctly.

Remove and re-install the image dram.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

The Fuser Unit is not installed correctly. Reset Fuser Unit. Error: 320

The fuser unit is not properly installed. Remove and re-install the fuser unit.

Belt Unit not installed correctly. Re-set the Belt Unit. Error: 330

The belt unit is not properly installed. Remove and re-install the belt unit.

[COVER] Open. Error: 310, 311, 587

Indicated cover is open. Close the cover.

Error: 310 The output tray, 311 The front cover, 587 The upper output tray

Please check data. Program Data Write Error

An error occurred when firmware was being updated.

Use a correct update file.

Power OFF/ON

Turn the machine off, and then back on.
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If the same error occurs, contact your dealer.

Inspection is required.

Turn the machine off, and then back on.

If the same error occurs, contact your dealer.

Cancelling ...

The cancel button was pressed while copying. The copy job is being cancelled. Wait for a while.

Automatic document feeder (ADF) cover is open.

The ADF cover of the scanner is open. Close the cover.

Document jam has occurred. Open the automatic document feeder (ADF) cover on 
the scanner to check.

Paper jammed in the ADF of the scanner.

Open the ADF cover and remove jammed paper.

Scanner lamp error check the lamp.

Light volume of the scanner is low. Contact your dealer.

Power OFF/ON Carriage Error <1>

An error has occurred on the carriage of the scanner. Turn the machine off, and then back on.

If the same error occurs, contact your dealer.

USB Memory Full

Scan To USB Memory was cancelled because the USB Memory is full.

Check the free space in the USB Memory.

Writing to USB Memory failed.

The USB Memory is write-protected. Unlock the protection.

USB Memory disconnected.

The USB Memory was removed while performing Scan To USB Memory.

Connect to PC failed.

No destination computer was found for Scan to Computer. Make sure that your computer is turned on 
and recordable.
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To erase the message, press [Close].

Insufficient Memory occurred during Rx.

Memory full error has occurred during fax reception. Ensure available Memory.

Communication Error

An error has occurred during fax transmission or fax reception.

Telephone

The external phone is in use.

File Transmission Error

An error such as a malfunction of the server or disconnection of a network cable has occurred while 
performing Scan To shared folder.

Check the network connection.

To erase the message, press [Close].

E-mail Transmission Error

An error such as a malfunction of the server or disconnection of a network cable has occurred while 
performing Scan To E-mail. Check the network connection.

To erase the message, press [Close].

Please check SMTP settings.

Cannot connect to the SMTP server. Check the network settings.

Please check POP3 settings.

Cannot connect to the POP3 server. Check the network settings.

SMTP Login failed.

An attempt to log into the SMTP server ended up an authentication error.

Check the network settings.

SMTP Auth. Unsupported

The SMTP server does not support the authentication system.

Check the network settings.
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POP3 Login failed.

An attempt to log into the POP3 server ended up an authentication error.

Check the network settings.

Getting target IP failed. Please Check DHCP settings.

The DHCP server cannot be detected. Check the network connection.

Please check DNS settings.

Cannot connect to the DNS server. Check the network connection.

Please check Server settings.

Cannot connect to the file server. Check the network settings.

Server Login failed.

Logging into the file server failed. Check the server settings.

Entering directory failed.

Connecting to the directory of the FTP server failed. Check the server settings.

Changing data Transfer Type failed.

File transmission failed because the file transfer type was not accepted by the FTP server. Change the 
FTP transfer type to "binary".

File writing failed.

Files sent using Scan To shared folder could not be written. Check the access rights for the shared 
folder.

FTP destination Full.

Memory in the FTP server is low. Delete unnecessary files and ensure the free space.

Please change File Name.

The specified file name is not acceptable. Check the FTP server settings and change the file name.

Device communication protocol not supported.

The server does not support CIFS or FTP. Check the server settings.

818



Please check Network Share Name.

The name of the network shared folder is not correct. Check the folder name.

Please check data. Program Data Write Error

An error has occurred when program was being updated.

Please insert USB Memory.

Scan To USB Memory or print from USB Memory with USB Memory not inserted was attempted.

Insert USB Memory.

[TRAY] cassette missing.

The cassette in the indicated tray is pulled out.

Install the cassette.

Access Limitation Error Monochrome printing was performed due to the color 
printing limitation.

A color print job was converted to a mono print job due to an unauthorized user. Contact your 
administrator for color printing.

Access Limitation Error Data was deleted due to the color printing limitation.

A color print job was deleted due to an unauthorized user. Contact your administrator for color 
printing.

Restricted access error Data deleted due to printing restrictions.

A print job was deleted due to an unauthorized user. Contact your administrator for printing.

Incompatible USB device connected. Remove the connected USB device.

An unsupported USB device is connected. Remove the USB device.

Please remove the connected USB device. USB device has not been recognized.

The connected USB device was not recognized. Remove the USB device.

Please remove the USB Hub. USB Hub is connected.

A USB hub is connected. Remove the USB hub. This machine does not support USB hub.
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Inspection is required. SIP Error

Turn the machine off, and then back on. If the same error occurs, contact your dealer.

Please call service. Scanner unit failed to detect printer unit.

Turn the machine off, and then back on. If the same error occurs, contact your dealer.

HDD Error 0

While initializing this machine, a hard disk which needs formatting was detected.

HDD Error 250

While initializing this machine, a damaged file for encrypted authentication printing was found. Format 
the hard disk again.

Accounting Log buffer is near full.

The accounting log buffer is almost full.

Acquire the log and free the buffer.

Accounting Log Writing Error

An accounting log writing error has occurred.

To erase the message, press [Close].

Job Log Database Error

A data base access error has occurred while writing or reading the job log. Turning the machine off and 
on may resolve the problem.

To erase the message, press [Close].

Accounting Log Buffer Full (Delete old logs)

Old logs were deleted, because accounting log buffer was full. Acquire the log and free the buffer.

Power OFF/ON

Turn the machine off, and then back on. If the same error occurs, contact your dealer.

A decoding error occurred. Check the image data.

An error has occurred in the image data sent to this machine. Check the image data.
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Process has been canceled as there is no space on the device. Please free up enough 
Memory space by reducing usage and try again.

Processing data was cancelled due to Memory full.

Reduce the usage on the device to ensure available Memory, and then retry.

Process has been canceled by a device error. After maintenance or change of the 
device, please try again. 

Processing data was cancelled because an error occurred on the device.

Repair or replace the device, and then retry.

Access denied to PC. Please check PC.

Connecting to a computer failed when performing Scan to Computer. Check the settings on the 
computer.

Deleting data.

This machine ran out of color toner. Color print data is being deleted.

Error PDF

The PDF file is damaged.

This PDF file is password protected.

This PDF file is password protected. Enter a password to print.

Valid password required to print document.

This PDF needs authentication. Enter a password to print.

No communication with the SNTP server.

Obtaining current time from the SNTP server failed. Check the server.

USB Memory disconnected.

The USB Memory was removed while printing from USB Memory. Do not remove USB Memory while 
printing is in progress.

Cannot open the file.

The specified file could not be Opened. Check the file.
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Cannot read the file.

Files could not be read. Check the device where the files are stored.

File loading from USB.

Data is being read from USB Memory.

Press the Stop button to cancel reading.

An error occurred. Scanning is pending.

Printing has stopped due to an error.

Image Drum Sensor Error.

The toner sensor error has occurred in the image dram indicated on the screen.

Printing was stopped. Rear Output Tray was opened during printing. Open the 
Output Tray. Error code: 409

The rear output tray was moved while printing.

Place the rear output tray in the correct position, and then open and close the output tray.

Toner empty. Replace with new Toner Cartridge.

The indicated cartridge ran out of toner.

Replace the empty toner cartridge with a new one.

Wait Timeout in menu is disabled. Printing is disabled except by USB. Clear page 
buffer and enable time out in menu. 

Wait Timeout is disabled.

Insufficient Memory occurred during Fax Tx reservation.

Insufficient Memory error has occurred during Scan To fax.

Insufficient Memory.

Insufficient Memory error has occurred during fax reception.

E-mail receiving has been cancelled.

E-mail reception was cancelled.

Check the file format and size of the attached file.
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Wireless settings are incomplete.

Wrong values are set or items remain unset in the wireless LAN settings. Check the wireless settings.

Not connected to wireless access point.

No wireless LAN access points are found.

Make sure that the access point is turned on.

Disconnect and re-connect to wireless LAN.

Wireless startup failed.

Restart the machine. If the error persists, contact your dealer.

Firmware Update Error Please try again. If network doesn't work, please try 
firmware update over USB. 

Updating the firmware failed. Update again.

Registering with Google Cloud Print. Don't turn off the power until registration is 
complete.

This machine is being registered to the Google Cloud Print service. Wait for a while.

Deleting from Google Cloud Print.

This machine is being removed from the Google Cloud Print service. Wait for a while.

Caution, unknown Consumable detected Go to User Manual "Trouble Shooting" to 
restore operation

Use of consumables that are not specified by OKI Data may deteriorate printing quality and result in 
the printer not functioning to its capabilities.

Charges for services for problems caused by the use of consumables that are not specified by OKI Data 
are incurred even in the warranty period or maintenance contract period, or the services are not 
covered by the maintenance contract.

If you accept these risks and use consumables that are not specified by OKI Data, do the following:

Turn the machine off.

Holding the [Clear] button, turn the machine on.

Release the [Clear] button when "RAM CHECK 100%" is displayed.

This operation log is recorded in the printer.

If you have any questions, contact your dealer.

Replace the image drum. [PAGES] Pages Left. 

The image dram indicated on the screen reaches its lifetime.
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Replace the image drum with a new one.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Replace the image drum. Print Quality Not Guaranteed.

The image dram indicated on the screen reaches its lifetime.

Replace the image drum with a new one.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

Receiving data timeout.

Data could not received within a certain period of time.

IPv4 address is conflicted. Please change IPv4 address.

The IP address assigned to this machine is duplicated with that of another device.

Check the IP addresses, and then assign another IP address.

Incompatible [COLOR] Image Drum. Error:984, 685, 686, 687, 690, 691, 692, 693, 
700, 701, 702, 703, 704, 705, 706, 707

Non-optimum image dram is installed.

C: Cyan (blue), M: Magenta (red), Y: Yellow, K: Black

C Image Drum Not Installed. Error: 696

Cyan (blue) image dram is not installed.

Install the image dram.

M Image Drum Not Installed.Error: 695

Magenta (red) image dram is not installed.

Install the image dram.

Y Image Drum Not Installed. Error: 694

Yellow image dram is not installed.

Install the image dram.

K Image Drum Not Installed. Error: 697

Black image dram is not installed.

Install the image dram.
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Blank pages were detected on all pages. Please check how the document was set.

Scanned pages are all blank. Turn over the document.

In order to set paper that cannot be output to the Upper Output Tray, the paper was 
output from Output Tray. To turn off this display, press the [Close] button. 

Check the type of the specified paper.

Press [Close].

Simplex printing was performed as the paper setting did not allow duplex printing.

Duplex printing is not available on the specified paper.

Check the size and thickness of paper.

Press [Close].

Multi-purpose tray has not been set to be used as the tray, so multiple copies have 
been printed. Please verify multi-purpose tray settings. Press [Close] button to 
remove this dialog

MP tray setting is set to [Do Not Use]. Change the MP tray setting.

Output Paper Full. Remove the paper on [TRAY]. Error: 480, 485

Paper in the output tray is full.

Remove the handout.

Changing Language. Panel operation is disabled.

Display language is being changed.

Wait for a while.

Language Change Failed. Error num: %CODE%

Switching display languages failed. Press the power button to turn the machine off, and then back on.

Detected an abnormality of internal database. The data must be deleted. After 
pressing [Format], the data will be deleted, and then reboot. 

Data base is beyond restoration.

To delete the data base, press [Format].

Cannot print because your Summary Account balance is 0. User name for Printing: 
[USERNAME] Summary Account Name for Insufficient Balance: [ACCOUNTNAME] To 
continue the print job, increase the balance and select [Start].To increase the 
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balance, please contact the device administr. To cancel the print job, select 
[Cancel]. 

The number of print jobs excesses the limit. No more print jobs are authorized. Contact your 
administrator.
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Basic Operations

Names of Components

Basic Operations on the Operator Panel

Turning the Machine On or Off

Loading Paper

Setting a Document

Setting Output Tray

Saving Power Consumption with the Power Save Function

Reducing Power Consumption by Automatically Turning the Machine Off

Adjusting Volume

Simultaneous Operation (Multitasking)

Checking the Information of the Machine

Using the Offline Stapler

Easy Setup

Profile

Configure One Touch Button

JOB MACRO
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Names of Components

The chapter describes the name of each component.

Front View

Rear View

Inside of the machine

Front View

No. Name

1 Auto document feeder (ADF) cover

2 Document tray

3 Scanner unit

4 Document glass cover

5 Operator panel
Basic Operations on the Operator Panel

6 USB port

7 Multipurpose (MP) tray
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No. Name

8 Document glass

No. Name

9 Upper output tray

10 Output tray

11 Paper supporter

12 Front cover

13 Front cover open lever

14 Tray 1

15 Paper size dial

16 Offline stapler

Rear View

No. Name

17 Telephone connector (for connecting an external telephone)

18 LINE connector

19 Output tray cover

20 Rear output tray

21 Duplex unit

22 Power connector

23 Wireless LAN module cover

24 Network interface connector
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25 USB interface connector

Inside of the machine

No. Name

26 LED head

27 Fuser

28 Toner cartridge / Image drum (C: cyan)

29 Toner cartridge / Image drum (M: magenta)

30 Toner cartridge / Image drum (Y: yellow)

31 Toner cartridge / Image drum (K: black)

32 Open button
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Basic Operations on the Operator Panel

Names and Functions

Name and Functions on the Touch Panel

How to Customize the Touch Panel

Adjusting Brightness

Adjusting Angle

Entering Characters
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Names and Functions

This section describes the names and functions of components on the operator panel.

No. Name Function

1 Touch panel Allows you to select or set an item by pressing a displayed icon.

2 [HOME]
 button

Displays the home screen.

3 [COPY]
 button

Displays the copy function screen.

4 [SCAN]
 button

Displays the scan function screen.

5 [PRINT]
 button

Displays the print function screen.

6 [FAX] button Displays the fax function screen.

7 DATA IN
 MEMORY
 indicator

Lights up when data remains in Memory.

8 [Status]
 button

Displays the status menu. Flashes/lights up if there is an error status.
You can check the remaining amount of consumables and fax communication
 status.

9 [CLEAR]
 button

Executes the following operations by pressing, or pressing and holding this
 key according to the entry item.

Minimizes a setting value.

Enters zero in a setting value.

Clears the entry.

Clears the selected item.

10 [START]
 button

Starts copying, scanning, faxing, or printing from USB Memory.

11 [STOP]
 button

Cancels copying, fax transmissions, or other jobs.

12 [POWER
 SAVE]
 button

Enters or exits the power saving mode.
In Power Save mode, lights up in green; In Sleep mode, flashes in green
 (every 3 seconds); In Deep Sleep mode, flashes in green (every 6 seconds).

Saving Power Consumption with the Power Save Function

13 [POWER]
 button.

Turns this machine on or off.

14 10-key pad Enters numbers, alphabets, and symbols.
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Note
When changing the angle of the operator panel, use care not to let your hands be caught
 between this machine and the operator panel. Injury may result.

Do not press the touch panel hard or poke it with a pointed object. It may damage the touch
 panel and cause malfunction.
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Name and Functions on the Touch Panel

When this machine turns on, the home screen is displayed on the touch panel.

Home Screen

Memo
The screen image shows the factory default setting. The screen that appears by pressing the 
 (HOME) button can be changed by [Admin Setup] > [Management] > [Default Mode].

Item Description

1 Stationary button area Displays buttons that appear on the screen at all times.
Displays the following items.

[Job Macro]

[Function Settings]

[Device Settings]

[RESET]

[Logout]

Antenna mark: appears when the wireless LAN is enabled.

[ ]

Only available buttons are displayed on the selected menu.

2 Title and operation
 guide area

Displays the title of the current screen and provides guide for possible
 operations.

3 Main area Press to use the copy functions.

Press to use the scan functions.

Press to use the print functions.
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Press to use the fax functions.

The following steps and functions are
 displayed.

Change Consumable & Maintain

(Toner cartridges, Image drams, Belt
 units, Fuser units)

Maintain and Care for the Unit

(Feeder Rollers, LED head, Scanner
 reader)

How to View the Screen of Each Function
The following descriptions use the [Basic] tab of the copy function as an example.

Item Description

1 Stationary button area Displays buttons that appear on the screen at all times.
Only available buttons are displayed on the selected menu.

2 Title and operation
 guide area

Displays the title of the current screen and provides guide for
 possible operations.

3 Tab labels Displays labels for tabs. Press a label to switch between tabs.
If any setting is changed from its default setting,  is displayed.

4 Main area Displays a preview of copy output that will be produced with the
 current settings.
The current setting is displayed on each button.
<About marks on a button>

: Indicates that the setting is changed from its default setting.
: Indicates that the next page exists.
/ : Indicates that the setting is turned on or off.

Memo
You can enter a value in the field with  displayed by using the 10-key pad.

Topics

About the top screen of each function

836



Names and Functions of Screen Items for Copy

Descriptions of Screens for Scan

Names and Functions of Screen Items for Print

Names and Functions of Screen Items for Fax

Names and Functions of Screen Items for Internet Fax
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How to Customize the Touch Panel

Setting a Home Icon on the Home Screen

Functions That Can be Set to a Home Icon on the Home Screen

Setting a Shortcut Button of Each Function

You can customize home icons and shortcut buttons on the home screen and the top screen
 of each function to fit your needs.

Setting a Home Icon on the Home Screen

Memo
You can register 16 icons.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Configure Home Screen].

5. Press the button whose setting you want to change.
The shortcut button setting screen is displayed.

6. Operate the touch panel according to the changes you want to
 make.

Item Description

1 Layout preview
 area

Displays the locations of the shortcut buttons.

2 Add function Inserts a function into the location where  is indicated in the layout
 preview area.

3 Add blank Inserts an empty button into the location where  is indicated in the
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 layout preview area.

4 Move Moves the selected button to a specified location.

5 Delete Deletes the function that is registered to the selected button.

7. Press [OK].

Functions That Can be Set to a Home Icon on the Home
 Screen

You can register the following functions.

Copy*

Fax/Internet Fax*

Fax

Internet Fax

Scan*

Scan To E-mail

Scan To Shared Folder

Scan To USB Memory

Scan To Computer

Remote Scan TWAIN

Remote Scan WSD

Print*

Stored Job

Encrypted Job

Print From USB Memory

Job Macro

Google Cloud Print

Troubleshooting*

* indicates the factory default setting.

Setting a Shortcut Button of Each Function

The number of shortcut buttons that can be set varies depending on the function.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Follow the procedure in the table below.
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Functions whose settings you
 want to change

Display on the touch panel and operation
 procedures

Copy Press [Copy Setup] > [Configure Shortcuts].

Scan To E-mail Press [Scanner Setup] > [E-mail Setup] >
 [Configure Shortcuts].

Scan To Shared Folder Press [Scanner Setup] > [Shared Folder Setup] >
 [Configure Shortcuts].

Fax Sending Press [Fax Setup] > [Configure Shortcuts].

Internet Fax Sending Press [Internet Fax Setup] > [Configure Shortcuts].

Scanning to Fax Server Press [FaxServer Function] > [Configure Shortcuts].

5. Press the button whose setting you want to change.

6. Select a function to register.

Memo
Each shortcut button registered cannot be deleted. It can be replaced by a different
 shortcut button.

7. Press [OK].
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Adjusting Brightness

To change the brightness of the touch panel on the operator panel, perform the procedure
 below.

You can adjust the brightness of screen during operation and in the Power Save mode
 respectively.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times, and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times, and press [Management].

5. Press [System Setup].

6. Press  or  several times, and press [Panel Brightness During
 Operating] or [Panel Brightness While Power Save].

7. Enter value and press [OK].
Available values are from 1 to 7. The bigger the number is, the brighter the screen
 gets.
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Adjusting Angle

You can change the angle of the operator panel.

1. Hold the both sides of the touch panel and adjust to a desired
 angle.
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Entering Characters

Entering with the Touch Panel

Entering with the 10-key Pad

Entering with the Touch Panel

When you need to enter characters while you are setting an item, the following entry screen
 is displayed.

You can enter uppercase and lowercase alphabets, numbers, and symbols.

About the entry screen
The number of buttons in the entry screen differs depending on the input.

Item Description

1 text entry field Displays the entered characters.

2 The number of entered characters/the
 maximum number of characters that can
 be entered

Indicates the maximum number of characters
 that can be entered and the number of entered
 characters.

3 Back Space Deletes a character just before the cursor.

4 Character panel Enters characters.
The character type switches depending on the
 entry mode.

5 Return button Puts a line break. This button appears when
 entering body text of an E-mail.

6 Left button/right button/up button/down
 button

Moves the cursor left, right, up, or down.

7 Capital Lock Switches between the uppercase and lowercase
 characters.

8 Entry mode button Switches the entry mode (types of characters)
 for entering text.

Entering Characters

1. Press the touch panel.
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2. When the entry is complete, press [OK] or [Next].

Memo
To enter a diacritical mark, press and hold a character button with [...] shown. When a diacritical
 mark appears, press the character you want to enter.

The screen below shows an image when holding down the "a" button.

Switching the Entry Mode (Numbers  Alphabetic Characters)

1. Press [Alpha] or [Symbol].

Memo
[RU] may be shown in case of Russian, and [EL] in case of Greek. In case of other languages,
 only [Alpha] and [Symbol] may be shown.

Switching the Entry Mode (Uppercase  Lowercase)

1. Press the button to switch between the uppercase and lowercase
 characters.

Deleting an Entered Character

1. Use the back space (tentative name) button on the touch panel or
 the  (CLEAR) button.
The character before the cursor ( ) is deleted.

Memo
Press [ ], [ ], [ ], or [ ] to move the cursor ( ) to the character next to the
 character to delete.

Entering with the 10-key Pad
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You can enter the numbers labeled on each key.

Note
It is impossible to enter the alphabet.

Please enter the alphabet from the touch panel.

Deleting an Entered Character
To delete the character to the left of the cursor, press the  (CLEAR) button.

To clear characters you entered in a row, press and hold the  (CLEAR) button.
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Turning the Machine On or Off

About the Power Supply

The power supply must meet the following conditions.

AC 110 to 127VAC (Range 99 to 140VAC)

220 to 240VAC (Range 198 to 264VAC)

Frequency 50/60 Hz ± 2%

Note
If the power supply is unstable, use a voltage regulator.

The maximum power consumption of the machine is 1400 W. Check that the power supply is
 sufficient.

The operation that uses an uninterruptible power supply (UPS) or inverter is not guaranteed.
 Do not use an uninterruptible power supply (UPS) or inverter.

 

Be sure to turn this machine off before connecting and disconnecting the power cord and the
 ground wire.

Be sure to connect the ground wire to the designated ground terminal. 
If this machine cannot be grounded, contact your dealer.

Be sure not to connect the ground wire to the ground of a water pipe, gas pipe or telephone
 line, or to a lightning rod.

Be sure to connect the ground wire before connecting the power cord to the outlet. Also, be
 sure to unplug the power cord from the outlet before disconnecting the ground wire.

Be sure to plug or unplug the power cord by holding its power plug.

Securely plug the power cord into the outlet.

Do not plug or unplug the power cord with wet hands.

Install the power cord in a location where users cannot step on it, and do not place any object
 on the power cord.

Do not bundle or tie the power cord.

Do not use a damaged power cord.

Do not overload the outlet.

Do not connect the power cords of this machine and other electric products to the same outlet.
 If the power cord of this machine is connected to the same outlet as other electric products,
 especially an air conditioning machine, copier, or shredder, this machine may malfunction due
 to electrical noise. If you have to connect the power cord of this machine to the same outlet as
 other products, use a commercially available noise filter or noise cut transformer.

Use the power cord included in this machine, and plug the cord directly into the outlet. Do not
 use the power cords of other products for this machine.

Do not use an extension cord. If you have to use an extension cord, use a cord rated 15A or
 higher.

Fire or electric shock may result.
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Use of an extension cord may result in this machine malfunctioning due to AC voltage drop.

Do not turn this machine off or unplug the power cord during printing.

If you do not use this machine for an extended period of time due to holidays, trips, or other
 reasons, unplug the power cord.

Do not use the power cord included in this machine for other products.

Turning the Machine On

Turning the Machine Off
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Turning the Machine On

1. Plug the power cord into the power connector.

2. Plug the power cord into the outlet.

3. Check that no documents are set on the document glass or in the
 ADF, and the ADF cover is closed.

4. Press the power switch for approximately a second.

When the machine is turned on, the power switch LED lamp is lit.

When the machine is turned on for the first time after the wireless LAN board is
 attached, the wireless setting screen is displayed.

If you select [Yes], the wireless LAN setting is performed.
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If you select [Do not show next time.], the wireless setting is not performed. The
 wireless setting screen is not displayed any more.

If you select [No], the wireless LAN setting is not performed. The wireless setting
 screen is displayed every time you turn the machine on.

5. The machine enters standby status, and then the home screen is
 displayed.
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Turning the Machine Off

Note
Check that the machine is not receiving a fax or other data from a computer before shutting
 down.

Press and hold the power switch for 5 seconds or more to force shut down the machine. Use
 this method only if a problem occurs.

For troubleshooting of this machine, refer to "Troubleshooting".

1. Press the power switch for approximately a second.

The "Shutdown in progress. Please wait. The machine turns off automatically."
 message is displayed, and the power switch LED lamp flashes at approximately one-
second intervals.

After a while, the machine automatically turns off, and the power switch LED lamp
 goes out.

What You Should Do If You Do Not Use This Machine for an
 Extended Period of Time

If you do not use this machine for an extended period of time due to holidays, trips, or other
 reasons, unplug the power cord from the outlet.

Memo
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This machine does not have functional failures if the power cord is unplugged for an extended
 period of time (four weeks or more).

851



Loading Paper

This chapter describes various information about paper that can be loaded in a paper tray of
 this machine.

To set paper type and weight, press [Device Settings] > [Paper Setup] and press the tray
 you want to use, and then select [Media Type] or [Media Weight].

About Paper Types That Can be Loaded and Storage Methods

Paper storage

About Paper Sizes, Weight, and Number of Sheets That Can be Loaded

Loading Paper

Loading Envelopes

About Paper Types That Can be Loaded and Storage
 Methods

Available paper types
To perform high-quality printing, be sure to use the supported paper types that satisfy
 requirements, such as material, weight, or paper surface finishing. Use digital photo print
 paper.

If you print on paper that is not recommended by Oki Data, check the print quality and
 the movement of the paper thoroughly in advance to ensure that there are no problems.

Paper
 type

Paper type and paper size (mm) (The
 value enclosed with brackets is

 indicated in inches.)

Paper weight

Plain
 paper

A3 297 x 420 64 to 256 g/m2 (17 to 68 lb)
For duplex printing, 64 to 220 g/m2 (7
 to 58 lb)

Note
If you set paper that is 216 mm
 (8.5 inches) wide or narrower,
 printing becomes slower.

A4 210 x 297

A5 148 x 210

A6 105 x 148

B4 257 x 364

B5 182 x 257

B6 128 x 182

B6 Half 91 x 128

Letter 215.9 x 279.4
 (8.5 x 11)

Legal 13 215.9 x 330.2
 (8.5 x 13)

Legal 13.5 215.9 x 342.9
 (8.5 x 13.5)

Legal 14 215.9 x 355.6
 (8.5 x 14)

Executive 184.2 x 266.7
 (7.25 x 10.5)

852



Statement (5.5 x 8.5)

8.5" SQ (8.5 x 8.5)

Folio
 (210 x 330 mm)

210 x 330

8K
 (270 x 390 mm)

270 x 390

8K
 (273 x 394 mm)

273 x 394

8K
 (260 x 368 mm)

260 x 368

16K
 (184 x 260 mm)

184 x 260

16K
 (195 x 270 mm)

195 x 270

16K
 (197 x 273 mm)

197 x 273

4x6inch (4 x 6)

5x7inch (5 x 7)

Custom Width: 64 to 297
Length: 90 to 1321

64 to 256 g/m2 (17 to 68 lb)

Envelope Monarch 98.4 x 190.5
 (3.875 x 7.5)

Envelopes must be made of paper of
 85 g/m2 (24 lb), and their flaps must
 be folded.

Com-9 98.4 x 225.4
 (3.875 x 8.875)

Com-10 104.8 x 241.3
 (4.125 x 9.5)

DL 110 x 220 (4.33 x 8.66)

C5 162 x 229 (6.4 x 9)

C6 114 x 162 (4.49 x 6.38)

Label A4 210 x 297 0.1 to 0.2 mm

Letter 8.5 x 11
 (215.9 x 279.4)

Partly-
printing
 paper

Subject to plain paper 64 to 256 g/m2 (17 to 68 lb)

Color
 paper

Subject to plain paper 64 to 256 g/m2 (17 to 68 lb)

Recommended paper
The machine supports a variety of print media, including a range of paper weights and
 sizes. This section describes how to choose and use media. To obtain the best
 performance, use 75 to 90 g/m2 plain paper that is designed for use in copiers and laser
 printers. Use of heavily embossed or very rough textured paper is not recommended.
 Pre-printed stationery can be used, but the ink must not offset when exposed to the high
 fuser temperatures used in the printing process.

Envelopes

Envelopes must be free from twists, curls or other deformations. The envelopes must
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 also be of the rectangular flap type, with glue that remains intact when subjected to
 hot roll pressure fusing in the machine. Window envelopes are not suitable.

Labels

Labels must be of the type recommended for use in copiers and laser printers, in
 which the base carrier page is entirely covered by labels. Other types of label stocks
 may damage the machine due to the labels peeling off during the printing process.

Paper storage

Store paper under the following conditions to maintain quality.

Inside a cabinet or other dry and dark place

On a flat surface

Temperature: 20℃
Humidity: 50% RH (relative humidity)

Do not store paper in the places as shown below:

Directly on the floor

Where paper is exposed to direct sunlight

Near the inside of an exterior wall

On an uneven surface

Where static electricity may be generated

Where temperature excessively rises high and temperature rapidly changes

Near this machine, an air conditioner, a heater, or duct

Note
Do not unwrap paper until just before you use.

Do not leave paper unwrapped for a long period. Doing so may result in printing problems.

About Paper Sizes, Weight, and Number of Sheets That
 Can be Loaded

The following paper types and tray capacity can be loaded in each tray.

Loading in Tray 1

Available paper size Tray capacity Paper weight

A3
A4
A5*

A6*

B4
B5
B6
Tabloid
Letter
Legal (13 inches)

300 sheets
(if paper weight is 80 g/m2)

Light
(64 to 82 g/m2)
Medium Light
(83 to 90 g/m2)
Medium
(91 to 105 g/m2)
Heavy
(106 to 128 g/m2)
Ultra Heavy1
(129 to 188 g/m2)
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Legal (13.5 inches)
Legal (14 inches)
Executive
Statement*

8.5" SQ (8.5 x 8.5 inches)
Folio (210 x 330 mm)
8K (270 x 390 mm)
8K (273 x 394 mm)
8K (260 x 368 mm)
16K (184 x 260 mm)
16K (195 x 270 mm)
16K (197 x 273 mm)
Custom

Ultra Heavy2
(189 to 220 g/m2)

*Paper cannot be used for duplex printing.

Loading in Tray 2/3/4 (Optional)

Available paper
 size

Tray
 capacity

Paper weight

A3
A4
A5*

B4
B5
Tabloid
Letter
Legal (13 inches)
Legal
 (13.5 inches)
Legal (14 inches)
Executive
8.5" SQ
 (8.5 x 8.5 inches)
Folio
 (210 x 330 mm)
8K
 (270 x 390 mm)
8K
 (273 x 394 mm)
8K
 (260 x 368 mm)
16K
 (184 x 260 mm)
16K
 (195 x 270 mm)
16K
 (197 x 273 mm)
Custom

535 sheets
(if paper
 weight is
 80 g/m2)

Light
(64 to 82 g/m2)
Medium Light
(83 to 90 g/m2)
Medium
(91 to 105 g/m2)
Heavy
(106 to 128 g/m2)
Ultra Heavy 1
(129 to 188 g/m2)

Note
Weight of paper loaded on an additional tray unit is 64
 to 176g/m2.

The specified paper weight of Ultra Heavy1 is described
 as 129 to 188 g/m2, but the printable weight is up to
 176 g/m2.

* Paper cannot be used for duplex printing.
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Loading in the MP Tray

Available paper size Tray capacity Paper weight

A3
A4
A5*

A6*

B4
B5
B6
Tabloid
Letter
Legal (13 inches)
Legal (13.5 inches)
Legal (14 inches)
Executive
Statement*
8.5" SQ (8.5 x 8.5 inches)
Folio (210 x 330 mm)
8K (270 x 390 mm)
8K (273 x 394 mm)
8K (260 x 368 mm)
16K (184 x 260 mm)
16K (195 x 270 mm)
16K (197 x 273 mm)
Index Card (3x5inch)*
4x6inch*
5x7inch*

Custom
Com-10*

Monarch*

DL*

C5*

C4

100 sheets
(if paper weight is 80 g/m2)
10 sheets (envelopes)

Light
(64 to 82 g/m2)
Medium Light
(83 to 90 g/m2)
Medium
(91 to 105 g/m2)
Heavy
(106 to 128 g/m2)
Ultra Heavy1
(129 to 188 g/m2)
Ultra Heavy2
(189 to 220 g/m2)
Ultra Heavy3
(221 to 256 g/m2)

* Paper cannot be used for duplex printing.

Loading Paper

Paper can be loaded in the following three trays; Tray 1, Tray 2, Tray 3, and MP tray.

Load envelopes or labels in the MP tray.

Loading in Tray 1 or Tray 2/3/4
The following procedure describes how to load paper in Tray 1 or Tray 2/3/4 (optional).

Note
The following procedure uses Tray 1 as an example, and the same procedure applies to Tray
 2/3/4 (optional).
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1. Pull the paper cassette out.

2. Set the paper size dial (1) to match the loading paper size.

3. Slide the paper guide to the width of paper to be loaded.

4. Slide the paper stopper to the length of paper to be loaded.

When loading the A6 size paper, move the paper stopper (2) forward and remove it
 once, then install it on the metal part. Slide the paper support in the direction of the
 arrow and fix it.
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5. Fan a stack of paper well, and then align the edges of the paper.

6. Load paper with the print side face down.

Note
Do not load paper above the " " mark on the paper guide.

7. Secure the loaded paper with the paper guide.

8. Check if a size of loaded paper matches the setting of paper size
 dial.

9. Push the paper cassette until it stops.
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If loading a paper that you cannot select the size with a paper size dial options, set the
 dial to [Other], and then set a paper size on the operator panel.

10. Press [Device Settings] on the touch panel.

11. Press [Paper Setup].

12. Press the tray in which paper is loaded.

13. Set [Paper Size], [Media Type], and [Media Weight].

14. Press [Back] until the home screen is displayed.

Loading in the MP Tray
The following procedure describes how to load paper in the MP tray.

1. Open the MP tray forward by inserting your fingers into the front
 recesses.

2. Pull out the paper support by holding the center part of it.
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3. Open the sub support.

4. Open the paper set cover.

5. Adjust the manual feeding paper guide to the width of paper to be
 loaded.
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6. Insert the paper with the print side up until its edge touches the
 paper feed entrance.

Note
Do not load paper above the " " mark.

7. Close the paper set cover.

Note
When a printer is in the power saving mode, press the <POWER SAVE> button to restore
 from the mode.

8. Set [Paper Size], [Media Type], and [Media Weight] on the paper
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 setup screen.

9. Press [Close].

Note
Do not load paper in different sizes, types, or weights.

When adding paper, remove paper loaded in the MP tray, properly align edges of both
 bundles of paper, and then load them.

Do not insert objects other than paper in the MP tray.

Loading Envelopes

This section describes how to load envelopes in the MP tray.

1. Open the MP tray forward by inserting your fingers into the front
 recesses.

2. Pull out the paper support by holding the center part of it.

3. Open the sub support.
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4. Open the paper set cover.

5. Adjust the manual feeding paper guide to the width of an envelope
 to be loaded.

6. Load an envelope with the print side up until its edge touches the
 paper feed entrance.

Note
Do not load envelopes above the " " mark.
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Com-10, DL, C5 C4

Memo
If you are using envelopes with the flap (for gluing) on the long edge (Com-10, DL, C5),
 load them with the flap folded so that the flap is on the left side when fed.

7. Close the document set cover.

8. Open the rear output tray.
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Setting a Document

This chapter describes how to set the document on this machine.

About Documents That Can be Set

Setting in the ADF

Setting on the Document Glass

About Documents That Can be Set

About Where to Set a Document
Set a document in the ADF or on the document glass to copy, scan, or fax the document.

ADF

Scannable
 size

A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter , Letter ,
 Legal 13/13.5/14, Executive , Statement , Statement , Folio, 8.5 SQ

Paper
 capacity

100 sheets (80 g/m2) or maximum rise of 10 cm (4 inches)

Paper
 weight

60 to 120 g/m2 (16 to 32 lb)

Document glass

Scannable
 size

A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter , Letter ,
 Legal 13/13.5/14, Executive , Statement , Statement , Folio, 8.5 SQ

Document
 thickness

Up to 20 mm

Memo
Duplex scan is not available for A5 , A6, B5 , Statement .

Note
For documents on which adhesives, ink, or correction fluid is used, make sure that they have
 completely dried before setting.

About Documents That Cannot be Set
You cannot set the following documents in the ADF. Use the document glass, instead.

Documents with holes or tears

Documents folded or damaged

Badly curled or rolled documents

Damp documents

Documents that are stuck together due to static electricity

Carbon-backed documents
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Cloth, metal sheets, OHP films

Stapled, clipped, or taped documents

Documents that are pasted each other, or documents with glue

Glossy documents

Coated documents

Observe the following to avoid damaging the document glass.

When copying a thick document, do not press on it on the document glass.

Place a hard document gently.

Do not set a document that has sharp protrusions.

About the Scannable Area When Copied
Texts or images within the 2 mm area from the edges of standard paper cannot be
 scanned with the copy function.

Symbols Indicating Document Orientation
 This symbol indicates that the document is placed in the vertical orientation from

 the front of this machine.

For the ADF, place the document in such a way as to feed the long edge first.

 This symbol indicates that the document is placed in the horizontal orientation
 from the front of this machine.

For the ADF, place the document in such a way as to feed the short edge first.

When setting an A4  document in the ADF

When setting an A4  document in the ADF
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Setting in the ADF

1. Set a document face up in the ADF.
If [Direction] is set to [Top Edge on Top], set the document so that its left edge is
 pulled into the ADF first.

If [Direction] is set to [Top Edge on Left], set the document so that its top edge is
 pulled into the ADF first.

2. Align the document guide to the document width.

Note
If ADF paper feed problems often occur, reduce the number of document pages to set.

Documents of up to 100 sheets (80 g/m2) and 10 mm high can be loaded regardless of
 the size.

For curled documents, make sure that the document guides fit to the document width.
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Memo
The machine automatically detects the following document sizes.

Series Detectable sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

* If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.

Setting on the Document Glass

1. Open the document glass cover.

2. Set a document face down on the document glass.
If a document is portrait, align its top edge with the upper-left corner of the glass.

If a document is landscape, align its right edge with the upper-left corner of the glass.
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Note
Do not press the document glass forcefully.

3. Close the document glass cover gently.
You must change the [Direction] setting to suit the document orientation (portrait or
 landscape) in advance.

About the [Direction] setting

Changing the Document Orientation (Direction)

Memo
The machine automatically detects the following document sizes.

Series Detectable sizes

AB A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Folio

Letter Tabloid, Letter , Letter , Legal14, Executive , Statement 

* If Legal14 is detected in the Letter series, the value between Legal13, Legal13.5, and
 Legal14 which is specified from [Device Settings] > [Admin Setup] > [Scanner Setup] >
 [Default Settings] > [Auto detect Scan Size] > [Legal Size] is set as Scan Size.
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Note
When the document is set on the document glass, the document size is detected after the
 document glass cover is closed.

Be sure to close the document glass cover.
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Setting Output Tray

Upper Output Tray/Output Tray

Rear Output Tray

The machine outputs paper to the Output tray, Upper Output Tray (only for MC873 Series)
 or Rear output tray. Paper types that can be output to each tray are as follows.

1. Press [Device Settings] on the touch panel.

2. Press [Paper Setup].

3. Press  or  several times and press [Output Tray].

4. Set the output tray you want to use for each function.

Available paper for output trays.

Output tray Supported paper
 type

Capacity

Output tray Plain paper

Recycled paper

250 sheets (80 g/m2)

Upper output tray (Only for MC873
 Series)

Plain paper

Recycled paper

100 sheets (80 g/m2)

Rear output tray Plain paper

Recycled paper

Envelope

3x5inch, 4x6inch,
 5x7inch

Label

100 sheets (80 g/m2)

10 sheets (thick paper and
 envelopes)

Note
Do not open or close the Rear output tray during printing. Paper jams may result.

Upper Output Tray/Output Tray

Use these output trays for plain paper. Paper is output with the printed side down.

They are not available for envelopes, labels, or long paper.

Check that the rear output tray on the rear side of the machine is closed. While the rear
 output tray is open, paper is always output to the Rear Output Tray.
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Memo
Open the paper support so that outputs do not slip down from the output tray.

Rear Output Tray

Use rear output tray when printing on envelopes, labels, or long paper.

Paper is output with the printed side up. Plain paper is also available for this output tray.

1. Open the rear output tray (F) on the rear side of the machine.

2. Unfold the paper support.

3. Open the sub support.
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Saving Power Consumption with the Power Save
 Function

The machine has three Power Save modes: Power Save, Sleep, and Deep Sleep.

If you do not use the machine for a certain period of time, the machine automatically enters
 Power Save mode, saving power consumption. Alternatively, you can switch the machine to
 Power Save mode by pressing the  (POWER SAVE) button.

Setting Power Save Mode

Setting Sleep Mode

About Restrictions in Sleep Mode and Deep Sleep Mode

The procedures for switching the machine to each mode and conditions to exit each mode
 are shown in the table below.

Power
 Save
 mode

Procedure for
 switching the

 machine to each
 mode

Condition
 to

 switch
 to each
 mode

Machine status Condition to exit
 each mode

Power
 Save
 mode

After a certain
 period of time
 passes*1, or press
 the  (POWER
 SAVE) button

- The backlight on the
 operator panel turns off.
 The  (POWER SAVE)
 button lights up in green.

Press a button on the
 operator panel. Print
 data, a fax, or other
 data is received.
Set the document in
 the ADF.
Open or close the
 document glass cover.

Sleep
 mode

After a certain
 period of time
 passes*2

A certain
 function*3
 is
 enabled.

The screen on the operator
 panel turns off. The 
 (POWER SAVE) button
 flashes in green (every
 3 seconds).

Press the  (POWER
 SAVE) button. Print
 data, a fax, or other
 data is received.
Set the document in
 the ADF.
Open or close the
 document glass cover.

Deep
 Sleep
 mode

After a certain
 period of time
 passes*2

A certain
 function*3
 is
 disabled.

The screen on the operator
 panel turns off. The 
 (POWER SAVE) button
 flashes in green (every
 6 seconds).

Same conditions as
 Sleep mode are
 applied or there are
 restrictions to exit
 Deep Sleep*4.

*1 If the machine idles for a certain period of time (1 minute by factory default), the
 machine automatically enters Power Save mode. To change the time to enter Power
 Save mode, refer to "Setting Power Save Mode".

*2 If the machine idles for a certain period of time (15 minutes by factory default) in
 Power Save mode, the machine automatically enters Sleep mode or Deep Sleep mode.
 To change the time to enter Sleep mode or Deep Sleep mode, refer to "Setting Sleep
 Mode".

*3 For details on the applicable function, refer to "Setting Sleep Mode".
*4 For details on the restrictions, refer to "About Restrictions in Sleep Mode and Deep

 Sleep Mode".

875



Using the Operator Panel

You can set Power Save mode from the operator panel.

Set the length of idle time before entering Power Save mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Power Save].
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6. Press [Power Save Time].

7. Select transition time.
The factory default setting is 1 minute.
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Setting Power Save Mode

If you do not use the machine for a certain period of time, the machine automatically enters
 Power Save mode, saving power consumption.

Alternatively, you can press the  (POWER SAVE) button to manually switch the machine to
 Power Save mode. If you press the  (POWER SAVE) button in Power Save mode, the
 machine returns to standby status.

In Power Save mode, the  (POWER SAVE) button lights up.

Exiting Power Save Mode to Standby Mode
To exit Power Save mode to standby status, press the  (POWER SAVE) button.

Memo
When this machine receives data from a computer or other devices, this machine returns to
 standby status.

Also, when the document is set in the ADF or the document glass cover is opened/closed,
 this machine returns to the standby status.

You can register Power Save mode in the following three ways.

Using the Web Page of This Machine from a Computer

This section describes how to set Power Save mode from the Web page. You must log in
 as the administrator to set this setting.

Using Configuration Tool (Windows Only)

This section describes how to set Power Save mode from the Configuration Tool. You must
 enter the administrator password to set this setting.

Using the Operator Panel

This section describes how to set Power Save mode from the operator panel on the
 machine. You must enter the administrator password to set this setting.
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Using the Web Page of This Machine from a Computer

You can set Power Save mode from the Web page of this machine.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Click [Admin Setup].

4. Click [Management] > [Power Save].

5. Select the transition time from [Power Save Time], and then click
 [Submit].
Available transition time settings

1 minute*, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 10 minutes,
15 minutes, 30 minutes, 60 minutes

* indicates the factory default setting.
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Using Configuration Tool (Windows Only)

You can set Power Save mode from Configuration Tool.

Set the length of idle time before entering Power Save mode.

For details on Configuration Tool, refer to "Using Configuration Tool".

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Click the [Device Setting] tab.

4. Click [Menu settings].

5. Click  (Display administrator settings).

6. Enter the administrator password, and then click [OK].

7. Click  in order of [Admin Setup] > [Management] > [Power
 Save].

8. Select the transition time from [Power Save Time], and then click 
 (Save to device).

Available transition time settings

1 minute*, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 10 minutes,
15 minutes, 30 minutes, 60 minutes

* indicates the factory default setting.
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Using the Operator Panel

You can set Power Save mode from the operator panel.

Set the length of idle time before entering Power Save mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Power Save].

6. Press [Power Save Time].

7. Select transition time.
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Setting Sleep Mode

When a set period of time elapses, this machine enters Sleep mode from Power Save mode.
 In Sleep mode, the status of this machine is almost the same as when this machine is
 turned off.

In Sleep mode, the  (POWER SAVE) button flashes.

Note
If an error has occurred, the machine does not enter Sleep mode.

If a delayed transmission is reserved, the machine does not enter Sleep mode.

If a fax transmission is waiting for a redial, the machine does not enter Sleep mode.

If the wired network connection is switched to the wireless network connection, the machine
 does not enter Deep Sleep mode but enters Sleep mode.

If the wireless network connection is switched to the wired network connection, the machine
 enters Deep Sleep mode.

Exiting Sleep Mode or Deep Sleep Mode to Standby Mode
To exit Sleep mode to standby status, press the  (POWER SAVE) button.

Memo
When this machine receives data from a computer or other devices, this machine returns to
 standby status.

Also, when the document is set in the ADF or the document glass cover is opened/closed,
 this machine returns to the standby status.

You can register Sleep mode in the following three ways.

Using the Web Page of This Machine from a Computer

This section describes how to set Sleep mode from the Web page. You must enter the
 administrator password to set this setting.

Using Configuration Tool (Windows Only)

This section describes how to set Sleep mode from Configuration Tool. You must enter the
 administrator password to set this setting.

Using the Operator Panel

This section describes how to set Sleep mode from the operator panel of this machine. You
 must enter the administrator password to set this setting.
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Using the Web Page of This Machine from a Computer

You can set Sleep mode from the Web page of this machine.

Set the length of idle time before entering Sleep mode.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Click [Admin Setup].

4. Click [Management] > [Power Save].

5. Select the transition time from [Sleep Time], and then click
 [Submit].
Available transition time settings

1 minute, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 10 minutes,
15 minutes*, 30 minutes, 60 minutes

* indicates the factory default setting.

Topics

About Restrictions in Sleep Mode and Deep Sleep Mode
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Using Configuration Tool (Windows Only)

You can set Sleep mode from Configuration Tool.

Set the length of idle time before entering Sleep mode.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Click the [Device Setting] tab.

4. Click [Menu settings].

5. Click  (Display administrator settings).

6. Enter the administrator password, and then click [OK].

7. Click  in order of [Admin Setup] > [Management] > [Power
 Save].

8. Select the transition time from [Sleep Time], and then click 
 (Save to device).
Available transition time settings

1 minute, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 10 minutes,
15 minutes*, 30 minutes, 60 minutes

* indicates the factory default setting.

Topics

About Restrictions in Sleep Mode and Deep Sleep Mode
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Using the Operator Panel

You can set Sleep mode from the operator panel.

Set the length of idle time before entering Sleep mode.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Power Save].

6. Press [Sleep Time].

7. Select transition time.
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About Restrictions in Sleep Mode and Deep Sleep Mode

This section describes the restrictions when the machine is in Sleep mode or Deep Sleep
 mode.

If the machine displays an error, the machine does not enter Sleep mode or Deep Sleep
 mode.

In Sleep mode, the network function is restricted as follows.

The machine does not enter Deep Sleep mode
The machine does not enter Deep Sleep mode in the following cases.

IPSec is enabled

A TCP connection is established

Example: A connection is established with Telnet or FTP.

When the transition time to enter Sleep mode or Deep Sleep mode from Power Save
 mode elapses and the connection is disconnected, the machine enters Sleep mode.

E-mail reception is enabled

Wireless LAN is enabled

Google Cloud Print is enabled

LLTD is enabled

HUB Link Status is 1000BASE-T

IPv6 Global Address is assigned

Access Control in the Access Control settings is enabled and Local IC Card or LDAP IC
 Card in the Authentication Method is enabled.

Memo
To switch the machine to Deep Sleep mode, disable IPSec or e-mail reception.

Cannot print
In Deep Sleep mode, you cannot use the following protocols to print.

IPv6

NBT

WSDPrint

Cannot search or set
In Deep Sleep mode, you cannot search or set by using the following functions and
 protocols.

NBT

PnP-X

UPnP

LLTD
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MIB*

* References with some supported MIB (the Get command) are possible in Deep Sleep
 mode.

Protocols that have the client function do not operate
In Deep Sleep mode, the following protocols that have the client function do not operate.

E-mail alert*2

SNMP Trap

WINS*1

SNTP*2

*1 The elapse time in Deep Sleep mode is not included in the intervals of WINS update time.
WINS regular updates are not performed in Deep Sleep mode, possibly resulting in names
 that are registered in the WINS server being deleted.

*2 The elapse time in Deep Sleep mode is not included in the intervals of the e-mail alert
 notification time and the intervals of the NTP server update time.

The machine automatically enters Sleep mode from Deep Sleep
 mode

In a network environment where a large number of packets are sent, the machine
 automatically exits Deep Sleep mode to Sleep mode and responds.

Also, if a terminal that runs searches with Bonjour, such as Mac or iPhone, is connected
 to the same network, the machine automatically exits Deep Sleep mode to Sleep mode
 and responds.

This machine automatically enters Deep Sleep mode after a certain period of time.
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Reducing Power Consumption by Automatically Turning
 the Machine Off

If you do not use the machine for a certain period of time, the machine automatically enters
 Auto Power Off and turns off. To use the machine again, turn the machine on.

About the Auto Power Off Function Setting Items

This section describes three setting items that decide the Auto Power Off operation.

Setting Auto Power Off

This section describes how to set the transition time to enter Auto Power Off. To set this
 setting, the administrator password is required.
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About the Auto Power Off Function Setting Items

There are three types of Auto Power Off settings.

[Enable]: If you do not use the machine for a certain period of time, the machine
 automatically turns off.

[Auto Config]: The machine does not automatically turn off in the following cases.

A LAN cable is connected to the network interface connector.

A telephone cable is connected to the LINE connector.

Wireless LAN is enabled.

[Disable]: The Auto Power Off function is disabled. The machine does not automatically
 turn off.

Note
If an error has occurred, the machine does not automatically turn off.

If a delayed transmission is reserved, the machine does not automatically turn off.

If a fax transmission is waiting for a redial, the machine does not automatically turn off.
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Setting Auto Power Off

You can register Auto Power Off in the following three ways.

Using the Web Page of This Machine from a Computer

This section describes how to set Auto Power Off from the Web page. You must enter the
 administrator password to set this setting.

Using Configuration Tool (Windows Only)

This section describes how to set Auto Power Off from Configuration Tool. You must enter
 the administrator password to set this setting.

Using the Operator Panel

This section describes how to set Auto Power Off from the operator panel of this machine.
 You must enter the administrator password to set this setting.
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Using the Web Page of This Machine from a Computer

Setting Auto Power Off

Setting the Transition Time

You can set Auto Power Off from the Web page of this machine.

Setting Auto Power Off

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Click [Admin Setup].

4. Click [User Install] > [Power Setup].

5. Select [Auto Power Off], and then click [Submit].
Available value settings:

Enable, Auto Config*, Disable

* indicates the factory default setting.

Setting the Transition Time

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Click [Admin Setup].

4. Click [Management] > [Power Save].

5. Select [Auto Power Off Time], and then click [Submit].
Available value settings:

1 hour, 2 hours, 3 hours, 4 hours*, 8 hours, 12 hours, 18 hours,
24 hours

* indicates the factory default setting.
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Using Configuration Tool (Windows Only)

You can set Auto Power Off from Configuration Tool.

Set the length of idle time before entering Auto Power Off.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Click the [Device Setting] tab.

4. Click [Menu settings].

5. Click  (Display administrator settings).

6. Enter the administrator password, and then click [OK].

7. Click  in order of [Admin Setup] > [Management] > [Power
 Save].

8. Select the transition time from [Auto Power Off Time], and then
 click  (Save to device).
Available transition time settings:

1 hour, 2 hours, 3 hours, 4 hours*, 8 hours, 12 hours, 18 hours,
24 hours

* indicates the factory default setting.
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Using the Operator Panel

Enabling Auto Power Off

Setting the Transition Time

Enabling Auto Power Off

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [User Install].

5. Press [Power Setup].

6. Press [Auto Power Off].

7. Select the value.
Available value settings:

Enable, Auto Config*, Disable

* indicates the factory default setting.

Setting the Transition Time

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Power Save].

6. Press [Auto Power Off Time].

7. Select transition time.
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Adjusting Volume

Adjusting the Key Touch Tone Volume on the Operator Panel

Adjusting Copy Buzzer Volume

Adjusting Fax Buzzer Volume

Adjusting Paper JAM Buzzer Volume

This chapter describes how to adjust the volume of the sound that the machine emits such
 as the key touch tone volume of the operator panel.

Adjusting the Key Touch Tone Volume on the Operator
 Panel

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Sound Control].

6. Press [Key Touch Tone Volume].

7. Select a volume level.
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Adjusting Copy Buzzer Volume

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Sound Control].

6. Press [Copy Buzzer Volume].

7. Select a volume level.

Adjusting Fax Buzzer Volume

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Sound Control].

6. Press [FAX Buzzer Volume].

7. Select a volume level.

Adjusting Paper JAM Buzzer Volume
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1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press [Sound Control].

6. Press [JAM Buzzer Volume].

7. Select a volume level.
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Simultaneous Operation (Multitasking)

This machine can operate several functions simultaneously. For details, refer to the following
 table.

Note
You cannot use the operator panel while the machine reads documents.

During the simultaneous operation, each operation performance may be deteriorated.

Depending on the machine condition, such as Memory full, simultaneous operation may not
 be accepted.

: Available : Not available

First task Second task

Copy Fax
 transmission

Fax
 reception

Scan To Shared Folder/Scan
 To E-mail/Scan To USB

 Memory

Printing
 from a

 computer

Copy *2 *2 *2

Fax
 transmission

*1

Fax reception *2 *1 *2

Scan To
 Shared
 Folder

Scan To E-
Mail

 (Except for E-mail)

Scan To USB
 Memory

Printing from
 a computer

*2 *2 *2

*1 If the first task is sending, the second task is suspended until the first task is
 completes.

*2 When the first task completes, the second task starts to be printed.
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Checking the Information of the Machine

You can print and check the configuration or the job logs of this machine.

1. Press [Device Settings] on the touch panel.

2. Press [Reports].

3. Select the category of a report to print.

4. Select a report to print.
If the administrator login screen is displayed,enter administrator name and password.

The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

5. Press [Yes] on a confirmation screen.

Note
If [Admin Setup] > [Management] > [System Setup] > [Allow All Reports To Print] is set
 to [Disable], log in as the administrator to print the following reports.

Scan To Log

Speed Dial List

Group List

Fax Log

Address Book

Item Description

Configuration Prints detailed settings of this machine.

System File List Prints a list of job files.

Demo Page Prints a demo page.

Error Log Prints an error log.

Scan To Log Prints the results of the jobs of Scan To E-mail, Scan To
 Shared Folder, or Scan To USB Memory.
Display condition: [Admin Setup] > [Management] > [Job
 Log Setup] > [Save Job Log] is set to [Enable].

MFP
 Usage

Copies Prints the total of the job logs. Specifies the number of
 pages to print on the [Copies] screen.
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Network
 Information

Prints general information on the network.

Fax Speed Dial
 List

Prints the list of the fax numbers registered for speed dials.

Group List Prints the list of the fax numbers registered in groups.

Fax Tx Log Prints the list of the transmission results of the latest 100
 fax jobs.

Fax Rx Log Prints the list of the reception results of the latest 100 fax
 jobs.

Fax Tx/Rx Log Prints the list of the transmission and reception results of
 the latest 100 fax jobs.

Daily Tx/Rx
 Log Report

Prints Tx/Rx report for communications within 24 hours.

Fcode Box List Prints the list of Fcode boxes.

Block Junk
 Fax

Prints the address list for Block Junk Fax.

E-
mail/Internet
 Fax

Journal Report Prints the transmission and reception results of the latest 50
 Internet Fax, Scan To E-mail, and e-mail attachment files.

Address Book Prints the registered address list.

Print PCL Font List Prints a list of PCL font samples.

PSE Font List Prints a list of PSE font samples.

PPR Font List Prints a list of IBMPPR font samples.

FX Font List Prints a list of EPSON FX font samples.

Color Tuning
 Pattern

Prints a color tuning pattern.

Color Profile
 List

Prints a color profile list.

901



Using the Offline Stapler

1. Insert paper deeply into the stapler.
Paper is automatically stapled.

2. Remove paper.
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Easy Setup

In [Easy Setup], you can change the settings of date/time, fax, network, e-mail function by
 using [Device Settings] on the operator panel.

1. Press [Device Settings] on the touch panel.

2. Press [Easy Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Follow the on screen instructions.

Item Description

Language Setting Sets the language that is
 displayed on the operator
 panel.

Date/Time
 Setting

Time Zone Sets the GMT time zone.

Daylight Saving Sets daylight saving to ON
 or OFF.

Server SNTP
 Server
 (Primary)

Sets the SNTP server to
 use for setting the current
 date and time. You can
 enter up to 64 characters.

SNTP
 Server
 (Secondary)

Manual Date Sets the current date and
 time manually.

Time

Admin
 Password

New Password
Enter Password (Verify)

Changes the administrator
 password. 6 to
 12 characters can be used.

Fax
 Setting

Fax Number Sets the fax number of this
 machine. You can enter up
 to 40 digits.

Sender ID Sets the sender's
 information. You can enter
 up to 22 characters.

Network Network Type Sets a wired LAN or
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 Setting  wireless LAN.

Wireless
 Setting (If
 wireless LAN
 module fitted)

Automatic
 Setup
 (WPS)

WPS-PBC WPS-PBC is executed.

WPS-PIN WPS-PIN is executed.

Wireless
 Network
 Selection

A list of access point
 name found in the
 search

Displays a list of wireless
 LAN access points' names
 that are found in a search.

Manual
 Setup

SSID Enter an SSID.

Security Selects the security of the
 wireless LAN function.
"WPA2-EAP" can set only in
 Web.

WEP Key

WPA
 Encryption
 Type

Select a WPA2-PSK
 encryption type.
Displays if [WPA2-PSK] is
 selected for [Security].

WPA Pre-
shared Key

Enter the Pre-shared Key.
Displays if [WPA2-PSK] is
 selected for [Security].

Wireless reconnection Wireless reconnection is
 executed.

IP Address Sets the IP address. You
 can enter up to
 15 characters.

Subnet Mask Sets the subnet mask. You
 can enter up to
 15 characters.

Default Gateway Sets the gateway address.
 You can enter up to
 15 characters.

DNS Server (Primary) Sets the IP address for a
 Primary DNS server. You
 can enter up to
 15 characters.

DNS Server (Secondary) Sets the IP address for a
 Secondary DNS server.
 You can enter up to
 15 characters.

WINS Server (Primary) Sets the name or the IP
 address for the WINS
 server. You can enter up
 to 15 characters.

WINS Server (Secondary) Sets the name or the IP
 address for the WINS
 server. You can enter up
 to 15 characters.

E-mail
 Setting

Mail Server Address Sets the IP address or host
 name for the SMTP server.
 You can enter up to
 64 characters.

Set Sender's Address (From) Sets an e-mail address for
 this machine.
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Receive Setting Sets the protocol to be
 used for receiving e-mails.

Authentication Method Sets the authentication
 method.

SMTP User ID Sets the login ID to the
 server used for SMTP
 authentication. You can
 enter up to 64 characters.

SMTP Password Sets the password to the
 server used for SMTP
 authentication. You can
 enter up to 64 characters.

POP3 Server Sets the IP address or host
 name for the POP3 server.
 You can enter up to
 64 characters.

POP User ID Sets the login ID to the
 server used for POP
 authentication. You can
 enter up to 64 characters.

POP Password Sets the password to the
 server used for POP
 authentication. You can
 enter up to 16 characters.

Test Sends a test mail to the
 Mail Server.
You can check if
 communication between
 your machine and the mail
 server works normally.

Test Print Performing test printing
 allows you to check if the
 consumables and paper
 are properly set.
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Profile

You can create and edit a profile.

1. Press [Device Settings] on the touch panel.

2. Press [Profile].

3. Select a number, and then press [Register].
To edit registered profile, press [Edit].

4. Change the setting, and then press [OK].
Press [Back] until [OK] is displayed at the bottom of the touch panel if necessary.

5. Press [Back] until the home screen is displayed.

Item Factory
 default
 setting

Description

Edit /
 Register

Server
 Setting

No. - Displays an item number.

Profile Name (NULL) Set a profile name. You can
 enter up to 16 characters.

Protocol CIFS Selects a protocol to use for
 storing files.

Network Path (NULL) Sets a server address and
 directory to store the
 scanned data. You can enter
 up to 144 characters.

User Name (NULL) Sets a user name log in to
 the server. You can enter up
 to 32 characters.

Password (NULL) Sets a password log in to the
 server. You can enter up to
 32 characters.

Transmission
 Option

Encode Communication None Selects an encryption
 method for communication.
 Not available when using
 CIFS protocol. Choices vary
 depending on the protocol
 being selected.

Port No. 445 Sets a port number.
 Available range: 1 to 65535

PASV Mode OFF Sets whether to use a FTP
 Passive mode.
Display condition: FTP is set
 as a protocol.

CIFS Character Set UTF-16 Select the character code to
 use. Display condition: CIFS
 is set as a protocol.

Scan Setting Scan Size Auto Selects a scan size.
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Image
 Settings

Density 0 Sets the density of images.

Document
 Type

Text &
 Photo

Sets the image quality of
 documents.

Background
 Removal

Auto Sets the background removal
 of documents.

Resolution 200 dpi Selects a resolution for
 scanning.

Contrast 0 Sets the contrast of
 documents. The default
 value is the value set on
 [Admin Setup] menu.

Hue 0 Sets the red-green color
 balance. The default value is
 the value set on [Admin
 Setup] menu.

Saturation 0 Sets the color saturation of
 documents. The default
 value is the value set on
 [Admin Setup] menu.

RGB Red : 0
Green :
 0
Blue : 0

Sets the RGB contrast. The
 default value is the value
 set on [Admin Setup] menu.

File Name (NULL) Sets a file name. You can
 enter up to 64 characters.
The following options can be
 set.*1

#n: adding a serial number
 from 00000 to 99999
#d: adding the date of a file
 creation (yymmddhhmmss)

Color Mode Auto
 (Color /
 Mono)

Sets scanning color.

File Format Auto (Color
 / Mono)

Multi-
PDF

Sets a file format for
 scanning.

Auto (Color
 /
 Grayscale)

Multi-
PDF

Color Multi-
PDF

Grayscale Multi-
PDF

Mono Multi-
PDF

Compression
 Rate

Color Medium Sets a compression rate for
 scanning.

Grayscale Medium

Mono High

Edge Erase Setting OFF Sets whether to erase the
 edge shadow created in the
 surrounding of 2-page
 spread documents.
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Width 5 mm
 (0.2
 inch)

Sets an erasing width.
Available range: 5 to 50 mm
 (0.2 to 2.0 inches)

Center Erase Setting OFF Sets whether to eliminate
 the shadow lines in the
 center of the two-spread
 document.

Width 5 mm
 (0.2
 inch)

Sets an erasing width.
Available range: 5 to 50 mm
 (0.2 to 2.0 inches)

Mixed Size OFF Sets whether to distinguish
 the document size when
 scanning documents of
 different sizes.

Direction Top
 Edge
 on Top

Selects the default page
 orientation of documents.

White Page Skip OFF Sets whether to enable or
 disable the white page skip
 function.

Encrypted
 PDF

Encrypted PDF Not
 Encrypt

Sets whether to enable PDF
 encryption.

Encryption Level Medium Sets the encryption level.

Document
 Open
 Password

Disable Sets a password to open an
 encrypted PDF file.
A document open password
 cannot be the same as a
 permission password.
To encrypt a PDF file, you
 must set a document open
 password or permission
 password.
You can enter up to
 32 characters.

Password
Password
 (Verify)

(NULL) Enter a password (twice).

Permissions
 Password

Disable Sets a password to control
 printing, extracting or
 editing an encrypted PDF
 file.
A permission password
 cannot be the same as a
 document open password.
To encrypt a PDF file, you
 must set a document open
 password or permission
 password.
You can enter up to
 32 characters.

Password
Password
 (Verify)

(NULL) Enter a password (twice).

Permission Permission Not Sets the permission settings
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 To Print  Allowed  on an encrypted PDF file.
Display Condition: the
 permission password is set.

Permission
 To Extract

Not
 Allowed

Permission
 To Edit

Not
 Allowed

Delete Deletes profiles.

Sort By Name Sorts profile by alphabetical
 order.

Sort By Number Sorts profile by registered
 numerical order.

Search Searches for a profile.

Register to Free No. Registers to an empty.

Jump Moves to the page that
 includes the entered
 number.

*1 For profiles, "#n" or "#d" can be specified for [File Name].

If specifying "#n": 5-digit serial number from 00000 to 99999

If specifying "#d": Date and time when a file is created. 12-digit number in
 yymmddhhmmss format

yy: Year created (the last two digits of the Christian
 Era)

hh: Hours created (00 to
 23)

mm: Month created (01 to 12) mm: Minute created (00 to
 59)

dd: Date created (01 to 31) ss: Second created (00 to
 59)

* The date and time when a file is created are values of the timer of MC873.

An example of file name specification (if the file format is PDF)

If specifying "Data#n": Saved as file names such as "Data0000.pdf" and
 "Data00001.pdf".

If specifying "File#d": Saved as file names such as "File090715185045.pdf".

If specifying "Scan": "Scan.pdf" is created first, and then data is saved with the name
 of "Scan#.pdf".

For "#d", refer to the above.

If nothing is specified: "Image.pdf" is created first, and then data is saved with the
 name of "Image#d.pdf".

For "#d", refer to the above.

Note
File names registered in profiles are applied when executing Scan To Shared Folder.

When performing auto delivery using profiles with these file names, the above names are
 not applied.

The file name at auto delivery is fixed to "yymmddhhmmss_xxxxxxxx.pdf". The part of
 "yymmddhhmmss" is date and time when a file is created for the above "#d", and the
 part of "_xxxxxxxx" is additional 8-digit alphanumeric characters (meaningless value) so
 as not to duplicate other files.
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Configure One Touch Button

You can set frequently used destinations stored in the machine such as the address book to
 the one touch buttons. For each function, up to 40 destinations can be set to the one touch
 buttons.

1. Press [Device Settings] on the touch panel.

2. Press [Configure One Touch Button].

3. Select a function that you want to set for the one touch buttons.

4. Select a button to which you want to set a destination from [01:] to
 [40:].

5. Press [Replace].
A list of destinations that can be registered is displayed.

Memo
If you press [Replace], a destination can be registered or other destination can be
 replaced by a new one.

If you press [Delete], a destination will be deleted from the one touch button.

6. Select a destination.

7. Press [OK] when the setting is finished.

8. Press [Back] until the home screen is displayed.

Item Factory default
 setting

Description

Fax - Sets a fax number to a one touch button.

Internet Fax - Sets an E-mail address to a one touch
 button.

Scan To E-mail - Sets an E-mail address to a one touch
 button.

Scan To Shared
 Folder

- Sets a folder property to a one touch
 button.
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JOB MACRO

Registering a Frequently-used Setting as a Macro

Using a Registered Macro

Editing a Macro Title

Checking the Macro Content

Deleting a Registered Macro

You can register macros for frequently used function settings for copying, scanning, faxing,
 Internet faxing, and printing in the machine and create shortcuts. This "Job Macro" allows
 you to perform operations more simply and quickly.

You can create a macro for settings on the following functions.

Copying

Printing from USB Memory

Scanning to e-mail

Scanning to network PC

Scanning to USB Memory

Fax Sending

Internet Fax Sending

Scanning to Fax Server

Note
If the user authentication is enabled, log in to the machine before creating or editing a macro.

Memo
You can register up to 16 macros.

Registering a Frequently-used Setting as a Macro

You can create a macro for a frequently-used setting.

Registering Newly

1. Press [Copy] on the touch panel.
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2. Press [Job Macro] on the touch panel.

Memo
The Job Macro list screen also appears if [Register to Job Macro] is pressed in the following
 operation procedure. In this case, proceed to step 4.

Function Display on the touch panel and operation procedures

Copy [Basic] tab > [Register to Job Macro]

Scan To E-mail [Basic] tab > [Register to Job Macro]

Scan To USB Memory [Scan To USB Memory] tab > [Register to Job Macro]

Scan To Computer [Basic] tab > [Register to Job Macro]

Print from USB Memory [Register to Job Macro]

Fax Sending [Basic] tab > [Register to Job Macro]

Internet Fax Sending [Basic] tab > [Register to Job Macro]

Scanning to Fax Server [Basic] tab > [Register to Job Macro]

3. Press [Register] in the Job Macro list screen.

4. Check the setting, and then press [Yes].

5. Enter a new macro name.
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Entering Characters

6. Press [OK].
A confirmation screen is displayed.

Using a Registered Macro

You can use a macro by reading out it.

1. Press [Job Macro] on the touch panel.

2. Select a macro to use, and then press [Apply].
If the access control is enabled on the functions you want to use, a message is
 displayed to inform you that you are not permitted to use them, and the screen
 returns to the JOB MACRO menu.

3. Perform a job.

Editing a Macro Title

You can edit a macro title.

1. Press [Job Macro].

2. Press [Edit].

3. Select a macro, and then press [Title Edit].

4. Enter a new title.
Entering Characters

5. Press [OK].

Checking the Macro Content

1. Press [Job Macro].

2. Select a macro, and then press [Description].

3. Check the content, and then press [Back].
If you press [Apply] instead of [Back], the macro is applied.

Deleting a Registered Macro

You can delete a macro.

1. Press [Job Macro].
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2. Press [Edit].

3. Select a macro, and then press [Delete].
A confirmation screen is displayed.

4. Press [Yes].
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Editing Address Book

E-mail Address

Fax Numbers
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E-mail Address

Registering an E-mail Address from a Computer

Registering E-mail Group from a Computer

Deleting a Registered Destination from a Computer

Deleting a Registered E-mail Group from a Computer

Importing and Exporting Destination E-mail Addresses

Registering an E-mail Address from the Operator Panel

Registering E-mail Group from the Operator Panel

Registering E-mail Address from the History

Deleting a Registered Destination from the Operator Panel

Deleting a Registered E-mail Group from the Operator Panel
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Registering an E-mail Address from a Computer

If you use the E-mail Address Manager of Configuration Tool, you can register and edit a
 destination e-mail address.

You can register up to 1000 e-mail addresses in the address book.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
To use the E-mail Address Manager, install the User Setting plug-in. You can install the User
 Setting plug-in at the same time as when installing Configuration Tool or install the plug-in
 later.

Installing Software

You must register the machine in Configuration Tool in advance.

Starting Configuration Tool

Using Configuration Tool

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [E-mail Address Manager].
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5. Enter the administrator password, and then click [OK].

6. Click  (New(E-mail Address)).

7. Enter an e-mail address, and then click [OK].

8. Click  (Save to device).
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Registering E-mail Group from a Computer

If you use the E-mail Address Manager of Configuration Tool, you can register multiple
 registered e-mail addresses as a group. If you specify a group as a destination, you can
 send an e-mail to multiple e-mail addresses at a time.

You can create up to 32 e-mail address groups.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
To use the E-mail Address Manager, install the User Setting plug-in.

Installing Software

You must register Configuration Tool in the machine in advance.

Starting Configuration Tool

Using Configuration Tool

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [E-mail Address Manager].
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5. Enter the administrator password, and then click [OK].

6. Click  (New(Group)).

7. Register a group, and then click [OK].

8. Click  (Save to device).

922



Deleting a Registered Destination from a Computer

If you use the E-mail Address Manager of Configuration Tool, you can delete a registered e-
mail address.

If you click  (Save to device), the changed settings are reflected to the machine.

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [E-mail Address Manager].

5. Enter the administrator password, and then click [OK].
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6. Select an E-mail address to delete, and then click  (Delete).

Memo
If you click  (Delete and Sort), the selected destination is deleted and the
 subsequent numbers move up.

If you click  (Delete all), all the destinations or groups are deleted.

7. Click  (Save to device).
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Deleting a Registered E-mail Group from a Computer

If you use the E-mail Address Manager of Configuration Tool, you can delete a registered e-
mail address from the address book.

If you click  (Save to device), the changed settings are reflected to the machine.

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [E-mail Address Manager].

5. Enter the administrator password, and then click [OK].
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6. Select a group to delete, and then click  (Delete).

Memo
If you click  (Delete all), all the destinations or groups are deleted.

7. Click  (Save to device).
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Importing and Exporting Destination E-mail Addresses

Exporting Addresses to a File

Importing Addresses from a File

If you use the E-mail Address Manager of Configuration Tool, you can import and export the
 e-mail address or group of the address book. The following section describes some
 functions.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
To use the E-mail Address Manager, install the User Setting plug-in.

About how to install the plug-in

Installing Software

About icons used in Configuration Tool

List of Icons used in Configuration Tool

Exporting Addresses to a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the addresses you want to export from
 [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [E-mail Address Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Export to file).

7. Enter the name of a file to be saved and the name of the save
 destination folder, and then click [Save].

Note
After exporting, the edited CSV file may not restore properly.

Importing Addresses from a File
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1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine to which you want to import the addresses from
 [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [E-mail Address Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Import from file).

7. Click [Open] from [Select CSV File].

8. Select the file to import, and then click [Open].

9. Click [Next].

10. Select the settings to import, and then click [Import].

11. Click  (Save to device).

Memo
CSV files exported from Outlook Express (Windows Mail and Windows Live Mail) can also be
 restored.
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Registering an E-mail Address from the Operator Panel

For details on character entry methods, refer to "Entering Characters".

1. Press [Device Settings] on the touch panel.

2. Press [Address Book].

3. Press [E-mail Address].

4. Select a number, and then press [Register].

Memo
You cannot select any numbers that are specified with the auto delivery function.

5. Press the registration button of [Name].

6. Enter a name, and then press [OK].
You can enter up to 16 characters.

7. Press the registration button of [E-mail Address].

8. Enter an e-mail address, and then press [OK].

9. Press [OK].
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Registering E-mail Group from the Operator Panel

You can register an e-mail group from [Group No.] in [E-mail Address].

1. Press [Device Settings] on the touch panel.

2. Press [Address Book].

3. Press [E-mail Group].

4. Select a number, and then press [Register].

Memo
To edit a registered address, select [Edit].

5. Press the registration button of [Name].

6. Enter a name, and then press [OK].
You can enter up to 16 characters.

7. Press the registration button of [Address No.].

8. Select an e-mail address, and then press [OK].
The check box is selected. You can select multiple e-mail addresses.

9. Press [OK].

930



Registering E-mail Address from the History

You can add an e-mail address to the address book from the transmission history.

Note
The transmission history displays only sent faxes whose destinations were directly entered.

1. Press [Scan] or the  (SCAN) button.

2. Press [Scan To E-mail].

3. Press [Tx History].

4. Press [Register to Address Book].

5. Select an E-mail address, and then press [Register].

6. Press [Register to free number].

Memo
When overwriting a registered number, select the number, and then press [Overwrite].

You cannot select any numbers that are specified with the auto delivery function.

7. Press the registration button of [Name].

8. Enter a name, and then press [OK].
You can enter up to 16 characters.

9. Press [OK].

10. Repeat steps 3 to 9 until you complete registering all the e-mail
 addresses.
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Deleting a Registered Destination from the Operator
 Panel

Note
You cannot select any e-mail addresses that are specified with the auto delivery function.

1. Press [Device Settings] on the touch panel.

2. Press [Address Book].

3. Press [E-mail Address].

4. Select a number, and then press [Delete].

5. Press [Yes] on a confirmation screen.
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Deleting a Registered E-mail Group from the Operator
 Panel

1. Press [Device Settings] on the touch panel.

2. Press [Address Book].

3. Press [E-mail Group].

4. Select a number, and then press [Delete].

5. Press [Yes] on a confirmation screen.

933



Fax Numbers

Registering a Fax Number from a Computer

Registering a Group Number from a Computer

Deleting a Registered Fax Number from a Computer

Deleting a Registered Group Dial Number from a Computer

Importing and Exporting Speed Dials of Destinations

Registering a Fax Number from the Operator Panel

Registering a Group Number from the Operator Panel

Deleting a Registered Fax Number from the Operator Panel

Deleting a Registered Group Dial Number from the Operator Panel

Registering Fax Number from the History

Configure One Touch Button
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Registering a Fax Number from a Computer

If you use the Speed Dial Manager of Configuration Tool, you can register and edit a
 destination speed dial.

You can register up to 1000 destinations to speed dial.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
To use the Speed Dial Manager, install the User Setting plug-in.

For details on how to install the plug-in, refer to "Installing Software".

You must register the machine in Configuration Tool in advance.

Starting Configuration Tool

Using Configuration Tool

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Speed Dial Manager].
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5. Enter the administrator password, and then click [OK].

6. Click  (New(Speed Dial)).

7. Enter a fax number, and then click [OK].

8. Click  (Save to device).
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Registering a Group Number from a Computer

If you use the Speed Dial Manager of Configuration Tool, you can register multiple
 registered speed dials as a group.

You can create up to 32 groups, and register the entire groups as speed dial numbers.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
To use the Speed Dial Manager, install the User Setting plug-in.

For details on how to install the plug-in, refer to "Installing Software".

You must register the machine in Configuration Tool in advance.

Starting Configuration Tool

Using Configuration Tool

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Speed Dial Manager].
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5. Enter the administrator password, and then click [OK].

6. Click  (New(Group)).

7. Register a group, and then click [OK].

8. Click  (Save to device).
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Deleting a Registered Fax Number from a Computer

If you use the Speed Dial Manager of Configuration Tool, you can delete registered speed
 dials.

If you click  (Save to device), the changed settings are reflected to the machine.

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Speed Dial Manager].

5. Enter the administrator password, and then click [OK].
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6. Select the destination to delete, and then click  (Delete).

Memo
If you click  (Delete and Sort), the selected destination is deleted and the
 subsequent numbers move up.

If you click  (Delete all), all the destinations or groups are deleted.

7. Click  (Save to device).

940



Deleting a Registered Group Dial Number from a
 Computer

If you use the Speed Dial Manager of Configuration Tool, you can delete registered speed
 dial groups.

If you click  (Save to device), the changed settings are reflected to the machine.

About icons used in Configuration Tool

List of Icons used in Configuration Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Speed Dial Manager].

5. Enter the administrator password, and then click [OK].

941



6. Select the group to delete, and then click  (Delete).

Memo
If you click  (Delete all), all the destinations or groups are deleted.

7. Click  (Save to device).
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Importing and Exporting Speed Dials of Destinations

Exporting Speed Dials to a File

Importing Speed Dials to a File

If you use the Speed Dial Manager of Configuration Tool, you can import and export the
 speed dial or group of destinations. The following section describes some functions.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
To use Speed Dial Manager, install the User Setting plug-in.

About how to install the plug-in

Installing Software

About icons used in Configuration Tool

List of Icons used in Configuration Tool

Exporting Speed Dials to a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the speed dials you want to export
 from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Speed Dial Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Export to file).

7. Enter the name of a file, select a save destination folder, and then
 click [Save].

Note
After exporting, the edited CSV file may not restore properly.

Importing Speed Dials to a File
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1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine to which you want to import the speed dials
 from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Speed Dial Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Import from file).

7. Click [Open] from [Select CSV File].

8. Select the file to import, and then click [Open].

9. Click [Next].

10. Select the settings to import, and then click [Import].

11. Click  (Save to device).

Memo
CSV files exported from Outlook Express (Windows Mail and Windows Live Mail) can also be
 restored.
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Registering a Fax Number from the Operator Panel

You can register up to 1000 destinations to speed dial.

You can create up to 32 groups, and register the entire groups as speed dial numbers.

Registering a Fax Number One by One

For details on character entry methods, refer to "Entering Characters".

Memo
The numbers that are registered in groups with the [Speed Dial] function synchronize the
 numbers that are registered in groups with the [Group No.] function.

1. Press [Device Settings] on the touch panel.

2. Press [Phone Book].

3. Press [Speed Dial].

4. Select a speed dial number, and then press [Register].

5. Press the registration button of [Name].

6. Enter a name.
You can enter up to 24 characters.

7. Press [OK].

8. Press the registration button of [Fax Number].
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9. Enter a fax number.
You can enter up to 40 digits.

10. Press [OK].
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Registering a Group Number from the Operator Panel

For details on character entry methods, refer to "Entering Characters".

Memo
The numbers that are registered in groups with the [Speed Dial] function synchronize the
 numbers that are registered in groups with the [Group No] function.

1. Press [Device Settings] on the touch panel.

2. Press [Phone Book].

3. Press [Group No.].

4. Select a group number, and then press [Register].
The check box is selected. You can select multiple items.

5. Press the registration button of [Name].

6. Enter a name.
You can enter up to 16 characters.

7. Press [OK].

8. Press the registration button of [Speed Dial].

9. Select speed dial numbers, and then press [OK].

10. Press [OK].
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Deleting a Registered Fax Number from the Operator
 Panel

Note
You cannot delete the speed dial numbers that are used with the reserved transmission or auto
 delivery.

1. Press [Device Settings] on the touch panel.

2. Press [Phone Book].

3. Press [Speed Dial].

4. Select a speed dial number, and then press [Delete].

5. Press [Yes] on a confirmation screen.
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Deleting a Registered Group Dial Number from the
 Operator Panel

Memo
Even if you delete a group, the numbers that are registered as the speed dial numbers are not
 deleted.

1. Press [Device Settings] on the touch panel.

2. Press [Phone Book].

3. Press [Group No.].

4. Select a group number, and then press [Delete].

5. Press [Yes] on a confirmation screen.
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Registering Fax Number from the History

You can register fax numbers as speed dial numbers from the fax transmission history and
 the reception history.

1. Press [Fax] or the  (FAX) button.

2. Press [Fax].

3. Press [Redial].

4. Press [Tx History] or [Rx History].

5. Press [Register to Speed Dial].

6. Select a speed dial number, and then press [Register].

7. Press [Register to free number].

Memo
When overwriting a registered number, select the number, and then press [Over
 Write].

You cannot select any numbers that are specified with the auto delivery function.

8. Press the registration button of [Name].

9. Enter a name, and then press [OK].
You can enter up to 24 characters.

10. Press [OK].

11. Repeat steps 3 to 10 until you complete registering all the dial
 number.
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Configure One Touch Button

You can set frequently used destinations stored in the machine such as the address book to
 the one touch buttons. For each function, up to 40 destinations can be set to the one touch
 buttons.

1. Press [Device Settings] on the touch panel.

2. Press [Configure One Touch Button].

3. Select a function that you want to set for the one touch buttons.

4. Select a button to which you want to set a destination from [01:] to
 [40:].

5. Press [Replace].
A list of destinations that can be registered is displayed.

Memo
If you press [Replace], a destination can be registered or other destination can be
 replaced by a new one.

If you press [Delete], a destination will be deleted from the one touch button.

6. Select a destination.

7. Press [OK] when the setting is finished.

8. Press [Back] until the home screen is displayed.

Item Factory default setting Description

Fax - Sets a fax number to a one touch button.

Internet Fax - Sets an E-mail address to a one touch button.

Scan To E-mail - Sets an E-mail address to a one touch button.

Scan To Shared Folder - Sets a folder property to a one touch button.
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List of Objectives

Replacing Consumables

Solve Problems with the Machine

Save Consumables and Costs

Enhance Security

Improve Efficiency

Utilize a Paper Document As Data

Moving or Transporting This Machine

Checking the Status of This Machine
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Replacing Consumables

For K (black) Toner Cartridge Only

For C (cyan), M (magenta), Y (yellow) Toner Cartridge

Replacing the Image Drum

Replacing the Image Drum and Toner Cartridge at the Same Time

Replacing the Belt Unit

Replacing the Fuser Unit

Replacing the Feed Roller (Tray 1/Tray 2/Tray 3/Tray 4)

Replacing the Feed Roller (MP Tray)
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Solve Problems with the Machine

Check an Error with the Machine

Solve Problems in Each Function

Solve Problems with a Computer

Solve Problems with the Print Results

Other Problems

Check an Error with the Machine

You can check a solution to an error when an error message is displayed on the operator
 panel.

If an Error Message is Displayed on the Operator Panel

If Paper Jams Occur

If a Document Jam Occurs

If the STATUS Button on the Operator Panel Lights Up or Flashes

Solve Problems in Each Function

Copy Problems

Scan Problems

Print Problems

Fax Problems

AirPrint Problems

Google Cloud Print Problems

Solve Problems with a Computer

You can check a solution to a problem with a computer.

Problems on Other Software

Problems on Configuration Tool

About Restrictions on Each OS

Solve Problems with the Print Results

You can check the cause of a problem with the print results and its solution.

About Problems with Printing Results

Other Problems

Problems on Document and Paper

If a Power Failure Occurs
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Problems on the Machine or Paper

Troubleshooting
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Save Consumables and Costs

Save Paper

Save Money on Electricity

Reduce Fax Communication Costs

Reduce Printing Costs

Save Paper

Tips for Saving on Copying
The duplex copy function that enables you to copy on both sides of paper, the N-in-1
 function that enables you to copy multiple documents on a sheet of paper, and the ID
 card copy function that enables you to copy both sides of an ID card on one side of paper
 are available.

Copying on Both Sides of Paper (Duplex Copy)

Combining Multiple Pages on One Sheet of Paper (N-in-1)

Copying Both Sides of a Card to One Side (ID Card Copy)

Tips for Saving on Printing
The duplex printing function that enables you to print on both sides of paper, and the
 multi-page printing function that enables you to print multiple pages on a sheet of paper
 are available.

Printing on Both Sides of Paper (Duplex Printing)

Combining Multiple Pages onto One Sheet of Paper

Tips for Saving on Faxing
The auto delivery function that enables you to receive a fax as an e-mail attachment
 file is available. You can check the fax content by e-mail, allowing you to save paper
 by printing necessary documents only.

Forwarding Received Document Data to an E-mail Destination or Shared Folder
 (Auto Delivery)

The PC Fax function that enables you to send a document in a computer directly. You
 can save paper, because you do not need to print a document to send.

Sending a PC Fax

The duplex print function that enables you to print on both sides of paper.

Duplex Printing

Save Money on Electricity

Use the Power Save mode function. You can set this machine so that it can automatically
 enter Power Save mode after a certain period of time passes.

Saving Power Consumption with the Power Save Function
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Reduce Fax Communication Costs

Specifying the Transmission Time
Use the delayed transmission function. You can specify a night-time period or another
 time period to send a fax during which communication costs are low.

Sending at a Specified Date and Time (Delayed Tx)

Using the Internet Line
Use the Internet Fax function. You can reduce more costs than standard faxes, because
 you send and receive faxes through the Internet line.

Sending an Internet Fax (Procedure)

Reduce Printing Costs

Use the toner save mode function. You can reduce more toner consumption than usual when
 printing.

Saving Toner
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Enhance Security

Secure a Document to Print

Convert a Paper Document into an Encrypted PDF File

Restrict Machine Users and Available Functions

Prevent Wrong Fax Transmission

Restrict Computers on Which Remote Scan Can be Used

Secure a Document to Print

Assign a Password to a Document So That Third Persons Cannot
 View

Use the authentication print function. If you assign a password to a document in advance,
 the document can be printed only when the same password is entered from the operator
 panel.

Setting a Password to the Print Data (Authentication Print)

Encrypt a Document to Protect from Illegal Access
Use the encrypted authentication print function. If you assign a password to a document
 in advance, the document can be printed only when the same password is entered from
 the operator panel. Also, the document is encrypted before being sent from a computer,
 protecting the information from illegal access.

Setting a Password and Encrypting the Print Data (Encrypted Authentication Print)

Encrypt Document and Require User Authentication before
 Printing

Use the authentication print function. The user information currently logging in is
 automatically obtained and attached encrypted print job so that you do not need to enter
 a password. To use the function, enable the access control setting of the machine and
 log into the machine with the same user information as that you use on a computer.

Encrypting Printing Data and Requiring User Authentication before Printing (ID Secure
 Job)

Convert a Paper Document into an Encrypted PDF File

Use the PDF encryption function. You can set an encryption strength level, a password
 required for opening a file, and other settings.

Encrypting a PDF File

Restrict Machine Users and Available Functions

Use the access control function. You can restrict machine users and available functions.
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Enabling the Access Control

Prevent Wrong Fax Transmission

Use the security functions for sending faxes. The functions are useful for preventing wrong
 fax transmission.

Preventing Wrong Fax Transmissions

Restrict Computers on Which Remote Scan Can be Used

You can restrict computers on which Remote Scan can be used.

Registering a Computer That is Connected
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Improve Efficiency

Simplify Setting Operations When Printing from a Computer

Register Frequently-used Destinations

Set This Machine Remotely

Customize the Home Screen for My Own Use

Distinguish Output Destinations by a Job

Simplify Setting Operations When Printing from a
 Computer

Use the quick specification of printing settings function. You can register settings that you
 specify when printing from a computer, allowing you to set the time-consuming settings
 quickly.

Saving Frequently-Used Settings in the Printer Driver to Use

Register Frequently-used Destinations

Use the address book function and the phone book function. You can register frequently-
used e-mail and fax transmission destinations, allowing you to specify a destination easily
 just by selecting from registered ones when sending a document.

Registering an E-mail Destination

E-mail Address

Registering a Fax Destination

Fax Numbers

Registering an Internet Fax Destination

E-mail Address

Set This Machine Remotely

From a Web Browser
You can set each setting of this machine on the Web page from a computer.

Web Page of This Machine

From a Computer Running on Windows
You can set each setting of this machine with Configuration Tool from a computer.

Using Configuration Tool

Customize the Home Screen for My Own Use

You can set shortcut buttons in the home screen for functions that are placed deep in the
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 menu hierarchy.

How to Customize the Touch Panel

Distinguish Output Destinations by a Job

You can specify output destinations respectively for copy jobs, printing received fax, printing
 from the PC, etc.

Printouts of a copy job

Switching Output Trays

Printouts of received fax

Switching Output Trays

Printouts of PC printing

About Screens and Functions of Each Printer Driver

Printouts of data in a USB Memory

Printing Data in USB Memory

Printouts of E-mail attachment files or received Internet fax

Printing E-mail Attachment Files
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Utilize a Paper Document As Data

Send or Save a Document As Data

Receive a Received Fax As an E-mail Attachment File

Save a Received Fax to a Folder in a Computer

Send or Save a Document As Data

Send a Scanned Document as an E-mail Attachment File
Use the Scan to E-mail function. You can convert a scanned document into a PDF file or
 another data file format, and send the file as an e-mail attachment file.

Using Scan To E-mail

Scanned Document to a Shared Folder in a Computer
Use the Scan to Shared Folder function. You can convert a scanned document into a PDF
 file or another data file format, and save the file to a shared folder.

How to Use Scan To Shared Folder

Save a Scanned Document to USB Memory
Use the Scan to USB Memory function. You can convert a scanned document into a PDF
 file or another data file format, and save the file to USB Memory that is connected to this
 machine.

Saving Scanned Data in USB Memory

Send a Scanned Document to an Application on a Computer
Use the Scan to PC function. You can send a scanned document to an application, and
 edit an image.

Sending Scanned Data to a Computer

Receive a Received Fax As an E-mail Attachment File

Use the auto delivery function. You can check a received document as an e-mail attachment
 file, allowing you to discard the file without printing it if it is an unnecessary document.

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)

Save a Received Fax to a Folder in a Computer

Use the auto delivery function and the transmission data save function. You can save and
 manage a received fax to a shared folder as data without printing it.

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)
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Saving Sent and Received Data (Transmission Data Save)
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Moving or Transporting This Machine

This section explains how to move or transport your machine.

Moving This Machine

This section describes cautions for moving this machine.

Transporting This Machine

This section describes cautions for transporting this machine.
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Checking the Status of This Machine

Web Page of This Machine
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Operating Management/Specifications

Changing the Administrator Password

Administrator Setup

Management Software

User Authentication (Access Control)

Account Management

Moving/Transporting This Machine

Specifications
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Changing the Administrator Password

It is recommended to change the administrator password to protect your security. Write the
 new password down and keep it safe.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press  or  several times and press [Management].

5. Press  or  several times and press [Admin Password].

6. Enter a new password, and then press [OK].

7. Enter the password again.

8. Press [OK].

Note
Be careful not to forget the administrator password.
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Administrator Setup

You can change the administrator setup. To change the setting, follow the steps below.

The factory default administrator name and password are "admin" and "aaaaaa",
 respectively. Use them if any administrator names have not been registered yet.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].

4. Touch an item you want to change, and then change the setting.

The settings that you can change in [Admin Setup] are as follows.

If you change the default setting from the [Admin Setup] menu, and want to reflect the
 changed default on the touch panel immediately, press the  (HOME) button, the 
 (COPY) button, the  (SCAN) button, the  (PRINT) button or the  (FAX) button to
 switch the function.

Copy Setup

You can check and change the default settings of the copy functions for this machine.

Fax Setup

You can check and change the default settings of the fax functions and other various basic
 settings.

FaxServer Function

You can check and change the default settings of the FaxServer function for this machine.

Internet Fax Setup

You can check and change the default settings of the Internet Fax function for this
 machine.

Scanner Setup

You can check and change the default settings of the scanner functions and other various
 basic settings.

Print From USB Memory Setup

You can check and change the default settings of the Print from USB Memory function for
 this machine.

Print Setup

You can check and change a tray configuration, print settings, and other various settings
 of the print functions.

Network Menu

You can check and change various settings for a network and servers.

Configure Home Screen

Set the home screen with home icons.

Management

You can check and change the time to reset the screen on the operator panel, Power Save
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 mode, and other various settings related to the machine management.

User Install

You can check and change the time zone, time, and other various default settings required
 for managing this machine.
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Copy Setup

Item Factory
 default
 setting

Description

Default
 Settings

Color Mode Auto Select Auto / Color / Mono
 (Grayscale).

Scan Size Auto Sets the default scan size.

Duplex Copy OFF(Simplex) Sets the default setting of whether to
 turn duplex copying on or off, and
 the default binding position.

Zoom 100% Sets the default zoom rate.

Sort ON Sets whether to collate copied
 documents by default.

Image
 Settings

Density 0 Sets the default density.

Document Type Text & Photo Sets the default image quality.

Resolution Normal Sets the default resolution.

Background Removal Auto Sets the default background
 removal.

Show-Through
 Removal

Middle Sets the default value of the show-
through removal function.

Outside
 Erase

Setting OFF Sets whether to enable or disable the
 outside erase function.

Range
 Adjustment

3 Sets the criteria of the outside erase
 function.

Contrast 0 Sets the default contrast.

Hue 0 Sets the default value of the hue.

Saturation 0 Sets the default value of the
 saturation.

RGB 0 Sets the default value of RGB
 contrast.

Direction Top Edge On
 Top

Selects the default page orientation
 of documents.

ID Card Copy OFF Sets whether to use the ID card copy
 mode by default.

Continuous Scan OFF Sets whether to use Continuous Scan
 mode.

Mixed Size OFF Sets whether different sized
 documents are copied on each size
 paper by default.

Margin Setting OFF Sets the default margins.

Front Left 0 mm (0
 inch)

Available range: 0 to ±25 mm (0.0
 to 2.0 inch) (1 mm increment)

Top

Back Left
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Top

Edge Erase Setting ON Sets whether to erase the shade
 created in the surrounding of 2-page
 spread documents by default.

Width 2 mm (0.1
 inch)

Sets an erasing width.
Available range: 2 to ±50 mm (0.1
 to 2.0 inch) (1 mm increment)

Center
 Erase

Setting OFF Sets whether to eliminate the
 shadow lines in the center of the
 two-spread document.

Width 1 mm (0.1
 inch)

Sets an erasing width.
Available range: 1 to ±50 mm (0.1
 to 2.0 inch) (1 mm increment)

White Page Skip OFF Sets whether to enable or disable the
 white page skip function.

Watermark Page
 Number

Setting OFF Sets whether to add the page
 number as watermarks.

Start
 Number

1 Sets the start number of the page
 number.

Position Lower Right Sets the printing position of the page
 number.

String User Name OFF Sets whether to add the user name
 as watermarks.

Model
 Name

OFF Sets whether to add the model name
 as watermarks.

Date /
 Time

OFF Sets whether to add the date and
 time as watermarks.

Free Word OFF Sets whether to add a character
 string as watermarks.

String (NULL) Sets a character string.
You can register up to 64
 alphanumeric characters.

Position Lower Left Sets the printing position of the
 character string.

Font Size 10 point Sets the font size.
Available range: 8 to 24 points

Configure Shortcuts 01: Scan
 Size
02: Paper
 Feed
03: Duplex
 Copy
04: N-in-1
05: Zoom
06: Direction

Sets the shortcut button for the
 [Copy] tab.

Interrupt OFF Sets whether to enable or disable the
 Interrupt function.
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Fax Setup

Item Factory
 default
 setting

Description

Default
 Settings

Resolution Normal Sets the default image quality.

Background Removal Auto Sets the default setting of the
 background removal.

Density 0 Sets the default density to scan.

Scan Size Auto Sets the default scan size.

Continuous Scan(Glass) OFF Sets whether to use Continuous
 Scan.

Continuous Scan(ADF) OFF

Preview OFF Sets the preview image of sending
 image.

Edge Erase Setting OFF Sets whether to erase the edge
 shadow created on Fax scan
 image.

Width 2 mm (0.1
 inch)

Sets an erasing width created on
 Fax scan image.

TTI ON Sets whether to add the sender's
 name to the header of the sent fax
 by default.

Transmit Confirmation Report OFF or ON Sets whether to automatically print
 transmission results by default.

Memory Tx ON Sets whether to use Memory
 transmission (ON) or real-time
 transmission (OFF) by default.

Configure Shortcuts 01: Manual
 Dial
02: Speed
 Dial
03: Group
 List
04: Redial
05: Off Hook
06:
 Resolution

Sets the shortcut button for the
 [Fax] tab.

Fcode
 Box

Edit /
 Register

Confidential
 Box

Box
 Name

(NULL) Sets the name for confidential
 boxes. You can enter up to
 16 characters.

Sub-
Address

(NULL) Sets the sub-address for
 confidential box. You can enter up
 to 20 characters.

Hold
 Time

0 Sets the hold time for confidential
 box.
Available range: 0 to 31 days

I.D.Code (NULL) Sets the password for confidential
 box. Register a 4-digit numerical
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 number only.

Bulletin Box Box
 Name

(NULL) Sets a bulletin box name. You can
 enter up to 16 characters.

Sub-
Address

(NULL) Sets the sub-address for bulletin
 box. You can enter up to
 20 characters.

Delete Deletes an Fcode box.

Security
 Function

ID Check Tx OFF Sets whether to use the ID check
 transmission.

Broadcast Destination ON Sets whether to indicate the
 transmission destination number
 before starting broadcast
 transmission.

Confirm Dial OFF Sets whether to reenter the
 transmission destination fax
 number before sending a fax.

Secure Receive Setting OFF Sets whether to store a received
 fax in the Memory of this machine
 without printing immediately.

Password (NULL) Sets the password that is entered
 when printing a received fax image
 that is stored in the Memory of this
 machine.

Delete
 after
 printing

Yes Sets whether to delete a fax image
 after printing.

Other
 Settings

Redial Tries 2 time(s) Sets the number of redial attempts.
Available range: 0 to 9 times

Redial Interval 1 minute(s) Sets the time between redial
 attempts.
Available range: 0 to 5 minutes

Block Junk
 Fax

Setting OFF Sets Block Junk mode Fax.

Registered
 List

Register
 / Edit

(NULL) Register / Edit addresses for Block
 Junk Fax.
Display condition: To set [Mode2]
 or [Mode3], [Admin Setup] >
 [Other Settings] > [Block Junk
 Fax] > [Setting].

Delete Delete addresses for Block Junk
 Fax.
Display condition: To set [Mode2]
 or [Mode3], [Admin Setup] >
 [Other Settings] > [Block Junk
 Fax] > [Setting].

Ring Response 1 Ring Sets the number of rings required
 before receiving an incoming fax.

Dialing Pause Duration 2 second(s) Sets the dial pause time.
Available range: 0 to 10 seconds

Rx Reduc. Rate Auto Sets the reception reduction rate.

Reduc. Margin 24 mm (0.9
 inch) or
 100 mm

Sets the threshold level of
 reception reduction.
Available range: 0 to 100 mm (0 to
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 (3.9 inch)  3.9 inches)

ECM Mode ON Sets whether to use the error
 correction mode.

PreFix (NULL) Sets the dialing prefix. You can
 enter up to 40 digits.

Received Time Stamp OFF Sets whether to print the time
 stamp on received faxes.

Print Check Message ON Sets whether to report the error
 content if a transmission error
 occurs.

Duplex OFF Sets simplex or duplex for printing
 received fax and the binding
 position for duplex printing.

Rotate Tx ON Sets whether to enable or disable
 the Rotate Tx function.

Fax
 Setting

Service Bit OFF If set to OFF, some menu items are
 not displayed on the screen.

Country Code International
 or U.S.A

Sets the country code.

A/R Full Print ON Sets whether to print the list of the
 communication results
 automatically after every 50
 communications.

Daily Tx/Rx Log Report Setting OFF Enables / disables to print a daily
 report.

Print
 Time

0 Hour
0 Minute
0 Second

Sets the date and time for printing
 the daily report.

Tone For Echo (For Transmission) Disable Displays only if Service Bit is ON.

Tone For Echo (For Reception) Disable Displays only if Service Bit is ON.

H/Modem Rate (For Tx) 33.6 Kbps Sets the default modem reception
 transmission speed while the
 machine is sending a fax.

H/Modem Rate (For Rx) 33.6 Kbps Sets the default value of the
 modem transmission speed while
 the machine is receiving a fax.

Attenuator 10 dB,
 Range: 0 -
 15 dB

Enter Attenuator. Displays only if
 Service Bit is ON.

MF Attenuator 8 dB,
 Range: 0 -
 15 dB

Enter MF(Tone) Attenuator.
 Displays only if Service Bit is ON.

Pulse Make Ratio 40%,
 Range: 33,
 39, 40%

Sets to make rate of DP (10 pps)
 during call. Displays only if Service
 Bit is ON and Tone / Pulse setting
 is PULSE.

Pulse Dial Type N, Range: N,
 10-N, N+1

Sets the pulse type for dialing.
 Displays only if Service Bit is ON
 and Tone / Pulse setting is PULSE.

MF(Tone) Duration 100
 mseconds,

Enter MF(Tone) Duration. Displays
 only if Service Bit is ON and Tone /
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 Range: 75,
 85, 100
 mseconds

 Pulse setting is TONE.

Calling Timer 60
 mseconds,
 Range: 1 -
 255 seconds

Displays only if Service Bit is ON.

PBX Line OFF When connecting to PBX (internal
 exchange), put it to [ON].

Forwarding
 Setting

Forwarding Setting OFF Sets whether to enable the fax
 forwarding mode.

Forwarding Number (NULL) Sets a fax number used for the fax
 forwarding mode.

TAD Mode Type 3 Sets an operation type in Tel / Fax
 Ready mode.
[Type 3]: A fax signal is detected in
 15 seconds from when the
 answering machine answers.
 Normally, use this type.
[Type 1]: A fax signal is detected
 right after the answering machine
 answers, and then the reception
 starts. If you have any fax
 reception problems, they may be
 improved if this type is set.
[Type 2]: A fax signal is detected
 right after the answering machine
 answers. Set this type if you
 usually use this machine as a
 phone.

Tel Priority Mode OFF Sets when the external telephone
 and the machine ring in Tel / Fax
 Ready mode.
[ON]: The sender is assumed to
 make a voice call. The telephone
 rings early.

CNG Detection OFF Sets whether to determine whether
 the sender is sending a fax during
 the off the hook condition in Tel /
 Fax Ready mode.

T/F Timer Programming 35 seconds Sets when to start the auto fax
 reception if the communication
 does not start even after an
 incoming call arrives in Tel / Fax
 Ready mode or Ans / Fax Ready
 mode.

Soft Ringer Volume High Sets a phone ring volume in Tel /
 Fax Ready mode.

Remote Receive Number OFF Sets a remote switch over number.
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FaxServer Function

Item Factory
 default
 setting

Description

Environmental
 Settings

FaxServer
 Function

OFF Sets whether to use scanning to fax server.

Prefix (NULL) Sets to prefix code for scanning to fax server.

Suffix @faxserver Sets to suffix code for scanning to fax server.

Text OFF Sets whether to add body text.

Default
 Settings

Scan Size Auto Sets the default scan size.

Density 0 Sets the default density.

Resolution Normal Sets the default resolution.

Background
 Removal

Auto Sets the default setting of the background removal.

Continuous
 Scan

OFF Sets whether to use Continuous Scan mode by
 default.

Preview OFF Sets the preview image of sending image.

Compression
 Rate

Low Selects the default compression level.

Configure Shortcuts 01: Manual
 Dial
02: Speed
 Dial
03: Group
 List
04: Tx
 History
05: Scan
 Size

Sets the shortcut button for the [Internet Fax] tab.

Security
 Function

Broadcast
 Destination

ON Sets whether to indicate the transmission destination
 number before starting broadcast transmission.

Confirm Dial OFF Sets whether to reenter the transmission destination
 fax number before sending.

Other Settings Rotate Tx ON Sets whether to enable or disable the Rotate Tx
 function.
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Internet Fax Setup

Item Factory default
 setting

Description

Default
 Settings

Scan Size Auto Sets the default scan size.

Density 0 Sets the default density.

Resolution Normal Sets the default resolution.

Background
 Removal

Auto Sets the default background removal.

Continuous
 Scan

OFF Sets whether to use Continuous Scan mode
 by default.

Preview OFF Sets the preview image of sending image.

Compression
 Rate

Low Selects the default compression level.

Configure Shortcuts 01: Manual Input
02: Address Book
03: Group List
04: Tx History
05: LDAP

Sets the shortcut button for the [Internet
 Fax] tab.
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Scanner Setup

Item Factory
 default
 setting

Description

Default
 Settings

Color Mode Auto (Color
 / Mono)

Sets the default scanning color.

Scan Size Auto Sets the default scan size.

Auto Scan Size Default
 Size

A4 or
 Letter

Sets the standard size for automatic
 detection of document size.

Legal
 Size

Legal14 Sets the document length when the legal
 document is automatically detected.

Direction Top Edge
 on Top

Selects the default page orientation of
 documents.

Mixed Scan OFF Sets whether to distinguish the document
 size when scanning documents of different
 sizes.

Image
 Settings

Density 0 Sets the default density.

Document
 Type

Text&Photo Sets the image quality of documents.

Background
 Removal

Auto Sets the default the background removal.

Show-Through
 Removal

Middle Sets the default value of the show-through
 removal function.

Resolution 200dpi Sets the default resolution.

Contrast 0 Sets the default contrast.

Hue 0 Sets the default red-green color balance.

Saturation 0 Sets the default saturation.

RGB R:0
G:0
B:0

Sets the default RGB contrast.

Continuous Scan OFF Sets whether to use Continuous Scan mode
 by default.

Preview OFF Sets the preview image of sending image.

File Format Auto(Color /
 Mono)

Multi-PDF Selects the default file format.
[Auto(Color / Grayscale)]/ [Color]/
 [Grayscale] can be selected from Multi-
PDF, Multi-HC-PDF, Single-PDF, Single-HC-
PDF, Multi-PDF/A, Single-TIFF, Multi-TIFF,
 JPEG and XPS.
[Auto(Color / Mono)]/ [Mono] can be
 selected from Multi-PDF, Single-PDF, Multi-
PDF/A, Single-TIFF, Multi-TIFF and XPS.

Auto(Color /
 Grayscale)

Multi-PDF

Color PDF

Grayscale PDF

Mono PDF

Encrypted
 PDF Setting

Document
 Open
 Password

(NULL) Sets the default password to open an
 encrypted PDF. A document open
 password cannot be the same as a
 permission password. You can enter up to
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 32 characters.

Permissions
 Password

(NULL) Sets the default password to control
 printing or editing on an encrypted PDF
 file. A permission password cannot be the
 same as a document open password. You
 can enter up to 32 characters.

Display Default
 Password

Disable Sets whether the registered password is
 displayed or not displayed on the
 password selection screen for the
 document open password or permission
 password.
[Disable]: Displays the registered default
 password using* instead of each
 character.
[Enable]: Displays the registered default
 password as it is.

Compression
 Rate

Color Medium Selects a default compression level.

Grayscale Medium

Mono High

Edge Erase Setting OFF Sets whether to erase the edge shadow
 created in the surrounding of 2-page
 spread documents.

Width 5 mm
(0.2 inch)

Sets an erasing width.
Available range: 5 to ±50 mm (0.2 to
 2.0 inches) (1 mm increment)

Center Erase Setting OFF Sets whether to eliminate the shadow lines
 in the center of the two-spread document.

Width 5 mm
(0.2 inch)

Sets an erasing width.
Available range: 5 to ±50 mm (0.2 to
 2.0 inches) (1 mm increment)

White Page Skip OFF Sets whether to enable or disable the white
 page skip function.

E-mail
 Setup

Configure Shortcuts 01:
 Address
 Book
02: Group
 List
03: Tx
 History
04: Manual
 Input
05: LDAP

Sets the shortcut button for the [Scan To
 E-mail] tab.

File Name (NULL) Sets a file name. You can enter up to 64
 one-byte characters.
The following options can be set.*1

#n: adding a serial number from 00000 to
 99999
#d: adding the date of a file creation
 (yymmddhhmmss)
(yymmddhhmmss)

Template Edit Subject (NULL) Registers or edits e-mail subject text. You
 can enter up to 80 characters.
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Edit Body (NULL) Registers or edits e-mail body. You can
 enter up to 256 characters.

From / Reply
 To

From (NULL) Sets the e-mail address that is displayed in
 the [From] field. You can enter up to
 80 characters.

E-mail Sender
 ID

(NULL) Sets the sender name that is displayed in
 the [From] field. You can enter up to
 32 characters.

Reply
 To

Address
 Book

(NULL) Sets the e-mail address that is displayed in
 the [Reply to] column. You can enter up to
 80 characters.

Manual
 Input

(NULL)

LDAP (NULL)

Broadcast Destination ON Sets whether an e-mail address
 confirmation screen is displayed before
 broadcasting the e-mail.

MDN Response OFF Sets whether to request the MDN (message
 disposition notification) response.

A/R Full Print OFF Set whether to print the transmission and
 reception history reports automatically.

MCF Report OFF Sets whether to print a confirmation after
 transmission of Internet fax and Scan To
 E-mail.

Timeout of MCF Report 15 minutes Sets the timeout for printing a confirmation
 after transmission of Internet fax and Scan
 To E-mail. If the setting period of time is
 exceeded, the report is automatically
 printed without the MDN response.

Print Check Message OFF Sets whether to report the error content if
 a transmission error occurs.

USB
 Memory
 Setup

File Name (NULL) Sets the default file name. You can enter
 up to 255 characters.
The following options can be set as the
 default file name.*1

#n: adding a serial number from 00000 to
 99999
#d: adding the date of a file creation
 (yymmddhhmmss)
(yymmddhhmmss)

Shared
 Folder
 Setup

Configure Shortcuts 01: Color
 Mode
02: Scan
 Size
03: Duplex
 Scan
04: File
 Name
05:
 SubFolder

Sets the shortcut button for the [Scan To
 Shared Folder] tab.

TWAIN
 Setup

Network TWAIN ON Sets whether to use the Network TWAIN.

Port No.*2 9967 Sets the port number.
Available range: 1 to 65535
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WSD
 Scan
 Setup

WSD Scan Enable Specifies whether to use WSD Scan.

Binding Long Edge
 Bind

Sets the default binding position.

PC Scan Mode Simple
 Scan
 Mode

Selects the default PC scan mode.

Scanner
 Adjust

Scanner Calibration Execute Executes scanner calibration.

Auto Color Judge Level 4 Sets the criteria of document color.
Available range: 1 to 5

White Page Skip Level 3 Sets the criteria of white page.
Available range: 1 to 5

Multi Feed
 Check

Setting ON Sets whether to enable or disable multiple
 feed detection function.

Detection
 Accuracy

Normal Sets the accuracy of multiple feed
 detection.

Detection
 Cycle

Low Sets the cycle of multiple feed detection.

*1 For profiles, "#n" or "#d" can be specified for [File Name].

If specifying "#n": 5-digit serial number from 00000 to 99999

If specifying "#d": Date and time when a file is created. 12-digit number in yymmddhhmmss
 format

yy: Year created (the last two digits of the Christian
 Era)

hh: Hours created (00 to 23)

mm: Month created (01 to 12) mm: Minute created (00 to 59)

dd: Date created (01 to 31) ss: Second created (00 to 59)

* The date and time when a file is created are values of the timer of MC873.

An example of file name specification (if the file format is PDF)

If specifying "Data#n": Saved as file names such as "Data0000.pdf" and "Data00001.pdf".

If specifying "File#d": Saved as file names such as "File090715185045.pdf".

If specifying "Scan": "Scan.pdf" is created first, and then data is saved with the name of
 "Scan#.pdf".

For "#d", refer to the above.

*2 To enable the changed setting, the network card must be restarted. Follow the instructions on
 the confirmation screen that is displayed when changing the settings, and restart the network
 card.
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Print From USB Memory Setup

Item Factory default
 setting

Description

Default
 Settings

Color /
 Mono

Color Select Color / Mono (Grayscale).

Paper
 Feed

Tray 1 Specify a paper tray to use.

Copies 1 Sets the number of copies.

Duplex OFF Turns the duplex printing function on or off.
[OFF]: simplex printing
[Long Edge Bind]: duplex printing for long-edge
 binding
[Short Edge Bind]: duplex printing for short-
edge binding

Fit ON Specify whether to match the paper.
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Print Setup

Print Menu

Color Menu

System Configuration Menu

PCL Setup

PS Setup

XPS Setup

IBM PPR Setup

EPSON FX Setup

Encrypted Secure Print Setup

Print Menu

Item Factory
 default
 setting

Description

Print
 Setup

Copies 1 Set(s) Sets the number of copies. For local printing, this
 setting is invalid except for demo data.
Available range: 1 to 999

Duplex OFF Turns the duplex printing function on or off.
[OFF]: simplex printing
[Long Edge Bind]: duplex printing for long-edge
 binding
[Short Edge Bind]: duplex printing for short-edge
 binding

Media Check Enable Sets whether to check an inconsistency between the
 page size and the paper size in the tray.

Override A4 / Letter Yes Set the function that automatically switches paper to
 print from A4 to Letter if a tray runs out of A4 paper
 and Letter paper is loaded, or from Letter to A4 if a
 tray runs out of Letter paper.

Resolution 600dpi Sets the resolution.

Toner
 Save

Toner
 Save
 Level

OFF Sets the amount of toner to be saved.
This setting is enabled when copying, printing,
 printing received faxes, and printing from USB
 Memory.

Color All [All]: Toner Save is applied to all colors including
 100% black.
[Except100%Black]: Toner Save is applied to all
 colors other than 100% black.
This function is only applied to the print function.

Mono-Print Mode Auto Sets the print mode for black-and-white pages.

Orientation Portrait Sets the page orientation.

Edit Size Cassette Sets the size of the printable page area if the size is
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 size  not specified with the paper edit size command from
 a computer.

Width / Length 210 mm
 (8.3 inch)
 or
 216 mm
 (8.5 inch)

Sets the width of a custom paper size.
Available range: 64 to 297 mm (2.5 to 11.7 inches)

297 mm
 (11.7
 inch) or
 279 mm
 (11.0
 inch)

Sets the length of a custom paper size.
Available range: 90 to 1,321 mm (3.5 to 52.0 inches)

Printer
 Adjust

Manual Timeout 60 seconds Sets for how many seconds the machine waits for
 paper to be fed before cancelling a job when using
 the manual feeder.

Timeout Injob 40 seconds Sets for how many seconds the machine waits until
 pages are output from when the processing of the
 received data stops.

Timeout Local 40 seconds Sets how long each port is left opened after a job is
 complete. (The network is excluded.)

Timeout Network 90 seconds Sets how long the network port is left opened after a
 job is complete.

Print Mode Without
 Color Toner

Alarm

Jam Recovery Enable Sets whether to print the pages again that are not
 printed due to a paper jam after the jam is cleared.

Paper Black Setting 0 Adjusts finely if the black contrast becomes weak or
 blots or lines become conspicuous when printing on
 plain paper.
If fine blots or lines appear, decrease the value. If
 the dark part becomes light, increase the value.

Paper Color Setting 0 Adjusts finely if the color contrast becomes weak, or
 blots or lines become conspicuous when printing on
 plain paper.
If fine blots or lines appear, decrease the value. If
 the dark part becomes light, increase the value.

Transparency Black
 Setting

0 Adjusts finely if the black contrast becomes weak, or
 blots or lines become conspicuous when printing on
 special paper.
If fine blots or lines appear, decrease the value. If
 the dark part becomes light, increase the value.

Transparency Color
 Setting

0 Adjusts finely if the color contrast becomes weak, or
 blots or lines become conspicuous when printing on
 special paper.
If fine blots or lines appear, decrease the value. If
 the dark part becomes light, increase the value.

SMR
 Setting

Black 0 Corrects variations in print results caused by
 temperature and humidity conditions and differences
 in print density and frequency. Change the setting if
 the print quality is uneven.

Yellow 0

Magenta 0

Cyan 0

BG
 Setting

Black 0 Corrects variations in print results caused by
 temperature and humidity conditions and differences
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Yellow 0  in print density and frequency. Change the setting if
 the background is dark.Magenta 0

Cyan 0

Moisture Control Off Sets whether to enable the condensation control.

Narrow Paper Speed Mode1 Sets the printing speed of narrow paper.

Warmup Control Off Sets how warmup is performed.

Print
 Position
 Adjust

Tray 1 X Adjust 0 mm X Adjust: Adjusts the position of the entire printing
 image perpendicular to the direction of paper
 movement.

Available range: ±2.00 mm (0.25 increments).

Y Adjust: Adjusts the position of the entire printing
 image parallel to the direction of paper
 movement.

Available range: ±2.00 mm (0.25 increments).

Duplex X Adjust: Adjusts the position of the image
 on the back side of a duplex print perpendicular to
 the direction of paper movement.

Available range: ±2.00 mm (0.25 increments).

Duplex Y Adjust: Adjusts the position of the image
 on the back side of a duplex print parallel to the
 direction of paper movement.

Available range: ±2.00 mm (0.25 increments).

Y Adjust 0 mm

Duplex
 X
 Adjust

0 mm

Duplex
 Y
 Adjust

0 mm

Tray
 2/3/4
 (Optional)

X Adjust 0 mm

Y Adjust 0 mm

Duplex
 X
 Adjust

0 mm

Duplex
 Y
 Adjust

0 mm

MP Tray X Adjust 0 mm

Y Adjust 0 mm

Duplex
 X
 Adjust

0 mm

Duplex
 Y
 Adjust

0 mm

Drum Cleaning OFF Sets whether to clean the drum before printing. The
 image quality improvement may be expected.

Hex Dump OFF Prints out the data received from the host computer
 in hex. To finish printing, turn the machine off.

Color Menu

Item Factory
 default
 setting

Description

Density Control Auto Select "Auto" or "Manual" for adjusting density.

Adjust Density - Adjusting density is performed right after this menu is
 selected.

Color Tuning / Print
 Pattern

- A test page is printed for checking the adjusting value to
 be entered for any other C/M/Y/K Tuning menus.

Cyan
 Tuning

Cyan
 Highlight

0 Adjust the value for Highlight / Mid-tone / Dark of each
 color within a range of -3 to +3.
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+ : Adjusted to be darker.
- : Adjusted to be lighter.

Cyan Mid-
Tone

0

Cyan Dark 0

Magenta
 Tuning

Magenta
 Highlight

0

Magenta
 Mid-Tone

0

Magenta
 Dark

0

Yellow
 Tuning

Yellow
 Highlight

0

Yellow
 Mid-Tone

0

Yellow
 Dark

0

Black
 Tuning

Black
 Highlight

0

Black Mid-
Tone

0

Black Dark 0

Cyan Density 0 Adjust the total density of each color within a range of -3
 to +3.
+ : Adjusted to be darker.
- : Adjusted to be lighter.

Magenta Density 0

Yellow Density 0

Black Density 0

Adjust Registration Color registration adjustment is performed.

Ink
 Simulation

Ink
 Simulation

OFF Sets the ink simulation. This setting is enabled only for
 PS language jobs.

UCR UCR Low Adjusts the level of under color removal.

CMY100%
 Density

CMY100%
 Density

Disable Selects whether to use halftone for C, M, Y 100% density.

CMYK
 Conversion

CMYK
 Conversion

ON Selects whether to use simple (quick) mode when
 performing CMYK Conversion.
This menu setting is disabled if using the ink simulation
 function.

System Configuration Menu

Item Factory
 default
 setting

Description

Personality Auto Selects the emulation mode. If auto is set, the correct emulation is
 automatically selected every time a print job is received.

Alarm
 Release

Manual If [Manual] is set, non-critical warnings, such as requests for a different
 paper size, can be cleared by pressing [RESET]. If [Auto] is set, the
 warnings are cleared when the print job resumes.

Auto
 Continue

OFF Sets whether the machine automatically recovers from a Memory
 overflow.
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Error
 Report

OFF Sets whether to print error details if PostScript errors occur.

PCL Setup

Item Factory
 default
 setting

Description

Font Source Resident Selects the location of the font to use.

Font No. I0 Selects the font number to use.
Available range: I0 to I90 if [Resident] is set/C1 to C4 if
 [Resident 2] is set.

Font Pitch 10.00 CPI Sets the width of the PCL default font.
Available range: 0.44 to 99.99 CPI. (0.01CPI increments)

Font Height 12.00 point(s) Sets the height of the PCL default font.
Available range: 4.00 to 999.75 point. (0.25 point
 increments)

Symbol Set PC-8 Selects a PCL symbol set.

A4 Print Width 78 Column Sets the number of digits for automatic line feed on A4
 paper.

White Page Skip OFF Selects whether to print blank pages.

CR Function CR Sets the machine operation when receiving CR code.

LF Function LF Sets the machine operation when receiving LF code.

Print Margin Normal Sets the nonprintable area of the page.

True Black OFF Selects whether to print black image data using mixed CMYK
 or print using black toner only.

Pen Width Adjust ON Sets whether to emphasize thin lines so that the lines look
 thicker.

Tray
 ID#

Tray 1 1 Sets a value that specifies a tray with the PCL paper source
 specification command.
Available range: 1 to 59

Tray 2
 (Optional)

5

Tray 3
 (Optional)

20

Tray 4
 (Optional)

21

MP Tray 4

PS Setup

Item Factory default
 setting

Description

L1 Tray Type 1 Set the paper tray number for the Level 1 operator.
[Type 1]: The effective number for paper tray starts from
 1.
[Type 2]: The effective number for paper tray starts from
 0.

Network PS- RAW Specifies PS communication protocol mode of data from
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Protocol  Network.

USB PS-
Protocol

RAW Specifies PS communication protocol mode of data from
 USB.

PDF Paper Size Current Tray Size Set the paper size when printing with PDF Direct Print.

PDF Scaling
 Size

99% Sets reduction rate for PDF when [PDF Paper Size] is set to
 [Scaling Size].

XPS Setup

Item Factory default setting Description

DigitalSignature OFF Sets the DigitalSignature functions.

DiscardControl Auto Sets the DiscardControl function.

MC Mode ON Sets the MarkupComaptibility function.

Unzip Mode Speed Sets the XPS file decompression method.

White Page Skip OFF Selects whether to output blank pages in XPS.

IBM PPR Setup

Item Factory default
 setting

Description

Character
 Pitch

10 CPI Specifies character pitches in IBM PPR emulation.

Font
 Condense

12CPI to 20CPI Specifies 12CPI pitches for Condense Mode.

Character
 Set

SET-2 Specifies a character set.

Symbol
 Set

IBM-437 Specifies a symbol set.

Letter O
 Style

Disable Specifies the style that replaces 9BH with letter o and 9DH with a
 zero.

Zero
 Character

Normal Sets the zero to be slashed or unslashed.

Line Pitch 6 LPI Specifies the line spacing.

White Page
 Skip

OFF Selects whether to print blank pages.

CR
 Function

CR Selects a carriage return from [CR] or [CR+LF].

LF
 Function

LF Selects a line feed from [LF] or [LF+CR].

Line
 Length

80 Column Specifies the number of characters per line.

Form
 Length

11.7 inch or 11
 inch

Specifies the length of paper.

TOF
 Position

0.0 inch Specifies the distance from the top edge of paper to where the cut
 is to be made.

Left Margin 0.0 inch Specifies the distance from the left edge of paper to where the cut
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 is to be made.

Fit To
 Letter

Disable or
 Enable

Sets the printing mode that can fit paper to the printable area
 equivalent to 11 inches (66 lines).

Text
 Height

Same Sets the height of a character.
SAME: The height stays the same regardless of CPI.
DIFF: The height varies according to CPI.

Cont Paper
 Mode

Off Sets to Landscape the edit direction of paper supported by A3
 printer.

EPSON FX Setup

Item Factory default
 setting

Description

Character
 Pitch

10 CPI Specifies character pitches.

Character
 Set

SET-2 Specifies a character set.

Symbol
 Set

IBM-437 Specifies a symbol set.

Letter O
 Style

Disable Specifies the style that replaces 9BH with letter o and 9DH with a
 zero.

Zero
 Character

Normal Sets the zero to be slashed or unslashed.

Line Pitch 6 LPI Specifies the line spacing.

White Page
 Skip

OFF Selects whether to print blank pages.

CR
 Function

CR Select a carriage return from [CR] or [CR+LF].

Line
 Length

80 Column Specifies the number of characters per line.

Form
 Length

11.7 inch or 11
 inch

Specifies the length of paper.

TOF
 Position

0.0 inch Specifies the distance from the top edge of paper to where the cut
 is to be made.

Left Margin 0.0 inch Specifies the distance from the left edge of paper to where the cut
 is to be made.

Fit To
 Letter

Disable or
 Enable

Sets the printing mode that can fit paper to the printable area
 equivalent to 11 inches (66 lines).

Text
 Height

Same Sets the height of a character.
SAME: The height stays the same regardless of CPI.
DIFF: The height varies according to CPI.

Cont Paper
 Mode

Off Sets to Landscape the edit direction of paper supported by A3
 printer.

Encrypted Secure Print Setup

Item Factory
 default

Description
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 setting

Verify
 job
 option

Disable Set whether to verify a job before printing.
If enabled, the machine verifies that the job is not altered before starting
 printing. The security is enhanced, however it will take longer to start
 printing.

Erase
 job
 option

Zero out
 once

Set how to delete a job.
You can overwrite deleted data so that it will not be restored.
If enabled, it will take longer to delete.
Available value: No overwrite/Zero out once/Multiple random overwrites

Keep
 job for

2 hours Set the storage period of jobs.
If the set period elapses after jobs are stored, the jobs will be automatically
 deleted.
Available value:
15 minutes/30 minutes/1 hour/2 hours/4 hours/8 hours/12 hours/1 day/2
 days/3 days/4 days/5 days/6 days/7 days
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Network Menu

Item Factory default
 setting

Description

Network
 Setup

Network
 Setting

TCP/IP Enable Sets whether to
 enable TCP/IP.

NetBIOS over TCP Enable Sets whether to
 enable NetBIOS
 over TCP/IP.
Display condition:
 TCP/IP protocol is
 enabled.

IP Address Set Auto Sets the method of
 assigning an IP
 address.

IPv4 Address 192.168.100.100 Sets an IP address.
Display condition:
 TCP/IP protocol is
 enabled.

Subnet Mask 255.255.255.0 Sets a subnet mask.
Display condition:
 TCP/IP protocol is
 enabled.

Gateway Address 0.0.0.0 Sets a gateway
 address.
Display condition:
 TCP/IP protocol is
 enabled.

DHCPv6 Disable Selects enable /
 disable of DHCP
 when IPv6 is used.

DNS Server (Primary) 0.0.0.0 Sets the IP address
 for a Primary DNS
 server.
Display condition:
 TCP/IP protocol is
 enabled.

DNS Server (Secondary) 0.0.0.0 Sets the IP address
 for a Secondary
 DNS server.
Display condition:
 TCP/IP protocol is
 enabled.

WINS Server (Primary) 0.0.0.0 Sets the name or the
 IP address for the
 WINS server.
Display condition:
 TCP/IP protocol is
 enabled.

WINS Server (Secondary) 0.0.0.0 Sets the name or the
 IP address for the
 WINS server.
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Display condition:
 TCP/IP protocol is
 enabled.

Proxy Disable Sets whether to use
 proxy.

Proxy Server (NULL) Sets the name or IP
 address of the
 proxy server. You
 can enter up to
 15 characters.

Proxy Server Port No. 8080 Sets the port
 number of the
 proxy server.

Proxy User ID (NULL) Sets the user ID to
 connect to the
 proxy server.

Proxy Password (NULL) Sets the password to
 connect to the
 proxy server.

Web Enable Sets whether to
 enable access from
 a Web browser.
Display condition:
 TCP/IP protocol is
 enabled.

Telnet Disable Sets whether to
 enable access from
 the Telnet.
Display condition:
 TCP/IP protocol is
 enabled.

FTP Disable Sets whether to
 enable access with
 FTP.
Display condition:
 TCP/IP protocol is
 enabled.

IPSec Disable This item is
 displayed only if
 IPSec is set to valid.
 This item can be
 changed to disable
 only.

SNMP Enable Sets whether to
 enable access from
 SNMP.
Display condition:
 TCP/IP is enabled.

Network Scale Normal [Normal]: The
 machine operates
 effectively even if
 connected to a HUB
 with the spanning
 tree function.
 However, the
 machine takes
 longer to start up if
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 it is connected to a
 small LAN that
 consists of two or
 three computers.
[Small]: This setting
 covers a small LAN
 that consists of two
 or three computers
 to a large LAN, but
 the machine may
 not operate
 efficiently if it is
 connected to a HUB
 with the spanning
 tree function.

Gigabit Network Disable Sets whether to
 enable access with
 Gigabit Ethernet.

HUB Link Setting Auto Sets the hub linking
 method. Normally,
 select [Auto
 Negotiate].

Wireless
 Setting
(If wireless
 LAN module
 fitted)

Automatic Setup
 (WPS)

WPS-PBC - WPS-PBC is
 executed.

WPS-PIN - WPS-PIN is
 executed.

Wireless
 Network
 Selection

A list of access
 point name found
 in the search

- Displays a list of
 wireless LAN access
 points' names that
 are found in a
 search.

Manual
 Setup

SSID (NULL) Enter an SSID.

Security Disable Selects the security
 of the wireless LAN
 function.
"WPA2-EAP" can set
 only in Web.

WEP Key (NULL) Enter the WEP key.

WPA
 Encryption
 Type

AES Select a WPA2-PSK
 encryption type.
Displays if [WPA2-
PSK] is selected for
 [Security].

WPA Pre-
shared
 Key

(NULL) Enter the Pre-shared
 Key.
Displays if [WPA2-
PSK] is selected for
 [Security].

Wireless reconnection - Wireless
 reconnection is
 executed.

Enabling Wired Communications - Switch wireless
 network connection
 to wired network
 connection.
This item is
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 displayed if wireless
 communications are
 enabled.

Factory Defaults - The settings of the
 network, mail
 server, LDAP
 server, and secure
 protocol server are
 returned to the
 default settings.

Mail
 Server
 Setup

SMTP Server (NULL) Sets the IP address
 or server name for
 the SMTP server.

SMTP Port 25 Sets the port
 number for the
 SMTP server.
 Normally, use the
 default setting.
Available range: 1 to
 65535

SMTP Encryption None Selects an
 encryption method
 in the SMTP
 communication.

Receive Setting Disable Sets the protocol to
 be used for
 receiving e-mails.

POP3 Server (NULL) Sets the IP address
 or server name for
 the POP3 server.

POP3 Port 110 Sets the port
 number prepared by
 POP3 on the POP3
 server.
Available range: 1 to
 65535

POP Encryption None Selects an
 encryption method
 in the POP
 communication.

Authentication Method No
 Authentication

Selects an
 authentication
 method for e-mail
 transmissions.

SMTP User ID (NULL) Sets the login name
 to the server used
 for SMTP
 authentication.

SMTP Password (NULL) Sets a login
 password to the
 server used for
 SMTP
 authentication.

POP User ID (NULL) Sets a login name to
 the server used for
 POP certification or
 for printing received
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 e-mail attachment
 files.

POP Password (NULL) Sets a login
 password to the
 server used for POP
 certification or for
 printing received e-
mail attachment
 files.

LDAP
 Server
 Setting

Server Setting LDAP Server (NULL) Sets the IP address
 or server name for
 the LDAP server.

Port No. 389 Sets the port
 number for the
 LDAP server.
Available range: 1 to
 65535

Timeout 30 second(s) Sets the timeout
 value for the search
 response from the
 LDAP server.
Available range: 10
 to 120 seconds

Max. Entries 100 entries Sets the maximum
 number of search
 results from the
 LDAP server.

Search Root (NULL) Specifies a position
 to start searching
 the LDAP directory.

Attribute Name1 cn Specifies the
 attribute name
 searched for as the
 user name.

Name2 sn

Name3 givenName

E-mail Address mail Specifies the
 attribute name
 searched for as an
 e-mail address.

Additional Filter (NULL) Specify the attribute
 name to be added
 when searching.

Authentication Method Anonymous Sets the
 authentication
 method.
For Digest-MD5, the
 DNS server must be
 set. For Secure
 Protocol, the secure
 protocol server
 must be set.

User ID (NULL) Sets a user ID for
 LDAP server
 authentication. You
 can enter up to
 80 characters.
Display condition:
 the LDAP
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 authentication
 method is not set to
 [Anonymous].

Password (NULL) Sets a password for
 LDAP server
 authentication. You
 can enter up to
 32 characters.
Display condition:
 the LDAP
 authentication
 method is not set to
 [Anonymous].

Encryption None Sets the encryption
 of communication to
 the LDAP server.

Secure
 Protocol
 Server
 Setting

Domain (NULL) Sets a realm name
 for the Kerberos
 certification. You
 can enter up to
 64 characters.

Memo
To apply the settings that are changed on the [Network Menu] menu, you must restart a
 network card. Restart the network card according to a confirmation screen that is displayed
 when you change settings.
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Configure Home Screen

Factory default setting Description

Copy
Scan
Print
Fax/Internet Fax
Troubleshoot

Register frequently-used functions on the Home Screen.
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Management

Item Factory
 default
 setting

Description

Default Mode Home Sets the default mode screen of this machine.

Operation
 Clear

Operation Timeout 3 Sets time for automatic reset of screen to
 begin.
Available range: 1 to 10 minutes

Clear After Job OFF Sets whether to reset after job is completed.

Sound
 Control

Key Touch Tone
 Volume

Middle Sets the volume of the key-touch tone.

Copy Buzzer Volume Middle Sets the volume for the copy complete
 sound.

FAX Buzzer Volume Middle Sets the volume for the transmission
 complete sound.

JAM Buzzer Volume Middle Sets the volume for the paper jam alert tone.

AirPrint Buzzer
 Volume

Low Sets the AirPrint confirmation operation
 sound.

Local
 Interface*1

USB
 Menu

USB Enable Sets whether to enable USB.

Soft Reset Disable Sets whether to enable the soft reset
 command.

Speed 480Mpbs Selects the maximum transfer speed of USB
 interface.

Offline
 Receive

Disable Set whether to receive data in offline state or
 in recoverable error state.

Serial
 Number

Enable Sets whether to use a USB serial number.

USB
 Assignment

IPP Selects IPP-USB or Legacy for USB
 assignment.
When scanning via USB, select Legacy.

System
 Setup

Access Control Disable Sets access control.

User Authentication
 Method

Local Display condition: [Access Control] is set to
 [User] or [Password].

Unit of Measure Millimeter or
 Inch

Selects a displayed unit (millimeter / inch).

Default Paper Size A4 or Letter Sets the default paper size.

Date Format dd/mm/yyyy
 or
 mm/dd/yyyy

Sets the date format.

Allow All Reports To
 Print

Disable Sets whether to allow printing reports with
 personal information.

Near Life LED Enable Sets whether to light an LED if a near life
 warning occurs.

Status in Near Life Enable Sets whether to display a message if a near
 life warning occurs.
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Address Information
 Lock Time Out

30
 minute(s)

Sets time until a lock is released by the
 machine when an address book, telephone
 book, or profile is kept locked by the utilities.
Available range: 1 to 60 minutes

USB Memory
 Interface

Enable If [Disable] is set, the Scan To USB Memory
 and the print from USB Memory functions
 cannot be used.

Panel Brightness
 During Operating

7 Sets the LCD panel brightness.
Available range: 1 to 7 (1 increments)

Panel Brightness
 While Power Save

0 Sets the LCD panel brightness.
Available range: 0 to 7 (1 increments)

Panel Calibration Execute Executes LCD panel calibration.

Output Tray Paper
 Exist Lamp

Enable Selects whether to flash LED when paper
 remains on the Upper Output Tray.
Only for the models mounted the Upper
 Output Tray.

Power Save Power Save Time 1 minute Sets when to enter Power Save mode.

Sleep Time 15 minutes Sets when to enter Sleep mode.

Auto Power Off Time 4 hours Sets when to enter Auto Power Off.

Silent Mode ON Specifies a print preparation operation when
 entering standby status from Sleep mode.
If [ON] is set: it is quiet as there is no print
 preparation.
If [OFF] is set: there is a rotation noise of the
 image to perform print preparation but you
 can start first printing early.

ECO Mode*1 ON If [ON] is set: Printing starts even before the
 temperature of the fuser reaches the
 prescribed degrees, if the job is small.
If [OFF] is set: Printing starts after the
 temperature of the fuser reaches the
 prescribed degrees.

Memory
 Setup

Receive Buffer Size Auto Sets the reception buffer size that local
 interface secures.

Resource Save OFF Sets the resource save area.

Flash
 Memory
 Setup*1

Initialize Execute Initializes a flash Memory.
Display condition: [Initial Lock] is set to
 [Disable].

HDD
 Setup*1

Initialize Execute Initializes a hard disk.
Display condition: [Initial Lock] is set to
 [Disable].

Format
 Partition

PCL (NULL) Formats a partition.

Common (NULL)

PS (NULL)

Storage
 Maintenance
 Setup

Check File System Execute Resolves any mismatch between actual
 Memory and displayed Memory available in a
 file system and performs administration data
 (FAT information) recovery.

Check All Sectors Execute Performs recovery of a defective HDD sector
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 information and a file system mismatch as
 mentioned above.

Erase HDD Execute This function erases all data on the hard disk.

Initial Lock Enable Sets whether to give permission to change
 settings associated with the Memory
 initialization.

Encryption
 Setup

Job Limitation Disable If [Encrypted Job only] is selected, all
 requests for print except encrypted
 authentication printing are ignored.
If [ID Secure Job only] is selected, all
 printing jobs except for ID secured jobs are
 ignored.

Language
 Maint Setup

Select Language English Selects display language for the LCD panel.

Initialize*1 Execute Deletes downloaded message files.

Admin
 Password

New Password
Enter password
 (Verify)

aaaaaa Changes the administrator password. 6 to
 12 characters can be used.

Reset Settings*2 Execute Deletes job macros, fax transmission /
 reception data, and the history information,
 and returns the settings to the default.

Job Log
 Setup

Clear Job Log*3 Execute Clears the saved job logs.

Print
 Statistics

Supplies Report Disable Sets whether to print the consumable
 counter's report.

Reset Main Counter Execute Resets the main counter.

Reset Supplies
 Counter

Execute Reset the consumable counter.
Display condition: [Supplies Report] is set to
 [Active].

*1 A message is displayed to confirm the equipment restarts automatically when changes
 have been made. Select [Yes] to continue. Select [No] to cancel.

*2 A message is displayed to confirm the equipment restarts automatically when executed.
 Select [Yes] to continue. Select [No] to cancel.

*3 A message is displayed to confirm that all job logs are deleted when executed. Select
 [Yes] to continue. Select [No] to cancel.
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User Install

Item Factory
 default
 setting

Description

Time Zone 00:00 Sets the time
 GMT zone.
Available range:
 -12:00 to
 +13:00
 (15 minutes /
 increment)

Daylight Saving ON Sets whether to
 enable the
 Daylight
 Saving mode.

Time Setup Auto Setup SNTP Server
 (Primary)

Sets the SNTP
 server to use
 for setting the
 current date
 and time. You
 can enter up to
 64 characters.

SNTP Server
 (Secondary)

Manual Setup 2001/1/1 0:00 Sets the current
 date and time
 manually.

Power Setup Auto Power Off Auto Config Sets the
 behavior of
 Automatic
 Power Off.

High Humid Mode OFF Sets whether to
 enable the
 humidity
 mode.

Drum Near Life Timing 3000 Sets the timing
 for the near life
 warning for the
 drum
 cartridges.

Fuser Near Life Timing 2500 Sets the timing
 for the near life
 warning for the
 fuser unit.

Belt Near Life Timing 2000 Sets the timing
 for the near life
 warning for the
 belt unit.

MF (Tone) / DP (Pulse) Tone Select a dial
 type.
Tone
Pulse

Reception Mode Fax Ready
 Mode

Sets a reception
 mode.
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Fax Ready
 Mode
Tel / Fax Ready
 Mode
Ans / Fax Ready
 Mode
Tel Ready Mode
DRD
 (Distinctive
 Ring Detection)

DRD Type Type 1 Set Distinctive
 Ring Detection.
Type 1
Type 2
Type 3
Type 4

Dial Tone Detection*2 OFF Sets whether to
 detect a dial
 tone.

Busy Tone Detection ON Sets whether to
 detect a busy
 tone.

Monitor Control OFF Select from
 three choices.
OFF: Not to
 monitor.
Type 1: Monitor
 till receiving /
 sending the
 first valid
 facsimile
 signal.
Type 2: Execute
 Type 1
 monitoring
 during
 communication.

Monitor Volume Middle Sets the
 Monitor
 Volume.
OFF
Low
Middle
High

TTI Register / Edit TTI 1 (NULL) Registers or
 changes the
 transmission
 terminal
 identification
 (the name of a
 sender). You
 can enter up to
 22 characters.

TTI 2

TTI 3

Standard TTI TTI 1 Selects the
 default
 sender's name
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 from the
 registered list.
TTI 1
TTI 2
TTI 3

TTI Number (NULL) Register the fax
 number of this
 machine.

TTI Calendar Type dd/mm/yyyy or
 mm/dd/yyyy

Sets the
 calendar date
 format of
 sender's
 information.

Super G3 ON Sets whether to
 use Super G3
 (ultra high-
speed
 communication
 mode).

Wireless Module Disable

Erase Privacy Data*1 Execute Deletes the
 registered
 privacy data.
Display
 condition: The
 job accounting
 is invalid.

*1 A message is displayed to confirm the equipment restarts. Select [Yes] to continue.
 Select [No] to cancel.

*2 When you set the dial tone detection setting to [ON], the machine does not dial if the
 dial tone is not detected.
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Management Software

Using Configuration Tool

Web Page of This Machine
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User Authentication (Access Control)

This section describes the user authentication and access control functions.

The user authentication and access control functions allow you to limit the functions
 available to each user. If access control is enabled, the user authentication is required
 before using this machine. If the authentication succeeds, only functions specified in
 advance can be used.

Your machine has the following three methods of user authentication.

User name and password

PIN (personal identification number)

IC card

To control access to the machine, register users in advance. You can register up to 5,000
 users.

If access control is enabled, according to the setting, the user must enter user name and
 password, PIN, or IC card information to log in to the machine.

Note
The settings for fax transmission also apply to fax transmission from a computer.

To perform user authentication and access control, one of the following operations is
 required.

Registering a user information from the Web Page

Registering Users

Registering a PIN from Configuration Tool

Registering a PIN

Topics

Managing users from the Web Page

Access Control

Registering a user name and password from Configuration Tool

Registering a User Name and Password

To enable the user limit, change the setting.

Enabling the Access Control

To use the machine, log in with the registered user name and password, PIN, or IC card
 information.

About Operation If the Access Control is Enabled

When you log in with a user name and password, see the following.

Printing in the Windows Environment

Printing in the Mac OS X Environment

Faxing in the Windows Environment
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Enabling the Access Control

Before enabling access control of the machine, you need to register user information on the
 web page of the machine.

Access Control

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [OK].

5. Press [Management].

6. Press [System Setup].

7. Press [Access Control] to set it to [Enable].

Memo
Pressing [Access Control] switches between [Enable] and [Disable].

When the access control is enabled, the following screen appears (when the
 authentication type is Local).
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About Operation If the Access Control is Enabled

Log into This Machine (For General Users)

Log into This Machine (For the Administrator)

Log Out from This Machine

If your user information is not registered, press [Guest] to log in.

Log into This Machine (For General Users)

1. Enter the user name, and then press [OK].

2. Enter the password, and then press [OK].

Memo
If you want to log in with PIN or IC card information, press [Authentication Method] on the
 portal login screen to change.

3. Press [OK].
If the authentication succeeds, the home screen is displayed.

Log into This Machine (For the Administrator)

1. Press [Administrator].

2. Enter the administrator name, and then press [OK].

3. Enter the administrator password, and then press [OK].

4. Press [OK].
If the authentication succeeded, the home screen is displayed.

Log Out from This Machine

When you have finished operations, be sure to log out of the machine.

1. Press [Logout].

2. Press [Yes] on a confirmation screen.

Memo
If you do not operate the panel for a certain period of time, you are automatically logged out.
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Printing in the Windows Environment

Note
You cannot use the XPS printer driver for this function.

Memo
The following procedure uses Notepad and PCL driver as an example.

1. Select [Print] from the [File] menu.

2. Select the necessary printer driver in [Select Printer], and then
 click [Preferences].

3. Select the [Extend] tab.

4. Click [User Authentication].

5. Select the [Use User Authentication] check box.

6. Enter the user name in [Username] and the password in
 [Password].
If you click [Use Windows Login], your login name on Windows is automatically
 entered.

7. Click [OK].

8. Click [OK], and then click [Print].
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Printing in the Mac OS X Environment

Memo
The following procedure uses TextEdit as an example. The descriptions may vary depending on
 your application.

1. Select [Print] from the [File] menu.

2. Select the printer driver of this machine.

3. Select [User Authentication] from the panel menu.

4. Select the [Use User Authentication] check box.

5. Enter the user name in [User Name] and the password in
 [Password].

6. Click [Print].
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Faxing in the Windows Environment

Memo
The following procedure uses Notepad as an example. The description may vary depending on
 your application.

1. Select [Print] from the [File] menu.

2. Select the fax driver of this machine in [Select Printer], and then
 click [Preferences].

3. Click [User Authentication] on the [Setup] tab.

4. Select the [Use User Authentication] check box.

5. Enter the user name in [Username] and the password in
 [Password].
If you click [Use Windows Login], your login name on Windows is automatically
 entered.

6. Click [OK].

7. Click [OK], and then click [Print].
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Account Management

Note
If you use Print Job Accounting, this function cannot be used together.

When the access control is enabled, you can control amount of print jobs for each user or
 common account (an account shared by the users) using the web page of the machine.

Once user information is registered, an account is automatically assigned to each user.
 Common accounts should be registered by administrators.

Administrators need to set limit amount (points) of usage to each account.

And then assign a number of points to each job, for example, XX points for color copying,
 etc.

Each time users print, corresponding numbers of points are subtracted from their accounts.
 Users whose remaining points reach 0 cannot print.

Before enabling the account management, you need to register user information.

Access Control

To enable the account management, follow the procedure below.

Enabling Account Management

To assign an account to each user and set numbers of points to jobs, follow the procedure
 below.

Setting a Number of Points to Each Account

Creating shared account

Creating a Shared Account

To set numbers of points to jobs, follow the procedure below.

Setting Paper Points/Toner Points

To copy or print from a computer, follow the procedure below.

Printing When Account Management is Enabled

If you cannot print, see the following.

Precautions when Operating
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Enabling Account Management

1. Open the Web page of the machine.
Open the Web Page of This Machine

2. Log in as the administrator.
Log In as the Administrator

3. Click [Account Management].

4. Click [Basic Settings].

5. Enable the access control in [STEP1.Set access limits], and then
 click [Submit].

Note
When the access control is enabled, the login screen appears on the touch panel.
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6. Enable [Quota Management] in [STEP2. Quota Management
 Settings], and then click [Submit].

Memo
The quota management means managing amount of usage.

7. Set each item following the on-screen instructions, and then click
 [Submit].

Limited Usage Mode: Set an action when your points are insufficient.

Display Time of The "Insufficient Balance" Error: When you do not have enough
 points to perform the job, the error screen appears on the operator panel. Set the
 period of time for displaying the error screen.

Operations When Balance is Insufficient: Set whether to cancel or continue printing
 when the remaining points reach 0.
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Setting a Number of Points to Each Account

Set a number of points to each account.

1. Open the Web page of the machine.

2. Log in as the administrator.

3. Click [Account Management].

4. Click [Summary Account Settings].

5. Click [Individual Account Settings].

6. Click a user whom you set a number of points.

7. Enter assigned amount, balance, and set operation when balance is
 insufficient. Points are charged for each print job.

Memo
For the balance, you cannot enter a number larger than that for the assigned amount.
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8. Click [Submit].
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Creating a Shared Account

Create a shared account which can be used by the users.

1. Open the Web page of the machine.

2. Log in as the administrator.

3. Click [Account Management].

4. Click [Summary Account Settings].

5. Click [Creating/setting/deleting shared account].

6. Click [+].

7. Enter [Shared Account Name], [Assigned Amount], and [Balance],
 and then set [Operation When Balance is Insufficient].

8. Set a role which can use the shared account.
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For the role, see Access Control.

Access Control

9. Click [Submit].
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Setting Paper Points/Toner Points

Set numbers of points for paper size and Color/Mono (Grayscale). For example, you can set
 so that bigger size paper needs more points or color printing needs more points than
 grayscale printing. Points are charged on a page-by-page basis, so when you print two
 pages, you need twice as much as the set rate.

In addition, you can apply point reduction system for two-sided printing or saving toner to
 print.

1. Open the Web page of the machine.

2. Log in as the administrator.

3. Click [Account Management].

4. Click [Cost Settings].

5. Set paper size points, toner points.

Memo
The default value for each paper size point is calculated based on the area ratio of the
 paper to A4 paper.

6. Set reduction rate for two-side printing and saving toner.
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To restore the factory default settings, click [Reset].

7. Click [Submit].
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Printing When Account Management is Enabled

For copying, printing from USB Memory, Secure Print, Encrypted Secure Print, ID Secure
 Print,follow the procedure below.

1. Log into the machine.

2. If several accounts are available, select an account to use.

Memo
To switch accounts, log out from the current account, and then log into another account.

3. Perform required operation.
When printing from a computer, see "Printing in the Windows Environment".
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Precautions when Operating

If the Account Management is enabled and the remaining points run out, printing stops and
 the job will automatically be deleted after a certain period of time (The factory default
 setting is 40 seconds.) elapses.

If jobs are not executed, ask your administrator for checking your balance in [Summary
 Account Settings]. The period of time from when the shortage of points is detected to when
 the machine deletes the job can be set on the web page of the machine.

If printing stops due to point shortage, you need to cancel the current job or add points and
 complete printing to execute the next print jobs.

Memo
Contact the administrator if you want to check your balance yourself.
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Moving/Transporting This Machine

Moving This Machine

Transporting This Machine
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Moving This Machine

Lift this machine by 3 persons, because it weighs approximately 64 kg.

1. Turn the machine off.
Turning the Machine On or Off

2. Unplug all the cables.
Power cord

LAN or USB cable

Telephone cable

3. Remove any paper from the paper trays.

4. Fold the tip-over protection tools.

5. Lift up this machine, and then move it to a new location.

Injury may result.
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Transporting This Machine

Lift this machine by 3 persons, because it weighs approximately 64 kg.

Do not touch the fuser, because it is very hot.

Note
Use extra care when handling the image drum (the green cylinder), because it is fragile.

Do not expose the image drum to direct sunlight or strong light (approximately 1,500 lux or
 more). Even under room lighting, do not leave the image drum for five minutes or more.

1. Turn the machine off.
Turning the Machine On or Off

2. Unplug all the cables.
Power cord

LAN or USB cable

Telephone cable

3. Remove any paper from the paper trays.

4. If the optional additional tray unit or cabinet is installed, remove
 the 4 lock pieces.

5. Lift up the machine to remove the additional tray unit.

Injury may result.

Burns may result.
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6. Attach the packing material to the machine.

Note
Use the packing box and packing material attached to this machine when purchased.

7. Lift up the machine, and put it in the packing box.
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Specifications

General Specifications

Copier Specifications

Fax Specifications

PC Fax Specifications

Internet Fax Specifications

Scanner Specifications

Scan to E-mail Specifications

Scan to Shared Folder Specifications

Scan to USB Memory Specifications

Scan to Computer Specifications

Printing Specifications

Printing from USB Memory Specifications

Network Specifications

Wireless LAN Specifications (Option)
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General Specifications

MFP Model Model Number

MC853/MC873/ES8453 MFP/ES8473 MFP N35200A, N35200B

Item MC853/MC873/ES8453/ES8473

CPU PPC464FP 800 MHz

Memory Resident DDR2 32 bit 1.28 GB

ROM 64 MB

HDD 2.5"SATA 250 GB

Weight 62 kg (including consumables)

Dimensions 563 (W) x 600 (D) x 700 (H)

Power supply N35200A: 110 - 127 VAC 50/60 Hz ±2%
N35200B: 220 - 240 VAC 50/60 Hz ±2%

Power
 consumption

Typical
 operation

850 W

Idle 120 W

Peak 1400 W

Sleep
 mode

Less than 30 W (w/o option)

Deep
 sleep
 mode

Less than 3 W (w/o option)

Power
 save
 mode

Less than 30 W (w/o option)

Off mode Less than 0.15 W

Operating
 condition

Operating Temperature :10 - 32℃, Humidity : 20 - 80% RH

Idle Temperature : 0 - 43℃, Humidity : 10 - 90% RH

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX/1000BASE-T
IEEE802.11 b/g/n/a Wireless LAN (Option)

Display Graphics
 panel

Color touch panel 7 inches, WVGA (800 x 480)

Supported OS Windows 8.1/ Windows Server 2012 R2/ Windows 8/ Windows Server
 2012/ Windows 7/ Windows Vista/ Windows Server 2008 R2/ Windows
 Server 2008/ Windows Server 2003
Mac OS X 10.6.8 to 10.10
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Copier Specifications

Item MC853/ES8453 MC873/ES8473

Document
 size

ADF A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter ,
 Letter , Legal 13/13.5/14, Executive , Statement , Statement ,
 Folio, 8.5 SQ

Document
 glass

A3, A4 , A4 , A5 , A5 , A6 , B4, B5 , B5 , Tabloid, Letter ,
 Letter , Legal 13/13.5/14, Executive , Statement , Statement ,
 Folio, 8.5 SQ

First copy
 time

Color 12.5 seconds (ADF/Document glass)

Mono 12.5 seconds (ADF), 11.5 seconds (Document glass)

Copies Up to 999

Copy
 speed

Color Up to 23 cpm Up to 35 cpm

Mono Up to 23 cpm Up to 35 cpm
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Fax Specifications

Item MC853/MC873/ES8453/ES8473

Compatibility ITU-T G3/Super G3

Compression method MH, MR, MMR, JBIG

Modem speed Up to 33.6 Kbps

Lines PSTN, PBX

Line interface RJ11 x 2 (Line/TEL)

Document
 size

ADF A3, A4 , A4 , A5 , B4, B5 , Tabloid, Letter , Letter , Legal
 13/13.5/14, Statement , Folio

Document
 glass

A3, A4 , A4 , A5 , B4, B5 , Tabloid, Letter , Letter , Legal
 13/13.5/14, Statement , Folio

Transmission speed Approx. 2 seconds/page (ITU-T, MMR, Normal)

Stored document
 Memory size

8 MB

Storage document
 capacity

Up to 400 pages (ITU-T no.1, MMR, Normal)

Resolution Normal 8 dots x 3.85 line/mm

Fine 8 dots x 7.7 line/mm

Photo 8 dots x 7.7 line/mm

Extra-Fine 8 dots x 15.4 line/mm
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PC Fax Specifications

Item MC853/MC873/ES8453/ES8473

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX/1000BASE-T
IEEE802.11 b/g/n/a Wireless LAN (Option)

Supported
 OS

Windows 8.1, Windows Server 2012 R2, Windows 8, Windows Server 2012,
 Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 2008,
 Windows Server 2003
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Internet Fax Specifications

Item MC853/MC873/ES8453/ES8473

Communication protocol SMTP, POP3, MIME

File format TIFF TIFF
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Scanner Specifications

Item MC853/MC873/ES8453/ES8473

Scanner type Document Glass with ADF function

Image sensor Color CIS

Light source LED

Document
 thickness

ADF 60 - 120 g/m2 (16 - 32 lb)

Document
 glass

20 mm

ADF document capacity 100 sheets (80 g/m2)

Scanning area ADF 105 x 148 - 297 x 431.8 mm (4.13 x 5.8 -
 11.7 x 17 inches)

Document
 glass

297 x 431.8 mm (11.7 x 17 inches) or less

Scanning speed Color Approx. 1.2 seconds/page (A4, 300 x 300 dpi, ADF
 simplex)

Mono Approx. 1.2 seconds/page (A4, 300 x 300 dpi, ADF
 simplex)
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Scan to E-mail Specifications

Item MC853/MC873/ES8453/ES8473

Communication
 protocol

SMTP, POP3, MIME

File format PDF (supported encryption/High compressed), M/S-TIFF (RAW/G3/G4
 compressed), JPEG (JFIF) (color/grayscale only), XPS

Mail server
 authentication

SMTP-AUTH, POP3
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Scan to Shared Folder Specifications

Item MC853/MC873/ES8453/ES8473

Communication
 protocol

FTP, HTTP, CIFS

File format PDF (supported encryption/High compressed), M/S-TIFF (RAW/G3/G4
 compressed), JPEG (JFIF) (color/grayscale only), XPS
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Scan to USB Memory Specifications

Item MC853/MC873/ES8453/ES8473

Connectivity
 interface

USB2.0 Host IF

Storage device USB Memory (Up to 32 GB)
Not all USB Memory products are guaranteed to work.

Supported file
 system

FAT12, FAT (FAT16), FAT32

File format PDF (encryption/High compressed), M-TIFF (RAW/G3/G4 compressed), JPEG
 (JFIF) (color/grayscale only), XPS
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Scan to Computer Specifications

Item MC853/MC873/ES8453/ES8473

Communication
 protocol

Windows TWAIN, WIA, WSD

Mac OS X ICA

File format TWAIN, WIA, ICA: PDF, TIFF, JPEG, BMP, PCX, GIF, TGA, PNG,
 WMF
WSD: JPEG, PNG, TIFF, BMP
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Printing Specifications

Item MC853/ES8453 MC873/ES8473

Printing method Dry electrophotographic recording method with LED (Light-emitting diode)

Emulation T PostScript 3, PCL5C, PCL6 (XL), EPSON FX, IBM ProPrinter, XPS, PDF (v1.7 or
 earlier)

Resident fonts PCL: 87 european fonts
PS: 80 european fonts

Resolution 600 x 600 dpi, 600 x 1200 dpi, 600 x 600 dpi 2 bit

Color Yellow, Magenta, Cyan, Black

Print speed A4

Simplex: Up to 23 ppm

Duplex: Up to 19 ppm

Letter

Simplex: Up to 23 ppm

Duplex: Up to 19 ppm

A4

Simplex: Up to 35 ppm

Duplex: Up to 27 ppm

Letter

Simplex: Up to 35 ppm

Duplex: Up to 27 ppm

First
 print
 out
 time

Standby 9.5 seconds or less

Power
 save

27 seconds

Paper
 size

Tray 1 Legal 13/13.5/14, Letter, Executive, Tabloid, Statement, 8.5 inches SQ, Folio,
 A3, A4, A5, A6, B4, B5, B6, 8K (260 x 368 mm, 270 x 390 mm,
 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm),
 Custom size

Additional
 tray unit
 (Optional)

Legal 13/13.5/14, Letter, Executive, Tabloid, 8.5 inches SQ, Folio, A3, A4, A5,
 B4, B5, 8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K
 (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), Custom size

MP Tray Legal 13/13.5/14, Letter, Executive, Tabloid, Statement, 8.5 inches SQ, Folio,
 A3, A4, A5, A6, B4, B5, B6, Index card (3 x 5 inches), 4 x 6 inches,
 5 x 7 inches, Banner up to 52 inches, 8K (260 x 368 mm, 270 x 390 mm,
 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), C4,
 C5, DL, Com-10, Custom size

Duplex
 Printing

Legal 13/13.5/14, Letter, Executive, Tabloid, A3, A4, A5, B4, B5, B6,
 8.5 inches SQ, Folio, 8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm),
 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), Custom size

Custom
 size

Tray 1

105 - 297 mm (W), 148, 182 - 431.8 mm (L) (4.1 - 11.7 inches (W), 5.8,
 7.2 - 17.0 inches (L))

Additional tray unit (optional)

148 - 297 mm (W), 182 - 431.8 mm (L) (5.8 - 11.7 inches (W), 7.2 -
 17.0 inches (L))

MP tray

64 - 297 mm (W), 90 - 1321 mm (L) (2.5 - 11.7 inches (W), 3.5 - 52 inches
 (L))

Duplex

128 - 297 mm (W), 182 - 431.8 mm (L) (5.0 - 11.7 inches (W), 7.2 -
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 17.0 inches (L))

Media type Plain paper (64 g/m2- 256 g/m2), Envelopes, Label

Feeding method Automatic feeding from Tray 1, MP tray and Additional tray unit (optional),
 Manual feeding from MP tray

Paper loading
 capacity

Tray 1

300 sheets (less than 80 g/m2), total thickness 30 mm or lower.

MP tray

100 sheets (less than 80 g/m2) and total thickness 10 mm or lower, 10
 envelopes (85 g/m2).

Additional tray unit (optional)

535 sheets of Standard paper /80 g/m2 and total thickness 53 mm or lower.

Output method Face up/Face down

Paper output
 capacity

Output Tray

250 sheets (less than 80 g/m2)

Upper Output Tray

100 sheets (less than 80 g/m2)

Rear Output Tray

100 sheets (less than 80 g/m2), 10 sheets (ultra-heavy/envelopes)

Print guaranteed
 area

6.35 mm or more from the paper edge (not applicable to special media such
 as envelopes)

Print precision Print beginning: ± 2 mm, paper skew: ± 1 mm/100 mm
Image expansion: ± 1 mm/100 mm (80 g/m2)

Warm-up time From power on

32 seconds (at room temperature 25℃, rated voltage)

From power save mode

27 seconds (st room temperature 25℃, rated voltage)

Usage
 Environment
 Conditions

When in operation

10 - 32℃/ Relative Humidity of 20 - 80% (maximum wet bulb temperature
 of 25℃, maximum dry bulb temperature of 2℃)

When not in operation

0 - 43℃/ Relative Humidity of 10 - 90% (maximum wet bulb temperature of
 26.8℃, maximum dry bulb temperature of 2℃)

Conditions for
 the guarantee of
 print quality

Operating Range

Temperature 10℃, humidity 20 to 80% RH

Temperature 32℃, humidity 20 to 60% RH

Humidity 20% RH, temperature 10 to 32℃
Humidity 80% RH, temperature 10 to 27℃
Full-color Print Quality Assured Range

Temperature 17 to 27℃, humidity 50 to 70% RH

Consumables,
 Maintenance
 Unit

Toner cartridges, Image drums, Staple, Belt unit, Fuser unit, Feed roller set
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Printing from USB Memory Specifications

Item MC853/MC873/ES8453/ES8473

Interface USB 2.0 (High Speed) Host IF

Storage device USB Memory (Up to 32 GB)
Not all USB Memory products are guaranteed to work.

Supported file
 system

FAT12, FAT (FAT16), FAT32

File format PDF (v1.7, Does not support encrypted PDF), JPEG, TIFF (TIFF 6.0 Baseline),
 XPS, PRN (PS/PCL/XPS)
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Network Specifications

Item MC853/MC873/ES8453/ES8473

Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-T, IEEE802.11 a/b/g/n Wireless LAN

Protocol TCP/IPv4, TCP/IPv6, NetBIOS over TCP, LPR, Port9100, IPP, FTP, HTTP, TELNET, SMTP,
 POP3, SNMPv1/v3, DHCP, DHCPv6, DNS, DDNS, UPnP, WINS, SLP, Bonjour, SNTP,
 LLTD, Web Services Discovery (WSD), SSL/TLS, IPSec, CIFS, SMB (Version 1.0),
 LDAPv3, Kerberos
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Wireless LAN Specifications (Option)

Item

Wireless LAN standard IEEE802.11a/b/g/n conformity (2.4 GHz / 5 GHz)

Transfer rate IEEE802.11n: Max 150 Mbps
IEEE802.11g: Max 54 Mbps
IEEE802.11b: Max 11 Mbps
IEEE802.11a: Max 54 Mbps

Antenna system Built-in Antenna1T1R

Security Disable, WPA2-PSK, WPA2-EAP

Regulatory wireless LAN statements

- FCC Statement

- IC Statement

- Europe-CE Declaration of conformity.

FCC statement

FCC WARNING

Changes or modifications not expressly approved by the party responsible for compliance
 could void the user's authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B
 digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
 reasonable protection against harmful interference in a residential installation. This
 equipment generates, uses and can radiate radio frequency energy and, if not installed and
 used in accordance with the instructions, may cause harmful interference to radio
 communications. However, there is no guarantee that interference will not occur in a
 particular installation. If this equipment does cause harmful interference to radio or
 television reception, which can be determined by turning the equipment off and on, the
 user is encouraged to try to correct the interference by one or more of the following
 measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver
 is connected.

- Consult the dealer or an experienced radio/TV technician for help.

This transmitter must not be co-located or operating in conjunction with any other antenna
 or transmitter.

IC statement

This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS
 standard(s). Operation is subject to the following two conditions: (1) this device may not
 cause interference, and (2) this device must accept any interference, including interference
 that may cause undesired operation of this device.

Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d'Ubdustrie
 Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux
 deux conditions suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2)
 I'utilisateur de I'appareil doit accepter tout brouillage radioélectrique subi, même si le
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 brouillage est susceptible d'en compromettre le fonctionnement.

This Class [B] digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada.

Caution (FCC/IC):

5.15-5.25 GHz band is restricted to indoor operations only.

La bande 5150-5250 MHz est restreints à une utilisation à l'intérieur.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled
 environment and meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of
 the IC radio frequency (RF) Exposure rules. This equipment should be installed and
 operated keeping the radiator at least 20 cm or more away from person's body.

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
 environnement non contrôlé et respecte les règles les radioélectriques (RF) de la FCC lignes
 directrices d'exposition et d'exposition aux fréquences radioélectriques (RF) CNR-102 de
 l'IC. Cet équipement doit être installé et utilisé en gardant une distance de 20 cm ou plus
 entre le dispositif rayonnant et le corps.

Europe - CE Declaration of Conformity

This equipment complies with the essential requirements of the European Union directive
 1999/5/EC.

The telecommunications functionality of this product may be used in the following EU and
 EFTA countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia,
 Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein,
 Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak
 Republic, Slovenia, Spain, Sweden, Switzerland, Turkey and United Kingdom.
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AirPrint

Google Cloud Print

Network-Topics Software

Network Settings

Network Problems
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AirPrint

Using AirPrint (Print/Scan/FaxOut Service) allows you to print, scan, and send a fax from a
 Mac without installing drivers. Also, you can print from an iPhone, iPad and iPod touch with
 using AirPrint (Print). An overview of AirPrint is provided, and the basic settings are
 described here.

About AirPrint (Print/Scan/FaxOut Service)

Setting AirPrint (Print/Scan/FaxOut Service)

Registering the Machine in a Computer (Mac OS X)

Printing with AirPrint (Print)

Scanning with AirPrint (Scan)

Sending a Fax with AirPrint (FaxOut Service)
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About AirPrint (Print/Scan/FaxOut Service)

AirPrint (Print/Scan/FaxOut Service) is a function that enables you to easily print, scan, and
 send a fax from a Mac. Also, you can print from an iPhone, iPad and iPod touch with using
 AirPrint (Print). The mobile device or Mac automatically detects this machine.

With AirPrint (Print), you can easily print a photo, e-mail, Web page or other displays on the
 screen just by tapping the screen a few times.

AirPrint (Scan) is a feature to send scanned image on this machine to a Mac.

AirPrint (FaxOut Service) is a FAX sending function that is provided by Apple Inc. AirPrint
 (FaxOut Service) allows you to send faxes directly from a Mac.

These features require to connect this machine to a Mac via a wired LAN, wireless LAN, or
 USB cable.

For more information about AirPrint, visit the Apple Inc. website.
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Setting AirPrint (Print/Scan/FaxOut Service)

Connect this machine to the same network as a mobile device.

This machine supports infrastructure mode.

Note
This machine does not support ad-hoc mode.

This machine is connected to a mobile device via wireless access points.

This machine is connected to the access points with a wired or wireless LAN.

If you want to connect with a wireless LAN, set the wireless LAN in advance.

Connecting This Machine to a Network

If using a router or hub as an access point on a wired LAN, connect this machine to the
 router or hub with a LAN cable.

Connecting This Machine to a Network

To use AirPrint from a Mac computer, connect this machine to the Mac.

To print by using AirPrint (Print), you must configure settings from the terminal side.
 Proceed to "Printing with AirPrint (Print)".
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Registering the Machine in a Computer (Mac OS X)

If you use AirPrint (Print/Scan/FaxOut Service) for the first time, you must add the machine
 to a computer.

Memo
The screen of Mac OS X 10.10 is used as an example.

1. Turn the machine and computer on to establish a connection.

2. Select [System Preferences] from the Apple menu.

3. Click [Printers & Scanners].

4. Click [+], and then click [Add Printer or Scanner].

5. Select [OKI-MC873-******] and then click [Add].

6. Check that the machine is displayed in [Printers], and [OKI MC873-
AirPrint] is displayed in [Kind].
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7. Close [Printers & Scanners].
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Printing with AirPrint (Print)

Printing from an iOS Device

Printing from a Computer (Mac OS X)

Before using AirPrint with Mac OS X, register this machine on the computer.

Registering the Machine in a Computer (Mac OS X)

Printing from an iOS Device

1. Open a file.

2. Tap  (Action).

3. Tap  (Print).
The name of the printer model that you used most recently and exists on the same
 network is displayed.

Note
If you print for the first time and any model name other than this machine is displayed,
 select this machine in step 4.

4. Tap [Printer] to select your machine.

The functions that this machine supports are displayed.

5. Set options.
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6. Tap [Print].

Printing from a Computer (Mac OS X)

1. Open a file.

2. Select [Print] from the [File] menu.

3. Select [OKI-MC873] from [Printer].

4. Set options.

5. Click [Print].
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Scanning with AirPrint (Scan)

Selecting a Remote Scan Mode

Simple Scan Mode

Manual Scan Mode

Secure Scan Mode

Before using AirPrint with Mac OS X, register this machine on the computer.

Registering the Machine in a Computer (Mac OS X)

Selecting a Remote Scan Mode

There are three Remote Scan modes: Simple Scan, Manual Scan, and Secure Scan.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Scanner Setup].

5. Press [PC Scan Mode].

6. Select a scan mode, and then press [OK].

7. Press [Back] until the home screen is displayed.

Simple Scan Mode

1. Confirm that this machine is in the standby mode (home screen).

2. Set a document in the ADF or on the document glass.
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3. Start a scan program on the computer.

4. Click a scan button in the scan program.

Manual Scan Mode

1. Press the  (SCAN) button.

2. Set a document in the ADF or on the document glass.

3. Press [Remote Scan AirPrint].

4. Start a scan program on the computer.

5. Click a scan button in the scan program.

Secure Scan Mode

1. Press the  (SCAN) button.

2. Set a document in the ADF or on the document glass.
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3. Press [Remote Scan AirPrint].

4. Start a scan program on the computer.

5. Click a scan button in the scan program.
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Sending a Fax with AirPrint (FaxOut Service)

Before using AirPrint with Mac OS X, register this machine on the computer.

Registering the Machine in a Computer (Mac OS X)

Memo
The screen of Mac OS X 10.10 is used as an example.

1. Open a file.

2. Select [Print] from the [File] menu.

3. Select [OKI-MC873-******-Fax] from [Printer].

4. Enter the destination.
Enter [Dialing Prefix], and check [Use cover page] as necessary.

You can specify multiple destinations.

5. Select [Fax].

To display this screen, open [Open Print Queue] of [Printers & Scanners] from [System
 Preferences] before procedures.

To cancel, select [x].
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Google Cloud Print

Google Cloud Print is a print service provided by Google that enables you to print from a
 mobile phone, smartphone, computer, or other network devices. An overview of Google
 Cloud Print is provided, and the basic settings and management are described here.

About Google Cloud Print

Setting Google Cloud Print

Printing with Google Cloud Print

Checking Google Cloud Print Registrations

Checking or Changing the Use of Cloud Service Settings

Deleting the Registered Information

Checking That Deletion is Complete

About Importing the CA Licenses of the Proxy Server
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About Google Cloud Print

The machine supports Google Cloud Print.

Google Cloud Print is a print service that enables you to output data to a printer from a
 mobile phone, smartphone, computer, or other devices via the Internet.

With Google Cloud Print, you can send documents or images to a specified printer from
 anywhere. For example, you can print from your computer at home to a printer in your
 office, or from the application you always use to your printer at home - such printing can be
 easily achieved. There is no need to install drivers or download software.

To use Google Cloud Print, you must prepare the following.

This machine

When setting Google Cloud Print, the machine must be connected to the Internet.

Connecting This Machine to a Network

Memo
Since Google Cloud Print establishes communications via the Internet, it is recommended to
 employ security measures.

Restrict communications from the Internet with a firewall or other security system.

Change the administrator password that is provided by the machine from the default value.

Network devices

The network devices are computers or mobile devices that are connected to the Internet.
 Set up Google Cloud Print or perform print operations from supported applications.

Google account

This account is required for setting up Google Cloud Print or printing from a supported
 application.

Supported application

Applications that run on a network device and allow for Google Cloud Print.

For details on supported OSs and applications, visit the Google Web site. The
 recommended browser is Google Chrome.

Google Web site (http://www.google.com/cloudprint/learn/apps.html)

Network

Used between the network devices and the Cloud, and the Cloud and the machine.

Google Cloud Print does not support IPv6.
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Setting Google Cloud Print

To use Google Cloud Print, a Google account is required. This section describes how to
 register the machine in Google Cloud Print using a Google account.

If you already have an account, there is no need to create a new account. Proceed to step 3.

Memo
To enter the [Google Cloud Print] menu, the administrator name and password are required.
 The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

Although this manual describes the procedure for setting the servers from the operator
 panel, it is recommended to set the servers from the Web page of this machine if you can
 operate from a computer.

To check from the Web page, select [Admin Setup] > [Network] > [TCP/IP] in "About Items
 That Can be Set or Checked".

1. Access the Google Web site from a computer, smartphone, or other
 mobile device.

Google Web site (https://accounts.google.com/signup)

2. Create a Google account by following the on-screen instructions.

3. Check the IP address, subnet mask, and gateway address of the
 machine are set correctly.

4. Press [Device Settings] on the touch panel.

5. Press [Google Cloud Print].

6. Press [Google Cloud Print Settings].
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7. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

8. Check the [DNS Server (Primary)] setting value.
Since [0.0.0.0] indicates that the value is not set correctly, set the IP address that
 suits your environment.

If the secondary DNS server is used, check the [DNS Server (Secondary)] setting
 value.

If the proxy server is used, press [Proxy] to [Enable], and then proceed to step 10.

9. Press [Proxy Server].

10. Enter a server name.
You can enter up to 64 characters.
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11. Press [OK].

12. Press [Proxy Server Port No.].

13. Enter the proxy server port number.

14. Press [OK].

15. Press [Proxy User ID].

16. Enter the proxy user ID.
You can enter up to 64 characters.

17. Press [OK].

18. Press [Proxy Password].

19. Enter the proxy password.
You can enter up to 64 characters.

Memo
For the setting values, contact your network administrator.
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20. Press [OK].

21. Press [Back] to return to the [Google Cloud Print] menu.

22. Press [Register to Google Cloud Print].

23. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

24. When the [Register device to Google Cloud Print? Note: A Google
 account is required for registration.] message is displayed, select
 [Yes].

25. The authentication destination URL is displayed.

Press [Print] and the authentication destination URL is printed.

Note
There is a time restriction for registration (authentication) processing (approximately
 10 minutes).

Proceed to step 32 within the time restriction to complete the registration.

If you cannot complete within the time restriction and an error message is displayed,
 return to step 23, and then register again.
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26. Access the authentication destination URL that you printed in step
 27 from a computer or mobile device.

27. When the Google account login screen is displayed, enter the
 Google account information, and then click [Sign in].

28. When the registration screen is displayed, click [Finish printer
 registration].

29. Wait until the [Thanks, you're ready to go!] message is displayed.

30. When the registration content and completion message is displayed
 on the operator of the machine, check the message by scrolling
 the screen.

Topics
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Printing with Google Cloud Print
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Printing with Google Cloud Print

Printing Automatically

Printing Manually

Changing Printing Settings

Cancelling Printing

Set when to start printing when the machine receives print data from Google Cloud Print.

Note
Set the Google Cloud Print function before using Google Cloud Print.

Google Cloud Print

The print quality may not be the same as when printing with the printer driver or printing
 from the machine.

PDF files with transparency effects applied may not be printed correctly.

Encrypted PDF files may not be printed.

Printing Automatically

When the machine receives the print data, it is automatically printed.

1. Check that the machine is turned on.

2. Start an application that supports Google Cloud Print from a
 computer or mobile device.

Memo
Google Cloud Print supports Google Chrome, Gmail, Google Drive, or other applications.

3. Tap the wrench icon or the drop-down list in the application, and
 then select [Print] from the displayed drop-down list.

4. Select the registered machine on the displayed screen.

5. Set the printing settings, and then print.

Memo
To print, use the Google account that you used to register the machine in Google Cloud
 Print.

To print with a different Google account, you must set the [Share] settings that are
 provided by the Google Cloud Print service.
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Printing Manually

Print manually if you cannot print automatically or you want to print immediately after
 receiving data.

1. Check that the machine is turned on.

2. Press [Print] or the  (PRINT) button.

3. Press [Google Cloud Print].

4. Press [Yes] on the confirmation screen.

5. If the print data exists on the Google Cloud Print service, printing
 starts.

Memo
To print manually, set [Using Cloud Service] to [Enable] or [Pause].

For details on [Using Cloud Service], refer to "Checking or Changing the Use of Cloud
 Service Settings".

Changing Printing Settings

To change printing settings, select [Option] on the printer selection screen that is displayed
 when you print from a supported application.

You cannot change printing settings from the machine.

Cancelling Printing

To cancel during printing, cancel from the machine.

Cancelling a Print Job

To cancel before printing, delete a print job from the management screen of Google Cloud
 Print.

The Google Cloud Print administrator screen (https://www.google.com/cloudprint)
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Checking Google Cloud Print Registrations

Checking from the Management Screen of Google Cloud Print

Checking from the Web Page

Checking from the Operator Panel

You can check whether the machine is registered in Google Cloud Print in one of the
 following three ways.

Checking from the Management Screen of Google Cloud
 Print

1. Access the Google Web site from a computer, smartphone, or other
 mobile device.

Google Web site (https://accounts.google.com)

2. Enter the Google account information, and then click [Sign in].

3. Click [Print].
The registered printers are displayed.

Checking from the Web Page

1. Open a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine" on "Basic Operations".

3. Click [Administrator Login].
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Memo
The factory default user name and password for [Administrator Login] are "admin" and
 "aaaaaa", respectively.

4. Click [SKIP].

5. Click [View Information].

6. Click [Network].

7. Check that [Registered] is displayed for [Google Cloud Print].

Checking from the Operator Panel

1. Press  (SETTING).

2. Press  to select [Google Cloud Print], and then press  (OK).

3. Check that the following three items are displayed.
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Checking or Changing the Use of Cloud Service Settings

Checking the Use of Cloud Service Settings

Changing from the Web page

Changing from the Operator Panel

You can check and edit the Google Cloud Print settings.

Checking the Use of Cloud Service Settings

Check the use status of the Cloud service from the Web page of this machine.

1. Open a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine" on "Basic Operations".

3. Click [Administrator Login] on the top screen.

Memo
The factory default user name and password for [Administrator Login] are "admin" and
 "aaaaaa", respectively.

4. Click [SKIP].
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5. Click [View Information].

6. Click [Network].

7. Click [Google Cloud Print].

8. Click [Using Cloud Service].
The use status is displayed. There are three use statuses:

Enable: You can print automatically or manually.

Pause: You can print manually. Set this status if you do not want to print
 automatically.

Disable: You cannot print. Set this status if you want to suspend the use of Google
 Cloud Print or other cases.

Changing from the Web page

Change the Use of Cloud Service settings from the Web page of this machine.

1. Open a Web browser.

2. Enter "http://(The IP address of this machine)" in the in the
 address bar, and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine" on "Basic Operations".

3. Click [Administrator Login] on the top screen.

Memo
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The factory default user name and password for [Administrator Login] are "admin" and
 "aaaaaa", respectively.

4. Click [SKIP].

5. Click [View Information].

6. Click [Network].

7. Click [Google Cloud Print].

8. Click [Using Cloud Service].

9. Change settings.

Changing from the Operator Panel

1. Press [Device Settings] on the touch panel.

2. Press [Google Cloud Print].

3. Press [Google Cloud Print Settings].

4. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

5. Press [Using Cloud Service].

6. Select the type of settings.
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Deleting the Registered Information

Delete the information about the machine that is registered in Google Cloud Print by
 following the procedure below.

1. Check that the machine is connected to a network.

Memo
If you delete the information with the machine connected to a network, the registration
 information on the Google Cloud Print administrator screen is also deleted at the same
 time.

The Google Cloud Print administrator screen (https://www.google.com/cloudprint)

2. Press [Device Settings] on the touch panel.

3. Press [Google Cloud Print].

4. Press [Delete Registered Information].

5. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

6. Press [Yes] on the confirmation screen.

7. When the deletion is complete, the following screen is displayed.
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Checking That Deletion is Complete

Checking from the Management Screen of Google Cloud Print

Checking from the Web Page

Checking from the Operator Panel

If the Registration Information Remains on the Google Cloud Print Administrator Screen

If You Deleted the Information on the Google Cloud Print Administrator Screen

You can check whether the machine is deleted from Google Cloud Print in one of the
 following three ways.

Checking from the Management Screen of Google Cloud
 Print

1. Access the Google Web site from a computer, smartphone, or other
 mobile device.

Google Web site (https://accounts.google.com)

2. Enter the Google account information, and then click [Sign in].

3. Click [Print].
Check that the machine is not displayed.

Checking from the Web Page

1. Open a Web browser.

2. Enter "http://(The IP address of the machine)" in the in the
 address bar, and then press the <Enter> key.

3. Click [Administrator Login] on the top screen.

Memo
The factory default user name and password for [Administrator Login] are "admin" and
 "aaaaaa", respectively.

4. Click [SKIP].

5. Click [View Information].

6. Click [Network].
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7. Check that [Registered] is displayed for [Google Cloud Print].

Checking from the Operator Panel

1. Press [Device Settings] on the touch panel.

2. Press [Google Cloud Print].

3. Check that the two items, [Register to Google Cloud Print] and
 [Google Cloud Print Settings] are displayed.

If the Registration Information Remains on the Google
 Cloud Print Administrator Screen

If you delete the registration information by following the procedure in "Deleting the
 Registered Information" with the machine not being connected to a network, the registered
 machine may remain on the Google Cloud Print administrator screen
 (https://www.google.com/cloudprint). In such a case, delete the machine on the Google
 Cloud Print administrator screen.

If You Deleted the Information on the Google Cloud Print
 Administrator Screen

If you deleted the registered machine on the Google Cloud Print administrator screen
 (https://www.google.com/cloudprint), the registration information remains in the machine.
 In such a case, delete the registration information from the operator panel of the machine.

1. Press [Device Settings] on the touch panel.

2. Press [Google Cloud Print].

3. Press [Delete Registered Information].

4. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

5. Press [Yes] on the confirmation screen.
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About Importing the CA Licenses of the Proxy Server

You can import the CA licenses from the Web page of this machine (http://(The IP address
 of this machine)).

Specify the certificate that is issued by the certificate authority trusted by the proxy server.
 You can import a PEM, DER, or PKCS#7 file.

Memo
For details on your network, contact your network administrator.
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Network-Topics Software

Web Page of This Machine

Using Configuration Tool

Printing by Using OKI LPR Utility

Network Extension

Using Network Card Setup (Mac OS X)
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Network Settings

Connecting to a Wireless LAN (Only When the Wireless LAN Module is Mounted)

Connecting with a LAN Cable

Initializing the Network Settings

Setting the DHCP Server

1091



Connecting to a Wireless LAN (Only When the Wireless
 LAN Module is Mounted)

Connect this machine to a network with a wireless LAN.

Note
Wireless LAN module (optional) is required.

Read the following cautions carefully before using this machine in a wireless LAN environment.

The machine cannot connect to a wired LAN and wireless LAN at the same time. If using a
 wireless LAN, do not connect a LAN cable to this machine.

If the machine is used in a wireless network environment, the machine does not enter Deep
 Sleep mode but enters Sleep mode.

Do not place any electric products that emit weak radio waves (such as microwaves or digital
 cordless telephones) close to the machine.

If there is metal, aluminum sash, or a reinforced concrete wall between the machine and
 wireless LAN access points, connections may be harder to be established.

The communication speed of a wireless LAN connection may be slower than that of a wired
 LAN or USB connection depending on the environment. If you want to print big data such as
 a photo, it is recommended to print with a wired LAN or USB connection.

Preparations to use a wireless LAN
The machine can connect to a wireless LAN environment via wireless LAN access points
 (WPS supported).

Check whether your wireless LAN access point supports the following environment before
 using.

Item Value

Standard IEEE 802.11 a/b/g/n

Access method Infrastructure mode

Checking the wireless LAN setting method
Check whether your wireless LAN access point supports WPS, and then select a setting
 method.

If your access point supports WPS, refer to "Connecting with WPS", and if you are not
 sure whether your access point supports WPS, refer to "Selecting a Wireless LAN Access
 Point from the Operator Panel to Connect".

Connecting with WPS
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If a wireless LAN access point supports WPS, you can connect to the wireless LAN with the
 WPS button.

Selecting a Wireless LAN Access Point from the Operator Panel to Connect

If a wireless access point does not support WPS, you can specify a wireless LAN access
 point you want to use from the wireless LAN access points that the printer detects to
 establish a connection.

Setting from the Operator Panel Manually to Connect

Set the wireless LAN access point information (the SSID, encryption method, and
 encryption key) manually to connect to the wireless LAN.

Checking That Connection is Established Correctly

This section describes the procedure for checking by using the printer whether a
 connection to a wireless LAN is properly established.
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Connecting with WPS

If a wireless LAN access point supports WPS, you can easily connect to the wireless LAN with
 the easy setup button (WPS button).

Connect by following the procedure below.

1. Check the position of the WPS button by referring to the instruction
 manual that is included in a wireless LAN access point or other
 document.

2. Check that the wireless LAN access point starts and is operating
 properly.

3. Turn the machine on.

Memo
If the following screen is displayed, press [Yes], and then proceed to step 6.

4. Press [Device Settings].

5. Press [Wireless Setting].

6. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

The following message is displayed for approximately 5 seconds.
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7. Press [Automatic Setup (WPS)].

8. Press [WPS-PBC].

9. Press [Yes].

The machine starts searching for wireless LAN access points. The following screen is
 displayed for approximately 2 minutes, during which press and hold the WPS button
 for the wireless LAN access point for a few seconds.
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Note
You cannot operate the panel when WPS is in progress.

When the following screen is displayed, the setting of the wireless LAN is complete.

Memo
If the following screen is displayed, repeat the procedure from step 8.

[Overlap] is displayed when multiple WPS push buttons are pressed almost at the
 same time at two or more wireless LAN access points and connection is not
 established. Wait for a while, and then try again.

Topics

Checking That Connection is Established Correctly
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Selecting a Wireless LAN Access Point from the
 Operator Panel to Connect

If a wireless LAN access point does not support WPS, you can specify a wireless LAN access
 point you want to use from the wireless LAN access points that the machine detects to
 establish a connection. In such a case, you must enter an encryption key.

Set by following the procedure below.

1. Check the SSID and encryption key by referring to the instruction
 manual that is included in a wireless LAN access point or other
 documents, and write the information down.

Memo
An SSID is also called a network name, ESSID or ESS-ID.

An encryption key is also called a network key, security key, password or Pre-shared
 Key.

2. Check that the wireless LAN access point starts and is operating
 properly.

3. Turn the machine on.

Memo
If the following screen is displayed, press [Yes], and then proceed to step 6.

4. Press [Device Settings].

5. Press [Wireless Setting].
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6. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

The following message is displayed for approximately 5 seconds.

7. Press [Wireless Network Selection].

The machine starts searching for wireless LAN access points. Wait for a while.

8. Select a wireless LAN access point to connect, and then press
 [Select].

Note
If only [Manual Setup] is displayed, or the SSID of the wireless LAN access point you want
 to use is not included in the list, set by following the procedure in "Setting from the
 Operator Panel Manually to Connect".

The encryption key entry screen that is suitable for the encryption method of the selected
 wireless LAN access point is displayed.

9. Enter the encryption key, and then press [OK].

Memo
The encryption key varies depending on the wireless LAN access point or security.
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If the [Enter the Pre-shared Key.] message is displayed

Item Description

Security WPA2-PSK

Encryption key Enter the Pre-shared Key.

If the [To make this setting, make the changes from the web page.] message is
 displayed

Item Description

Security WPA2-EAP

Set from the Web page of this machine.

Open the Web Page of This Machine

If neither of the above two cases is applied

Item Description

Security Disable

Encryption key No entry is required.

10. If the displayed SSID is the same as the SSID that you prepared in
 step 1, press [Yes].

When the following screen is displayed, the setting of the wireless LAN is complete.

If the following screen is displayed, repeat the procedure from step 5.
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Topics

Checking That Connection is Established Correctly
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Setting from the Operator Panel Manually to Connect

Set the wireless LAN access point information (the SSID, encryption method and encryption
 key) manually to connect to the wireless LAN.

Set by following the procedure below.

1. Check the SSID and encryption key by referring to the instruction
 manual that is included in a wireless LAN access point or other
 documents, and write the information down.

Note
If the encryption method is WPA2-EAP, set from the Web page of this machine.

For details, open the Web page of this machine and click [Admin Setup] > [Network] >
 [Wireless Setting] > [Manual Setup].

Open the Web Page of This Machine

Memo
An SSID is also called a network name, ESSID, or ESS-ID.

An encryption key is also called a network key, security key, password, or Pre-shared
 Key.

2. Check that the wireless LAN access point starts and is operating
 properly.

3. Turn the machine on.

Memo
If the following screen is displayed, press [Yes], and then proceed to step 6.

4. Press [Device Settings].

5. Press [Wireless Setting].
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6. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

The following message is displayed for approximately 5 seconds.

7. Press [Wireless Network Selection].

The machine starts searching for wireless LAN access points. Wait for a while.

A list of SSIDs of valid wireless LAN access points is displayed.

8. Press [Manual Setup].
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9. Enter the SSID, and then press [Next].

Note
The SSID is case sensitive. Enter the SSID correctly.

10. Select the encryption method that you selected in step 1, and then
 press [Next].

Memo
The encryption key varies depending on the wireless LAN access point or security.

11. Select AES and then press [Next].

12. Enter the Pre-shared Key, and then press [Next].

13. If the displayed content is the same as that you prepared in step 1,
 press [Yes].
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Memo
It takes approximately 30 seconds for the machine to detect the wireless LAN access point.

When the following screen is displayed, the setting of the wireless LAN is complete.

If the machine cannot detect the specified wireless LAN access point, the following
 screen is displayed. In such a case, the specified wireless LAN access point may not
 be operating properly, or the entered information (the SSID, encryption method, and
 encryption key) may be wrong. Check.

Topics

Checking That Connection is Established Correctly
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Checking That Connection is Established Correctly

This section describes the procedure for checking whether a connection is established to a
 wireless LAN correctly with the machine.

Check by following the procedure below.

1. If the antenna mark is displayed at the top right of the touch panel,
 the connection is established correctly.

Memo
The antenna mark may not be displayed on some screens such as the copy top screen.

If the wireless LAN connection is unstable
If the wireless LAN connection is unstable, read the cautions in "Connecting This Machine
 to a Network" in this manual, and then change the positions of the machine and wireless
 LAN access point. If you cannot find a solution even after reading the cautions, bring the
 machine and the wireless LAN access point close to each other.
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Connecting with a LAN Cable

If there is no DHCP server on a network, you must set the IP address on a computer or
 machine manually.

Even if you are instructed to set a unique IP address that is specified by your network
 administrator, Internet service provider, or router manufacturer, you must set the IP
 address to the computer and machine manually.

Note
Complete the network setting of the computer before this procedure.

You must log in as the administrator.

If you set an IP address manually, contact your network administrator or Internet service
 provider for the IP address to use. If the IP address is set incorrectly, the network may go
 down or Internet access may be disabled.

Memo
If you construct a small network that consists of only the machine and a computer, set IP
 addresses as shown below (according to RFC1918).

For the computer

IP address: 192.168.0.1 to 254

Subnet mask: 255.255.255.0

Default gateway: Not used

DNS server: Not used

For the machine

IP address setting: Manual

IP address: 192.168.0.1 to 254 (Select a different value from the computer's IP address.)

Subnet mask: 255.255.255.0

Default gateway: 0.0.0.0

Network scale: Small

To set [Network Scale], select [Device Settings] > [Admin Setup] > [Network Menu] >
 [Network Setup] > [Network Setting] > [Network Scale] > [Small].

1. Prepare a LAN cable and hub.
Prepare a LAN cable (category 5 or higher, twist pair, straight) and hub.

2. Turn the machine and computer off.
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Turning the Machine Off

3. Attach the core to the LAN cable.
Wind the LAN cable in a single loop at 2 to 3 cm from the end of the cable, and then
 attach the core to the looped cable.

4. Insert one end of the LAN cable into the network interface
 connector.

5. Insert the other end of the LAN cable into the hub.

6. Turn the machine on.
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Initializing the Network Settings

Initializing from Setting Menus of this Machine

Initializing from the Operator Panel of this Machine (Boot Menu)

Note
This procedure initializes all the network settings.

Initializing from Setting Menus of this Machine

You can restore the network settings to the factory default settings.

1. Press [Device Settings] on the touch panel.

2. Press  or  several times and press [Admin Setup].

3. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

4. Press [Network Menu].

5. Press [Network Setup].

6. Press [Factory Defaults].

7. Press [Yes].

Initializing from the Operator Panel of this Machine (Boot
 Menu)

If you cannot initialize from the configuration menu of this machine, you can initialize from
 the operator panel.

1. Turn the machine on while pressing and holding "6" on the 10-key
 pad.

2. Enter the administrator name and password and press [OK].
The factory default administrator name and password are "admin" and "aaaaaa"
 respectively.

3. Press "#" on the 10-key pad.
The [Boot Menu] screen is displayed.
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4. Press "1" on the 10-key pad.

5. Press "1" on the 10-key pad.
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Setting the DHCP Server

DHCP assigns an IP address to each host on a TCP/IP network.

Note
To print via a network, this machine must have an IP address. For details on how to assign a
 static IP address, refer to the manual of your DHCP server.

Memo
The following procedure is explained using Windows Server 2008 R2 as an example. The steps
 and menus may vary depending on your operation system.

1. Click [Start], and then select [Administrative Tools] > [Server
 Manager].
If [DHCP] is already displayed in [Administrative Tools], proceed to step 8.

2. Select [Add Roles] from [Roles Summary].

3. Click [Next] in [Add Roles Wizard].

4. Select the [DHCP Server] check box, and then click [Next].

5. Set the settings by following the on-screen instructions, if
 necessary.

6. Check the setting on the [Confirm Installation Selection] screen,
 and then click [Install].

7. When the installation is complete, click [Close].

8. Click [Start], and then select [Administrative Tools] > [DHCP] to
 start the [DHCP] wizard.

9. Select a server to use from the DHCP list.

10. Select [New Scope] from the [Action] menu.

11. Set the settings by following the on-screen instructions in [New
 Scope Wizard] if necessary.

Memo
Be sure to set the default gateway.

Select [Yes, I want to activate the scope now] on the [Active Scope] screen.
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12. Click [Finish].

13. Select the new scope from the DHCP list, and then select
 [Reservations].

14. Select [New Reservation] from the [Action] menu.

15. Set the settings.

16. Click [Add].

17. Click [Close].

18. Select [Exit] from the [File] menu.
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Network Problems

Unable to print from network

Unable to Print

Unable to save scanned images in a network folder

Unable to Save Files in a Network Folder
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Utility Software

List of Utility Software

Installing Software

Web Page of This Machine

Adjusting Color with PS Gamma Adjuster Utility

Using Configuration Tool

About ActKey

Printing by Using OKI LPR Utility

Network Extension

Using the Network Scanner Setup Tool (Mac OS X Only)

Using Network Card Setup (Mac OS X)

Print Job Accounting Client
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List of Utility Software

Windows Utilities

Mac OS X Utilities

This section describes utilities you can use on this machine. For how to use each utility, refer
 to its topic.

Windows Utilities

Item Relevant
 function

Description System requirements References

PS Gamma
 Adjuster

Print You can adjust the color
 density used for
 photographs.

Windows 8.1/ Windows
 Server 2012 R2/
 Windows 8/ Windows
 Server 2012/
 Windows 7/
 Windows Vista/
 Windows Server 2008
 R2/ Windows Server
 2008/ Windows Server
 2003

Adjusting
 Color with
 PS Gamma
 Adjuster
 Utility

Configuration
 Tool

Settings You cans set the access
 control settings of this
 machine, change the
 menu, and register the
 e-mail address, speed
 dials, profiles, PIN
 number, auto delivery
 settings, and network
 scan settings.

Windows 8.1/ Windows
 Server 2012 R2/
 Windows 8/ Windows
 Server 2012/
 Windows 7/
 Windows Vista/
 Windows Server 2008
 R2/ Windows Server
 2008/ Windows Server
 2003

Using
 Configuration
 Tool

PDF Print
 Direct

Printing Prints out PDF files
 without launching any
 applications.

Windows 8.1/ Windows
 Server 2012 R2/
 Windows 8/ Windows
 Server 2012/
 Windows 7/
 Windows Vista/
 Windows Server 2008
 R2/ Windows Server
 2008/ Windows Server
 2003

Printing without
 Opening a PDF
 File (PDF Print
 Direct)

ActKey Scan Use when forwarding a
 scanned image to the
 specified application or
 saving in the specified
 folder in the computer,
 sending a fax with the
 PCFax Software.

Windows 8.1/ Windows
 Server 2012 R2/
 Windows 8/ Windows
 Server 2012/
 Windows 7/
 Windows Vista/
 Windows Server 2008
 R2/ Windows Server
 2008/ Windows Server
 2003

About
 ActKey

OKI LPR
 Utility

Print You can check printing
 via the network
 connection, the print

Windows 8.1/ Windows
 Server 2012 R2/
 Windows 8/ Windows

Printing by
 Using OKI
 LPR Utility

1115



 management, and the
 status of this machine.

 Server 2012/
 Windows 7/
 Windows Vista/
 Windows Server 2008
 R2/ Windows Server
 2008/ Windows Server
 2003

Network
 Extension

Management You can check the
 settings of this machine
 and option settings from
 the printer driver. This
 utility is automatically
 installed when installing
 a printer driver via a
 network connection.

Windows 8.1/ Windows
 Server 2012 R2/
 Windows 8/ Windows
 Server 2012/
 Windows 7/
 Windows Vista/
 Windows Server 2008
 R2/ Windows Server
 2008/ Windows Server
 2003
The computer running
 on TCP/IP

Network
 Extension

Mac OS X Utilities

Item Relevant
 function

Description System
 Requirements

References

PS
 Gamma
 Adjuster

Print You can adjust the color density used for
 photographs.

Mac OS X 10.6.8
 to 10.10

Adjusting
 Color with
 PS
 Gamma
 Adjuster
 Utility

Color
 Correct
 Utility

Print Adjust the Color Matching.
You can change the overall trend of
 output colors by adjusting the palette
 color output, gamma value, hue or
 saturation of the primary colors.

Using the
 Network
 Scanner
 Setup Tool
 (Mac OS X
 Only)

Network
 Scanner
 Setup
 Tool

Scan This utility is activated when you select
 the scanner driver from the application
 and select a connected device.
You do not need to set the connection
 destination once it is set.

Using the
 Network
 Scanner
 Setup Tool
 (Mac OS X
 Only)

Network
 Card
 Setup

Settings You can set a network. Using
 Network
 Card
 Setup
 (Mac OS X)
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Installing Software

For Windows

For Mac OS X

Install the utility you want to use by following the procedure below.

For Windows

Install utility software by using the Software DVD-ROM.

PCL6 Printer Driver

PS Printer Driver

XPS Printer Driver

Fax Driver

Scanner Driver

ActKey

OKI LPR Utility

Configuration Tool

PDF Print Direct

Print Job Accounting Client

Connect the machine to a computer via a network or USB interface.

Note
Check the status of this machine before installing.

This machine is turned on.

This machine is connected to a network with a network cable and the IP address or other
 settings are set.

USB connection is disabled by factory default. You need to change the USB mode setting
 before connecting this machine to a computer with a USB cable.

Select [Admin Setup] - [Management] - [Local Interface] - [USB Menu], and then change
 [USB Assignment] from [IPP] to [Legacy].

1. Insert the "Software DVD-ROM" into a computer.

2. When [AutoPlay] is displayed, click [Run Setup.exe].
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Memo
If the [User Account Control] dialog box is displayed, click [Yes].

3. Select a language from the drop-down list.

4. Read the license agreement, and then click [Accept].

5. Read Environmental advice for Users and click [Next].

6. Select [Network (Wired/Wireless)] or [USB] corresponding to your
 connection environment, and then click [Next].

7. Select the model name of this machine, and then click [Next].

8. Click [Custom Install].
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9. Click [Separate Install].

10. Click a driver or software to install.
Installation starts.

Memo
The procedure below varies depending on the selected software.

The procedure below uses the installation of the Configuration Tool as an example.

11. Select plug-ins you want to install and click [Install].

Install starts.

12. When installation is complete, click [Close].

For Mac OS X

You can copy a utility by dragging to any location. You can also run a utility directly from the
 "Software DVD-ROM".

1. Insert the included "Software DVD-ROM" into a computer.

2. From [OKI] > double-click the [Utilities] folder.

3. Copy the folder of a utility to install by dragging to any location.

Memo
To start utility software, double-click the software icon in the folder.
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Web Page of This Machine

You can make network settings or menu settings from the Web page of this machine.

Open the Web Page of This Machine

Log In as the Administrator

Changing the Administrator Password

Checking or Changing the Settings of This Machine from a Computer

Encrypting Communication with SSL/TLS

Encrypting Communication with IPSec

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)

Limiting by Using an IP Address (IP Filtering)

Limiting by Using a MAC Address (MAC Address Filtering)

E-mail Alert

Checking the Status of This Machine by Using SNMPv3

Connecting This Machine to the Authentication Network by Using IEEE802.1X

Setting the LDAP Server

Setting the Reception Protocol

Access Control

About Items That Can be Set or Checked
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Open the Web Page of This Machine

About the Operating Environment

Memo
Set the security setting for the Web page to the middle level, or enable Cookie.

To enter the [Admin Setup] menu, the administrator password is required.

To change settings of the machine on the Web page, you must log in as the administrator
 of the machine.

The description uses the following environment as an example.

Device name: MC873

IP address of the machine: 192.168.0.2

1. Start a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".

Note
If the IP address includes a value in one or two digits, do not enter "0" before the value.
 Communications may not be performed correctly.

An example of a correct entry: http://192.168.0.2/

An example of an incorrect entry: http://192.168.000.002/
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Log In as the Administrator

To change settings of the machine on the Web browser, you must log in as the administrator
 of the machine.

1. Click [Administrator Login].

2. Enter "admin" in [User Name] and the current password in
 [Password], and then click [OK].

Memo
The password is the same as the "administrator password" on the operator panel.

3. Set the machine information that can be checked on a network,
 click [OK] or [SKIP].

Note
To omit the setting, click [SKIP].

To not display from the next login, select the [Do not show this page again.] check
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 box, and then click [OK] or [SKIP].

4. The following screen is displayed.

Note
The following items are for developers and not available for general users.

Indexed Scanning

sXP Application

OutputManagement
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Changing the Administrator Password

You can change the administrator password of this machine from the Web page. The
 administrator password specified on the Web page is used when logging from the Web page
 or operator panel.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Management] > [New Admin Password].

5. Enter a new password in [New Password].

Memo
You can enter 6 to 12 alphanumeric characters for the password.

The password is case sensitive.

6. Re-enter the new password in [New Admin Password (Verify)].
The password is not be displayed. Write down the password and keep it in a safe
 place.

7. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Memo
You do not need to restart the machine. The next time you log in as the administrator, you can
 use the new password.
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Checking or Changing the Settings of This Machine from
 a Computer

About the Operating Environment

Open the Web Page of This Machine from a Computer

Log In as the Administrator

You can operate the following from the Web page of this machine.

The Web page can be used for Windows and Mac OS X.

Displaying the status of the machine

Creating a profile

Setting a tray, network, default setting of a function, and the machine

Displaying a list of jobs

Printing a PDF file without using the printer driver

Setting auto delivery and transmission data save

Linking to frequently-used Web pages

About the Operating Environment

Memo
Check whether your browser is set as follows.

Set the security setting for the Web page to the middle level, or enable Cookie.

To enter the [Admin Setup] menu, the administrator password is required. The factory
 default password is "aaaaaa".

To change settings of the machine on the Web page, you must log in as the administrator of
 the machine.

About how to set a network

Connecting This Machine to a Network

The description uses the following environment as an example.

Device name: MC873

IP address of the machine: 192.168.0.2

Open the Web Page of This Machine from a Computer

1. Start a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".
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Note
If the IP address includes a value in one or two digits, do not enter "0" before the value.
 Communications may not be performed correctly.

An example of a correct entry: http://192.168.0.2/

An example of an incorrect entry: http://192.168.000.002/

Log In as the Administrator

Note
To change settings of this machine on the Web browser, you must log in as this administrator of
 this machine.

1. Start a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".

3. Click [Administrator Login].

4. Enter "admin" in [User Name] and the current password in
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 [Password], and then click [OK].

Memo
The password is the same as the "administrator password" on the operator panel.

5. Set the machine information that can be checked on a network,
 click [OK] or [SKIP].

Note
To omit the setting, click [SKIP].

To not display from the next login, select the [Do not show this page again.] check
 box, and then click [OK] or [SKIP].

6. The following screen is displayed.

Topics

Change the administrator password in the following way.

Changing the Administrator Password
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Encrypting Communication with SSL/TLS

You can encrypt communication between your computer and this machine. Communication
 is encrypted with SSL/TLS in the following cases. When you set HTTPS communication, you
 can use a certificate that is pre-installed in this machine.

Creating a Certificate

You can use a certificate when sending data to this machine that is connected to a
 network. This section describes how to create a certificate by using the Web page.

Importing a Certificate

This section describes how to import a certificate and a private key from the Web page.

Exporting a Certificate

This section describes how to export a certificate.

Enabling Encryption Settings

You must enable encryption after creating a certificate. This section describes how to
 enable encryption by using the Web page.

Setting This Machine as the IPP Printer in a Windows Environment

If you enable IPP print, you can send print data to this machine via the Internet. This
 section describes how to enable IPP print in a Windows environment.

Setting This Machine as the IPP Printer in a Mac OS X Environment

If you enable IPP print, you can send print data to this machine via the Internet. This
 section describes how to enable IPP print in a Mac OS X environment.
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Creating a Certificate

You can create a certificate on the Web page. You can use the following three certificates.

Pre-installed certificate

Self-signed certificate

Authority-issued certificate

Note
Before you create a certificate, be sure to delete the pre-installed certificate.

If you change the IP address of this machine after creating the certificate, the certificate
 becomes invalid. Be sure not to change the IP address of this machine after creating the
 certificate.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [Security] > [SSL/TLS].

5. Specify detailed settings by following the on-screen instructions.

Memo
The IP address of this machine is set to [Common Name].

6. Check the settings, and then click [OK].
In the case of a self-signed certificate, close the Web page by following the on-
screen instructions, proceed to "Enabling Encryption Settings".

If you want to obtain a certificate issued by the certificate authority, proceed to step
 7.

7. Send the CSR to a certificate authority by following the on-screen
 instructions.

8. Click [OK].

9. Install a certificate from a certificate authority by following the on-
screen instructions.

10. Click [Submit].
Proceed to "Enabling Encryption Settings".
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Importing a Certificate

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Click [Admin Setup].

4. Select [Network] > [Security] > [SSL/TLS].

5. Select [Using Certificate and Private Key after imported] to import
 a certificate.

Memo
You can import a certificate in PKCS#12 format.

1134



Exporting a Certificate

You can export a certificate on the Web page.

For functions that communicate with SSL/TLS, a procedure to trust the exported certificate
 is required on the computer.

Import the exported certificate of this machine into the trusted certificate store of the
 computer to trust the certificate.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Click [Admin Setup].

4. Select [Network] > [Security] > [SSL/TLS].

5. Select [Export Certificate] to export a certificate.

Memo
You can export a certificate in PEM format.
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Enabling Encryption Settings

After creating a certificate, perform the following procedure to enable encryption.

If you enable encryption, communication is encrypted immediately after the settings is
 changed from the Web page.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [Security] > [SSL/TLS].

5. Select [Enable] for the protocol to which apply the encryption.

6. Click [Submit].
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Setting This Machine as the IPP Printer in a Windows
 Environment

Add this machine to your computer as an IPP printer.

1. Click [Start], and then select [Devices and Printers] > [Add a
 Printer].

2. Select [Add a network, wireless or Bluetooth printer] in the [Add
 Printer] wizard.

3. Select [The printer that I want isn't] from the list of available
 printers.

4. Select [Select a shared printer by name].

5. Enter "http://(The IP address of this machine)/ipp" or "http://IP
 address of this machine)/ipp/lp", and then click [Next].

6. Click [Have Disk].

7. Insert the "Software DVD-ROM" into the computer.

8. Enter the following value in [Copy manufacturer's files from], and
 then click [Use].

For PCL driver: "D: Drivers _PCL"

For XPS driver: "D: Drivers XPS"

For PS driver: "D: Drivers PS"

Memo
The above value is an example of the DVD-ROM drive is set to the D drive.

9. Select the INF file, and then click [Open].

10. Click [OK].

11. Select a model, and then click [OK].

12. Click [Next].

13. Select [Finish].

14. Print the test page after installation is complete.
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Setting This Machine as the IPP Printer in a Mac OS X
 Environment

Add this machine to a computer as an IPP printer.

1. Insert the "Software DVD-ROM" into the computer, and then install
 the driver.

Installing Software

2. Select [System Preferences] from the Apple menu.

3. Click [Print & Scan].

4. Click [+].

5. Click the [IP] tab.

6. Select [IPP (Internet Printing Protocol)] from [Protocol].

7. Enter the IP address of this machine in [Address].

8. Enter "ipp/lp" in [Queue].

9. Click [Add].

10. Click [Continue].

11. Check that the machine is registered in [Print & Scan].
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Encrypting Communication with IPSec

You can encrypt communication between your computer and the machine.

The communication is encrypted by IPSec. When IPSec is enabled, encryption is applied for
 all the applications by using IP protocols.

You can specify up to 50 hosts by their IP addresses. When a host that is not registered tries
 to access the machine, it is rejected. When you try to access a host that is not registered,
 the attempt is invalid.

Be sure to configure the machine in advance, before configuring your computer.

Memo
You must have a pre-shared key readied in advance.

Setting This Machine

This section describes the settings you need to set on the printer to enable IPSec. You
 must log in to the Web page as the administrator to complete this setting.

Setting a Computer

This section describes the settings you need to set on a computer to enable IPSec. You
 must set the printer before this setting.
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Setting This Machine

To enable IPSec, you must set this machine by using the Web page in advance.

Note
If IPsec is set to this machine and the host, IPSec communication is established. If IPSec is
 not set to the host, IPSec communication is not established.

Do not forget to take notes of the values specified in this procedure. These values are
 necessary when setting IPSec on a computer.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [Security] > [IPSec].

5. Specify detailed settings by following the on-screen instructions.

Memo
You must enable either [AH] or [ESP] in the [Phase2 Proposal] setting.

6. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Note
If you were unable to set up IPSec due to the inconsistency of the parameters that were
 specified, you cannot access the Web page. In such a case, disable the IPSec from the operator
 panel of this machine or initialize the network settings.

Topics

Proceed to setting a computer.

Setting a Computer
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Setting a Computer

Creating an IP Security Policy

Setting Key Exchange

Setting an IP Filter

Setting Filter Actions

Assigning an IP Security Policy

Set IPSec to a computer.

Follow the procedure below, and be sure to perform all the steps in order.

Memo
Set this machine before setting the computer.

Setting This Machine

Creating an IP Security Policy

1. Click [Start], and then select [Control Panel] > [System and
 Security] > [Administrative Tools].

2. Double-click [Local Security Policy].

3. Click [IP Security Policies on Local Computer] in the [Local Security
 Policy] window.

4. Select [Create IP Security Policy] from the [Action] menu.

5. Click [Next] in [IP Security Policy Wizard].

6. Enter [Name] and [Description], and then click [Next].

7. Clear the [Activate the default response rule (earlier versions of
 Windows only)] check box, and then click [Next].

8. Select the [Edit Properties] check box, and then click [Finish].

Setting Key Exchange

1. Select the [General] tab in the New IP Security Policy Properties
 window.
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2. Click [Settings].

3. Enter a value (minutes) in [Authenticate and generate a new key
 after every] in the [Key Exchange Settings] window.

Note
Specify the same value as [Lifetime] in the "Phase1 Proposal" setting in "Setting This
 Machine". Enter a value in minutes in this step even if [Lifetime] is specified in seconds.

4. Click [Methods].

5. Click [Add] in the [Key Exchange Security Methods] window.

6. Specify [Integrity algorithm], [Encryption algorithm], and [Diffie-
Hellman group].

Note
Select the same value specified in [IKE Encryption Algorithm], [IKE Hush Algorithm], and
 [Diffie-Hellman group] in the "Phase1 Proposal" setting in "Setting This Machine".

7. Click [OK].

8. Select [OK] in the [Key Exchange Security Methods] window.

9. Click [OK] in the [Key Exchange Settings] window.

Setting an IP Filter

1. Select the [Rules] tab in the IP security policy properties window.

2. Click [Add].

3. Click [Next] in [Security Rule Wizard].

4. Select [This rule does not specify a tunnel] on the [Tunnel
 Endpoint] screen, and then click [Next].

5. Select [All Network Connections] on the [Network Type] screen,
 and then click [Next].

6. Click [Add] on the [IP Filter List] screen.

7. Click [Add] in the [IP Filter List] window.

8. Click [Next] on [IP Filter Wizard].
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9. Click [Next] on the [IP Filter Description and Mirrored property]
 screen.

10. Click [Next] on the [IP Traffic Source] screen.

11. Click [Next] on the [IP Traffic Destination] screen.

12. Click [Next] on the [IP Protocol Type] screen.

13. Click [Finish].

Setting Filter Actions

1. Click [OK] in the [IP Filter List] window.

2. Select a new IP filter from the list on the [Security Rule Wizard],
 and then click [Next].

3. Click [Add] on the [Filter Action] screen.

4. Click [Next] in the [Filter Action Wizard].

5. Enter [Name] and [Description] on the [Filter Action Name] screen.

6. Select [Negotiate security] on the [Filter Action General Options]
 screen, and then click [Next].

7. Select [Do not allow unsecured communication] on the
 [Communicating with computers that do not support IPsec]
 screen, and then click [Next].

8. Select [Custom] on the [IP Traffic Security] screen, and then click
 [Settings].

9. Set in the [Custom Security Method Settings] window, and then
 click [OK].

Note
Select the same value specified in [IKE Encryption Algorithm], [IKE Hush Algorithm], and
 [Diffie-Hellman group] in the "Phase1 Proposal" setting in "Setting This Machine".

10. Click [Next] on the [IP Traffic Security] screen.

11. Select the [Edit Properties] check box, and then click [Finish].
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Assigning an IP Security Policy

1. If you want to enable Key PFS, select the [Use session key perfect
 forward secrecy (PFS)] check box in the [Filter Action Properties]
 window.

2. If you perform IPSec communication with the IPv6 global address,
 select the [Accept unsecured communication, but always respond
 using IPsec] check box.

3. Click [OK].

4. Select the new filter action, and then click [Next].

5. Select the authentication method on the [Authentication Method]
 screen, and then click [Next].

6. Click [Finish].

7. Click [OK] in the New IP Security Policy Properties window.

8. Select the new IP security policy in the [Local Security Policy]
 window.

9. Select [Assign] from the [Action] menu.

10. Check that [Yes] is displayed for [Policy Assigned] for the new IP
 security policy.

11. Click [x] in the [Local Security Policy] window.
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Forwarding Received Document Data to an E-mail
 Destination or Shared Folder (Auto Delivery)

This section describes the auto delivery function and how to set it.

The auto delivery function automatically forwards received data to specified destinations.
 You can specify up to five e-mail addresses and one network folder as destinations.

You can use this function for received faxes, Internet Faxes, and e-mail attachment files.
 The data is forwarded as a PDF or TIFF file depending on the file format of the received
 data.

You can register up to 100 sets of forwarding destinations for the auto delivery function.

1. Open the Web page of this machine.
About the IP Address of this machine, refer to "Checking the Information of the
 Machine".

2. Log in as the administrator.

3. Select [Transmission Settings].

You must set a server in advance.

Before Using Scan To E-mail

4. Click [New] on the [Automated Delivery Setup] page.

5. Enter a name in [Automated Delivery].
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6. Select [ON] for [Automated Delivery].

7. Select the check box of a required item for [Search field].

8. Select [OFF] for [Print].
To print the received data, select [ON].
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9. Click [Edit] in [Deliver To].

10. Enter a destination e-mail address, and then click [Add].

11. Check that the entered address is displayed in [Address List], and
 then click [OK].

12. Click [Edit] in [Deliver to].
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To specify a network folder, register a destination (profile) in advance.

Before Using Scan To Shared Folder

13. Select a destination from [Profile List], and then click [OK].

14. Click [Submit].

Memo
If [Forwarding Setting] is enabled, received faxes are not automatically delivered with this
 function.

A received fax is delivered as a PDF file.

If a received e-mail attachment file is not a PDF, JPEG, or TIFF file, the file is not forwarded.

The body text of received e-mails cannot be forwarded.
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The size of data that this function can handle is limited.

If the Memory card space of the machine is insufficient to save received faxes, Internet
 Faxes or e-mail attachment files, the transmission data is not automatically delivered.
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Limiting by Using an IP Address (IP Filtering)

You can control access to the machine by using an IP address. You can set whether to allow
 for setting or printing from a specified IP address. IP filtering is disabled by factory default.

Note
Be sure to specify the correct IP address. An incorrect entry of an IP address does not allow
 for access to the printer by using the IP protocol.

If you enable IP filtering, access to hosts that are not specified in this setting is rejected.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [Security] > [IP Filtering].

5. Specify detailed settings by following the on-screen instructions.

Note
If nothing is registered in [Administrator's IP Address to Register], any access to the
 machine may not be allowed depending on the specified IP address range.

If you use a proxy server, [Your Current Local Host/Proxy IP Address] and the IP
 address of your host may not match.

6. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Memo
You can use only IPv4 for IP filtering.
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Limiting by Using a MAC Address (MAC Address
 Filtering)

You can control access to the machine by using a MAC address. You can allow for or reject
 access from a specified MAC address.

Note
Be sure to specify the correct MAC address. An incorrect entry of a MAC address does not allow
 for access to the machine from a network.

1. Open the Web page of this machine.
How to login to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [Security] > [MAC Address Filtering].

5. Specify detailed settings by following the on-screen instructions.

Note
If nothing is registered in [Administrator's MAC Address to Register], access to the
 machine may not be allowed depending on the specified MAC address.

If you use a proxy server, [Your Current Local Host/Proxy MAC Address] and the MAC
 address of your host may not match.

6. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Memo
You cannot specify to accept or to reject for each address.
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E-mail Alert

Setting to Send an E-mail from This Machine Only if an
 Error Occurs

To use this function, you need to set up your mail server in advance.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [E-mail] > [Alert Settings].

5. Enter an e-mail address to receive a notification in [Failure
 Notification Settings].

6. Click [Setting] of the entered e-mail address.
If you want to apply the notification conditions to another address, click [Copy].

7. Select [Upon occurrence of an event] in [Way of E-mail Alerting],
 and then click [To Step 2].

8. Specify detailed settings by following the on-screen instructions.
If you insert a check in any errors or warnings that require notification, a window to
 specify the time difference between the sending of the notification and the occurrence
 of the error is displayed.

9. Click [OK].

10. Click [View a summary of current configuration] to check the
 current settings, and then click [x] to close the window.
You can check the current settings of up to two addresses in the main window. Select
 the address you want to check from the list box.

11. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Setting to Send an E-mail from This Machine Regularly

1. Open the Web page of this machine.
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How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [E-mail] > [Alert Settings].

5. Enter an e-mail address to receive a notification in [Failure
 Notification Settings].

6. Click [Setting] of the entered e-mail address.
If you want to apply the notification conditions to another address, click [Copy].

7. Select [Periodically] in [Way of E-mail Alerting], and then click [To
 Step 2].

8. Specify detailed settings by following the on-screen instructions.

9. Click [OK].

10. Click [View a summary of current configuration] to check the
 current settings, and then click [x] to close the window.
You can check the current settings of up to two addresses in the main window. Select
 the address you want to check from the list box.

11. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Memo
If any failure that is not eligible for notification, an e-mail is not sent.
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Checking the Status of This Machine by Using SNMPv3

If you use an SNMP manager that supports SNMPv3, you can encrypt the machine
 management with SNMP.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [SNMP] > [Settings].

5. Specify detailed settings by following the on-screen instructions.

6. Click [Submit].
The new settings take effect when the network function of this machine restarts.

Memo
An SNMP agent is implemented. You can confirm and change the machine settings with a
 commercially available SNMP agent. For the MIB in the machine, refer to the "Software DVD-
ROM", and check the "README" file in the [Misc] > [MIB Files] folder.

1157



Connecting This Machine to the Authentication Network
 by Using IEEE802.1X

This machine supports IEEE802.1X authentication. With this authentication function, you can
 set the machine, that is connected to a network, deny connection except for specific
 computers.

Setting by Using PEAP

EAP authentication must be performed after computer connection is authenticated by
 enabling IEEE802.1X. This section describes how to set PEAP, which is an EAP
 authentication type. You must log in as the administrator to complete this setting.

Setting by Using EAP-TLS

EAP authentication must be performed after computer connection is authenticated by
 enabling IEEE802.1X. This section describes how to set EAP-TLS, which is an EAP
 authentication type. You must log in as the administrator to complete this setting.
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Setting by Using PEAP

This machine supports the IEEE802.1 authentication.

Set up this machine and the computer before following the procedure below.

About initial setup and IP address

Easy Setup

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [IEEE802.1X].

5. Select [Enable] from [IEEE802.1X].

6. Select [PEAP] from [EAP Type].

7. Enter a user name in [EAP User].

8. Enter a password in [EAP Password].

9. Select [Authenticate Server], and then click [Import].

10. Enter the file name of the CA certificate, and then click [OK].
Specify the certificate issued by the certificate authority that the RADIUS server
 obtained. You can import a PEM, DER, and PKCS#7 file.

11. Click [Submit].
The new settings take effect when the network function of this machine restarts.

12. Turn the machine off after this machine becomes online.

13. Connect the LAN cable to the network interface connector.

14. Connect the LAN cable to the authentication port of an
 authentication switch.

15. Turn the machine on.

16. Set up this machine.
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Setting by Using EAP-TLS

This machine supports the IEEE802.1X authentication.

Set up this machine and the computer before following the procedure below.

About initial setup and IP address

Easy Setup

1. Open the Web page of this machine.
How to log in to the Web page

Open the Web Page of This Machine

2. Log in as the administrator.

3. Select [Admin Setup].

4. Select [Network] > [IEEE802.1X].

5. Select [Enable] for [IEEE802.1X].

6. Select [EAP-TLS] for [EAP Type].

7. Enter a user name in [EAP User].

8. Select [Do not use SSL/TLS Certificate for EAP authentication], and
 then click [Import].

9. Enter the file name of the certificate.
You can only import a PKCS#12 file.

10. Enter the password of the certificate, and then click [OK].

11. Select [Authenticate Server], and then click [Import].

12. Enter the file name of the CA certificate, and then click [OK].
Specify the certificate issued by the certificate authority that the RADIUS server
 obtained. You can import a PEM, DER, and PKCS#7 file.

13. Click [Submit].
The new settings take effect when the network function of this machine restarts.

14. Turn the machine off after this machine becomes online.

15. Connect the LAN cable to the network interface connector.

16. Connect the LAN cable to the authentication port of an
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 authentication switch.

17. Turn the machine on.

18. Set up this machine.
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Setting the LDAP Server

Memo
For details on the LDAP server and encryption setting, contact your network administrator.

1. Open the Web page of this machine.
How to log in to the Web page

Checking or Changing the Settings of This Machine from a Computer

2. Log in as the administrator.
How to log in as the administrator

Checking or Changing the Settings of This Machine from a Computer

3. Select [Admin Setup].

4. Select [Network] > [LDAP].

5. Enter the domain name or IP address of the LDAP server in [LDAP
 Server].

6. Enter the port number of the LDAP server in [Port Number].

7. Specify a value of time-out to wait for the search results in
 [Timeout].

8. Specify the maximum number of the search result entries in [Max.
 Entries].

9. Specify a BaseDN to access the LDAP server in [Search Root].

10. Enter attribute names to search as the user name in [User Name].
Be sure to enter a value in [Name 1].

11. Enter an e-mail address to search for in [Mail Address].

12. Specify a search condition in [Additional Filter] if necessary.

13. Select a necessary authentication method in [Method].

Note
If you select [Anonymous] or [Simple], user authentication using LDAP fails. You must
 select [Digest-MD5] or [Secure Protocol] if you want to set the LDAP server for the user
 authentication.
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Memo
If you select [Digest-MD5], you must set the DNS server.

If you select [Secure Protocol], you must set both the DNS server and secure protocol
 server.

14. If you select other than [Anonymous] in step 13, specify the user
 ID and password to log in to the LDAP server.

15. Select the encryption method in [Encryption].

16. Click [Submit].
The new settings take effect when the network function of this machine restarts.
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Setting the Reception Protocol

You can set reception protocol (POP3, SMTP, etc.) so that the machine can receive e-mail.

1. Open a Web browser.

2. Enter "http://(The IP address of this machine)" in the address bar,
 and then press the <Enter> key.

3. Click [Administrator Login].

4. Enter "admin" in [User Name] and the administrator password of
 the machine in [Password], and then click [OK].
For Mac OS X, enter "admin" in [Name] and the administrator password of the
 machine in [Password], and then click [Login].

5. Click [SKIP].

6. Click [Admin Setup] at the top of the screen.

7. Click [Network] > [Mail Server] on the left side of the screen.

8. Set the mail server based on the information on the setting
 information sheet if necessary.

9. Click [Submit].

10. Click [E-mail] > [Receive Settings] on the left side of the screen.

11. Select [POP3], and then click [To STEP2].

12. Set the POP3 protocol if necessary.

13. Click [Submit].
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Access Control

Before enabling access control of the machine, you need to register user information on the
 web page of the machine.

Each user information has a role and once the access control is enabled, users can only
 perform operations that are allowed to each role.

You can create groups and manage several users in a group.

Registering Users

Registering Roles

Registering Groups

Setting the LDAP Authorization
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Registering Users

1. Open the Web page of the machine.
Open the Web Page of This Machine

2. Log in as the administrator.
Log In as the Administrator

3. Click [User Management].

4. Click [User List].

5. Specify the user type.
Local User: Register user information to the machine.

LDAP User: User registered to the LDAP server. LDAP server authentication setting is
 required.

Kerberos Users: Users registered to the Kerberos server. Kerberos server
 authentication setting is required.

6. Click [+].

7. When the user information setting screen appears, enter the
 required information.

User name: Enter a user name.

Password: Enter a password.

Display Name: Enter a display name.

E-mail address: Enter your mail address.

Language Code: Enter the language code.

PIN: Enter your PIN.

Card ID: Enter your ID card information.

Role: Set your role.

Group: Set the group you belong to.

8. Press [Submit].
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Registering Roles

Each user has a role and acceptable operations are limited depending on the role.

Two or more roles can be assigned to a user.

For example, you can create roles for posts of duty and departments, and then assign
 acceptable operations to each role.

Controllable operations by roles are as follows:

Copy

Scan to Fax Server

Scan To E-mail

Scan To USB Memory

Scan To Fax

Sending data to a fax server

Internet fax transmission

Printing from a computer

Printing from USB Memory

1. Open the Web page of the machine.
Open the Web Page of This Machine

2. Log in as the administrator.
Log In as the Administrator

3. Click [User Management].

4. Click [Role List].

5. Click [+].

6. When the Role information screen appears, enter the required
 information.

Role Name: Enter a role name.

Role Description: Enter explanation for the role, etc.

Permission: Set to allow or forbid each operation or no authority to any operations.
 If no authority is set, operations that are allowed with other roles are forbidden.

Local User List: Add users to that role.

Kerberos User List: Add Kerberos users to that role.

7. Click [Submit].
You can copy registered roles to add.

Press [Copy] on the right of the role name to display the role information screen, and
 then change items if required and register.
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Registering Groups

You can create groups and manage several users in a group. You can register up to 1,000
 groups. You can register up to 5,000 users in a group.

1. Open the Web page of the machine.
Open the Web Page of This Machine

2. Log in as the administrator.
Log In as the Administrator

3. Click [User Management].

4. Click [Group List].

5. Click [+].

6. When the group information screen appears, enter the required
 information.

Group Name: Enter a group name.

Group Description: Enter explanation for the group, etc.

Local User List: Add users to that group.

Kerberos User List: Add Kerberos users to that group.

7. Click [Submit].
You can copy registered roles to add.

Press [Copy] on the right of the group name to display the group information screen,
 and then change items if required and register.
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Setting the LDAP Authorization

1. Open the Web page of the machine.
Open the Web Page of This Machine

2. Log in as the administrator.
Log In as the Administrator

3. Click [User Management].

4. Click [LDAP Authentication Settings].

5. Click [LDAP Authentication Settings].

6. Enter LDAP Key to obtain each information.
[Cache authentication information] in [User information cash settings] sets whether to
 save LDAP authentication information into the cash on the machine.

Memo
Cache authentication information is a function which automatically switches to cash
 authentication when the machine cannot communicate with the LDAP server.

You can set an expiration date for the cache authentication information on a daily
 basis. The expiration date means length of time that elapses since the last successful
 online authentication. The elapsed time is watched on a per-user basis.

7. Press [Submit].

8. Click [Role Assignment Regulations].

9. Click [+] to add rules to assign roles.

10. When the Role assignment screen appears, enter the required
 information.

11. Press [Submit].
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About Items That Can be Set or Checked

View Information

Item Description

Status Displays the current status of the machine. All the warnings and errors that have
 occurred on the machine are displayed as "Alert information". You can also check
 the operating status of each network service, a list of machine information, and the
 IP address that is set to the machine.

Counter Displays the number of printouts by printing or scanning.

Supplies
 Life

Displays the remaining amount and lifetime of consumables.

Usage
 Report

Displays the print statistics results.

Network You can check general information, the status of TCP/IP, maintenance information,
 and other Network setting information.

System Displays the machine information.

Paper Setup
This function is displayed only if you log in as the administrator of the machine.

Item Description

Tray
 Configuration

You can set a paper size for each tray, custom paper, and other settings.
When using the printer driver, the values that are set with the printer driver are
 given priority over these settings.

Select Tray Select a tray that is used when a received document is printed or paper is
 automatically selected.
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Paper Input
 Options

Sets tray switch and a priority order.

Duplex Last
 Page

Sets whether to perform duplex printing if the last page is a simplex page.

List
This function is displayed only if you log in as the administrator of the machine.

Item Description

Profile You can set information that is required for performing Scan to Network PC, and
 register it as a profile. You can set a protocol, save destination URL, file name,
 density, document size, color format, monochrome format, and other settings
 to a profile.

NetworkScan Registers, deletes, and edits a destination for a network scan.

Admin Setup
This function is displayed only if you log in as the administrator of the machine.

Network

Item Description

General Network Settings Sets the general network settings.

Wireless Setting Sets the wireless settings.

TCP/IP Sets TCP/IP information.
Easy Setup

NBT Sets NetBIOS over TCP information.

Mail Server Sets a mail server.

E-mail Receive
 Settings

Sets an e-mail receive settings.
Before Using Scan To E-mail
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Alert Settings Sets the function that enables you to receive e-mail alerts about
 events that have occurred on the machine.

E-mail Alert

SNMP Settings Sets SNMP.

Trap Sets SNMP Trap.

IPP Settings Sets the function that enables you to perform IPP print.

Authentication Sets authentication.

Google Cloud Print Sets Google Cloud Print information.

Windows Rally Sets Windows Rally information.

IEEE802.1X Sets EEE802.1X/EAP information.

Secure Protocol Server Sets secure protocol server information.

LDAP Sets LDAP information.

Security Protocol
 ON/OFF

Stops a network protocol and network service that are not used.

IP Filtering Restricts access by using IP addresses. Access from outside your
 company is also supported. However, this function requires
 sufficient knowledge about IP addresses. Some settings may result
 in serious problems that prevent you from accessing the machine
 via a network.

MAC Address
 Filtering

Restricts access by using MAC addresses. Access from outside your
 company is also supported. However, this function requires
 sufficient knowledge about MAC addresses. Some settings may
 result in serious problems that prevent you from accessing the
 machine via a network.

SSL/TLS Encrypts communications between a computer (client) and the
 machine.

IPSec Sets the encryption for communications between a computer
 (client) and the machine, and settings to prevent tampering.

Change
 Network
 Password

Changes the administrator password. The default value of the
 password is the last six digits of the MAC address.

Maintenance Reset/Restore Restarts and resets a network. Even if you access the Web page
 from the Web browser after restarting, the Web page is not
 displayed until the restart is complete. Resetting restores the IP
 address to its default status, resulting in information you manually
 set being lost. In such a case, the Web page cannot be displayed.

Network Scale Improves operation efficiency on a network. This setting is very
 effective when a hub that has the spanning tree function is used,
 or a computer and the machine are connected one-on-one with a
 cross cable.

Copy Setup

You can set the image quality, density, scan size, margins, edge erase, duplex, and other
 settings.

Fax Setup

Item Description

Default Settings Sets the image quality, density, and other default settings for sending faxes.

Security Function Sets security for sending faxes.

Other Settings Sets other settings for sending faxes.
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FaxServer Function

Item Description

Environmental Settings Sets the environmental settings.

Default Settings Sets the default settings.

Security Function Sets the security settings.

Other Settings Sets other settings for sending data to the fax server.

Insernet Fax Serup

Sets Internet Fax.

Scanner Setup

Item Description

Default Settings Sets the image quality, density, and other default settings for scanning.

E-mail Setup Sets e-mail settings that are required for performing Scan to E-mail.

USB Memory Setup Sets USB Memory settings for performing Scan to USB Memory.

TWAIN Setup Sets TWAIN.

WSD Scan Setup Sets WSD Scan.

PC Scan Mode Sets PC Scan mode.

Auto Color Judge Level Sets Auto Color Judge Level.

Print From USB Memory Setup

Set Print From USB Memory.

Print Setup

Item Description

Print
 Menu

Print Setup Sets the number of copies, resolution, and other settings. When using
 the printer driver, the values that are set with the printer driver are
 given priority over these settings.

Printer
 Adjust

Sets manual timeout, jam recovery, and other print adjustment settings.

Print
 Position
 Adjust

Adjusts front X, front Y, back X and back Y positions.

Drum
 Cleaning

Sets cleaning of an image drum.

Hex Dump Displays all the received print data in hex. To exit this mode, restart the
 machine.

Color Menu Sets Color settings.

System Configuration
 Menu

Sets operation modes, alarm release, and other machine operation
 settings for each situation.

Emulation PCL Setup Sets PCL.

PS Setup Sets PS.

XPS Setup Sets XPS.

IBM PPR
 Setup

Sets IBM PPR Setup.
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EPSON FX
 Setup

Sets EPSON FX Setup.

Encrypted
 Secure
 Print
 Setup

Job
 Verification

Set whether to verify a job before printing. If enabled, security is
 enhanced because the machine verifies that the job is not altered before
 starting printing, however it will take longer to start printing.

Erase job
 option

Set how to delete a job. You can overwrite deleted data so that it will not
 be restored. If enabled, it will take longer to delete.

Storage
 Period of
 Jobs

Set the storage period of jobs. If the set period elapses after jobs are
 stored, the jobs will be automatically deleted.

Management

You can set device settings.

Item Description

Local
 Interface

USB
 Menu

Sets USB.

System Setup Sets access control, display units, and other settings.

Power Save Sets power save settings.

Memory Setup Sets the reception buffer size and resource save area.

Language Maint
 Setup

Sets Language settings.

Admin Password Sets an administrator password.

Reset Settings Initializes all the data that is set in "Management", including speed dial,
 copy and fax function settings.

User Install

Item Description

Power Setup Sets Auto power off and Power supply Return.

Fax Setup Sets a fax line, sender, and other settings.

Time Setup Sets the time to the machine.

Note
If you select [Auto], you cannot set the time from the operator panel.

Other Settings Sets High humid mode.

Job List

Item Description

Job
 List

Displays a list of print jobs that are sent to the machine. You can delete unnecessary
 jobs.
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Direct Print

Item Description

Web Printing Specifies and prints a PDF file.

E-mail
 Printing

E-mail
 Printing

Prints a PDF, JPEG and TIFF file if it is attached on an e-mail that
 the machine receives.

Receive
 Settings

Sets an e-mail receive settings.

Transmission Settings
This function is displayed only if you log in as the administrator of the machine.

Item Description

Automated
 Delivery
 Setup

Sets the function that enables you to automatically convert a received fax into
 an e-mail and send it, and the function that enables you to automatically
 deliver a received e-mail.

Transmission
 Settings

Sets the function that enables you to save received and sent faxes and e-mail
 data to a server and other storages.

Automated
 Delivery Log

Displays the automated delivery logs. Display condition: [Admin Setup] >
 [Management] > [Job Log Setup] > [Save Job Log] is set to [Enable].

Transmission
 Log

Displays the transmission logs. Display condition: [Admin Setup] >
 [Management] > [Job Log Setup] > [Save Job Log] is set to [Enable].

Links
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Item Description

Links Displays the links that are set by the manufacturer, and the links that are set by your
 administrator.

Edit
 Links

Your administrator can set any URLs. Five support links and five other links can be
 registered. Include "http://" in an entered URL.

1178



Adjusting Color with PS Gamma Adjuster Utility

You can adjust the half-tone density of CMYK colors printed by the printer. Use this function
 if the color in a photograph or graphic is too dark.

Note
This function can be used with PS Printer Driver.

With Windows, the [Gamma Adjuster] menu or its content may not be displayed on the
 [Color] tab of the printer driver after registering a halftone adjustment name in [Custom
 Gamma Adjustment]. In such a case, restart your computer.

Using the halftone adjustment may cause printing to become slower. If you want to prioritize
 speed, uncheck [Gamma Adjuster] check box in the [Color] tab for the windows print driver,
 or select [None] for [Custom gamma] in the [Quality2] tab on the [Print Options] panel for
 the Mac OS X printer driver.

Applications that were started before registering [Gamma Curve Name] must be restarted
 before printing.

Some applications allow you to specify dot gain compensation and halftone adjustment when
 printing or have the function that includes such settings in an EPS file. To use such functions
 provided by the application, uncheck [Gamma Adjuster] check box in the [Color] tab for the
 windows print driver, or select [None] for [Custom gamma] in the [Quality2] tab on the
 [Print Options] panel for the Mac OS X printer driver.

The "Select Printer" list of PS Gamma Adjuster displays model names. If more than one
 printer of the same model exist in the [Printer and Device] folder, the registered [Gamma
 Curve Name] is applied to all same-model printers.

How to install PS Gamma Adjuster

List of Utility Software

For Windows PS Printer Driver

For Mac OS X PS Printer Driver

For Windows PS Printer Driver

Registering an Adjusted Halftone

1. Click [Start], and then select [All Programs] > [Okidata] > [PS
 Gamma Adjuster] > [PS Gamma Adjuster].

2. Select [MC873(PS)] from [Select Printer].

3. Click [New].

4. Adjust the halftone.
Edit the graph or enter the gamma value or the tone density in the text box to adjust
 the halftone.

5. Enter a setting name in [Gamma Curve Name], and then click
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 [OK].

6. Click [Add].

7. Click [Apply].

8. Click [OK].

9. Click [Exit] to exit PS Gamma Adjuster Utility.

Printing with a Registered Halftone

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Click [Properties].

4. Check the [Gamma Adjuster] check box on the [Color] tab.

5. Select the registered halftone adjustment name.

6. Change other settings if necessary, and then click [OK].

7. Click [Print] on the [Print] screen.

For Mac OS X PS Printer Driver

Registering an Adjusted Halftone

1. Start PS Gamma Adjuster.

2. Click [New].

3. Adjust the halftone.
Edit the graph or enter the gamma value or the tone density in the text box to adjust
 the halftone.

4. Enter a setting name in [Gamma Curve Name], and then click
 [Save].

5. Click [Select PPD].

6. Select a PPD file to register an adjusted halftone, and then click
 [Open].
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7. Select the created halftone adjustment, and then click [Add].

8. Click [Save].

9. Select [Print & Scan] in [System Preferences].

10. Delete the registered printer to which the adjustment has been
 made, and then register the printer again.

Memo
Do not click the [Configure] button that is displayed while the printer is being
 registered.

If a dialog box in which you can select a printer option is displayed while the printer is
 being registered, click [Cancel], and then register the printer again.

Printing with a Registered Halftone

1. Open the file to print.

2. Select [Print] from the [File] menu.

3. Select the [Print Options] panel.

4. Select the created halftone adjustment from [Custom gamma] in
 the [Quality2] tab.

5. Change other settings if necessary, and then click [Print].
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Using Configuration Tool

In the Configuration Tool, you can manage multiple machines and change settings. For e-
mail address settings and registering/deleting speed dials, see "Editing Address Book".

The Configuration Tool functions are as follows.

Starting Configuration Tool

List of Icons used in Configuration Tool

Removing This Machine

Checking the Status of This Machine

Setting the Device Setting Plug-in

This section describes how to save settings to a file and restore settings from a file.

Setting Profiles

This section describes how to export profiles that are registered in this machine to a file,
 and how to import profiles you want to register in this machine from a file.

Setting a Network Scan

This section describes how to export network scan information that is registered in this
 machine, and how to delete the registered network scan information from this machine.

Cloning Settings

This section describes how to clone various settings of this machine.

Setting the Alert Info Plug-in

This section describes how to display a message on a computer when a print job or
 another job is complete by using the Alert Info plug-in.

Setting the Network Setting Plug-in

This section describes how to set the IP address of your machine, enable or disable device
 settings (Web), and set the display of the Web page by using the Network Setting plug-
in.

Registering Forms (Form Overlay)

You can register such as logos to the machine as forms, and then print overlays. This
 section describes how to register forms.

Checking the Free Space in Memory

This section describes how to check the free space in Memory by using Configuration Tool.

Deleting Unnecessary Jobs from Memory

You can delete print jobs in Memory by using Configuration Tool.

Registering a PIN

Registering a User Name and Password
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Starting Configuration Tool

Registering This Machine

How to Start Configuration Tool

Names and Functions of Screen Items for Configuration Tool

The following five types of plug-ins are available for Configuration Tool.

User Setting Plug-in

Device Setting Plug-in

Alert Info Plug-in

Network Setting Plug-in

Storage Manager Plug-in

How to install Configuration Tool.

Installing Software

Registering This Machine

If you install this machine for the first time, register it in Configuration Tool.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Register Device] from the [Tools] menu.

Search results are displayed.

3. Select this machine, and then click [Register].

4. Click [Yes] on a confirmation screen.

How to Start Configuration Tool

Start Configuration Tool plug-in by following the procedure below.
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1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].
The start screen is displayed.

2. Select the machine from [Registered Device Table].
The [Device Info] screen is displayed.

Names and Functions of Screen Items for Configuration
 Tool

This section describes the name and function of each screen.

[Device Info] tab
The status and information of the machine are displayed.

[Device Setting] tab
Set the device menu.

Item Description

1 Menu Settings Edit the setting of the menu.

2 Cloning Copy device menu settings to another device.

3 Change password Change device password.
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[User Setting] tab
Set the device address book, profile, or other settings.

Item Description

4 E-mail Address
 Manager

Set/Edit device E-mail Address.

5 Speed Dial Manager Set/Edit device Speed Dial.

6 Profile Manager Set/Edit device Profile.

7 Network Scan
 Manager

This option sets/edits a destination to which to transmit data
 scanned from a device.

8 PIN Manager Set/Edit device PIN and User.

9 Automated Delivery
 Manager

Set/Edit device Automated Delivery Setup and Transmission
 Settings.

10 Cloning Copy settings of each device Manager to another device.

[Alert Info] plug-in
Detect a device event and sends a notification.

Item Description

11 Basic settings Edit the basic Alert Info settings.

12 Setting devices Edit the communications settings for each device.

13 Filter settings Edit the filter conditions for popup notifications.

14 Display log Display the notification information detected.
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[Network Setting] plug-in
Set the device network.

Item Description

15 Discover Devices Discovers network devices.

16 Environment Settings Changes the device discovery criteria or communication options.

[Storage Manager] plug-in
Create or edit a file to download to a device.

Registration and deletion of form data

Management of a stored job
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List of Icons used in Configuration Tool

Icon name Description

New(E-mail Address) Registers a new e-mail address.

New(Group) Registers a new e-mail address group.

New(Speed Dial) Registers a new speed dial number.

New(Group) Registers a new speed dial number group.

New Registers a new profile.

Create by Copying Copy content of items whose check boxes are selected, and
 create a new document profile.

New(PIN) Registers a new PIN number.

New(User) Registers a new user.

LDAP server Specifies LDAP server for referring to the user related to the
 PIN.

Displays PIN as Standard Switches to the list display based on the PIN codes.

Displays User as Standard Switches to the list display based on the user names.

New Register a new automatic setting delivery number.

Reread Settings Reloads the setting information of this machine.

Save to device Saves the settings in the machine.
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Delete Deletes the specified items.

Delete and Sort Deletes the specified items, and then moves up other items.

Delete all Deletes all items.

Export to file Export the current settings to a file.

Import from file Imports the settings from a file.

Return to top page Returns to the top page.

Back Returns to the previous page.

Return to before changes Cancels the last change.

Display administrator
 settings

Displays the administrator setting.

Backup settings Saves settings of the device displayed on the screen in a file.

Restore settings Restores the settings of the device that are stored in an
 external file.

Discover Devices Searches for the machine again.

Environment Settings Changes search conditions for this machine.

Device Settings Changes the IP address of the machine.

Restart device Restarts the machine.

Change Password Changes the network password.
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Display Web Page Display the Web page of this machine.

New Project Creates a new project.

Open Project Opens a project.

Save Project Saves a project.

Save as... Saves the project under a name.

Add File to Project Adds a file to a project.

Remove file from project Deletes a file from a project.

Open a macro file filtering
 window

Displays a filtering screen of the PCL form file.

Create download file Creates a download file.

Send download file to
 printer

Sends a download file.

Send project file to printer Sends a project.

Send file(s) to printer Sends a file.

Open a job Management
 window

Displays the job control screen.

Open an Administrator
 Functions window

Displays the administrator function screen.
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Removing This Machine

You can remove a registered machine.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Right-click the machine from [Registered Device Table].

3. Select [Remove device].

4. Click [Yes] on a confirmation screen.
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Checking the Status of This Machine

You can check the status and information of this machine.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [Device Info] tab.

Memo
If this machine is connected to the network, [Device Status] is displayed.

To update information, click [Update Device Information].
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Setting the Device Setting Plug-in

Saving Settings to a File

Restoring Settings from a File

Setting a Password

With the Device Setting plug-in, you can change the machine menu and copy settings to
 another device.

If you click  (Save to device), the changed settings are reflected to the machine.

Before using the following functions, install the Device Setting plug-in.

How to install plug-ins

Installing Software

About icons

Starting Configuration Tool

Saving Settings to a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [Device Setting] tab.

4. Click [Menu settings].

5. Click  (Backup settings).

6. Enter the name of a file, select a save destination folder, and then
 click [Save].
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Restoring Settings from a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [Device Setting] tab.

4. Click [Menu settings].

5. Click  (Restore settings).

6. Check the content of the displayed message, and then click [Yes].

7. Select the file to restore, and then click [Open].

8. Click  (Save to device).

Setting a Password

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [Device Setting] tab.

4. Click [Change password].
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5. Enter the current password and a new password, and then click
 [OK].
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Setting Profiles

Exporting Profiles to a File

Importing Profiles from a File

You can register and edit profiles on this machine using Profile Manager in the User Setting
 plug-in. The following section describes some functions.

If you click  (Save to device), the changed settings are reflected to the machine.

Note
Before using Profile Manager, install the User Setting plug-in.

How to install plug-ins

Installing Software

About profiles

Profile

About icons

Starting Configuration Tool

Exporting Profiles to a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the profiles you want to export from
 [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Profile Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Export to file).

7. Enter the name of a file, select a save destination folder, and then
 click [Save].

Note
After exporting, the edited CSV file may not restore properly.
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Importing Profiles from a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine to which you want to import the profiles from
 [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Profile Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Import from file).

7. Select the file to import, and then click [Open].

8. Select the settings to import, and then click [Import].

9. Click  (Save to device).
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Setting a Network Scan

Exporting Network Scan Settings to a File

Importing Network Scan Settings from a File

Deleting Network Scan Settings

Network Scan Manager in the User Setting plug-in allows you to register and edit addresses
 to use for the network scan functions such as Scan to PC. The following section describes
 some functions.

If you click  (Save to device), the changed settings are reflected to the machine.

Before using Network Scan Manager, install the User Setting pug-in.

How to install plug-ins

Installing Software

About icons

Starting Configuration Tool

Exporting Network Scan Settings to a File

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the network scan settings you want to
 export from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Network Scan Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Export to file).

7. Enter the name of a file, select a save destination folder, and then
 click [Save].

Note
After exporting, the edited CSV file may not restore properly.

Importing Network Scan Settings from a File
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1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine to which you want to import the network scan
 settings from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Network Scan Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Import from file).

7. Select the file to import, and then click [Open].

8. Select the settings to import, and then click [Import].

9. Click  (Save to device).

Deleting Network Scan Settings

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Network Scan Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Select the destination to delete.

7. Click  (Delete).

8. Click [Yes] on a confirmation screen.

9. Click  (Save to device).
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Cloning Settings

Cloning the Settings of This Machine

Cloning User Settings

Cloning the Settings of This Machine

You can copy machine's settings to a different device.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the settings you want to clone from
 [Registered Device Table].

3. Select the [Device Setting] tab.

4. Click [Cloning].

5. Select a cloning destination, and then click [Execute].

6. Enter the password for the cloning source and target, and then
 click [OK].

Cloning User Settings

You can copy user settings to a different device.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the settings you want to clone from
 [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [Cloning].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Select a cloning destination to and cloning settings.

7. Click [Execute].
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8. Enter the password for the cloning source and target and click
 [OK].
Results are displayed.

1202



Setting the Alert Info Plug-in

Basic Settings

Device Settings

Filter Settings

Checking Logs

You can use the Alert Info plug-in to display a message on your computer when a job is
 complete. As a special term for this software, completion of a job is called an "event".

Note
Before using the following functions, install the Alert Info plug-in.

How to install plug-ins

Installing Software

The Alert Info plug-in can be used with devices connected to the network.

The time and time zone of this machine must be consistent with those of your computer.

Basic Settings

You can set basic settings of the Alert Info plug-in.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Alert Info] from the [Plug-ins] menu.

3. Select [Basic settings].
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4. Change the setting if necessary.

5. Click [Update].

Device Settings

The Alert Info plug-in settings can be changed for each device.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Alert Info] from the [Plug-ins] menu.

3. Select [Setting devices].

4. Click [Update device].

5. Select a device to set.

6. Change the settings if necessary, and then click [OK].

Filter Settings

You can set display alert conditions for sending and receiving faxes, printing the document,
 or receiving e-mails and Internet faxes.
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1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Alert Info] from the [Plug-ins] menu.

3. Select [Filter settings].

4. Change the setting if necessary.

5. Click [OK].

Memo
Up to 300 senders can be registered as e-mail, Internet fax, or fax sender.

Checking Logs

Using the event log, you can check whether there are any records about the machine that is
 registered.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Alert Info] from the [Plug-ins] menu.

3. Select [Display log].
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Memo
You can check the total number of recorded events in [Log Number List].

You can check details of recorded logs in [Log details].
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Setting the Network Setting Plug-in

Searching for the Machine on a Network

Specifying Search Conditions

Changing the IP Address

You can set a network with Configuration Tool. Before setting, install the Network Setting
 plug-in.

How to install plug-ins

Installing Software

About how to Make Network Settings

Connecting This Machine to a Network

About icons

Starting Configuration Tool

Searching for the Machine on a Network

You can search for this machine.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Network Setting] from the [Plug-ins] menu.

3. Select [Discover Devices].
Search results are displayed.

Specifying Search Conditions

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Network Setting] from the [Plug-ins] menu.

3. Select [Environment Settings].

4. Change the search conditions if necessary, and then click [OK].
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Changing the IP Address

You can change the IP address for this machine.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Network Setting] from the [Plug-ins] menu.

3. Select [Discover Devices].

4. Select the machine from the device list.

5. Click  (Device Settings).

6. Change the setting if necessary.

7. Click [OK].
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8. Enter the network password, and then click [OK].
The default password is the last six alphanumerical digits of the MAC address.

9. Click [OK] to restart this machine.
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Registering Forms (Form Overlay)

Creating a Form

Registering the Form to the Machine Using Configuration Tool

You can register such as logos to the machine as forms, and then print overlays. This section
 describes how to register forms.

About how to Print Overlays

Overlaying Forms or Logos (Overlay)

Note
Before using the function, install the Storage Manager plug-in.

How to install plug-ins

Installing Software

The Windows XPS printer driver cannot be used.

Creating a Form

1. Click [Start], and then select [Devices and Printers].

2. Right-click the printer icon, and then select the necessary printer
 driver from [Printer Properties].

3. Select the [Ports] tab, select the [FILE] check box from [Port], and
 then click [Configure Port].

4. Create a form to register on the machine.
If using the Windows PCL printer driver, proceed to step 9.

5. Select [Print] from the [File] menu.

6. Click [Preferences] (or [Properties]).

7. Select the [Extend] tab, and then click [Overlays].

8. Select [Create Form].

9. Start printing.

10. Enter the file name under which you want to save.

11. Return [Printer Port] from the [Ports] tab.
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Registering the Form to the Machine Using Configuration
 Tool

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Storage Manager] from the [Plug-ins] menu.

3. Click  (New Project).

4. Click  (Add File to Project), and then select a created form file.
The form is added to the project.

5. Click the form file.

6. Enter [ID], and then click [OK].

Note
Do not change [Target Volume] and [Path].

7. Select the machine from the bottom of the Storage Manager Plug-
in window.

8. Click  (Send project file to printer).

9. Click [OK].
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Checking the Free Space in Memory

You can check the free space in Memory using the Storage Manager plug-in.

Note
Before using the function, install the Storage Manager plug-in.

How to install plug-ins

Installing Software

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Storage Manager] from the [Plug-ins] menu.

3. Click the device name in the device selection area at the bottom of
 the Storage Manager plug-in screen.
The storage, volume name, size, free space, location name, label, status, file name,
 size, and comment are displayed by communicating with the device.
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Deleting Unnecessary Jobs from Memory

You can delete print jobs in Memory using the Storage Manager plug-in.

Note
Before using the function, install the Storage Manager plug-in.

How to install plug-ins

Installing Software

Encrypted authorized print jobs cannot be deleted with the Storage Manager plug-in.

1. Click [Start], and then select [All Programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select [Storage Manager] from the [Plug-ins] menu.

3. Click  (Open a job Management window).

4. To view a specific user's print jobs, enter the password, and then
 click [Apply job password].

Memo
To view all the print jobs, enter the administrator password, and then click [Apply
 administrator password]. The factory default administrator password is "aaaaaa".

5. Select a job to delete, and then click  (Remove file from project).

6. Click [OK].
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Registering a PIN

Creating a new PIN

Changing PIN Settings

Deleting a PIN

Exporting a PIN to a File

Importing a PIN from a File

You can restrict access to this machine by using a PIN.

If you click  (Save to device), the changed settings are reflected to this machine.

Note
If you use Configuration Tool to register PIN, the access control method will be changed and you
 cannot use some functions such as role-based access control.

Creating a new PIN

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (New(PIN)).

7. Enter the PIN number you want to use.

8. Set each items if necessary, and then press [OK].

9. Click  (Save to device).

Changing PIN Settings

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].
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2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Select the PIN number you want to change the setting.

7. Set each items if necessary, and then click [OK].

8. Click  (Save to device).

Deleting a PIN

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Select the check box of the PIN you want to delete.

7. Click  (Delete).

8. Click [Yes] on a confirmation screen.

9. Click  (Save to device).

Exporting a PIN to a File

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine that has the PIN you want to export from
 [Registered Device Table].

3. Select the [User Setting] tab.
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4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Export to file).

7. Enter the file name, select the folder to save the file, and then click
 [Save].

Note
The CSV file that is edit after exported may not restore properly.

Importing a PIN from a File

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine to which you want to import the PIN from
 [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (Import from file).

7. Select the file to import, and then click [Open].

8. Select the settings to import, and then click [Import].

9. Click  (Save to device).
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Registering a User Name and Password

Creating a New User

Changing User Settings

Deleting a User

You can restrict access to this machine by using a user name and password.

If you click  (Save to device), the changed settings are reflected to this machine.

Note
If you use Configuration Tool to register user name and password, the access control method will
 be changed and you cannot use some functions such as role-based access control.

Creating a New User

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Click  (New(User)).

7. Enter the user name and password.

Memo
You cannot use "admin" as a new user name.

8. Select either an existing PIN from [PIN Number] or select [New].

9. If you select [New], enter the PIN number in [New PIN Number],
 set each value if necessary, and then click [OK].

10. Click [Close].

11. Click  (Save to device).
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Changing User Settings

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Select the user name to change.

7. Change settings if necessary, and then click [OK].

8. Click  (Save to device).

Deleting a User

1. Click [Start], and then select [All programs] > [Okidata] >
 [Configuration Tool] > [Configuration Tool].

2. Select the machine from [Registered Device Table].

3. Select the [User Setting] tab.

4. Click [PIN Manager].

5. Enter the administrator password, and then click [OK].
The factory default password is "aaaaaa".

6. Select the check box of the user you want to delete.

7. Click  (Delete).

8. Click [Yes] on a confirmation screen.

9. Click  (Save to device).
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About ActKey

ActKey enables you to start scanning according to the specified settings just by clicking a
 button.

Memo
ActKey does not support Mac OS X.

When you install ActKey, Network Configuration is also installed at the same time.

Before Using Remote Scan

Using ActKey (Windows)
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Printing by Using OKI LPR Utility

Starting OKI LPR Utility

Registering a Printer to OKI LPR Utility

Adding a Comment to a Registered Printer

Checking the Status of a Registered Printer

Forwarding Print Jobs to a Registered Printer

Printing the Same Document from the Registered Multiple Printers

Opening the Web Page of the Registered Printer

Following the IP Address of the Registered Printer Automatically

Setting the OKI LPR Utility Port Number

Uninstalling OKI LPR Utility (Uninstall)

Sending a File to a Printer That is Registered in OKI LPR Utility

Deleting an Unnecessary Print Job

You can perform a print job via a network, manage print jobs, and check the machine status
 by using OKI LPR Utility.

To use OKI LPR Utility, TCP/IP must be enabled.

Note
OKI LPR Utility cannot be used for shared printers. Use the standard TCP/IP port.

How to install OKI LPR Utility

Installing Software

Starting OKI LPR Utility

1. Click [Start], and then select [All Programs] > [Okidata] > [OKI
 LPR Utility] > [OKI LPR Utility].

Registering a Printer to OKI LPR Utility

Add a printer to OKI LPR Utility.

Note
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You must have the administrator rights.

If you cannot add a printer, exit OKI LPR Utility, and then follow the procedure below.

Click [Start] > [All Programs] > [Okidata] > [OKI LPR Utility], right-click [OKI LPR Utility],
 and then select [Run as administrator] to start.

Memo
You cannot add the printer that is already registered in OKI LPR Utility. To change the port,
 select [Confirm Connections] from [Remote Print].

1. Start OKI LPR Utility.

2. Select [Add Printer] from the [Remote Print] menu.
If the "You do not have sufficient privileges to complete this action." message is
 displayed, follow the procedure described in "If you cannot add a printer..." above.

3. Select [Printer Name], and then enter the IP address.
Network printers and printers connected to the LPR port are not displayed.

4. When selecting a network printer, select [Discover].

5. Click [OK].

Adding a Comment to a Registered Printer

You can add a comment to identify the printer that you have added to OKI LPR Utility.

1. Start OKI LPR Utility.

2. Select a printer.

3. Select [Confirm Connections] from the [Remote Print] menu.

4. Enter a comment, and then click [OK].

5. Select [Show comments] from the [Option] menu.

Checking the Status of a Registered Printer

1. Start OKI LPR Utility.

2. Select a printer.

3. Select [Printer Status] from the [Remote Print] menu.

Forwarding Print Jobs to a Registered Printer
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This section describes how to forward selected print jobs to a registered printer using the
 OKI LPR Utility. This section also describes how to automatically forward a print job to a
 different registered printer when a problem occurs on the forward destination printer.

Forwarding the Selected Print Jobs

Note
Print jobs can only be forwarded to an OKI printer of the same model as your printer.

Before forwarding a job, you must add an OKI printer of the same model.

1. Start OKI LPR Utility.

2. Select [Job Status] from the [Remote Print] menu.

3. To forward a print job, select a job, select [Redirect] from the [Job]
 menu, and then select the destination printer.

Forwarding Print Jobs Automatically
If you are unable to print because the selected printer is busy, offline, out of paper, or
 due to other reasons, you can set so that a print job can be automatically forwarded to
 another OKI model printer.

Note
Print jobs can only be forwarded to the same OKI model printer as the one you are using.

Before forwarding a job, you must add another same OKI model printer.

You must log in as the administrator.

1. Start OKI LPR Utility.

2. Select the printer to set.

3. Select [Confirm Connections] from the [Remote Print] menu.

4. Click [Details].

5. Select the [Automatic Job Redirect Used] check box.

6. To forward jobs only if an error occurs, select the [Redirect only at
 the time of an error] check box.

7. Click [Add].

8. Enter the forwarding destination IP address, and then click [OK].

9. Click [OK].
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Printing the Same Document from the Registered Multiple
 Printers

You can print from multiple printers with a single command.

Note
This function enables you to send a print command to multiple remote printers so that they
 can print at the same time.

You must have the administrator rights.

1. Start OKI LPR Utility.

2. Select the printer to set.

3. Select [Confirm Connections] from the [Remote Print] menu.

4. Click [Details].

5. Select the [Print to more than one printer at a time] check box.

6. Click [Options].

7. Click [Add].

8. Enter the IP address of the printer from which you want to print at
 the same time, and then click [OK].

9. Click [OK].

Opening the Web Page of the Registered Printer

You can open the Web page of this machine from OKI LPR Utility.

1. Start OKI LPR Utility.

2. Select a printer.

3. Select [Web Setting] from the [Remote Print] menu.

Memo
You cannot open the Web page when the Web port number has been changed.

For details, see "Setting the OKI LPR Utility Port Number".

Following the IP Address of the Registered Printer
 Automatically
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You can set so that you can maintain the connection with the original printer even after the
 IP address of the printer changes.

Note
You must have the administrator rights.

Memo
The IP address may change if DHCP dynamically assigns IP addresses or the network
 administrator manually changes the IP address of the printer.

1. Start OKI LPR Utility.

2. Select [Setup] from the [Option] menu.

3. Select the [Auto Reconnect] check box, and then click [OK].

Setting the OKI LPR Utility Port Number

1. Select a printer.

2. Select [Confirm Connections] from the [Remote Print] menu.

3. Click [Details].

4. Enter the port number in [Port Numbers].

5. Click [OK].

Uninstalling OKI LPR Utility (Uninstall)

Note
You must have the administrator rights.

1. Check that OKI LPR Utility is closed.

2. Click [Start], and then select [All Programs] > [Okidata] > [OKI
 LPR Utility] > [Uninstall OKI LPR Utility].
If the [User Account Control] dialog box is displayed, click [Yes].

3. Click [Yes] on a confirmation screen.

Sending a File to a Printer That is Registered in OKI LPR
 Utility
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If there is a printer that is connected via a network and registered in OKI LPR Utility, you
 can download the print data.

1. Click [Start] on a computer, and then select [All Programs] >
 [Okidata] > [OKI LPR Utility] > [OKI LPR Utility].

2. Select the printer to which the data is downloaded.

3. Select [Download] from [Remote Print].

4. Select a file, and then click [OK].
The file is sent to the printer.

Deleting an Unnecessary Print Job

You can use OKI LPR Utility to delete unnecessary print jobs.

1. Click [Start] on a computer, and then select [All Programs] >
 [Okidata] > [OKI LPR Utility] > [OKI LPR Utility].

2. Select [Job Status] from the [Remote Print] menu.

3. Select a job to delete.

4. Select [Delete Job] from the [Job] menu.
The unnecessary job is deleted.
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Network Extension

About Network Extension

Showing Printer Propaties

Checking the Settings of the Machine

Set Options Automatically

Uninstall the Utility

About Network Extension

In Network Extension, you can check the settings on this machine and set the composition
 of the options.

In order to use Network Extension, TCP/IP needs to be activated.

Note
This requires administrator rights.

Memo
Network Extension is automatically installed when installing a printer driver through a TCP/IP
 network.

Network Extension works in conjunction with the printer driver. Do not install only Network
 Extension.

Network Extension only functions when the printer driver is connected to OKI LPR port or the
 standard TCP/IP port.

Showing Printer Propaties

To use Network Extension, open the printer properties screen.
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1. Click [Start], and then select [Devices and Printers].

2. Right-click the printer icon, and then select [Printer properties].

Checking the Settings of the Machine

You can check the settings of this machine.

1. Start the printer properties screen.
About Screens and Functions of Each Printer Driver

2. Select the [Status] tab.

3. Click [Update].

4. Click [OK].

Click [Web Setting] to start the webpage automatically. You can change settings of this
 machine on this webpage screen.

Web Page of This Machine

Memo
The [Option] tab may not be displayed properly when using Network Extension in unsupported
 environments.

Set Options Automatically

You can get the composition of options of the connected machine and automatically set the
 printer driver.

1. Start the printer properties screen.
About Screens and Functions of Each Printer Driver

2. Select the [Device Options] tab.

3. Click [Get Printer Settings].

4. Click [OK].

Memo
You cannot configure this when using Network Extension in unsupported environments.

Uninstall the Utility
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1. Click [Start], and then select [Control Panel] > [Programs] >
 [Uninstall a program].

2. Select [OKI Network Extension], and then click [Uninstall].

3. Follow the instructions on the screen and complete the
 uninstallation.
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Using the Network Scanner Setup Tool (Mac OS X Only)

This section describes about the Network Scanner Setup Tool which is a tool for setting the
 connection destination.

Before Using WSD Scan
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Using Network Card Setup (Mac OS X)

You can use Network Card Setup to configure the network.

To use Network Card Setup, TCP/IP must be activated.

Setting the IP Address

Configuring Web Settings

Quitting Network Card Setup

Setting the IP Address

1. Start Network Card Setup.
Installing Software

2. Select this machine from the list.

3. Select [IP Address Settings] from the [Operations] menu.

4. Change other settings if necessary, and then click [Save].

5. Enter the password, and then click [OK].
The default password is the last six alphanumerical digits of the MAC address.

The password is case sensitive.

6. Click [OK] to enable new settings.
The network card of this machine restarts.

Configuring Web Settings

You can set the network settings for this machine by starting Network Card Setup.

Enabling Web Settings

1. Start Network Card Setup.
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Installing Software

2. Select this machine from the list.

3. Select [Web Settings] from the [Operations] menu.

4. Check [Device web settings will be enabled], and then click [Save].

5. Enter the password, and then click [OK].
The default password is the last six alphanumerical digits of the MAC address.

The password is case sensitive.

6. Click [OK] in a confirmation window.

Opening the Web page

1. Starts Network Card Setup.
Installing Software

2. Select this machine from the list.

3. Select [Show Device Webpage] from the [Operations] menu.
The Web page opens, and the machine status page is displayed.

Quitting Network Card Setup

1. Select [Quit] from the [Network Card Setup] menu.
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Print Job Accounting Client

Print Job Accounting Client is software that sets user information in the printer driver for
 using the job account function or authorizing access to the machine.

Setting in the Windows Environment

Setting in the Mac OS X Environment

Setting in the Windows Environment

You can set a user name and user ID to the printer driver.

Note
If you update or reinstall a printer driver, Job Accounting mode becomes invalid, requiring you to
 set the mode again. However, if you are using the function that enables you to set the same
 mode to all the printer drivers, you do not need to set the mode again.

Setting the User Name and Job Account ID
You can set the user name and Job Account ID in the printer driver properties.

1. Click [Start], and then select [All Programs] > [Okidata] > [Print
 Job Accounting Client] > [Change Job Accounting Mode].

2. Select the driver to set from the list of drivers.
If you want to set all the printer drivers to the same mode, select the [Set the same
 mode for All drivers.] check box.

3. Select [Tab], and then click [Change].
A window is displayed.

4. Click [OK].

5. Select [Close] from the [File] menu.

6. Click [Start], and then select [Devices and Printers].
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7. Right-click the OKI MC873 icon, and then select [Printer
 Properties].

8. Select the [Job Accounting] tab, enter the user name and job
 accounting ID, and then click [OK].

Setting Popup Mode
When using this function, you must enter the user name and job account ID each time
 you start a print job.

1. Click [Start], and then select [All Programs] > [Okidata] > [Print
 Job Accounting Client] > [Change Job Accounting Mode].

2. Select the driver to set from the list of drivers.
If you want to set all the printer drivers to the same mode, click the [Set the same
 mode for All drivers] check box.

3. Select [Popup], and then click [Change].
A window is displayed.

4. Click [OK].

5. Select [Close] from the [File] menu.

Setting a Job Account ID for Each User in Hide Mode
The system manager can create and register an ID file in which job account IDs and user
 names that are tied to user names for logging in to Windows are described in advance.
 Users do not need to enter their user names and job account IDs when printing, as they
 can be identified with this software.

Use Hide Mode for shared printers.

1. Create an ID file using Notepad or spreadsheet software.

Memo
Describe user names and user IDs in an ID file in the following order.

A login user name (a user name that is entered to log in to Windows), a user ID (a
 user ID that is tied to the login user name).

The user name can be omitted. If the user name is omitted, the login user name is
 used as the user name.

Separate each item with a comma.

If using spreadsheet software, describe a login user name, job account ID, and user
 name on each line for each user.

2. Save the file in "CSV" extension format.

3. Click [Start], and then select [All Programs] > [Okidata] > [Print
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 Job Accounting Client] > [Change Job Accounting Mode].

4. Select the driver to set from the list of drivers.
If you want to set all the printer drivers to the same mode, click the [Set the same
 mode for All drivers] check box.

Note
If you are using a shared printer, do not use the function that enable you to set all the
 print drivers to the same mode. If printing on the client side of a shared printer, account
 information is not output.

5. Select [Hide], and then click [Change].

6. Click [OK].

7. Select [Import ID File] from the [Hide Mode] menu.

8. Specify the ID file you created in step 1, and then click [Open].

9. Clear the [Set fixed Job Account ID for all users] check box from
 the [Hide Mode] menu.

10. Select [Close] from the [File] menu.

Setting in the Mac OS X Environment

This is client software for Print Job Accounting.

You can set the user name and user ID in the printer driver.

Registering a User ID

1. Start the Print Job Accounting client.

2. Click [New].

3. Enter the Mac OS X login name, new user name, new user ID, and
 then click [Save].

4. Click [Save].
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5. Enter the password, and then click [OK].

6. Exit the Print Job Accounting client.

Registering Multiple Users at the Same Time
You can register multiple user IDs and user names at the same time by using a CSV file.

Memo
The following procedure uses TextEdit as an example.

1. Start TextEdit.

2. Enter in the order of login name, user ID, and user name,
 separated with commas.

3. Save the file in a CSV format.

4. Start the Print Job Accounting client.

5. Select [Import] from the [File] menu.

6. Select the CSV file you created in step 3, and then click [Open].

7. Click [Save].

8. Enter the password, and then click [OK].

9. Exit the Print Job Accounting client.

Changing a User ID and User Name
You can change the user name and user ID.

1. Start the Print Job Accounting client.

2. Select the user to change, and then click [Edit].

3. Enter the new user ID and user name, and then click [Save].

4. Click [Save].

5. Enter the password, and then click [OK].

6. Exit the Print Job Accounting Client.

Deleting a User ID and User Name
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You can delete the username and user ID.

1. Start the Print Job Accounting client.

2. Select the user to delete, and then click [Delete].

3. Click [Save].

4. Enter the password, and then click [OK].

5. Exit the Print Job Accounting client.
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Print Frequently Used
 Documents Directly from the
 Operator Panel

Storing Frequently-printed
 Documents in the Printer

Easily Print from USB Memory
 without Using your Computer

Printing Data in USB Memory

Create Your Own Banners

Printing on Long Paper

Create Your Own Event Posters

Dividing a Document to Print on
 Some Sheets for Making a
 Poster

Create Your Own Saddle-bound
 Booklets

Making a Booklet

Send Paperless Faxes from
 Your Computer

Sending a PC Fax

Preview Incoming Faxes via E-
mail

Scan Bulky Documents to
 Reduce Clutter

Make It More Convenient
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Forwarding Received Document
 Data to an E-mail Destination
 or Shared Folder (Auto
 Delivery)
Saving Sent and Received Data
 (Transmission Data Save)

Sending Scanned Data to a
 Computer
Scanning from a Computer

Change the Settings Remotely

Starting Configuration Tool
Open the Web Page of This
 Machine

Customize the Touch Panel to
 Suit Your Preferences

How to Customize the Touch
 Panel
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Print Frequently Used Documents Directly from the
 Operator Panel

In business, you often need to print documents for people to write on, such as fax forms or
 in-company Memos. How do you handle standardized forms such as these?

Do you use your computer to print them out each time? Do you make copies of each form
 whenever they are needed? If you think this is too much trouble, we recommend using the
 "Stored Job" function to store each document as a Print Job on the machine.

With this function, you can store your frequently used standardized documents in the
 machine's Memory and print them directly from the Operator Panel whenever you need
 them. This ability to print without having to start up your computer can help you save
 precious time.

Storing Frequently-printed Documents in the Printer

Example of Other Convenient Usage
Printing of questionnaire

Printing of product flyers and tourist information
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Easily Print from USB Memory without Using your
 Computer

Have you ever been in a sticky situation where you needed to quickly print more copies of
 your presentation documents, but did not have easy access to a computer?

In this case, we recommend using the "Printing Data in USB Memory" function, which
 enables you to print documents without using a computer.

You can print files stored in USB Memory without using a printer driver. Simply insert USB
 Memory that contains the data that you want to print into the machine's USB port, and use
 the Operator Panel to perform printing.

Printing Data in USB Memory

Example of Other Convenient Usage
Printing the data in USB Memory customers brought
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Create Your Own Banners

Banners with large, eye-grabbing text are effective tools for generating publicity. They can
 attract attention to your big sales campaign or new product launch event, and they are
 good for school events and comMemoration ceremonies. Have you ever wanted to use one,
 but hesitated because of the trouble of having to order it or because of the cost?

In this case, we recommend using the "Printing on Long Paper" function, which enables you
 to print on elongated paper.

With an OKI Data printer, you can design a banner on your computer, and then print the
 data whenever and however many times you need it. You can also use this function to print
 large-as-life copies of your favorite panorama photos.

Printing on Long Paper
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Create Your Own Event Posters

Have you ever wanted to use display panels for an exhibition, or posters that guide the way
 to a venue? Have you ever just wanted to create your own posters because you did not
 need enough to place an order with another company?

In this case, we recommend using the "Poster Print" function.

The function works by dividing a poster into several parts, and printing the enlarged portions
 on multiple sheets of paper. By gluing the separately printed sheets together, you can
 create a rather large poster.

Dividing a Document to Print on Some Sheets for Making a Poster

Example of Other Convenient Usage
Printing Event Notification Poster for Nursery and Kindergarten

Printing the Price List and Menu List

1246



Create Your Own Saddle-bound Booklets

For an event such as a private group trip, a printed guide can make the experience more
 enjoyable. Printing the information in booklet form makes it compact and easy to carry.
 However, do you have any idea how to create a booklet?

In this case, we recommend using the "Booklet Print" function.

With this function, you can arrange the pages into the appropriate order for printing. You
 can then use a commercially available booklet stapler to create a true saddle-bound
 booklet.

Making a Booklet

Example of Other Convenient Usage
Printing of Product Catalogue

Memo
When you want to put a different types of the cover.

Printing Only the Cover from a Different Tray
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Send Paperless Faxes from Your Computer

Do you find it troublesome to create documents on your computer, print them out, take
 them to the fax machine, and then dial the number? Do you ever dial the wrong number?
 Have you ever been distressed over losing an important document after you faxed it?

In this case, we recommend using the "PC Fax" function, which enables you to send faxes
 directly from your computer.

With this function, files on your computer are faxed directly to the recipient, eliminating the
 need to print them out first. In addition to saving time and money, you can also keep your
 peace of mind by saving the data on your computer.

Sending a PC Fax

It is troublesome to transmit after printing

If you are using the PC Fax, you can avoid the waste of paper and time.
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Preview Incoming Faxes via E-mail

Offices can receive a lot of unnecessary faxes, and it is a ridiculous waste of paper to print
 all of them out. Have you ever wanted to check the contents of incoming faxes, and print
 only the ones that are important?

In this case, we recommend using the "Auto Delivery" function.

With this function, you can forward incoming faxes to your computer and receive them as e-
mail attachments. With the ability to check the contents of faxes on your computer screen,
 you can simply delete the ones that are not important, without printing them out.

We also recommend using the "Transmission Data Save" function in combination with "Auto
 Delivery". This function enables you to save a record of all incoming and outgoing messages
 on the server, which you can access at any time.

Forwarding Received Document Data to an E-mail Destination or Shared Folder (Auto
 Delivery)

Saving Sent and Received Data (Transmission Data Save)
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Scan Bulky Documents to Reduce Clutter

How do you store your valuable paper records, or important paper documents that have
 been annotated with handwritten notes? In business, new paper documents are generated
 every day. Before you know it, you may find yourself buried under a mountain of paper.

To prevent this type of situation, we recommend scanning your paper documents,
 converting them to PDF format, and storing them on a computer.

With the "Scan To Computer" function, you can use the machine's Operator Panel to save
 the scanned data to your computer. With the "Remote Scan" function, you can operate the
 machine via your computer and select the location to store the scanned data. By scanning
 documents and saving them to your computer, you can reduce the risk of misplacing,
 damaging, or losing them, while making it easier to retrieve them. At the same time, you
 can reduce the clutter around your desk, enabling you to work more efficiently. The
 "Remote Scan" function, which is useful when scanning photographs and images, allows
 you to preview the scanned data on your computer so that you can adjust the colors and
 image quality.

Sending Scanned Data to a Computer

Scanning from a Computer

Example of Other Convenient Usage
Processing with Data of the Product Introducing Documentation
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Change the Settings Remotely

Say you need to update all of the data in the address book on the machine. That means you
 must also update the settings on all of the other machines, including those that are located
 on other floors. If you have numerous machines in various locations, it may be a time-
consuming process to change the settings on each and every machine.

In this case, we recommend using the "Configuration Tool" or "Web page" function.

"Configuration Tool" is an application that runs on your computer. If you do not have the
 application or if you are using a mobile device, the "Web page" function is useful. These
 functions enable you to change and manage the settings from a remote location, without
 operating the machine directly.

Starting Configuration Tool

Open the Web Page of This Machine
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Customize the Touch Panel to Suit Your Preferences

There are probably some functions that you use every day, but do you have to navigate
 through various tabs and menus to reach them? Do you ever press the wrong button along
 the way and have to start over? Have you ever wished you could quickly select the
 functions that you frequently use?

In this case, the [Shortcut] function is convenient.

With this function, you can eliminate the stress of having to select the functions each time,
 by moving deeply nested functions, as well as functions from different tabs, up to the top
 screen. By customizing the touch panel, you can work more efficiently.

How to Customize the Touch Panel
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Trademarks and Other Information
OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server, Windows Vista and Internet Explorer are
 registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac and Mac OS are the registered trademarks of Apple Inc.

iPad, iPhone, iPod, and iPod touch are trademarks registered to Apple Inc. in the United
 States and other countries.

AirPrint and the AirPrint logo are trademarks of Apple Inc.

Google, Google Docs, Android, and Gmail are trademarks of Google Inc.

Google Cloud Print is a trademark of Google Inc.

Adobe, Illustrator, Photoshop, PostScript and Reader are trademarks or trademarks of
 Adobe Systems Incorporated in the United States and other countries.

Other product names and brand names are registered trademarks or trademarks of their
 proprietors.

As an Energy Star Program Participant, the manufacturer has determined that this
 product meets the Energy Star guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2004/108/EC
 (EMC), 2006/95/EC (LVD), 1999/5/EC (R&TTE), 2009/125/EC (ErP) and
 2011/65/EU(RoHS), as amended where applicable, on the approximation of the
 laws of the member states relating to Electromagnetic Compatibility, Low Voltage,
 Radio & Telecommunications Terminal Equipment, Energy related Products and
 Restriction on the use of certain Hazardous Substances in electrical and electronic
 equipment.

The following cables were used to evaluate this product for EMC directive 2004/108/EC
 compliance, and configurations other than this may affect that compliance.

CABLE TYPE LENGTH
(METER)

CORE SHIELD

Power 1.8

USB 5.0

LAN 15.0
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Telephone 3.0

EMERGENCY FIRST AID
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO NOT
 attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes
 keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of staining
 skin or clothing.

MANUFACTURER
Oki Data Corporation,

4-11-22 Shibaura, Minato-ku,

Tokyo 108-8551,

Japan

For all sales, support and general enquiries contact your local distributor.

IMPORTER TO THE EU/AUTHORISED REPRESENTATIVE
OKI Europe Limited

Blays House

Wick Road

Egham

Surrey, TW20 0HJ

United Kingdom

For all sales, support and general enquiries contact your local distributor.

ENVIRONMENTAL INFORMATION
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License
This product contains software developed by the Heimdal Project.

Copyright (c) 1995 - 2008 Kungliga Tekniska Högskolan

(Royal Institute of Technology, Stockholm, Sweden).

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
 permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above
 copyright notice, this list of conditions and the following
 disclaimer in the documentation and/or other materials
 provided with the distribution.

3. Neither the name of the Institute nor the names of its
 contributors may be used to endorse or promote products
 derived from this software without specific prior written
 permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS" AND
 ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE INSTITUTE OR CONTRIBUTORS
 BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
 SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
 INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
 CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
 POSSIBILITY OF SUCH DAMAGE.

Open Source License Disclosure
The following open source software is included to use Google Cloud Print. The
 descriptions about the open source license are as follows.

json-c

Copyright (c) 2009-2012 Eric Haszlakiewicz
Permission is hereby granted, free of charge, to any person obtaining a copy of this
 software and associated documentation files (the "Software"), to deal in the Software
 without restriction, including without limitation the rights to use, copy, modify, merge,
 publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
 to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or
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 substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
 IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
 FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT. IN NO EVENT SHALL
 THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
 OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
 ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
 OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2004, 2005 Metaparadigm Pte Ltd
Permission is hereby granted, free of charge, to any person obtaining a copy of this
 software and associated documentation files (the "Software"), to deal in the Software
 without restriction, including without limitation the rights to use, copy, modify, merge,
 publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
 to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or
 substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
 IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
 FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT. IN NO EVENT SHALL
 THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
 OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
 ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
 OTHER DEALINGS IN THE SOFTWARE.
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Contact Us

Oki Systems (UK) Ltd
Blays House
Wick Road
Egham
Surrey
TW20 0HJ
Tel: +44 (0) 1784 274300
Fax: +44 (0) 1784 274301
http://www.oki.co.uk

Oki Systems Ireland Limited
The Square Industrial Complex
Tallaght
Dublin 24
Tel:+353 (0) 1 4049590
Fax:+353 (0)1 4049591
http://www.oki.ie

Oki Systems Ireland Limited - Northern Ireland
19 Ferndale Avenue
Glengormley
BT36 5AL
Northern Ireland
Tel:+44 (0) 7767 271447
Fax:+44 (0) 1 404 9520
http://www.oki.ie
Technical Support for all Ireland:
Tel:+353 1 4049570
Fax:+353 1 4049555
E-mail: tech.support@oki.ie

OKI Systems (Czech and Slovak), s.r.o.
IBC – Pobřežní 3
186 00 Praha 8
Czech Republic
Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk

Oki Systems (Deutschland) GmbH
Hansaallee 187
40549 Düsseldorf
Tel:
  01805/6544357**
  01805/OKIHELP**
Fax: +49 (0) 211 59 33 45
Website:
www.okiprintingsolutions.de
info@oki.de
**0,14€/Minute aus dem dt. Festnetz der T-Com (Stand 11.2008)

Διανομέας των συστημάτων OKI
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CPI S.A1 Rafailidou str.
177 78 Tavros
Athens
Greece
Tel: +30 210 48 05 800
Fax:+30 210 48 05 801
EMail:sales@cpi.gr

Oki Systèmes (France) S.A.
44-50 Av. du Général de Gaulle
94246 L'Hay les Roses
Paris
Tel:+33 01 46 15 80 00
Télécopie:+33 01 46 15 80 60
Website: www.oki.fr

OKI Systems (Magyarország) Kft.
Capital Square
Tower 2
7th Floor
H-1133 Budapest,
Váci út 76
Hungary
Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu

OKI Systems (Italia) S.p.A.
via Milano, 11,
20084 Lacchiarella (MI)
Tel:+39 (0) 2 900261
Fax:+39 (0) 2 90026344
Website: www.oki.it

OKI Systems (Polska)
Platinium Business Park II, 3rd Floor
ul. Domaniewska 42
02-672 Warsaw
Poland
Tel:+48 22 448 65 00
Fax:+48 22 448 65 01
Website: www.oki.com.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl

Oki Systems (Ibérica) S.A.
Sucursal Portugal
Edifício Prime -
Av. Quinta Grande 53
7º C Alfragide
2614-521 Amadora
Portugal
Tel:+351 21 470 4200
Fax:+351 21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt

Oki Service
Serviço de apoio técnico ao
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Cliente
Tel: 808 200 197
E-mail : okiserv@oki.pt

OKI Systems Rus, LLC (Russia)
Sector B, 3rd Floor, Svyatogor-4 Business Center10/4, Letnikovskaya str.115114,
 Moscow
Tel: +7 495 258 6065
Fax: +7 495 258 6070
e-mail: info@oki.ru
Website: www.oki.ru
Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru

Oki Systems (Österreich)
Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge
Tel: +43 223 6677 110
Drucker Support:
+43 (0) 2236 677110-501
Fax Support:
+43 (0) 2236 677110-502
Website: www.oki.at

OKI Europe Ltd. (Ukraine)
Raisy Opkinoy Street,8
Building B, 2nd Floor,
Kiev 02002
Ukraine
Tel: +380 44 537 5288
e-mail: info@oki.ua
Website: www.oki.ua

OKI Sistem ve Yazıcı Çözümleri
Tic. Ltd. Şti.
Harman sok Duran Is Merkezi,
No:4, Kat:6,
34394, Levent
İstanbul
Tel: +90 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr
www.okiprintingsolutions.com.tr

Oki Systems (Belgium)
Medialaan 24
1800 Vilvoorde
Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be

AlphaLink Bulgaria Ltd.
2 Kukush Str.
Building "Antim Tower", fl. 6
1463 Sofia, Bulgaria
tel: +359 2 821 1160
fax: +359 2 821 1193
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Website: http://bulgaria.oki.com

OKI Systems (Danmark)
Herstedøstervej 27
2620 Albertslund
Danmark
Adm.: +45 43 66 65 00
Hotline: +45 43 66 65 40
Salg: +45 43 66 65 30
Fax: +45 43 66 65 90
Website: www.oki.dk

Oki Systems (Finland) Oy
Polaris Capella
Vänrikinkuja 3
02600 Espoo
Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809
Website: www.oki.fi

Oki Systems (Holland) b.v.
Neptunustraat 27-29
2132 JA Hoofddorp
Helpdesk: 0800 5667654
Tel:+31 (0) 23 55 63 740
Fax:+31 (0) 23 55 63 750
Website: www.oki.nl

Oki Systems (Norway) AS
Tevlingveien 23
N-1081 Oslo
Tel:+47 (0) 63 89 36 00
Telefax:+47 (0) 63 89 36 01
Ordrefax:+47 (0) 63 89 36 02
Website: www.oki.no

General Systems S.R.L. (Romania)
Sos. Bucuresti-Ploiesti Nr. 135.
Bucharest 1
Romania
Tel: +40 21 303 3138
Fax: +40 21303 3150
Website: http://romania.oki.com
Var vänlig kontakta din Återförsäljare i första hand, för konsultation. I andra hand
 kontakta

Oki Systems (Sweden) AB
Borgafjordsgatan 7
Box 1191
164 26 Kista
Tel. +46 (0) 8 634 37 00
e-mail:
info@oki.se för allmänna frågor om
Oki produkter
support@oki.se för teknisk support
gällandes Oki produkter
Vardagar: 08.30 - 12.00,
13.00 - 16.00
Website: www.oki.se
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Oki Systems (Schweiz)
Baslerstrasse 15
CH-4310 Rheinfelden
Support deutsch +41 61 827 94 81
Support francais +41 61 827 94 82
Support italiano +41 061 827 9473
Tel: +41 61 827 9494
Website: www.oki.ch

Oki Data Americas Inc.(United States • États-Unis)
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA
Tel: 1-800-654-3282
Fax: 1-856-222-5247
http://WWW.OKIPRINTINGSOLUTIONS.COM
http://my.okidata.com

Oki Data Americas Inc.(Canada • Canadá)
4140B Sladeview Crescent Unit 7 & 8
Mississauga, Ontario
Canada L5L 6A1
Tél: 1-905-608-5000
Téléc: 1-905-608-5040
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data Americas Inc.(América Latina (OTRO))
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA
Tel (Español): 1-856-222-7496
1-856-222-5276
Fax: 1-856-222-5260
Email: LASatisfaction@okidata.com

Oki Data de Mexico, S.A. de C.V.
Mariano Escobedo #748, Piso 8
Col. Nueva Anzures
C.P. 11590, México, D.F.
Tel: 52-555-263-8780
Fax: 52-555-250-3501
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data do Brasil Informática Ltda.
Av. Alfredo Egídio de Souza Aranha, 100 - 5º Andar - Bloco C
Chácara Santo Antonio - São Paulo, SP - Brasil
CEP: 04726-170
Tel:55-11-3543-5500 (Grande São Paulo)
0800-11-5577 (Demais localidades)
Fax: 55-11-3444-3501
email: okidata@okidata.com.br
HTTP://www.okiprintingsolutions.com

Argentina/Chile/Paraguay/Perú/Uruguay
Oki Data Americas, Inc.
Sucursal Argentina
Ugarte 3610 Piso 4°(1605) Olivos
Buenos Aires, Argentina
Tel: +54 11 5288 7500
Fax: +54 11 5288 7599
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Colombia/Ecuador/Venezuela
/Centroamérica y Caribe
Oki Data Americas, Inc.
Sucursal Colombia
Carrera 13 #97-51, Oficina 101
Bogotá Colombia
Tel: +57 1 704 5159

Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)
Tel:(65) 6221 3722
Fax:(65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
1168/81-82 Lumpini Tower,
27th Floor Rama IV Road
Tungmahamek, Sathorn
Bangkok 10120
Tel:(662) 679 9235
Fax:(662) 679 9243/245
http://www.okisysthai.com

Oki Data(Australia) Pty Ltd.
Level1 67 Epping Road, Macquarie Park
NSW 2113, Australia
Tel: +61 2 8071 0000
(Support Tel: 1800 807 472)
Fax: +61 2 8071 0010
http://www.oki.com.au

Comworth Systems Ltd.
8 Antares Place Rosedale,
Auckland 0632, New Zealand
Tel:(64) 9 477 0500
Fax:(64) 9 477 0549
http://www.comworth.co.nz

Oki Data(S) P Ltd. Malaysia Rep Office
Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia
Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166
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